Financial Reporting Studio User’s Guide, 9.3.1

Copyright © 1989, 2007, Oracle and/or its affiliates. All rights reserved.

Authors: Sigrid Perry

The Programs (which include both the software and documentation) contain proprietary information; they are provided under a license agreement containing restrictions on use and disclosure and are also protected by copyright, patent, and other intellectual and industrial property laws. Reverse engineering, disassembly, or decompilation of the Programs, except to the extent required to obtain interoperability with other independently created software or as specified by law, is prohibited.

The information contained in this document is subject to change without notice. If you find any problems in the documentation, please report them to us in writing. This document is not warranted to be error-free. Except as may be expressly permitted in your license agreement for these Programs, no part of these Programs may be reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose.

If the Programs are delivered to the United States Government or anyone licensing or using the Programs on behalf of the United States Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS Programs, software, databases, and related documentation and technical data delivered to U.S. Government customers are "commercial computer software" or "commercial technical data" pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the Programs, including documentation and technical data, shall be subject to the licensing restrictions set forth in the applicable Oracle license agreement, and, to the extent applicable, the additional rights set forth in FAR 52.227-19, Commercial Computer Software--Restricted Rights (June 1987). Oracle USA, Inc., 500 Oracle Parkway, Redwood City, CA 94065.

The Programs are not intended for use in any nuclear, aviation, mass transit, medical, or other inherently dangerous applications. It shall be the licensee’s responsibility to take all appropriate fail-safe, backup, redundancy and other measures to ensure the safe use of such applications if the Programs are used for such purposes, and we disclaim liability for any damages caused by such use of the Programs.

Oracle is a registered trademark of Oracle Corporation and/or its affiliates. Other names may be trademarks of their respective owners.

The Programs may provide links to Web sites and access to content, products, and services from third parties. Oracle is not responsible for the availability of, or any content provided on, third-party Web sites. You bear all risks associated with the use of such content. If you choose to purchase any products or services from a third party, the relationship is directly between you and the third party. Oracle is not responsible for: (a) the quality of third-party products or services; or (b) fulfilling any of the terms of the agreement with the third party, including delivery of products or services and warranty obligations related to purchased products or services. Oracle is not responsible for any loss or damage of any sort that you may incur from dealing with any third party.
Chapter 1. Getting Started with Financial Reporting .......................................... 15
   Terminology in this Release ............................................................................. 15
   Financial Reporting Components .................................................................. 16
      Data Sources .................................................................................................. 16
      Sample Report ............................................................................................... 17
      Report Components ....................................................................................... 18
      Report Objects .............................................................................................. 19
      Studio Workspace .......................................................................................... 19
      Report Designer ............................................................................................. 20
      Property Sheet ............................................................................................... 20

Navigating in the Studio Workspace .................................................................. 20
   Workspace Functionality ................................................................................ 20
   Batch and Book Editor, Batch Scheduler ....................................................... 21

Design Considerations ...................................................................................... 21
   Planning Details as a Database Connection ................................................... 21
   Support for Hyperion® Workforce Planning Smart Lists ................................ 21
   Database Connection for Essbase and Planning Details .................................. 22
   Data Queries - Expanded Versus Single Data Segments ............................... 22
   Designing Considerations .............................................................................. 22

Recommendations for Designing Dynamic Reports ......................................... 23

Basic Financial Reporting Tasks ....................................................................... 23
   Starting Financial Reporting Studio ............................................................... 24
   Logging on to Workspace ................................................................................ 24
   Designing Reports ........................................................................................... 24
   Opening Existing Reports ................................................................................ 26
   Viewing Snapshot Reports ............................................................................... 26
   Creating a Book ............................................................................................... 26
   Creating a Batch ............................................................................................... 27
   Setting Preferences ......................................................................................... 27
   Changing your Password ............................................................................... 27
   Closing Studio Explore or the Designer ......................................................... 27
Chapter 2. Selecting Members for Report Designers

Assigning Members to Data Rows or Columns .................................................. 40
Assigning Members to the Page Axis ................................................................ 41
Assigning Special Members .............................................................................. 42
   Setting Up Report Prompts for Members ....................................................... 42
   Setting Up Same As References .................................................................. 43
   Setting Up a Current Point of View ............................................................... 44
   Selecting the User Point of View as a Member in the Book Point of View .... 45
Assigning Members Using Functions ................................................................. 45
Editing Functions ............................................................................................. 52
Copying Members Between Applications ......................................................... 52
Removing or Adding Members .......................................................................... 53
Selecting Multiple Members Based on Criteria .............................................. 54
Filtering the View of Members Based on Criteria ........................................... 54
Defining Member Lists ..................................................................................... 55
Editing Member Lists ....................................................................................... 56
Searching for Members .................................................................................... 56
Sorting Members ............................................................................................... 58
Previewing Selected Members .......................................................................... 58
Access Privileges for the Planning Details Database Source ......................... 58

Chapter 3. Customizing Charts ........................................................................ 61
About Charts ..................................................................................................... 61
### Bar Charts ....................................................... 62
### Line Charts ....................................................... 62
### Combo Charts .................................................... 63
### Pie Charts ....................................................... 64
### Formatting Charts ................................................ 65
  - Defining Chart Data .............................................. 65
  - Using the Format Chart Dialog Box .................................. 67
  - Formatting Fonts in Charts ........................................... 69
  - Formatting Chart Border and Background Options ......................... 70
  - Formatting Bars in Bar and Combo Charts .................................. 70
  - Formatting Lines in Line and Combo Charts .................................. 71
  - Defining Combo Chart Options .......................................... 72
  - Formatting Pie Charts ................................................ 72
  - Setting Background Options for a Chart ................................. 73
  - Positioning Charts on Reports .......................................... 74
  - Defining Gridlines .................................................. 75
  - Defining Styles for Data Sets ........................................... 75
  - Resizing and Moving Charts ............................................. 76
### Formatting Chart Titles and Labels ................................ 76
  - Defining a Chart Legend Title ......................................... 76
  - Defining a Chart Title ................................................ 77
  - Defining Chart Axis Titles ............................................. 78
  - Defining Axis Labels .................................................. 78
  - Viewing Charts ...................................................... 79

### Chapter 4. Building Reports ............................................. 81
### Adding Report Objects ................................................ 81
  - Using Linked and Local Objects ........................................... 82
    - Linked Objects .................................................... 82
    - Local Objects in Financial Reporting ................................. 83
  - Adding Text Objects ................................................ 84
    - Modifying Text Objects .............................................. 84
    - Saving Text Objects ................................................ 85
  - Adding Grids ........................................................ 86
    - Modifying the Properties of Grid Objects ............................. 88
    - Saving Grid Objects ................................................ 89
  - Inserting Images ..................................................... 89
    - Saving Image Objects ............................................... 90
  - Inserting Charts ...................................................... 91
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saving Chart Objects</td>
<td>92</td>
</tr>
<tr>
<td>Creating Headers and Footers</td>
<td>92</td>
</tr>
<tr>
<td>Positioning Report Objects</td>
<td>93</td>
</tr>
<tr>
<td>Resizing Report Objects</td>
<td>94</td>
</tr>
<tr>
<td>Saving Report Objects</td>
<td>95</td>
</tr>
<tr>
<td>Removing Report Objects from a Report</td>
<td>95</td>
</tr>
<tr>
<td>Designing Headers and Footers</td>
<td>95</td>
</tr>
<tr>
<td>Creating a Title Page</td>
<td>96</td>
</tr>
<tr>
<td>Inserting Page Breaks Before Report Objects</td>
<td>97</td>
</tr>
<tr>
<td>Viewing Report Summaries</td>
<td>97</td>
</tr>
<tr>
<td>Viewing Server Information</td>
<td>97</td>
</tr>
<tr>
<td><strong>Chapter 5. Customizing Grids</strong></td>
<td>99</td>
</tr>
<tr>
<td>Inserting Rows or Columns in Grids</td>
<td>100</td>
</tr>
<tr>
<td>Cutting, Copying, and Pasting in Grids</td>
<td>101</td>
</tr>
<tr>
<td>Specifying Row and Column Headings for Grids</td>
<td>102</td>
</tr>
<tr>
<td>Overriding Row and Column Headings for Grids</td>
<td>103</td>
</tr>
<tr>
<td>About Row and Column Templates</td>
<td>105</td>
</tr>
<tr>
<td>How Inheritance Works with Row and Column Templates</td>
<td>106</td>
</tr>
<tr>
<td>Property Values</td>
<td>106</td>
</tr>
<tr>
<td>Creating a Row and Column Template</td>
<td>108</td>
</tr>
<tr>
<td>Inserting a Row and Column Template</td>
<td>111</td>
</tr>
<tr>
<td>Unlinking a Row and Column Template</td>
<td>111</td>
</tr>
<tr>
<td>Modifying a Row and Column Template</td>
<td>112</td>
</tr>
<tr>
<td>Setting Data Query Optimization Options</td>
<td>112</td>
</tr>
<tr>
<td>Enabling Expansions for Essbase</td>
<td>115</td>
</tr>
<tr>
<td>Displaying Line Item Detail for Financial Management</td>
<td>115</td>
</tr>
<tr>
<td>Showing Supporting Detail for Planning</td>
<td>115</td>
</tr>
<tr>
<td>Defining the Grid Point of View</td>
<td>117</td>
</tr>
<tr>
<td>Showing or Hiding the Grid POV Bar</td>
<td>118</td>
</tr>
<tr>
<td>Selecting Members for the Grid Point of View</td>
<td>118</td>
</tr>
<tr>
<td>Setting Up a Grid Point of View</td>
<td>118</td>
</tr>
<tr>
<td>Inserting Page Breaks</td>
<td>119</td>
</tr>
<tr>
<td>Defining Page Axis Headings</td>
<td>120</td>
</tr>
<tr>
<td>Changing the Database Connection of Grids</td>
<td>122</td>
</tr>
<tr>
<td>Assigning Multiple Database Connection to Grids</td>
<td>122</td>
</tr>
<tr>
<td>Adding Auto Calculations to Data Rows and Columns</td>
<td>123</td>
</tr>
<tr>
<td>Applying Formatting to Auto Calculated Data Rows and Columns</td>
<td>126</td>
</tr>
<tr>
<td>Defining Formula Rows or Columns</td>
<td>128</td>
</tr>
</tbody>
</table>
Chapter 9. Formatting Reports .................................................. 163

Formatting Text Boxes ..................................................... 163

Specifying Fonts for Text Boxes ......................................... 163
Aligning Text in Text Boxes ............................................. 164
Adding Borders and Shading to Text Boxes ......................... 165
Formatting Grids ............................................................. 165
Expanding the View of a Grid ........................................... 165
Formatting Best Practices ............................................... 166
Formatting Numbers in Grids .......................................... 166

Aligning Text in Grids ...................................................... 168
Modifying Font Options .................................................. 170
Adding Borders or Shading .............................................. 171
Replacing Text ............................................................... 173
Inheriting Cell Formatting .............................................. 174
Copying Cell Formatting ................................................ 175
Hiding Rows, Columns, or Grids ...................................... 176
Controlling the Evaluation of Suppression in Hidden Rows or Columns .................. 177
Sorting Rows, Columns, and Pages ................................... 177
About Conditional Formatting ....................................... 179

Applying Conditional Formatting on Grids ......................... 182
Deleting Conditions ......................................................... 186
Adding Conditional Formats ........................................... 186
Changing the Order of Conditional Formats ....................... 187
Deleting Conditional Formats ......................................... 187
Changing Row Height and Column Width ......................... 188
Merging Cells into One Cell ............................................ 188
Chapter 10. Using Functions

Mathematical Functions

Arguments

Numeric Arguments

Row, Column, or Cell Reference Arguments

Property Arguments

Embedded Functions as Arguments

Text Functions

Text Function Consideration

Current / Cur Keyword

List of Functions

Abs

Average

AverageA

CalcStatus

CellText

CellText Function with MemberOverride

Count

CountA

DataSource

Date

Difference

Eval

GetCell

GetHeading

GridDimension

HFMCurrency

ListOfCellDocuments

IfThen, If

Notes on Conditions

Complex Conditions
Contents

Max .............................................................. 236
MemberAlias ....................................................... 236
MemberDescription ................................................ 237
MemberName ...................................................... 239
MemberProperty .................................................... 240
MemberQualifiedName ............................................... 241
Min .............................................................. 242
Mod .............................................................. 243
Page .............................................................. 244
PageCount ........................................................ 244
PercentOfTotal ...................................................... 245
Pi ................................................................ 246
PlanningAnnotations ................................................ 246
  Specifying Demarcations Between Annotations ................. 248
POVAlias .......................................................... 249
POVDescription ................................................... 249
POV / POVMember .................................................. 250
ProcessManagementStatus ........................................... 250
Product .............................................................. 251
Random ............................................................ 252
Rank ............................................................. 252
ReportAuthor ....................................................... 254
ReportCreated ...................................................... 254
ReportDesc ........................................................ 254
ReportFolder ....................................................... 255
ReportModified .................................................... 255
ReportModifiedBy .................................................. 256
ReportName ........................................................ 256
ReportRunBy ....................................................... 256
Round ............................................................ 256
Sqrt .............................................................. 257
Sum .............................................................. 258
Truncate / Trunc ................................................... 259
VariableValue ....................................................... 260
Variance / Var ....................................................... 260
  Expected Results Using Essbase ................................ 261
  Expected Results Using Planning Details ....................... 261
  Expected Results Using Financial Management ............... 261
  Variance Behavior ............................................... 262
Chapter 11. Managing the Explore Repository ............................................. 271
Creating Folders ................................................................. 271
Duplicating Objects in the Repository ........................................... 272
Filtering Report Objects ........................................................... 272
Cutting, Copying, and Pasting in the Repository ............................... 273
Managing Database Connections .................................................. 273
Exporting Repository Objects and Report Objects ................................ 273
Importing Report Objects into the Repository ...................................... 273
Sending Links to Reports Through E-Mail ........................................ 273
Deleting Items from the Repository .................................................. 273
Changing the Database Connection for Reports and Report Objects in the Repository ................................................. 274
Changing a Report Database Connection ........................................... 274
Managing Security for Objects in the Repository ................................... 274

Chapter 12. Using Batch Processing .................................................... 277

Chapter 13. XBRL in Financial Reporting ................................................. 279
XBRL Terms ................................................................................. 279
Setting Up Financial Reporting for XBRL .......................................... 280
Enabling XBRL ............................................................................. 280
Downloading XBRL taxonomies to the XBRL directory ...................... 280
Using XBRL Management ............................................................. 281
Managing the XBRL Schema .......................................................... 281
Updating Schema Registration ....................................................... 282
Maintaining Schema Registration .................................................... 283
Chapter 14. Working with Books and Snapshot Books ................................................ 295

Chapter 15. Administrative Tasks for Financial Reporting ........................................ 297

POV Management .................................................. 297

Using the User POV Utility ........................................ 298

Report Server Tasks ................................................ 300

Specifying the Maximum Number of Calculation Iterations ......................... 300

Log File Output Management ....................................... 301

Periodic Log File Rolling ........................................... 302

Changing Logging Options ......................................... 302

Application Server Logging ......................................... 303

Back Up Current Log Files .......................................... 303

Assigning Financial Reporting TCP Ports for Firewall Environments or Port Conflict
Resolution ............................................................ 304

Accessing Server Components Through a Device that Performs NAT .............. 305

Network Address Translation (NAT) ................................ 306

Remote Method Invocation (RMI) ................................... 306

Issue Using RMI Through Devices that Perform NAT .............................. 306

Adding Required Java Arguments on Windows Systems ............................ 306

Adding Required Java Arguments on UNIX Systems ................................ 308

WebLogic ............................................................... 308

WebSphere ............................................................. 308

Essbase Ports .......................................................... 309

Differences Between Essbase Ports and Connections .............................. 309
### Contents

- Checking the Current Essbase Connections ........................................... 310
- Changing Settings in Essbase Configuration Files ............................... 310
- Calculating the Formula for the Maximum Number of Essbase Ports .......... 311

#### Scheduler E-mail Configuration

- Scheduler Command Line Interface ..................................................... 311
- Creating Batch Input Files ................................................................... 312
- Launching Batches from a Command Line ........................................... 312
- Scheduling Batches Using an External Scheduler .................................... 312
- Encoding Passwords ............................................................................ 313
- Modifying Attributes .......................................................................... 313

#### Batch Input File XML Tag Reference

- Batch Input File XML Tag Reference ................................................... 315
  - BATCH_JOB_OBJECT - Node Tag ...................................................... 315
  - RUN_OPTIONS - Child Node Tag ..................................................... 315
  - NOTIFICATION, EMAIL - Child Node Tag ...................................... 316
  - JOB_STATUS - Child Node Tag ....................................................... 316
  - JOB_OBJECT - Child Node Tag ....................................................... 316
  - DATA_SOURCE_USER_CREDENTIALS - Child Node Tag .................... 316
  - HR_USER_CREDENTIALS - Child Node Tag ...................................... 316
  - OUTPUT_OPTIONS - Child Node Tag .............................................. 316
  - CHILD NODE - HTML ..................................................................... 317
  - CHILD NODE - PDF ......................................................................... 317
  - CHILD NODE - SAVE_AS_SNAPSHOT ............................................. 317
  - CHILD NODE - PRINT .................................................................... 317
  - USER_POV - Child Node .................................................................. 318

#### Setting XBRL Schema Registration

- Setting XBRL Schema Registration ...................................................... 318
  - CHILD NODE - KEY ......................................................................... 318
  - CHILD NODE - POV ........................................................................ 318
  - DIMENSION - Child Node ................................................................. 319
  - METADATAEXPRESSION - Child Node ............................................ 319

#### RMI Encryption Implementation

- RMI Encryption Implementation .......................................................... 319

---

### Appendix A. Property Sheet Help

- Appendix A. Property Sheet Help .......................................................... 321
- Report Properties ................................................................................ 321
- Grid Properties ................................................................................... 321
  - Grid Properties - General Category ................................................ 322
  - Grid Properties - Suppression Category ........................................... 323
  - Grid Properties - Position Category ................................................. 323
- Page Properties ................................................................................. 324
- Heading Row/Column Properties ......................................................... 325
Appendix B. Frequently Asked Questions ................................................. 333
Why are dimensions listed on the user POV when changing them has no effect on the grid? ............................................................. 333
Why are the grid POVs not displayed in the Report Designer Workspace? ........................................................................ 334
How will a user running Workspace know that the dimension is set on the grid POV? ........................................................... 334
How can a report be designed so that any changes to a user's user POV changes the members selected from a row, column, or page axis on a grid? ................................................ 335
Why do you need a book POV? ................................................................... 335
What are Report Member Selections? ......................................................... 335
Why not just call Report Member Selections the report POV? .................... 335
Why do you need a batch POV? ............................................................... 336

Appendix C. Currency Table ........................................................................ 337

Glossary ............................................................................................. 339

Index ............................................................................................... 363
Oracle’s Hyperion® Financial Reporting – System 9 is a powerful tool for designing and presenting analytic data graphically. You can design traditional financial report formats such as cash management reports, profit and loss statements, and balance sheets. You can also design nontraditional formats for financial or analytic data that include text and graphics.

Financial Reporting uses an object-oriented graphical report layout. Whether you have little or advanced experience using an object-oriented graphical program, it is easy to design reports. You use report objects, such as text boxes, grids, images, and charts, to design your reports. You can use the same report objects in multiple reports.

**Terminology in this Release**

To differentiate between the Oracle’s Hyperion® Financial Reporting Studio and the Web client the following terms are used in this guide:

- In this guide, for Financial Reporting Studio, “workspace” is referred to as “Studio workspace”. When in the Report Designer, “workspace” is referred to as the “Report Designer workspace”. The Web client equivalent is referred to as “Hyperion System 9 Workspace™” (Workspace).

- In this guide, for Financial Reporting Studio, “explore” is referred to as “Studio Explore”. The Web client equivalent is referred to as “Explore”.
Note:
This guide provides detailed information on functions that are performed in Financial Reporting Studio. Also, it briefly describes additional functionality that can be performed in Financial Reporting Workspace. For information about Financial Reporting functionality that is performed in Workspace, see the Hyperion Workspace User’s Guide.

Financial Reporting Components

Financial Reporting is comprised of numerous components that can be accessed in Financial Reporting Studio, Workspace, or both:

- **Report Designer**—In Financial Reporting Studio - Enables you to create, edit, or delete report objects, reports or snapshot reports.
- **Explore**
  - In Financial Reporting Studio - Enables you to create, open, save, and delete folders and store report objects, reports, and snapshot reports.
  - In Financial Reporting Workspace - Enables you to open stored files, create folders, export and import files, and set up e-mail links to folders, reports, and snapshot books.
- **Book Editor**—In Financial Reporting Workspace - Provides the capability of creating a book of reports, which can be saved as a book or a snapshot book.
- **Scheduler**—In Financial Reporting Workspace-Enables you to schedule a batch and view the status of batches that are scheduled for future processing.
- **Batch Editor**—In Financial Reporting Workspace-Enables you to add objects to a batch job, remove objects from a batch job, schedule a batch, and indicate whether or not you want the batch deleted after it runs.
- **Workspace**—The tasks you can perform are based on your user rights.
  - In Financial Reporting Studio - If you are Report Designer or Global Administrator, you can create, edit, or delete report objects, reports or snapshot reports in the designer Studio workspace or work with reports and report objects in Studio Explore.
  - In Workspace - you can create a book of reports, schedule batches, view batches, and edit batches. If you are a user with viewer rights you can view reports and export documents to Word, Excel, and PowerPoint. For information on Workspace, see the Hyperion Workspace User’s Guide.

Data Sources

You can retrieve data from SAP BW data sources. You can also design and view reports that retrieve and format data from Oracle’s Hyperion® Financial Management – System 9. Microsoft SQL Server Analysis Services (SSAS), and Oracle’s Hyperion® Essbase® – System 9.
SAP BW Data Source
You can query multiple SAP BW data sources within a report. SAP BW data sources can include InfoProviders, which provide unified access to all types of SAP BW objects. These objects include InfoCubes, ODS objects, Master Data Tables, InfoSets, and remote InfoCubes.

With SAP BW data sources, Financial Reporting provides direct access to aggregates, which are integrated views of data in an InfoCube. Aggregates make it possible to access InfoCube data quickly in reporting. Financial Reporting provides direct access to aggregates through an OLAP BAPI, which is a specialized interface for accessing BW data through presentation tools.

Note:
The SAP-BW's BAPI driver does not allow you to issue an MDX query on any cube which has more than 50 characters.

SSAS Data Source
SSAS delivers both online analytical processing (OLAP) and data mining functionality for business intelligence applications. Financial Reporting allows you to connect to a SSAS data source and produce financial reports. Considerations for SSAS:

- CSS/Single sign-on is not supported.
- SSAS does not support paging or cursoring. For example, if a parent node has one thousand children, and a user expands that node, one thousand are pushed to the client.
- To log on against the SSAS data source, the domain name is required in the User Name field.
- By default, when using SSAS 2000, any user can log on to the data source. To force a user to log on, set SSASImpersonate=true in the fr_global.properties file.

Sample Report
The following figure shows a sample report created in Financial Reporting Studio. The sample report is designed with a header that contains an image and a title, and two grids and charts. The charts reference the grid data above.
Report Components

The following table describes the components that you can use while designing reports in Financial Reporting Studio. Report components include report objects, such as grids and charts, headers and footers, and rows, columns, and cells of grids.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header</td>
<td>An area where you can display text on the top of each page of a report. You can add other report objects to a header.</td>
</tr>
<tr>
<td>Text Box</td>
<td>A report object that can contain text, or functions that retrieve data such as report settings, data values, point of view (POV) values, or dimension members</td>
</tr>
<tr>
<td>Grid</td>
<td>A report object in which you retrieve data in the rows, columns, and page axes</td>
</tr>
<tr>
<td>Chart</td>
<td>A report object that displays data from a specified grid. Charts are graphical representations of the data in a grid</td>
</tr>
</tbody>
</table>
**Report Objects**

Report objects are basic components for designing reports in Financial Reporting Studio. Report objects include text boxes, grids, images, and charts. You can use the toolbar buttons and menu commands to add report objects to the report.

The following table shows the toolbar buttons that you use to insert report objects. You can insert a new or a previously saved report object.

<table>
<thead>
<tr>
<th>Table 1</th>
<th>Report Object Toolbar Buttons</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Button</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td><img src="image" alt="Textbox" /></td>
<td>Inserts a text box.</td>
</tr>
<tr>
<td><img src="image" alt="Grid" /></td>
<td>Inserts a grid.</td>
</tr>
<tr>
<td><img src="image" alt="Chart" /></td>
<td>Inserts a chart.</td>
</tr>
<tr>
<td><img src="image" alt="Image" /></td>
<td>Inserts an image.</td>
</tr>
</tbody>
</table>

**Studio Workspace**

The Studio workspace is an area where you can open a new or existing report in the Report Designer and access the repository. The Studio workspace is the first area you see when you log on to Financial Reporting Studio. Only a Report Designer and Global Administrator can access...
to the Financial Reporting Studio Explore and Designer. See the Hyperion Workspace User’s Guide for more information on rights and security.

Report Designer

In the Financial Reporting Studio Designer area, the Report Designer can create and edit reports. You can view your report data in print, print preview, or Web preview.

In Financial Reporting Studio Designer, you select toolbar buttons or menu commands to add report objects to the report. You can then customize each report object using its property sheet. For example, you can select a grid, and use the Grid Properties property sheet to specify dimensions, select members, and specify heading options. For more information on the property sheets, see “Property Sheet” on page 20.

You can also select a report object and right-click to display a shortcut menu. For a list of shortcut commands available, see “Shortcut Menu Commands” on page 33.

Property Sheet

Property sheets enable you to set various options for the currently selected report component. When you set a property option, it is automatically applied to the selected report object.

The property sheet features change based on the category selected. There are several categories available, depending on the type of report component selected. Each category shows another set of characteristics you can set for a selected report component.

By default, property sheets are displayed on the right side of the designer. You can hide the property sheet window.

To hide a property sheet that is displayed, deselect View > Property Sheet.
To display a properties sheet that is hidden, select View > Property Sheet.

Navigating in the Studio Workspace

After you log on, you see the Studio Explore page, which displays the Financial Reporting Studio repository. Use the top of the page to select menu commands, use shortcuts from the toolbar area, or right-click to select shortcut menu items.

The Report Designer can create a report by selecting File > New > Report from the menu bar.
For menu option availability, see “Menus” on page 29, for toolbars, see “Toolbars” on page 27 and for shortcuts, see “Shortcut Menu Commands” on page 33.

Workspace Functionality

In addition to the functionality available in the Financial Reporting Studio, Workspace provides expanded functionality for the Report Designer. For example, repository objects such as reports, books, and graphics can be opened, copied, deleted, moved, imported, exported and renamed.
Folders can be created, opened, deleted, imported, exported and renamed. Reports and books can be previewed (HTML or PDF). You can also sort items in the repository by clicking a column field header. In addition, the following menu commands are available: For detailed information on the following topics, see the Hyperion Workspace User’s Guide.

- Access Privileges
- Preferences
- Change and manage Database Connections
- Email Links
- Display items of type
- Hyperion System 9 Shared Services™

**Batch and Book Editor, Batch Scheduler**

Included with Workspace is the ability to work with books and batches. Batches can be created, edited and saved. Batches can also be scheduled, with full Batch Scheduler capabilities available from Workspace. Books can also be created, edited and saved. Advanced Member Selection has capabilities such as member functions (for example, Children, Descendants) and lists, similar to Financial Reporting Studio. For more information on batches, Book Editor, and Batch Scheduler, see the Hyperion Workspace User’s Guide.

**Design Considerations**

Report performance can vary for each client. What is acceptable for one client may not be acceptable for another. For example, if reports are run in batches during off-peak hours, they may have to be completed before the next business day. When data is updated hourly, report performance may only be acceptable if report output returns in seconds.

**Planning Details as a Database Connection**

Once you install the Hyperion System 9 Planning™ Planning Details ADM driver, you may choose Planning Details as a database connection. The Planning Details ADM driver is optimized as a data source to provide features such as supporting details, planning unit annotations and metadata filtering. If your report grid does not use those Planning features, for optimal performance, choose Essbase as the database connection for your report. For more information, see “Showing Supporting Detail for Planning” on page 115 and “PlanningAnnotations” on page 246.

**Support for Hyperion® Workforce Planning Smart Lists**

Smart Lists are attribute-like values that are assigned to members, where the actual assignment is stored as data in the Essbase cube for the member (for example, 0, 1, 2, 3, 4) and the Planning
Repository translates those numbers to textual strings (for example, 0=“Straight Line Depreciation”, 1=“Double Declining Balance”, and so on).

Examples of Financial Reporting support of Smart Lists:

- Grids which reference cells in a Planning database which contain Smart Lists will return a string value instead of a number. String values are always shown in the results instead of numbers.
- The Text function GetCell() returns the string value instead of a number when it references a cell containing an Smart List.
- Using “numeric” comparison operators and string comparison operators (equals, startswith, and so on), Conditional Formatting and Suppression allows selection of any cell (Data, Formula, Text) with the "Cell Value" operand. For example, Conditional Suppression can refer to a data cell which contains a Smart List string and apply Conditional Suppression such as "suppress row if cell value B, 6 starts with 'ABC'".
- You can apply conditional formatting and suppression to Hyperion® Workforce Planning Smart Lists textual data.

Database Connection for Essbase and Planning Details

When you change a report from an Interactive Reporting database connection to a Planning Details database connection or vice versa, there are several restrictions because the data source reference is the only change. For more information, see “Changing a Report Database Connection” on page 274.

Data Queries - Expanded Versus Single Data Segments

A data segment is a row or column that retrieves data from a database. An expanded data segment is a row or column that can expand, so that the resulting grid expands to two or more rows or columns when viewed. Often, expanded data segments use functions such as Children Of or Descendants Of. A single data segment is a row or column that remains a single row or column when shown in the viewer.

While it is generally valid to use expanded and single data segments in the same grid, when designing a grid with large amounts of data, consider using expanded data segments rather than single data segments. Expanded data segments provide some performance advantages over single data segments. However, to produce detailed formatting on different data rows or columns, use single data segments.

Designing Considerations

Before designing reports, the designer should consider the following items:

- Has the data source application been designed to support the required hierarchies and calculations for all reports?
- What is the goal of the report?
Who are the end users of the report?

How frequently is the report generated and by how many users?

What is an acceptable retrieval/generation time?

How many cells does the report query (before suppression)?

**Recommendations for Designing Dynamic Reports**

When designing dynamic reports, consider the following information:

- Use expanded data segments for optimal performance:
  - Use functions on expanded data segments that are not placed on separate rows/columns
  - Use multiple member selections on expanded data segments that are not placed in separate rows/columns
  - Use single data segments only when required for formatting or calculations

- Write efficient formulas:
  - Use row/column formulas rather than cell formulas, when possible
  - Use reference properties
  - Use a cell reference instead of cross-axis references
  - Remove unnecessary parenthesis from formulas

- Don’t limit your report to the Grid object:
  - Add functions in text boxes that highlight specific areas
  - Hide a grid of data in a report to highlight just the graphics

- Create report templates:
  - Leverage the power of POVs and prompting functions
  - Design once using the CurrentPOV and prompting functions
  - Learn the power of Grid, User, Book, and Batch POVs

- Create reusable objects and row and column templates. Text, Image, Grid, Chart objects, and row and column templates can be reused in multiple reports

**Basic Financial Reporting Tasks**

Basic tasks in Financial Reporting Studio are as follows:

- “Designing Reports” on page 24.
- “Opening Existing Reports” on page 26.
- “Creating a Book” on page 26
Starting Financial Reporting Studio

To start the Financial Reporting Studio:

1. Perform an action:
   - Double-click the Financial Reporting Studio icon on your desktop.
   - From the Windows Start menu, select Programs > Hyperion > Reporting & Analysis > Financial Reporting > Studio.

2. When the Hyperion Login dialog box is displayed, type your User ID, Password, and select a report server. Click OK.

Logging on to Workspace

To log on to Workspace:

1. Enter the following case-sensitive URL in the Address box of the Web browser:
   http://webserver:port number/workspace/index.jsp

2. Enter your username and password.

3. Click Log On. Workspace is displayed.

Designing Reports

You can design reports in the Financial Reporting Studio Designer using a blank report layout where you can specify the contents of the report, including grids, charts, images, text boxes, headers, and footers.

To design a report in the Report Designer:


2. To add data to your report, select Insert > Grid, then drag an area on the Designer Studio workspace for the grid.

3. In the Select a Database Connection dialog box, perform an action:
   - Select a database connection from the drop-down list and click OK.
Create a new database connection by clicking the **New Database Connection** button. The Database Connection Properties dialog box is displayed:

<table>
<thead>
<tr>
<th>Database Connection Name</th>
<th>SAP Sample</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>SAP-BW</td>
</tr>
<tr>
<td>Server</td>
<td>172.27.27.66</td>
</tr>
<tr>
<td>User ID</td>
<td>BV/USR01</td>
</tr>
<tr>
<td>Password</td>
<td></td>
</tr>
<tr>
<td>System Number</td>
<td>01</td>
</tr>
<tr>
<td>Client</td>
<td>800</td>
</tr>
<tr>
<td>Catalog</td>
<td>OD_DECU</td>
</tr>
<tr>
<td>Cube</td>
<td>OD_DECU/JHC_GC_VAP.CV_01</td>
</tr>
</tbody>
</table>

a. In the **Database Connection Name** text box, enter a unique name for the connection.
b. Select a data source type from the **Type** drop-down list: HFM, Planning Details, Essbase, Microsoft Analytical Server (SSAS), or SAP-BW.

**Note:**

When designing a report with a Planning data source, select the Planning Details data source type only if your grid contains Supporting Detail or Planning Unit Annotations. In all other cases, select Essbase as the data source type.

c. For Essbase, Financial Management, SSAS, or SAP BW data source, enter the database server name in the Server text box.
d. Enter a user Id in **User ID**.
e. Click ![icon](image) to select the Application/Catalog and Database.
f. For an SAP BW data source, enter the two-digit system number of the SAP system in the **System Number** text box and the client computer name in the **Client** text box. For more information about the system number and client specifications, see the SAP documentation.
g. For a Planning Detail data source, enter the name of the plan type in the Plan Type text box.

**Note:**
The Database/Cube Lookup is combined into the Application/Catalog Lookup button. The Application/Catalog Look up button displays a tree view of the applications/catalogs and corresponding databases/cubes; The applications are listed as parents and the databases are listed as children. For data sources that are not associated with a database, only applications are listed.

4 Click OK.

**Opening Existing Reports**

You can open existing reports in the Designer or Studio Explore to modify the report design or to display the report with current data. Data is refreshed when the report is opened or viewed. Static data can be saved with a report when you save it as a snapshot report.

➤ To open an existing report in the Designer:
1 Select File > Open.
2 Double-click a folder from the Open dialog box or highlight the folder name and click Open. A list of all reports contained in the folder is displayed.
3 Select reports to open, then click Open.

➤ To open an existing report in Studio Explore:
1 From Studio Explore, double-click a folder to view all reports in the folder.
2 Double-click a report you want to open.

**Viewing Snapshot Reports**

You view snapshot reports to display and print static reports. You can open a snapshot report from Studio Explore repository.

➤ To view a snapshot report, select one or more snapshot reports from the repository and select File > Print Preview. For information on viewing or printing a snapshot report, see Chapter 8, “Previewing and Printing Reports.”

**Creating a Book**

Books are created in Workspace. For information on creating a book, see *Hyperion Workspace User’s Guide.*
Creating a Batch

Batches are created in Workspace. For information on creating a batch, see Hyperion Workspace User’s Guide.

Setting Preferences

Preferences are set in Workspace. For information on setting preferences, see the Hyperion Workspace User’s Guide.

Changing your Password

Passwords are set in Workspace. For instructions, see the Hyperion Workspace User’s Guide.

Closing Studio Explore or the Designer

You can close Studio Explore and Designer pages:

➤ To close Studio Explore or a Designer page, select File > Close.

Exiting Financial Reporting Studio

You can exit Financial Reporting Studio at any time. If there are unsaved reports or batches open, you are prompted to save them before exiting.

➤ To exit Financial Reporting Studio, select File > Exit.

Toolbars

The toolbars provide quick access to the most frequently used features. The availability of some toolbar buttons depends on the content of the current window and the selected report object. You can use the View menu to display or hide the Standard and Designer toolbars.

Note:

To view toolbar features available for Financial Reporting in Workspace, see Hyperion Workspace User’s Guide.

Standard Toolbar

The Standard toolbar contains shortcuts to standard features. You can use the View menu to display or hide the Standard toolbar. The following table describes the Standard toolbar buttons.
### Designer Toolbar

The Designer toolbar contains shortcuts to design features. You can use the View menu to display or hide the Designer toolbar. The following table describes the Designer toolbar buttons and their equivalent menu commands. The Designer toolbar applies to the Studio workspace only.

<table>
<thead>
<tr>
<th>Button</th>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Insert Grid" /></td>
<td>File &gt; Grid</td>
<td>Insert Grid button - Adds a grid to the report.</td>
</tr>
<tr>
<td><img src="image" alt="Insert Text" /></td>
<td>File &gt; Text</td>
<td>Insert Text button - Adds a text object to the report.</td>
</tr>
<tr>
<td><img src="image" alt="Insert Image" /></td>
<td>File &gt; Image</td>
<td>Insert Image button - Adds an image to the report.</td>
</tr>
<tr>
<td><img src="image" alt="Insert Chart" /></td>
<td>File &gt; Chart</td>
<td>Insert Chart button - Adds a chart to the report.</td>
</tr>
<tr>
<td><img src="image" alt="Insert Row" /></td>
<td>File &gt; Row</td>
<td>Insert Row button - Inserts a row above a highlighted row in a grid.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Click the main button to insert a data row as the selected row in the grid.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Click the drop-down arrow to insert another row type from the drop-down list (formula row or text row).</td>
</tr>
<tr>
<td><img src="image" alt="Insert Column" /></td>
<td>File &gt; Column</td>
<td>Insert Column button - Adds a column to the left of a highlighted column in a grid.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Click the main button to insert a data column as the selected column in the grid.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Click the drop-down arrow to insert another column type from the drop-down list (formula column or text column).</td>
</tr>
</tbody>
</table>
The following sections show the commands available under the menus. The menus include File, Edit, View, Insert, Format, Task, Window, and Help.

Note:

To view menu command available for Financial Reporting in Workspace, see Hyperion Workspace User's Guide.

### File Menu

The File menu is available in Financial Reporting Studio workspace, Report Designer, and Studio Explore. You can use the File menu to open, save, and print reports. The availability of some of
the menu options depends on the content of the current window and the module from which the menu is accessed. The following table shows the commands in the File menu:

<table>
<thead>
<tr>
<th>Command</th>
<th>Financial Reporting Studio Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Enables you to create a report.</td>
</tr>
<tr>
<td>Open</td>
<td>Opens a report, a snapshot report, or a report object into the designer.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the current report in the designer or Studio Explore.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the current report or snapshot report.</td>
</tr>
<tr>
<td>Save As</td>
<td>Saves the current item as a report or snapshot</td>
</tr>
<tr>
<td>Save Object</td>
<td>Opens the Save Object dialog box where you can save the selected object to Studio Explore.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This is only available in the Designer.</td>
</tr>
<tr>
<td>Explore</td>
<td>Opens the repository where you can access report objects and open reports, snapshot reports, report</td>
</tr>
<tr>
<td></td>
<td>objects, and folders.</td>
</tr>
<tr>
<td>Print</td>
<td>Opens the Print dialog box, through which you can specify a printer and print reports.</td>
</tr>
<tr>
<td>Page Setup</td>
<td>Opens the Page Setup dialog box through which you can specify page size, page margins, and Designer</td>
</tr>
<tr>
<td></td>
<td>workspace size.</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Displays a view of a selected report as it would look printed.</td>
</tr>
<tr>
<td>Web Preview</td>
<td>Displays the report in Workspace. Viewing options for a report include HTML and PDF.</td>
</tr>
<tr>
<td>Summary</td>
<td>Opens the Report Summary dialog box, from which you can view summary information about the report</td>
</tr>
<tr>
<td>Report Server Info</td>
<td>Opens the Report Server Info dialog box, through which you can view server information, including</td>
</tr>
<tr>
<td></td>
<td>Report Activity, JVM Memory, and Threads</td>
</tr>
<tr>
<td>Exit</td>
<td>Exits Financial Reporting.</td>
</tr>
</tbody>
</table>

**Edit Menu**

The following table shows the command available under the Edit menu.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>For the designer, removes an object from a report. in Studio Explore, removes a report, snapshot report or report object.</td>
</tr>
</tbody>
</table>

**View Menu**

You can use the View menu to show or hide toolbars, properties sheets, gridlines, refresh and display items by type. You can also apply the zoom option for a selected grid. The following table shows the commands available under the View menu.
### Insert Menu

The Insert menu is available in the Designer. You can use the Insert menu to add new or saved report objects and insert new rows or columns in grids. The availability of some of the menu options depends on the content of the current window. The following table shows the commands available under the Insert menu.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grid</td>
<td>Inserts a grid in the report</td>
</tr>
<tr>
<td>Text</td>
<td>Inserts a text box in the report</td>
</tr>
<tr>
<td>Image</td>
<td>Inserts an image in the report</td>
</tr>
<tr>
<td>Chart</td>
<td>Inserts a chart in the report</td>
</tr>
<tr>
<td>Saved Object</td>
<td>Opens the Insert Saved Object dialog box from which you can insert saved grids, charts, images, and text objects from the repository into the report. You can link the saved object to the source object by selecting the Link to Source Object check box in the Insert Saved Object dialog box.</td>
</tr>
<tr>
<td>Row &gt; Data</td>
<td>Inserts a data row in the grid above the insertion point</td>
</tr>
<tr>
<td>Row &gt; Formula</td>
<td>Inserts a formula row in the grid above the insertion point</td>
</tr>
<tr>
<td>Row &gt; Text</td>
<td>Inserts a text row in the grid above the insertion point</td>
</tr>
<tr>
<td>Column &gt; Data</td>
<td>Inserts a data column in the grid to the left of insertion point</td>
</tr>
<tr>
<td>Column &gt; Formula</td>
<td>Inserts a formula column in the grid to the left of insertion point</td>
</tr>
</tbody>
</table>
### Format Menu

The Format menu is available from the Designer. You can use the Format Cells dialog box, accessible through the Format menu and the Designer toolbar, to change the font of selected text or grid objects, specify row height and column width to hide rows or columns or set other formatting options. The commands that are available depend on whether a report or report object is selected. The following table shows the commands available under the Format menu.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cells</td>
<td>Opens the Format Cells dialog box through which you can format numbers, align text, modify font options, add border and shading, and replace text for the selected cells in the grid</td>
</tr>
<tr>
<td>Conditional Format</td>
<td>Opens the Conditional Format dialog box through which you can apply conditional formatting. For more information, see Chapter 9, &quot;Formatting Reports.&quot;</td>
</tr>
<tr>
<td>Bring to Front</td>
<td>When organizing report objects, select Bring to Front to move an object in front of another object</td>
</tr>
<tr>
<td>Send to Back</td>
<td>When organizing report objects, select Send to Back to rearrange other report objects on top of, or in front of, the selected object</td>
</tr>
<tr>
<td>Font</td>
<td>For text objects, opens the Font dialog box through which you can apply formatting to text in a text object.</td>
</tr>
</tbody>
</table>

### Task Menu

The Format menu is available from the Designer. You can use the Task menu to set up the POV and sort rows or columns on the grid. The following table shows the commands available under the Task menu:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Up User POV</td>
<td>Change the POV setup for data sources in a report that is open.</td>
</tr>
<tr>
<td>Data Query Optimization Settings</td>
<td>When working with grids, set data query optimization options to enable you to optimize the efficiency of the data queries that you specify.</td>
</tr>
</tbody>
</table>

### Administration Menu

The Administration menu is only available from Workspace. Administrators can use the Administration menu to maintain users, maintain groups, and configure the Report Server. For detailed information, see the *Hyperion Workspace User’s Guide*.
**Window Menu**

The Window menu is available in the Studio workspace, Report Designer, and Studio Explore. You can use the Window menu to cascade, tile, arrange Hyperion Desktop windows or access another open Hyperion Desktop window. The availability of some commands depends on the content of the current window and the module from which the menu is accessed. The following table describes the commands in the Window menu.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cascade</td>
<td>Overlays each of the open windows in the Hyperion Desktop placing the file most recently accessed on top</td>
</tr>
<tr>
<td>Tile Horizontally</td>
<td>Arranges each of the open windows in the Hyperion Desktop so they display horizontally, one below the other</td>
</tr>
<tr>
<td>Tile Vertically</td>
<td>Arranges each of the open windows in the Hyperion Desktop so they display vertically, side by side</td>
</tr>
<tr>
<td>Arrange Icons</td>
<td>Arranges minimized windows in the Hyperion Desktop so they are evenly spaced</td>
</tr>
</tbody>
</table>

**Help Menu**

The Window menu is available in Studio workspace, Report Designer, and Studio Explore. You use the Help menu to access Help, the PDF version of the User’s Guide, and information about Financial Reporting. The following table describes the commands in the Help menu.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contents</td>
<td>Opens the online help Contents tab, from which you can search for topics</td>
</tr>
<tr>
<td>About Financial Reporting Studio</td>
<td>Contains information about Financial Reporting, including version, your logon User ID, and Report Server</td>
</tr>
</tbody>
</table>

**Shortcut Menu Commands**

You can use the shortcut menu commands to perform many common tasks. Various shortcut menu commands are displayed when you right-click in the Report Designer or Studio Explore. The commands available depend on the component selected. The following tables describe the available shortcut menu commands:
### Table 7  Shortcut Menu: Editing a Row or Column from the Designer

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Removes the selected row/column from the report and places it in the Windows clipboard</td>
</tr>
<tr>
<td>Copy</td>
<td>Duplicates the selected row/column and places it in the Windows clipboard</td>
</tr>
<tr>
<td>Paste</td>
<td>Places the cut or copied row/column in the report</td>
</tr>
<tr>
<td>Delete</td>
<td>Removes the selected row/column from the report</td>
</tr>
<tr>
<td>Save as Row and Column Template</td>
<td>Save the selected row/columns as a row and column template, which is a reusable repository object</td>
</tr>
<tr>
<td>Insert Row and Column Template</td>
<td>Inserts a row and column template from the repository into a grid below a row or to the left of the selected column</td>
</tr>
<tr>
<td>Format</td>
<td>Opens the Format Cells dialog box from which you can format numbers, align text, modify font options, add border and shading, and replace text for the selected item in the grid</td>
</tr>
<tr>
<td>Conditional Format</td>
<td>Opens the Conditional Format dialog box through which you can apply conditional formatting. For more information, see Chapter 9, “Formatting Reports.”</td>
</tr>
<tr>
<td>Insert Row/Column &gt; Data</td>
<td>When selected, a data row/column is added to the report</td>
</tr>
<tr>
<td>Insert Row/Column &gt; Formula</td>
<td>When selected, a formula row/column is added to the report</td>
</tr>
<tr>
<td>Insert Row/Column &gt; Text</td>
<td>When selected, a text row/column is added to the report</td>
</tr>
</tbody>
</table>

### Table 8  Shortcut Menu: Selecting a Grid (not the object)

<table>
<thead>
<tr>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimension Layout</td>
<td>Displays the Dimension Layout dialog box where you can change dimensions for the pages, rows, and columns of a grid</td>
</tr>
<tr>
<td>Grid Point of View</td>
<td>Displays or hides the Grid Point of View bar</td>
</tr>
<tr>
<td>Grid Point of View Setup</td>
<td>Displays the Setup Grid Point of View dialog box where you select members for the Grid Point of View</td>
</tr>
<tr>
<td>Data Query Optimization Settings</td>
<td>Displays the Data Query Optimization Setting dialog box where you can suppress the rows on the database connection server or the report server, include or exclude the Essbase sparse command, and set the number of asymmetric columns to consolidate</td>
</tr>
</tbody>
</table>
### Table 9  Shortcut Menu: Report Background

<table>
<thead>
<tr>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td>Saves the report</td>
</tr>
<tr>
<td>Print</td>
<td>Prints the report</td>
</tr>
<tr>
<td>Page Setup</td>
<td>Opens the Page Setup dialog box from which you can specify page setup options, including page, margins, and Report Designer workspace size</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Displays each page as it looks when printed</td>
</tr>
<tr>
<td>Web Preview</td>
<td>Displays each page as it looks in Workspace</td>
</tr>
<tr>
<td>Summary</td>
<td>Opens the Report Summary dialog box from which you can view report summary information</td>
</tr>
<tr>
<td>Show Guidelines</td>
<td>Displays the guidelines in Report Designer workspace</td>
</tr>
<tr>
<td>Insert Object &gt; Grid</td>
<td>Enables you to insert a grid</td>
</tr>
<tr>
<td>Insert Object &gt; Text</td>
<td>Enables you to insert a text box in the report</td>
</tr>
<tr>
<td>Insert Object &gt; Image</td>
<td>Enables you to insert an image in the report</td>
</tr>
<tr>
<td>Insert Object &gt; Chart</td>
<td>Enables you to insert a chart in the report</td>
</tr>
<tr>
<td>Insert Object &gt; Saved Object</td>
<td>Opens the Insert Saved Object dialog box, through which you can insert an object that is saved in Studio Explore</td>
</tr>
</tbody>
</table>

### Table 10  Shortcut Menu: Editing a Grid Title Bar, Text, Image or Chart Object

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Object</td>
<td>Opens the Save Object dialog box through which you can save the selected object to the repository or a folder in the repository.</td>
</tr>
<tr>
<td>Delete</td>
<td>Removes the selected item from the report.</td>
</tr>
<tr>
<td>Horizontal Position on Form &gt; None</td>
<td>This selection indicates no horizontal positioning for the selected object.</td>
</tr>
<tr>
<td>Horizontal Position on Form &gt; Relative</td>
<td>Sets the horizontal positioning of the object relative to the positioning of other objects on the form.</td>
</tr>
<tr>
<td>Horizontal Position on Form &gt; Left</td>
<td>Sets the horizontal positioning of the object to the left of the form.</td>
</tr>
<tr>
<td>Horizontal Position on Form &gt; Center</td>
<td>Sets the horizontal positioning of the object to the center of the form.</td>
</tr>
<tr>
<td>Horizontal Position on Form &gt; Right</td>
<td>Sets the horizontal positioning of the object to the right of the form</td>
</tr>
<tr>
<td>Vertical Position on Form &gt; None</td>
<td>This selection indicates no vertical positioning for the selected object.</td>
</tr>
</tbody>
</table>
### Editing a Grid Title Bar, Text, Image, or Chart Object - Right-Click Menu in Designer

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertical Position on Form &gt; Relative</td>
<td>Sets the vertical positioning of the object relative to the positioning of other objects on the form.</td>
</tr>
<tr>
<td>Vertical Position on Form &gt; Top</td>
<td>Sets the vertical positioning of the object to the top of the form.</td>
</tr>
<tr>
<td>Vertical Position on Form &gt; Middle</td>
<td>Sets the vertical positioning of the object to the middle of the form.</td>
</tr>
<tr>
<td>Vertical Position on Form &gt; Bottom</td>
<td>Sets the vertical positioning of the object to the bottom of the form.</td>
</tr>
<tr>
<td>Bring to Front</td>
<td>When organizing report objects, select Bring to Front to move an object in front of another object</td>
</tr>
<tr>
<td>Send to Back</td>
<td>When organizing report objects, select Send to Back to rearrange other report objects on top of, or in front of, the selected object</td>
</tr>
<tr>
<td>Zoom</td>
<td>When working with grids, select Zoom to expand the view of a grid to the size of Report Designer Workspace</td>
</tr>
</tbody>
</table>

### Table 11  Shortcut Menu: Studio Explore

### Repository - Right-Click Menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Folder</td>
<td>Adds a folder to the Studio Explore</td>
</tr>
<tr>
<td>Open</td>
<td>Opens a report, snapshot report, or report object into the Designer</td>
</tr>
<tr>
<td>Print</td>
<td>Opens the Print dialog box where you can print the selected report from the repository</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Displays the report as it looks when printed</td>
</tr>
<tr>
<td>Delete</td>
<td>Removes the selected file from the repository on confirmation</td>
</tr>
<tr>
<td>Display Items of Type &gt; All Items</td>
<td>From Financial Reporting Studio. When selected, all files are displayed</td>
</tr>
<tr>
<td>Display Items of Type &gt; Report</td>
<td>From Financial Reporting Studio. When selected, only report files are displayed</td>
</tr>
<tr>
<td>Display Items of Type &gt; Snapshot</td>
<td>From Financial Reporting Studio. When selected, only snapshot files are displayed</td>
</tr>
<tr>
<td>Display Items of Type &gt; Book</td>
<td>From Financial Reporting Studio. When selected, only book files are displayed</td>
</tr>
<tr>
<td>Display Items of Type &gt; Snapshot Book</td>
<td>From Financial Reporting. When selected, only snapshot book files are displayed</td>
</tr>
<tr>
<td>Display Items of Type &gt; Batch</td>
<td>From Financial Reporting Studio. When selected, only batch files are displayed</td>
</tr>
<tr>
<td>Display Items of Type &gt; Saved Report Object</td>
<td>From Financial Reporting Studio. When selected, only saved report objects (for example, images) are displayed</td>
</tr>
</tbody>
</table>
### Repository - Right-Click Menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh</td>
<td>Refreshes the repository to include new folders and reports</td>
</tr>
</tbody>
</table>

### Table 12  Shortcut Menu: Designer Grid Cell Level Selection

#### Cell Level - Right Click Menu

<table>
<thead>
<tr>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format</td>
<td>Opens the Format Cells dialog box from which you can format numbers, align text, modify font options, add borders and shading, and replace text for the selected item in the grid</td>
</tr>
<tr>
<td>Conditional Format...</td>
<td>Opens the Conditional Format dialog box through which you can apply conditional formatting. For more information, see Chapter 9, “Formatting Reports.”</td>
</tr>
<tr>
<td>Merge</td>
<td>Combines two or more cells into one cell in a grid</td>
</tr>
</tbody>
</table>

### Error Messages

Error messages communicate essential information, alerts, and warnings of critical problems. They also contain descriptions, solutions, and detailed information, when available.

![Hyperion Reports](image)

Failed to connect to Server.

The error message dialog comprises the following sections:

- An icon. One of three icons may be displayed, symbolizing a message type. The usage and descriptions of these icons adhere to Microsoft standards as follows:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Message Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![i icon]</td>
<td>Information</td>
<td>Provides information about results of a command. Offers no user choices; the user acknowledges the message by clicking the OK button.</td>
</tr>
<tr>
<td>![exclamation mark icon]</td>
<td>Warning</td>
<td>Alerts the user to a condition or situation that requires the user's decision and input before proceeding, such as an impending action with potentially destructive, irreversible consequences. The message can be in the form of a question; for example: “Save changes to MyReport?”</td>
</tr>
<tr>
<td>Icon</td>
<td>Message Type</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Critical</td>
<td>Informs the user of a serious problem that requires intervention or correction before work can continue.</td>
</tr>
</tbody>
</table>

- A short message. The message is as specific as possible and never misleading; for example:

  Failed to connect to server.

- A remedy. If possible, the remedy includes information that tells the user what to check: for example: Verify:

  network connections, server is running, application name is valid, database name is valid.

- Details about the error. Click the Show Details button to view available detail information; for example:

  ErrorStack: com.hyperion.reporting.util.
  HyperionReportException: Error getting Datasource Connection
  at com.hyperion.reporting.client.DesignerManager.
  getDatasourceConnection(Unknown Source)
  at com.hyperion.reporting.javacom.DesignerManagerComImpl.getDatasourceConnection(Unknown Source

ErrorStack: com.hyperion.reporting.util.
HyperionReportException: Error getting Datasource Connection
at com.hyperion.reporting.client.DesignerManager.
getDatasourceConnection(Unknown Source)
at com.hyperion.reporting.javacom.DesignerManagerComImpl.getDatasourceConnection(Unknown Source

Specifying data for grids entails setting criteria that identify the data for retrieval. You set the criteria by assigning members to the rows, columns, and page axes in a grid, as well as to the grid point of view (POV) and user POV bars. For more information, see Chapter 6, “Defining the User POV” and “Defining the Grid Point of View” on page 117.

You can create lists of reusable members, and use functions that retrieve members dynamically. Before you begin to define members, you must insert a grid in the report and define its dimension layout. For more information, see “Adding Grids” on page 86.

Note:

If you use Planning Details as a type of database connection to go against a Planning cube, all available dimensions are listed. However, you have access privileges to members only in certain dimensions. This affects the output of your report. For more information, on how access privileges affect your report, see the topic “Access Privileges for the Planning Details Database Source” on page 58.
Assigning Members to Data Rows or Columns

You assign members and member lists to retrieve data for your reports. You can select members to be displayed in your report, or you can use functions to select dimension members dynamically. You can insert a separate row or column in a grid for each selected member, or you can place all of the selected members on one row or column.

➤ To select members for data rows or columns:

1 Open a report.

2 To add members using the Select Members dialog box, take an action:
   ● Double-click a dimension in the grid.
   ● Select a dimension in the grid. Then in the formula bar, click the button with the dimension name.

   Note:
   If you know the member names for a dimension, enter the member names, separated by commas, into the formula bar text area. Case sensitivity is enabled for member names, however it is not enabled for function names. For example, for the Measures dimension you might enter children of (Profit), then click the check mark to verify the member names.

3 Take an action:
   ● To assign individual members, select the Members tab, then highlight the members to add to the data row or column.
   ● To assign member lists, select the Lists tab, then highlight the member lists to add to the data row or column.
   ● To assign functions, select the Functions tab, then highlight the functions to add to the data row or column.

4 Take an action:
   ● To add the highlighted items to the Selected area, click .
   ● To add a member function (children, descendents, and so on) to a selected member, click .

   Note:
   The Add Relationship button is available only on the Members tab.

5 Optional: In the Selected area, review the selected members by clicking the View button, then selecting Preview. For more information, see “Previewing Selected Members” on page 58.

6 Optional: To insert a row or column for each selected member, select the check box, Place selections into separate rows (or Columns).
Assigning Members to the Page Axis

You can assign members to the page axis of a grid. When you select members for the page axis and run the report, the system generates a grid for each page member. If a chart references a grid with multiple page members, a new chart is generated for each page member.

For example, suppose you assign the following members of the Scenario and Entity dimensions to the page axis:

- Target 1 and Target 2 of the Scenario dimension
- Radio Promotions and Web Promotions to the Entity dimension

When you view the report, it is formatted and populated with data from all combinations of members on the page axis. The report contains four grids, one for each page member combination.

You can select any combination of the members:

- Target 1: Radio Promotions
- Target 1: Web Promotions
- Target 2: Radio Promotions
- Target 2: Web Promotions

To add or change dimensions that are assigned to the page axis, see “Adding Grids” on page 86.

Note:

In Financial Reporting, the members (and corresponding data) in the page axis are all retrieved when the report is run. Reports with a large number of members on the page axis, may impact performance.

➤ To assign members to the page axis:

1. Open a report.
2. Select a dimension on the Pages bar.
3. On the formula bar, select the button with the dimension name.

Note:

If you know the member names for a dimension, enter the member name into the formula bar text area. For example, for the Measures dimension enter Profit, Sales. Click the check mark, to verify the member selection.
4 In the Member Selection dialog box, select the members to use on the page axis, then click OK.

Assigning Special Members

You can use the Select Members dialog box to select the special members Prompt, Same As, Current Point of View, and User Point of View.

- Prompt acts like a variable that asks the user to select members when a report is run. You determine the dimension and defaults at design time, and the user selects the members when generating the report. Prompt also enables the report writer to filter the dimension members from which the user can select when running the report.
- Same As creates a column or row member selection with the same member selection setting as another column or row.
- Current Point of View acts as a variable that employs the POV to specify the member of a dimension when the report is run.
- User Point of View can be selected as a member on the book POV. The parameters can be modified by the end user.

Setting Up Report Prompts for Members

A prompt is a way of enabling the viewer to assign members to a dimension. The prompt is set up during design time. As a report designer, you can limit the type of data to assign to a dimension. You can also specify whether the Respond to Prompts dialog box displays member names, descriptions (for a Financial Management database connection) or aliases (for Essbase or Planning database connections), or both member names and descriptions or aliases.

For example, you might create a report that enables the user to select from lines of products. The report designer selects Prompt as a member of Product, then selects specific lines of product. The end user who runs the report selects from those product lines.

➤ To set up a report prompt for members:

1 Open a report.

2 Double-click a dimension cell for which you want to assign a prompt.

3 In the Available area of the Members tab, select Prompt for (dimension name) and move it the Selected area.

4 Click OK.

The Define Prompts dialog box is displayed:
5 Optional: To limit the prompt selection to specific default members, or a list of members, or both, take an action:

- If the member name is known, enter the member name in Default Member or click the Default Member search button. If multiple member are provided for the prompt, members must be separated by commas. For information on selecting members, see “Assigning Members to Data Rows or Columns” on page 40.

Note:

If you leave Default Member blank, the Respond to Prompts dialog box does not display a default member when a user runs the report or creates a batch. The user must specify a member rather than accept a blank default. If a member is not selected, the report is not run.

- If the list of members is known, click the Choices List button to select a list of members. If multiple member lists are provided for the prompt, member lists must be separated by commas. For more information, see “Defining Member Lists” on page 55.

6 From the Member Labels in Prompt Selection Dialog drop-down list, select the kinds of labels to be displayed in the Respond to Prompts dialog box when the report is run:

- If the database connection is Essbase or Planning, select Member Name, Alias, or Member Name and Alias.

- If the database connection is Financial Management or SAP BW, select Member Name, Description, or Member Name and Description.

7 Click OK.

Setting Up Same As References

Same As enables the designer to obtain a member selection from another row or column. The following characteristics apply to Same As in Financial Reporting:
In a report, members referred to by Same As are always from the same dimension, same type of database connection, and same grid.

Members referred to by Same As are only available for member selections on rows and columns in a grid. Same As cannot be used as member selection in:

- Page Axis
- Grid POV
- User POV
- Book POV
- Batches POV
- Default member selection for a prompt
- A response to a prompt
- Member function member parameter, such as range
- Member selection in the book editor

Same As can reference a row or column that gets its member selection from a prompt or Current POV.

Same As cannot reference another Same As reference.

Same As is not supported within row and column templates.

Same As must be used alone and cannot be combined with any other member selections.

To set up Same As:

1. Open a report and double-click a member selection for which you want to set up Same As.
2. On the Members tab, expand Same As Member Selections and select Same As... for the row or column for the dimension, then click the Add button, to add the Same As for the dimension to the Selected area.
3. Click OK.

Setting Up a Current Point of View

A current POV enables the designer to obtain a member for a row, column, or page from the user POV.

To set up a current POV:

1. Open a report and double-click a member selection for which you want to set up a current POV.
2. On the Members tab, select Current Point of View for the dimension, then click the Add button, to add the Current Point of View for the dimension to the Selected area.
3. Click OK.
Selecting the User Point of View as a Member in the Book Point of View

When a report is added to a book, the dimensions that are on the user POV in the report definitions are applied to the book POV. Members on the book POV default to the user POV in the Book Editor.

To select the user POV as a member in the book POV:

1. Select File > Repository.

   Tip: You can filter the repository by selecting View > Display Items of Type and then selecting Book.


3. In the book POV, double-click a dimension for which you want to set up a user POV.

4. From the Select Members dialog box, select the User Point of View for the dimension.

5. Click OK.

Assigning Members Using Functions

You can use functions to select members dynamically. After you select a function, you can edit its parameters. For more information on the dynamic use of functions, see “Using the Formula Bar” on page 134. For more information on editing function parameters, see “Editing Functions” on page 52.

Table 13 and Table 14 describe the functions used to assign members.

Note:

Except where noted, all functions listed are supported for Essbase and Planning Details. Supported functions for Financial Management (HFM), SAP-BW and SSAS are noted in separate columns.

<table>
<thead>
<tr>
<th>Function</th>
<th>Syntax</th>
<th>Financial Management</th>
<th>SAP BW and SSAS</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Children</td>
<td>Children of member (Inclusive)</td>
<td>x</td>
<td>x</td>
<td>The members one level below the specified parent</td>
</tr>
<tr>
<td>Descendants</td>
<td>Descendants of member (Inclusive)</td>
<td>x</td>
<td>x</td>
<td>The members at all levels below the specified parent</td>
</tr>
<tr>
<td>BottomOfHierarchy</td>
<td>Bottom of Hierarchy dimension</td>
<td>x</td>
<td></td>
<td>All Level 0 members</td>
</tr>
<tr>
<td>Function</td>
<td>Syntax</td>
<td>Financial Management</td>
<td>SAP BW and SSAS</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------------------------------</td>
<td>----------------------</td>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Siblings</td>
<td>Siblings of member (Inclusive)</td>
<td>x</td>
<td>x</td>
<td>The members with the same parent as the specified member</td>
</tr>
<tr>
<td>OnSameLevelAs</td>
<td>Same level as member</td>
<td></td>
<td></td>
<td>The members from the same dimension and on the same level as the specified member</td>
</tr>
<tr>
<td>SameLevelAs</td>
<td></td>
<td>x</td>
<td></td>
<td>All members of the same ???</td>
</tr>
<tr>
<td>OfSameGeneration</td>
<td>Same generation as member</td>
<td></td>
<td></td>
<td>The members of the same dimension and generation as the specified member</td>
</tr>
<tr>
<td>Parent</td>
<td>Parent of member (Inclusive)</td>
<td>x</td>
<td>x</td>
<td>The member one level above the specified member</td>
</tr>
<tr>
<td>TopOfHierarchy</td>
<td>Top of Hierarchy dimension</td>
<td>x</td>
<td></td>
<td>The top-level member of hierarchy</td>
</tr>
<tr>
<td>SystemMemberList</td>
<td>System-defined Member List</td>
<td>x</td>
<td></td>
<td>The members in a specified system-defined member list</td>
</tr>
<tr>
<td>Ancestors</td>
<td>Ancestors of member (Inclusive)</td>
<td>x</td>
<td>x</td>
<td>The members at all levels above the specified member</td>
</tr>
<tr>
<td>AllMembers</td>
<td>All Members in Hierarchy dimension</td>
<td>x</td>
<td></td>
<td>The members of the specified dimension</td>
</tr>
<tr>
<td>Member</td>
<td>member</td>
<td>x</td>
<td>x</td>
<td>The specified member</td>
</tr>
<tr>
<td>Members</td>
<td></td>
<td>x</td>
<td></td>
<td>All members of the current dimension</td>
</tr>
<tr>
<td>Base</td>
<td>Base members of Hierarchy dimension</td>
<td>x</td>
<td></td>
<td>The base or level 0 members of a hierarchy</td>
</tr>
<tr>
<td>UserDefined1</td>
<td>All members where user defined is selected attribute</td>
<td>x</td>
<td></td>
<td>Supported in Financial Management Only. All entities and custom dimensions can be used with the following exceptions: View, ICP, Year, Period, Scenario. The members of selected attribute</td>
</tr>
<tr>
<td>UserDefined2</td>
<td>All members where user defined is selected attribute</td>
<td>x</td>
<td></td>
<td>Supported in Financial Management Only. All entities and custom dimensions can be used with the following exceptions: View, ICP, Year, Period, Scenario. The members of selected attribute</td>
</tr>
<tr>
<td>UserDefined3</td>
<td>All members where user defined is selected attribute</td>
<td>x</td>
<td></td>
<td>Supported in Financial Management Only. All entities and custom dimensions can be used with the following exceptions: View, ICP, Year, Period, Scenario. The members of selected attribute</td>
</tr>
</tbody>
</table>
The member functions listed in the following table can be selected from the Functions tab through member selection. They cannot, however, be entered dynamically in the formula bar.

### Table 14 Functions Available Only Through Member Selection

<table>
<thead>
<tr>
<th>Function</th>
<th>Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Property</td>
<td></td>
<td>Used with Essbase and Planning Details only. Extracts the members with the specified property value</td>
</tr>
<tr>
<td>UserMemberList</td>
<td></td>
<td>Used with Essbase only. The members in a specified user-defined member list</td>
</tr>
<tr>
<td>Match</td>
<td></td>
<td>Used with Financial Management, Essbase and Planning Details. The members that match a specified pattern or set of characters.</td>
</tr>
<tr>
<td><strong>Note:</strong> When using the '*' wildcard with Planning, the pattern may only contain one *, and it may only appear as the last character.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CommonChildren</td>
<td></td>
<td>Used with Financial Management only. This function is valid for the common members in the Entity dimension only. For example, with the following structure:</td>
</tr>
<tr>
<td>Parent1</td>
<td></td>
<td>ChildA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ChildB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ChildC</td>
</tr>
<tr>
<td>Parent2</td>
<td></td>
<td>ChildA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ChildB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ChildD</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The common children function replaces the Member with the Parent. In this example, the Member is Parent1 and the Parent is Parent2. Therefore, the result of using the CommonChildren function in this example would be the following output:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Parent2.ChildA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Parent2.ChildB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Parent2.ChildC</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This is the children of Parent1 with Parent2 now substituted as the parent. In this example, since ChildA and ChildB are children of Parent2 the result for these two would be valid. However, the result for Parent2.ChildC is not really valid and would return nothing.</td>
</tr>
<tr>
<td>RelativeMember</td>
<td></td>
<td>Used for all dimensions with Essbase and Planning</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td><strong>Lead</strong></td>
<td>using SSAS or SAP BW, returns the current and next members relative to the selected member.</td>
<td></td>
</tr>
<tr>
<td><strong>Lag</strong></td>
<td>using SSAS or SAP BW, returns the current and previous members relative to the selected member.</td>
<td></td>
</tr>
<tr>
<td><strong>Details</strong></td>
<td>database connections. This function is also available for the Year dimension with a Financial Management database connection. This function enables you to perform arithmetic offset. <strong>Note:</strong> Arithmetic offset is the distance to move forward or backward on a specified level. For example, with an Essbase database connection, to list this data: <strong>Current Qtr Next Month</strong> you set the parameters as follows: Member = Current Point Of View Offset = +1 Hierarchy = Year RelativeMemberList = Lev0, Year UseFirstDescendant = checked <strong>Note:</strong> In this example, UseFirstDescendant = checked causes the system to start from the first descendant of Qtr1, which is Jan. The offset is +1, which makes the Next Month = Feb. If the current POV = Qtr1, the result is as follows: <strong>Current Qtr Next Month</strong> Qtr1 Feb <strong>Note:</strong> When using a time dimension, keep the offset in the same calendar year as the specified level. For example, if you start with June, you can offset back to January or forward to December. For a Financial Management database connection, to list this data: <strong>Year Next Year</strong> you set the parameters as follows: Year = Current Point Of View for Year Offset = +1 Hierarchy = Year If the current Point of View = Year, the result is as follows: <strong>Current Year Next Year</strong> 2003 2004 <strong>PeriodOffset</strong></td>
<td>Used with a Financial Management database connection only. This function enables you to perform arithmetic offset on only the Period dimension. <strong>Note:</strong> Arithmetic offset is the distance to move forward or backward from a specified level. For example, to list this data:</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
</tbody>
</table>
| **Current Qtr Next Month**     | you set the parameters as follows:  
  Member = Current POV  
  Offset = +1  
  Hierarchy = Dim  
  Note: PeriodOffset always spans the period and year combination. Therefore, if you select Jan offset -2 (assuming the year is 2002), the answer (member shown) would be Nov 2001. |
| **DynamicMemberList**          | Used with Financial Management database connection only. This function enables you to select a member list that is defined to support dynamic POV on the Entity dimension. DynamicMemberList is based on a POV, and takes Entity and Parent (optional) as parameters, If the Parent parameter is specified, the Parent name is used for all entities returned from the enumeration of the list. If the Parent parameter is not specified, then no substitution is done.  
  Entity is based on the Scenario, Year, and Period defined at the POV level. Therefore, the system will not use Scenario, Year, and Period on the grid. If you place Scenario, Year, or Period on the grid, the following message is displayed: “5200: Error executing query: Scenario, year, and period must be specified on the point of view for a dynamic member list.”  
  Note: The DynamicMemberList can be executed from the Lists tab or Functions tab. On the Lists tab, you begin by selecting a (dynamic) list, then adding the Entity and Parent parameters. On the Functions tab, you begin by selecting the DynamicMemberList function, then selecting a dynamic list (DynamicNamedGroup), Entity, and Parent. |
| **Dynamic Time Series Members**| The following eight Dynamic Time Series members can be defined within Essbase. Only Dynamic Time Series members that are defined in the Essbase database are displayed in the Functions tab of the Select Members dialog box in Financial Reporting.  
  ● H-T-D History-to-date  
  ● Y-T-D Year-to-date  
  ● S-T-D Season-to-date  
  ● P-T-D Period-to-date  
  ● Q-T-D Quarter-to-date  
  ● M-T-D Month-to-date  
  ● W-T-D Week-to-date  
  ● D-T-D Day-to-date  
  These members provide up to eight levels of period-to-date reporting. How many members you use, and which members, depends on your data and database outline. |
<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function</td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> These members are used only with time-based dimensions and the lowest-level data. You can view H-T-D, Q-T-D, and M-T-D Dynamic Time Series members on the Functions tab if you select the Year dimension for the Sample application and Basic database. For more information on Dynamic Time Series members, see the <em>Essbase Database Administrator's Guide, Volume 1</em>.</td>
</tr>
<tr>
<td>Substitution Variables</td>
<td>Stored in a directory for the selected dimension in the Select Members dialog box, substitution variables serve as placeholders for information that changes regularly. A variable value can be changed at any time by the Essbase administrator. These are useful for reports that depend on reporting periods. With a substitution variable, such as CurMnth, set on the server, you can change the assigned value each month to the time period. <strong>Note:</strong> The list of available Essbase substitution variables displayed in the Member Selection dialog is obtained when you start the Financial Reporting Report Client. If you add a new substitution variable using the Essbase Application Manager, you must restart the Report Client to see the addition. Anytime you run a report, the latest values for all Essbase substitution variables are used. You can view a CurrMonth substitution variable member on the Members tab if you select the Year dimension for the Sample application and Basic database. A substitution variable is preceded by a green square. For more information on substitution variables, see the <em>Hyperion Essbase Database Administrator's Guide, Volume 1</em>.</td>
</tr>
<tr>
<td>SuppressSharedMember</td>
<td>For Essbase and Planning Details only, suppress the display of duplicate members. This function is only valid with the following functions: DMBOTTOM, OFSAMEGEN, or ONSAMELEVELAS. <strong>Note:</strong> Use UNION and not AND to work correctly.</td>
</tr>
<tr>
<td>Range</td>
<td>For Essbase, SAP BW, SSAS, and Planning Details database connections, you can specify a range of members by selecting a start member and an end member of the range. For example, you can use the Year dimension to specify all months in the first quarter by selecting January as the start member of the range and March as the end member. For Financial Management, the Range function applies only to the Period dimension. For example, if you want to list this data: <strong>Beginning Period Ending Period</strong> for a range of members in the current quarter, you set the parameters as follows:</td>
</tr>
</tbody>
</table>
### Function | Description
--- | ---
Start Member = July  
End Member = September  
Years to Iterate Over = 0  
The number of iterations you specify determines the number of times you pass through the Period dimension. For example, if you specify 1 for the Years to Iterate Over parameter, the report spans July to September of the following year.  
**Note:** Do not use a Prompt and a Range function in the same grid when the Range function also includes Prompts.

| OrderBy | For Planning Details database connection only, you can specify the order of members that come back from member selection by a member property.  
The OrderBy function comprises two required parameters:  
- **Property** - Provides the Member Name option and a list of all properties available for members. Name is the default.  
- **Direction** - Provides the options for directions: Ascending, Descending, Hierarchy Ascending, Hierarchy Descending.  
The OrderBy function applies to all member selections in the Selected list. |

| DimBottom | For SSAS only, the bottom level members of a dimension |

| SortHierarchy | For Oracle's Hyperion® Web Analysis – System 9 only, sort members in outline order, by hierarchy. It is translated into Essbase report script command `<sortHierarchy. See Essbase documentation for details. |

➤ To assign members using functions:

1. **Open a report.**
2. **Double-click a dimension cell for which you want to assign members using functions.**
3. **In the Select Members dialog box, select the Functions tab.**
4. **Highlight one or more functions.**

   **Note:**  
   Hold down the Ctrl key while selecting multiple functions.

5. **Click the Add button, , to open the Edit (name) Function dialog box.**
Note:
The Edit *(name)* Function dialog box is not displayed for functions that do not require parameter values, such as BottomofHierarchy, TopofHierarchy, AllMembers, and SuppressSharedMembers.

6 Double-click the **Value** column inside row 1, then edit its value by clicking ![Look up button].

Note:
Since the Value field for an SSAS data source is populated with the Key instead of member name, for ease of use, we recommend you use ![Look up button] to select members.

Tip:
You can resize the columns using the arrows that appear when you hover the cursor over the column dividers that display between categories.

7 Repeat steps step 2 through step 6 to edit the remaining rows.

8 Click **OK**.

9 Click **OK** to return to your report.

### Editing Functions

You can edit a function by changing its parameter values. For example, you can specify that a function include or exclude a specified member, or you can change the hierarchy value of a function.

➤ To edit a function:

1 Open a report and select the data row or column or a data row or column heading cell in which you want to edit a function.

2 In the **Selected** area of the Select Members dialog box, double-click the function to edit.

3 Double-click the **Value** column inside row 1, then edit its value by clicking the **Lookup** button.

4 Repeat step 1 through step 3 to edit the remaining rows.

5 Click **OK**.

6 Click **OK** to return to your report.

### Copying Members Between Applications

You can take any valid members from an application, such as an Excel spreadsheet, and paste them as new members in the corresponding dimension of another application. For example, suppose you have the following members in Excel for the Year dimension: Jan, Feb, Mar, Apr, May, Jun, July, Aug, Sep, Oct, Nov, Dec. You can copy those members to a grid that contains
the Year dimension. If you paste members into a row or column that contains a secondary database connection, the type of database connection is carried over with the members.

➤ To copy members between applications:
1. Open an application containing the members you want copied to a report.
2. Copy the members to use with Financial Reporting.
4. Select File > Open.
5. Open a report.
6. Select a cell in a grid that contains the dimension to which you want to copy members.
7. In the formula bar, right-click inside the text box, then select Edit > Paste.
8. Edit the text in the formula bar by adding commas between members.
9. Click \( \checkmark \) to verify the member names.

Removing or Adding Members

You can remove or add members from a dimension. Removing members changes the output of your report, giving you more control over its content.

➤ To remove or add members that are contained in one cell:
1. Click the cell containing the members. The dimension name is displayed on the formula bar button; members are displayed in the text area of the formula bar.
2. In the formula bar, take an action:
   - Double-click the dimension name that is displayed on the command button to display the Select Members dialog box.
     - To remove one or more items from the Selected area, select the items, then click the Remove button, \( \checkmark \).
     - To remove all items, click \( \checkmark \).
   - Edit the text area of the formula bar by removing or adding members. Separate members with commas. Then click \( \checkmark \) to verify the member names.

➤ To remove members that are in separate rows or columns:
1. Select the row or column.
2. Right-click the row or column, then select Delete.
Selecting Multiple Members Based on Criteria

You can select members dynamically based on user-defined criteria. You define criteria by creating expressions of members, Boolean operations, and commands.

Boolean operators enable you to specify precise member combinations for the report, which is useful for dealing with large volumes of data. Use the AND, OR, UNION, and NOT Boolean operators, combined with expression commands, to refine your member selections.

To select multiple members based on criteria:

1. Open a report.
2. Double-click a dimension cell for which you want to assign members.
3. In the Select Members dialog box, right-click inside the Selected area, then click Advanced.

Note:
At least two members must be displayed in the Selected area before you can create criteria.

4. Build expressions by using one or more of the following operators and symbols:
   - Select NOT to add the Boolean operator NOT to the expression. NOT is the inverse of the selected condition.
   - Type a left parenthesis, (, to add an opening character to the expression.
   - Type a right parenthesis, ), to add a closing character to the expression.
   - Click in the OPERATOR column, then select AND, OR, or UNION.
     - When all conditions must be met, use the AND operator.
     - When one condition of several must be met, use the OR operator.
     - To combine the data, use the UNION operator.

Note:
You must use two pairs of parentheses if you are using three members. For example, if you selected descendants of Market and you want to exclude East, West, and South, your advanced member selection query should be as follows: Descendants of Market AND NOT ( East AND NOT ( West AND NOT SOUTH ))

5. Click OK to return to your report.

Filtering the View of Members Based on Criteria

You define filters to view only members that meet your criteria. You can then select from the filtered list for your report. For example, you can display Regions in the United States division only. Filters are useful for reducing the number of members that are displayed.

For an SAP BW data source, your filtering criteria can include display attributes, which provide descriptive information about a dimensions, levels, or members. Filtering criteria can use
wildcards and the Contains, Starts with, Ends with, and Is Null operators as well as the equal sign ( = ), less-than ( < ), an greater-than ( > ) operators.

➤ To define filters:
1 Open a report.
2 Double-click a dimension cell for which you want to edit a member.
   The Select members dialog box is displayed.
3 Right-click inside the Available area and name one of the following selections:
   ● Select Filter > Custom, highlight the lists or available functions, then click the Add button, to move them to the Selected area.
   ● Select Filter > Predefined, then highlight the desired list.
4 Click OK.
5 Click OK to return to your report.

Defining Member Lists

Member lists are user-defined saved queries or system-defined lists of members. System-defined lists are typically created by the database administrator. Member lists can include members, other member lists, and functions.

Note:
User-defined lists can be created only with Essbase as a database connection. The size of a member list cannot exceed 4K.

➤ To define a member list:
1 Open a report.
2 Double-click a dimension cell for which you want to assign a member.
3 In the Select Members dialog box, take an action:
   ● In the Members tab, highlight the members to include in the member list, right-click inside the Available area, then click Save Highlighted.
   ● In the Lists tab, right-click inside the Available area, then click Create.
4 From the Available area of the Create (dimension) List dialog box, select the members, member lists, and functions to include in the member list and move them to the Selected area using the Add button, or Add Relationship button,.
5 Optional: To edit a function, use the procedure described in “Editing Functions” on page 52.
6 Click OK.
7 Enter a name and description for the member list, then click OK.
Note:
Do not use quotation marks (""") when entering a member list. If you do, Financial Reporting saves the name with the quotation marks, but you cannot select the name later.

8 Click OK to return to your report.

Editing Member Lists

You can edit user-defined member lists. For example, you can add or remove members or functions from a member list.

➤ To edit a member list:
1 Open a report.
2 Double-click a dimension cell for which you want to edit a member list.
3 In the Select Members dialog box, select the Lists tab.
4 Double-click the user-defined member list to edit.
5 In the Edit...List dialog box, take an action:
   ● To add members to the Selected list, highlight the items in the Members, Lists, or Functions tabs, then click the Add button, or Add Relationship button,
   ● To remove members from the list, highlight the members in the Selected area, then click the Remove button,
   ● To remove all items, click the Remove All button,
6 Click OK.
7 Click OK to return to your report.

Searching for Members

You can perform searches for members to edit. You can search using a text string or by property (that is, name and description). You can also use a blank space as a separator to perform simultaneous searches. If you enclose a string of characters in quotation marks, the system searches for an exact match, including the blank spaces between the characters.

The system saves the previous 25 search criteria strings. If you are searching for a list or function you must activate this function by using the Find Next or Find Previous button.

Note:
For Financial Management, when you search for an entity, you must search on parent.entity (for example, D62VIELO,D62475LO). When you search just the entity, you must precede the entity with a wildcard, (for example, *D62475LO).
The following table shows the options used to find members:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find text box</td>
<td>Used to enter the characters for performing a search, or select a saved search criteria string from the list. The search string can be a partial search string, a word, or multiple words. Use this to search for a member. Click the Find button to display the members that match the search criteria.</td>
</tr>
</tbody>
</table>
| Use Wildcards     | Use the Find text with wildcard symbols (* and ?) to search for the specified members. By default, Use Wildcards is enabled.  
  ● Use ? to represent a single character search.  
  ● Use * to represent a multiple character search.  
  **Note:** If the search criteria has a space in it, enclose the search phrase in a double quote. For example, *IC Offset* should be "*IC Offset". If the location of the "*" wildcard is at the end only, for example IC Offset*, then you need not enclose the phrase in quotes. |
| (Find Previous)   | Click to set search parameters for the Find text box. Choose from the following parameter options:  
  ● Search - Select a member property by which to search.  
  ● Wildcard Search (default) - Insert the text and wildcard symbols (* and ?) in the Find text box to search for the specified member. The * represents multiple characters and the ? represents a single character.  
  ● Case-sensitive Search - Allows case-sensitive text in the Find text box to search for the specified member. |
| (Find Next)       | Use this to search for a list or function. Highlights the next item that matches the search criteria. |

➤ To search for members:

1. **Open a report.**

2. **Double-click a dimension cell for which you want to search for members.**

3. **In the Available dialog box, enter text in the Find text box or select a saved criteria string from the drop-down list.**

   **Note:**

   The wildcard option is automatically enabled during member selection.

4. **Perform an action:**

   ● If you are searching for a member, click the **Find** button.

   ● If you are searching for a list or a function, click the **Find Next** button, or the **Find Previous** button.

5. **Click OK to return to your report.**
Sorting Members

You can sort members to facilitate viewing them within member selection. By default, the members are displayed in the sort order of the database connection.

You can sort selectable members in a preferred order, and you can sort the members that are selected to match the row or column order of data in your report. The order in which selected items are displayed in member selection is the order in which they are evaluated and displayed on the report.

You sort the members by property and display them in ascending or descending order. By default, the system sorts the list numerically, then alphabetically.

You can enable the system to sort the list whenever the view changes, or you can sort the list manually.

➢ To sort members manually:
1. Open a report.
2. Double-click a dimension cell for which you want to sort members.
3. In the Selected Members list, click View, then select Sort.
4. In the Sort (dimension) Items dialog box, select the property for the primary sort, then click . Optionally repeat this step to select a second and third sort method.
5. Click OK twice.

Previewing Selected Members

You can preview the members or member lists selected for your report before you run it. The members that you view result from an evaluated member list or function.

➢ To preview members:
1. Open a report.
2. Double-click the cell for which you want to preview members.
3. In the Select Members dialog box, click the Selected area.
4. Click the View button, and select Preview.
5. The Preview (dimension) Items dialog box is displayed, listing the member selection for that selected cell.
6. Click OK to close the Preview (dimension) Items dialog box.

Access Privileges for the Planning Details Database Source

If your grid uses Planning Details as a database connection, Financial Reporting gives you access privileges on members in certain dimensions. The dimensions include Accounts, Entities, Scenarios, and Versions. In the Select Member dialog box, all members for the Planning Details
database connection are listed regardless of access privileges. Therefore, you can place members on a grid that are not returned when the report is run. The members you choose affect the output of the report. For example, if you select a member to which the user cannot access in the Point of View or Page Axis, an error message is returned.

For information on setting access privileges security for an end user, see *Hyperion Workspace Administrator’s Guide*.

The following four scenarios describe which values are returned on a grid that contains valid and invalid dimensions or members.

For the following scenarios, the user is reporting against a Planning Details database connection and has access privileges to the following dimensions and members:

- Accounts: Sales, Profit
- Versions: 1st Draft, 3rd Draft, Final Version
- Entities: North, Canada
- Scenarios: Budget

**Scenario 1**

The user runs a report for the following grid:

**Page: Budget**

<table>
<thead>
<tr>
<th></th>
<th>1st Draft</th>
<th>2nd Draft</th>
<th>3rd Draft</th>
</tr>
</thead>
<tbody>
<tr>
<td>North</td>
<td>#.##</td>
<td>#.##</td>
<td>#.##</td>
</tr>
<tr>
<td>Central</td>
<td>#.##</td>
<td>#.##</td>
<td>#.##</td>
</tr>
<tr>
<td>South</td>
<td>#.##</td>
<td>#.##</td>
<td>#.##</td>
</tr>
</tbody>
</table>

**Result:** Because the user does not have access to Central, South, and 2nd Draft, the report returns the following results:

**Page: Budget**

<table>
<thead>
<tr>
<th></th>
<th>1st Draft</th>
<th>3rd Draft</th>
</tr>
</thead>
<tbody>
<tr>
<td>North</td>
<td>23.89</td>
<td>12.90</td>
</tr>
</tbody>
</table>

**Scenario 2**

The user runs a report for the following grid:

**Page: Actual**

<table>
<thead>
<tr>
<th></th>
<th>1st Draft</th>
<th>2nd Draft</th>
<th>3rd Draft</th>
</tr>
</thead>
<tbody>
<tr>
<td>North</td>
<td>#.##</td>
<td>#.##</td>
<td>#.##</td>
</tr>
<tr>
<td>Central</td>
<td>#.##</td>
<td>#.##</td>
<td>#.##</td>
</tr>
</tbody>
</table>
Result: Because the user does not have access to Scenarios: Actual on the Page, no page is displayed and an error message describing your access privileges is returned.

Scenario 3

The user runs a report for the following grid:

Page: Budget

<table>
<thead>
<tr>
<th></th>
<th>1st Draft</th>
<th>2nd Draft</th>
<th>3rd Draft</th>
</tr>
</thead>
<tbody>
<tr>
<td>South</td>
<td>#.##</td>
<td>#.##</td>
<td>#.##</td>
</tr>
</tbody>
</table>

Result: Because the user does not have access to the Entities on the rows, no page is displayed and an error message describing your access privileges is returned.

Scenario 4

The user runs a report for the following grid:

Page: Budget

<table>
<thead>
<tr>
<th>Descendants of Versions</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Descendents of Entities</td>
<td>#.##</td>
</tr>
</tbody>
</table>

Result: The report returns the following data:

Page: Budget

<table>
<thead>
<tr>
<th></th>
<th>1st Draft</th>
<th>3rd Draft</th>
<th>Final Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>North</td>
<td>23.89</td>
<td>12.90</td>
<td>67.12</td>
</tr>
<tr>
<td>Canada</td>
<td>2.67</td>
<td>8.90</td>
<td>54.78</td>
</tr>
</tbody>
</table>
Customizing Charts

In This Chapter

About Charts ................................................................................................................... 61
Formatting Charts .............................................................................................................. 65
Formatting Chart Titles and Labels ............................................................................................. 76

This chapter describes the kinds of charts you can create and the ways in which you can format them. The following topics create the basic framework for customizing charts:

A chart is a graphical representation of report data from a grid on a report. The chart retrieves data dynamically from the grid, so if data in the grid changes, the chart is updated automatically.

You can define and format the following components of a chart:

- Chart type and data content
- Chart attributes such as title, title angle, font angle, and background formatting
- Legend and axis information such as labels, font, background color, and orientation
- Formatting options specific to a chart type, such as bar width for a bar chart
- Horizontal and vertical positioning of a chart on a report

You can hide the controlling grid to display only the chart in your report. For more information, see “Hiding Rows, Columns, or Grids” on page 176.

For information about adding charts to your report, see “Inserting Charts” on page 91.

About Charts

You create charts to portray data graphically in your reports. You can use the different chart types to illustrate trends and tendencies, highlight differences and improvements, or add value and informative charts and graphs to your reports.

You can design the following types of charts: bar charts, line charts, combo charts, and pie charts. These chart types are described in the following sections.
Bar Charts

A bar chart can display as many as 50 data sets, with any number of values assigned to each data set. Properties for the following items are supported for the bar chart:

- Appearance
- Legend
- Axes
- Element Style
- Bar

You can display data sets by grouping corresponding bars or stacking them, or you can display them in separate rows. You can show bars with or without a 3D effect, applying one of the following bar shapes: bar, triangle bar, diamond bar, or cylinder.

The following example shows four data sets - East, West, South, and Central - with four values assigned to each data set. The bars are grouped and displayed with a 3D effect.

Line Charts

A line chart can display as many as 50 data sets, with automatic, uniform spacing along the X axis. Properties for the following items are supported for the line chart:

- Appearance
- Legend
- Axes
- Element Style
- Line

The following example shows four data sets, represented by lines for East, West, South, and Central. Each line reflects the absolute value of the data set.
**Combo Charts**

A combo chart is a combination bar chart and line chart. Combo charts are typically used for comparison charting. The combo chart accepts a group of bar data sets and line data sets. It uses all of the display parameters found in bar charts and line charts. Two data set selections are required: one for the bar rendering and one for the line rendering. Properties for the following items are supported for the combo chart:

- Appearance
- Legend
- Axes
- Element Style
- Bar
- Line

The following sample combo chart shows four data sets: Qtr1, Qtr2, Qtr3, and Qtr4. The dimensions compare Product to Markets. There are four values assigned to each data set. The bars are grouped and displayed with a 3D effect. The chart uses bar and line chart display options.
Pie Charts

A pie chart shows one data set segmented in slices of a pie. Properties for the following items are supported for the pie chart:

- Appearance
- Legend
- Element Style
- Pie

The following example shows a pie chart that displays quarterly data for the data set for East, West, South, and Central.

Figure 4 Sample Combo Chart

Figure 5 Sample Pie Chart
Formatting Charts

You format charts to customize their appearance and layout in your reports. You can also format charts to portray data using different chart types, including bar charts or combo charts. You make formatting changes to charts in the Format Chart dialog box. You access this dialog box from the Chart Properties property sheet.

For additional information on the Format Chart dialog box, see the following topics:

- “Using the Format Chart Dialog Box” on page 67
- “Formatting Fonts in Charts” on page 69
- “Formatting Chart Border and Background Options” on page 70
- “Formatting Bars in Bar and Combo Charts” on page 70
- “Formatting Lines in Line and Combo Charts” on page 71
- “Defining Combo Chart Options” on page 72
- “Formatting Pie Charts” on page 72
- “Setting Background Options for a Chart” on page 73
- “Positioning Charts on Reports” on page 74
- “Defining Gridlines” on page 75
- “Defining Styles for Data Sets” on page 75
- “Resizing and Moving Charts” on page 76
- “Formatting Chart Titles and Labels” on page 76
- “Viewing Charts” on page 79

Defining Chart Data

You define chart data using the Chart Properties property sheet. You can identify, from the controlling grid, the rows and columns that contain the data to display. You can reference data or formula rows and columns from the controlling grid by selecting contiguous or noncontiguous rows and columns for the data range. You can also include or exclude auto calculations from the data set.

If you are designing a line, bar, or combo chart, you can reference multiple rows or columns from the grid. If you are designing a pie chart, you can reference any single row or column from the grid. When you define a combo chart, you specify the data rows and columns for the bar and line.

Charts display aggregate rows or aggregate columns that expand. For example, if you specify row 1 and row 1 contains a function that retrieves 10 child members, the chart displays 10 data sets, or one data set for each child member.

To define chart data:

1. Open a report and create a grid and a chart.
2 On the Chart Properties property sheet, select the type of chart to design (bar, line, pie, or combo) from the Chart Type drop-down list. The following figure shows the options on the Chart Properties property sheet. For more information, see Appendix A, “Property Sheet Help.”

Figure 6 Chart Properties Property Sheet

Note:
When you are formatting a combo chart, the Chart Properties property sheet displays range selection options for data on the line and bar charts.

3 From the Grid drop-down list, select the name of the grid for this chart to reference. The grid must exist on the current report.

4 For Legend Items from Grid, select Rows to reference row data or Columns to reference column data.

5 Specify the range of data to display in the chart for all chart types (bar, line, combo, or pie). In the Data Range list boxes, select the rows to include from the Rows list of check boxes and the columns to include from the Columns list of check boxes.

Note:
You can specify contiguous or non contiguous rows and columns when selecting a data range.

6 Optional: To include auto calculations from the data set, select the Include Auto Calculation check box.
7. Optional: To insert a page break before the chart, select the Page Break Before check box.

8. Optional: Modify the horizontal and vertical positions for the object using the drop-down list boxes for Position Object on Report. For more information, see “Positioning Charts on Reports” on page 74.

9. To view the chart with data, select File > Print Preview or File > Web Preview.

Using the Format Chart Dialog Box

You make formatting changes to charts by clicking the Format Chart button in the Chart Properties sheet. The tabs that are displayed on Format Chart depends on the type of chart you select from the Chart Properties property sheet. For example, if you select a pie chart, the dialog box includes a Pie Options tab but not a Bar Options tab.

Note:
Depending on the type of chart you are using, certain controls on the Format Chart dialog box may be disabled.
Table 16 describes the Format Chart dialog box tabs.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appearance</td>
<td>You use the Appearance tab to specify a title for the chart, a chart border, font, gridlines, gridline style, gridline color, and grid background color for all chart types. You can indicate a depth for the chart grid. The Appearance tab also provides a preview of your chart.</td>
</tr>
<tr>
<td>Legend</td>
<td>You use the Legend tab to specify legend properties for all chart types. You can specify the location of the legend on the chart and define the legend title. You can set the font, font style, font size, and text effects for the legend title. The default setting for suppress repeating labels is off, but you can enable the option to inherit settings from the grid. For more information, see “Defining a Chart Legend Title” on page 76.</td>
</tr>
<tr>
<td>Axes</td>
<td>You use the Axes tab to specify axis properties, including metadata, primary, and secondary axis titles and the axis labels. You can indicate primary and secondary axis labels and specify font options for both. You can also specify data labels for the primary and secondary axis using a default or custom range of values. You can specify font options, such as font, font style, font size, and text effects. <strong>Note:</strong> You can provide a secondary axis title label when working with bar, combo, and line charts. These titles and labels display a value between zero and 100, representing a percentage. If you are working with combo charts, you can show data labels for the secondary axis using a default or custom range of values. You can show metadata labels and specify a font angle for display of the labels. You can also modify other font options for metadata labels. For more information, see “Defining Chart Axis Titles” on page 78. <strong>Note:</strong> You can define axis properties for all chart types except pie charts.</td>
</tr>
<tr>
<td>Element Style</td>
<td>You use the Element Style tab to specify attributes such as bar and pie fill, line style, line marker style, marker size, and line width for data sets, depending on the chart type. For example, you specify pie fill only for a pie chart. You can specify a bar shape for bar and combo charts. You select each data set and specify a pattern, style, color, and shape to apply to it. You can specify up to two colors to use with each pattern or fill specification. You can toggle between the two different colors when applying color to the bars in a chart.</td>
</tr>
<tr>
<td>Line Options</td>
<td>When formatting a line chart, you use the options on the Line Options tab to specify the type of line (rows, percent, or stacked-label display). You can also show point values to display the values in your chart and set font options for these values. The Line Options tab provides a preview of your line chart as you modify the formatting.</td>
</tr>
<tr>
<td>Bar Options</td>
<td>When formatting a bar chart, you use the Bar Options tab to specify the type of bar (group, stack, or rows) and the orientation (vertical or horizontal) of the bar chart. You can specify a bar width (zero to 100) for the bars in the chart. You can select a bar border style and width (zero to 20). You can show point values to display the data values in your chart and set font options for these values. The Bar Options tab provides a preview of your bar chart as you modify the formatting.</td>
</tr>
<tr>
<td>Line Options and Bar Options</td>
<td>When formatting a combo chart, the Format Chart dialog box includes a Line Options tab and a Bar Options tab. Consult the Line Options tab and Bar Options tab descriptions in this table for information about the tabs. <strong>Note:</strong> When you are formatting a combo chart, the Chart Properties property sheet displays range selection options for data on the line and bar charts.</td>
</tr>
<tr>
<td><strong>Tab</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Pie Options</td>
<td>You use the Pie Options tab to specify formatting options for a pie chart. You can modify the angle of the pie chart, specify a separation distance (which applies to the first slice of the pie chart only), and select slice values (percent, data, or label) to display in the pie chart. You can also format the font options for these values. You can indicate the position (exterior or radial) for the slice values. You can specify a slice border style (solid, dotted, dashed, or dotdashed) and a border width (zero to 20) for the slice. The Pie Options tab provides a preview of your pie chart as you modify the formatting options.</td>
</tr>
</tbody>
</table>

**Formatting Fonts in Charts**

When working with charts, you can format fonts to customize their appearance. Font formatting options include font selection, font size, color, and font angle (zero to 315 degrees, in increments of 45 degrees).

You can format fonts by clicking the Format button, which is displayed throughout the tabs located on the Format Chart dialog box.

**Note:**

You can preview font selection options in the Preview window in the Format Dialog Box.

**Figure 8 Format Dialog Box**
The Format dialog box enables you to preview your font option selections before returning to the chart. For more information on formatting fonts, see “Modifying Font Options” on page 170.

**Formatting Chart Border and Background Options**

You can format the chart border and background using the Borders and Background dialog box. You access this dialog box by clicking the Borders and Background icon, which is displayed throughout the Format Chart dialog box.

Borders and background format options include border type, border color, background color, and border width.

**Figure 9  Borders and Background Dialog Box**

<table>
<thead>
<tr>
<th>Borders and Background</th>
</tr>
</thead>
<tbody>
<tr>
<td>Border Type</td>
</tr>
<tr>
<td>- None</td>
</tr>
<tr>
<td>- Box</td>
</tr>
<tr>
<td>- Shadow</td>
</tr>
<tr>
<td>- Raised</td>
</tr>
<tr>
<td>- Recess</td>
</tr>
<tr>
<td>Border Color</td>
</tr>
<tr>
<td>Background Color</td>
</tr>
<tr>
<td>Border Width</td>
</tr>
</tbody>
</table>

**Formatting Bars in Bar and Combo Charts**

You can display bars in a bar or combo chart by grouping data sets and specifying their orientation on the chart. You can also display point values in your bar or combo chart. You can modify the shapes and widths of bars and bar borders.

Use the following guidelines to specify how bars are displayed in your charts:

- Vertical orientation starts the bars on the horizontal axis and displays the bars vertically.
- Horizontal orientation starts the bars on the vertical axis and displays the bars horizontally.
- You can display bars in three dimensions. The third dimension depth represents the pixel depth of the 3D effect or shadow.
- The bar width represents the relative width of the bar as a percentage of available space. A smaller number results in more space between bars.
- The bar shape represents the shape of the displayed bars.
- You can apply shading (pattern and color) by data set using the Element Style tab of the Format Chart dialog box. For more information, see Table 16 on page 68.
To format bars in bar and combo charts:

1. Open a report and create or select a bar or combo chart.
2. On the Chart Properties property sheet, click the Format Chart button.
3. Select the Bar Options tab.
4. Select a Type option:
   - To display bars side-by-side, select Group.
   - To display bars stacked vertically bottom-to-top, select Stack.
   - To display the bars front-to-back, select Rows.
5. Select an Orientation option:
   - To display the bars vertically on the horizontal axis, select Vertical.
   - To display the bars horizontally on the vertical axis, select Horizontal.
6. To show the numerical value or data that the bar represents, select the Show Point Values check box. The value is displayed within the bar.
7. Click the Font button, to set font options for the bar values.
8. To specify a style to be applied to the border of the bars in the chart, select Solid, Dotted, Dashed, or DotDashed from the Bar Border Style drop-down list.
9. To alter the width of the bars, use the slide tool in the Bar Width box.
10. To increase or decrease the width of the bar borders, use the slide tool in the Bar Border Width box.
11. Click OK.

Note:
You can define styles for the bars representing the current data set. For more information, see “Defining Styles for Data Sets” on page 75.

Formatting Lines in Line and Combo Charts

You can specify display options for lines in line and combo charts. For example, you can display lines in separate rows, stacked as a percentage of the total of all values, or stacked as absolute values.

To format lines in line and combo charts:

1. Open a report and create or select a line or combo chart.
2. On the Chart Properties property sheet, click the Format Chart button.
3. Select the Line Options tab.
4. Select one of the following line types:
   - To display the line sets in separate rows, select Rows. For example, if you define the 3D depth as nonzero, the lines are displayed in separate rows, from front to back.
To display the line sets stacked on top of each other, normalized to 100%, select Percent. As each line set is drawn, its values are added to previous values displayed and are shown as percentages of the total of all values.

- To display the line sets stacked, select Stack. As each line set is drawn, its values are added to previous values. Select one of the following from the drop-down list:
  - To show pop-ups with accumulated values, select Total Value.
  - To show pop-ups as individual item values, select Segment Value.

5 To show the numerical value or data that the line represents, select the Show Point Values check box. The value is displayed on top of the line.

6 To set font options for the point values of the lines, click the Font button.

7 Click OK.

Note:
You can define styles for the lines representing the current data set. For more information, see “Defining Styles for Data Sets” on page 75.

### Defining Combo Chart Options

A combo chart combines a line chart and a bar chart. Typically used to contrast data sets, combo charts employ bar and line options and are set with the same variables as bar charts and line charts.

When you are formatting a combo chart, the Format Chart dialog box includes the Line Options tab and Bar Options tab. For more information, see Table 16 on page 68. For information about defining bar options for a combo chart, see “Formatting Bars in Bar and Combo Charts” on page 70. For information about defining line options for a combo chart, see “Formatting Lines in Line and Combo Charts” on page 71.

### Formatting Pie Charts

When creating a pie chart, you can specify the starting angle for the first pie slice, the level of separation between pie slices, the position and type of pie slice labels, and the slice border style and width. You can also set font options including font, font size, effects, and angle for the textual display of the slice values.

To format a pie chart:

1 Open a report and create or select a pie chart.
2 On the Chart Properties property sheet, click the Format Chart button.
3 Click the Pie Options tab.
4 To specify the angle of the first pie slice, use the slide tool for Pie Angle. The angle is measured in degrees from 0 to 360, counterclockwise, with 0 degrees pointing to the 3 o'clock position.
5 To indicate the distance between the pie slices, use the slide tool for **Separation**. Moving the slide tool to the left makes the space between slices smaller; moving the slide tool to the right increases the space between slices.

6 Select a **Show Slice Values as** option:
   - To show data values as a percentage, select **Percent**.
   - To show the absolute value of the pie chart data, select **Data**.
   - To display the data value as a label, select **Label**.

7 To set font options for the slice values shown in the chart, click the **Font** button, ✎.

8 Select a **Position** option:
   - To show the slice values outside of the pie chart, select **Exterior**.
   - To show the slice values inside of the pie chart, select **Radial**. Use the slide tool to adjust the location of the data value inside of the slice.

9 From the **Slice Border Style** drop down list, select a style to apply to the border of the slices in your pie chart: solid, dotted, dashed, or dotdash.

10 To indicate the width of the borders for the pie chart slices, use the slide tool for **Slice Border Width**. The maximum width is 100.

11 Click **OK**.

**Note:**
You can define styles for the slices of the pie that represent the current data set. For more information, see “Defining Styles for Data Sets” on page 75.

## Setting Background Options for a Chart

You can set background options for a chart, such as a border, gridlines, gridline color, gridline style, and grid background. You can also set the grid depth.

➤ To set background options for a chart:

1 Open a report and select a chart.

2 From the Chart Properties property sheet, click the **Format Chart** button.

3 Select the **Appearance** tab.

4 **Optional:** To place a border around the chart, select the **Chart Border** check box.

5 Click the **Borders and Background** icon, ✎, to format the border and background of the chart.

6 To modify the gridlines, gridline color, style, or background, select an option from the drop-down list boxes:
   - To specify which gridlines to consider for the current format (both, vertical, horizontal or none), select an option from the **Gridlines** drop-down list.
   - To define a style (solid, dotted, dashed, dotdash, or bar) for the gridlines, select an option from the **Gridline Style** drop-down list.
● To define a color for the gridlines, select an option from the Gridline Color drop-down color palette.

● To define a background color to display behind the gridlines, select an option from the Grid Background drop-down color palette.

Note:
When setting background options for a pie chart, these options are not available.

7 Optional: Modify the Grid Depth using the slide tool provided.

8 Click OK.

Positioning Charts on Reports
You can specify a chart’s position on the report and how it is displayed when printed. You can specify a position relative to the grid, a position relative to other report objects, or no position at all. If you do not specify a position, the chart remains in the location where it was originally created on the report.

➤ To position a chart on a report:

1 Open a report and select a chart.

2 On the Chart Properties property sheet, modify the horizontal and vertical positions for the object using Position Object on Report:

   a. From the Horizontal drop-down list, select one of the following horizontal positions:

      ● Select None to anchor this chart at its current position in the report. The chart is printed in this position.

      ● Select Relative if you want the chart to maintain a distance relative to other report objects located to the left of it. This option assures that the chart is not printed on top of another report object.

      ● Select Left to position the chart against the left margin of the report.

      ● Select Center to position the chart in the center of the report.

      ● Select Right to position the chart against the right margin of the report.

   b. In the Vertical drop-down list, select one of the following vertical positions:

      ● Select None to anchor this chart at its current position in the report. The chart is printed in this position.

      ● Select Relative if you want the chart to maintain a distance relative to other report objects located above it. This option assures that the chart is not printed on top of another report object.

      ● Select Top to position the chart at the top of the report.

      ● Select Middle to position the chart in the middle of the report.

      ● Select Bottom to position the chart at the bottom of the report.
Defining Gridlines

You can display gridlines behind a bar, line, or combo chart. You can show or hide gridlines, and you can specify gridline color, style, and background color.

➤ To define gridlines:

1 Open a report and select a chart.
2 On the Chart Properties property sheet, click the Format Chart button.
3 Select the Appearance tab.
4 From the Gridlines drop-down list, select one of the following options:
   ● Horizontal to show horizontal gridlines
   ● Vertical to show vertical gridlines
   ● Both to display horizontal and vertical gridlines
   ● None to hide gridlines
5 Optional: To specify a style (solid, dotted, dashed, dotdash, or bar) for the gridlines, click Gridline Style and select an option from the drop-down list.
6 Optional: To specify a color for the gridlines, click Gridline Color and select a color from the drop-down color palette.
7 Optional: To specify a background color to display behind the gridlines, click Grid Background and select a color from the drop-down color palette.

Defining Styles for Data Sets

You can define styles for data sets in charts. You can define a pattern and color for each data set in your report. The specified shading and patterns are applied to each respective data set to differentiate values in the chart.

➤ To define styles for a data set:

1 Open a report and select a chart.
2 On the Chart Properties property sheet, click the Format Chart button.
3 Select the Element Style tab.
4 Select a data set.
5 Select a fill pattern for the selected data set.
6 From the Color 1 and Color 2 drop-down list boxes, select two colors for contrasting the pattern.

   Note:

   To toggle between the two different colors selected, click the Toggle Color icon,.
7 Select a line style, line marker style, marker size, and line width to apply to the data set.
8 Click OK.

**Resizing and Moving Charts**

You can change the size of a chart and move a chart to another location in a report.

➤ To resize a chart:
1 Select a chart by clicking on that chart object.
2 Click and drag a handle, located on the perimeter of the chart, to change the size.

➤ To move a chart:
1 Click inside the chart, selecting the chart as an object.
2 Hold down the left mouse button and drag the chart to another location in the report.

**Formatting Chart Titles and Labels**

You can specify and format chart legend titles, chart titles, chart axes titles, and axis labels in your chart. You can also format the font and borders and background of the titles and axes you indicate. You specify chart titles and labels in the Format Chart dialog box.

For more information on defining chart titles and labels, see the following topics:

- “Defining a Chart Legend Title” on page 76
- “Defining a Chart Title” on page 77
- “Defining Chart Axis Titles” on page 78
- “Defining Axis Labels” on page 78

**Defining a Chart Legend Title**

You define a legend to identify and describe the data sets used in your chart. You can specify font and background options and border color. You can also specify the placement location for the legend within the chart boundaries.

You can also suppress repeating labels, through which you can inherit settings from the referenced grid. Repeating labels are axis labels that repeat in a chart if you do not suppress them.

**Note:**

Chart legend options are available for all chart types.

➤ To define chart legend options:
1 Open a report and select a chart.
2 On the Chart Properties property sheet, click the Format Chart button.

3 Select the Legend tab to display the formatting and placement options for legends.

4 Select the Place Legend check box to select the vertical and horizontal positions of the chart legend relative to the chart boundaries. Vertical positioning options include Top, Middle, and Bottom. Horizontal positioning options include Left, Center, Right.

5 Click the Borders and Background icon, , to format the border and background of the legend.

6 In the Legend Title text box, enter a title for the legend.

7 Click the Font button, , to set font options, including font, font size, effects, and angle, for the legend title and its labels, then click OK.

8 To suppress X-axis labels that would otherwise repeat, select from the following options for Suppress Repeating Labels: Inherit Settings from Grid, On, or Off.

9 Click OK.

### Defining a Chart Title

When defining chart appearance, you can specify a title and then select font and background options for the title.

To define a chart title:

1 Open a report and select a chart.

2 From the Chart Properties property sheet, click the Format Chart button.

3 Select the Appearance tab.

4 In the Chart Title text box, enter a title for the chart.

**Tip:**

When defining legend, axes or chart titles, you can print the title on multiple lines using a \n in the title. You can use a \'s to indicate a possessive apostrophe in the legend, axes or chart title. You can combine these commands to use apostrophes with titles that span multiple lines.

5 **Optional:** Click the Font button, , then set font options and click OK.

6 **Optional:** Click the Borders and Background icon, , then specify border and background options for the chart title, and click OK.

7 To place a border around the chart, select the Chart Border check box.

8 **Optional:** Click the Borders and Background icon, , then specify border and background options for the chart border and click OK.

9 Click OK.
Defining Chart Axis Titles

You can specify a metadata title and primary and secondary axis titles, to identify the data that is displayed on the axes of your chart. You can also specify font options, including font size, color, and font angle. You can label your metadata using the same formatting options.

You can also specify font options, including font size, color, and font angle. You can label your metadata using the same formatting options.

You can specify color, border, and background options for the title of each axis.

Note:
Chart axis options are available for bar, line, and combo charts only.

➤ To define a chart axis title:
1 Open a report and select a chart.
2 On the Chart Properties property sheet, click the Format Chart button.
3 Select the Axes tab to display the formatting options for axes, then perform one or more of the following actions:
   ● In the Metadata Title text box, enter the title for the horizontal axis.
   ● In the Primary Axis Title text box, enter the title for the primary vertical axis. This is displayed to the left of the chart.
   ● In the Secondary Axis Title text box, enter the title for the secondary vertical axis. This is displayed to the right of the chart.
4 Click the Font button, to set font options and then click OK.
5 Click the Borders and Background icon, then specify border and background options for the axis title and click OK.
6 Click OK.

Defining Axis Labels

You can define and format labels for the primary and secondary axis in a chart. For a combo chart, you can specify and format a secondary axis label. You can also display and format metadata labels.

Note:
A primary or secondary axis label enables you to specify a custom range of values on the axis.

➤ To define axis labels:
1 Open a report and select a chart.
2 On the Chart Properties property sheet, click the Format Chart button.

3 Select the Axes tab and perform one or more of the following actions:
   
   ● To use the default range of values on the primary axis, select the check box for Primary Axis Label.
   
   ● To enter a range of values, including minimum, maximum, and step, on the primary axis, select the check box for Primary Axis Label and the Custom Range check box.
   
   **Note:**
   You can use the custom range to change the starting and ending numbers of your axis and the numeric intervals. For example, you can display values 40 through 60 at three step intervals by entering 40, 60, and 3 in the Min, Max, and Step check boxes, consecutively.

   ● To use the default range of values on the secondary axis of a combo chart, select the check box for Secondary Axis Label.
   
   ● To enter a range of values, including maximum, minimum, and step, on the secondary axis of a combo chart, select the check box for Secondary Axis Label and the Custom Range check box.
   
   ● To display the percentage of the default range of values on the secondary axis in a bar of line chart, select the check box for Secondary Axis Label.
   
   ● To enter a range of values, including minimum, maximum, and step, on the secondary axis in a bar or line chart, select the check box for Secondary Axis Label and the Custom Range check box.

4 Click the Font button, A, to set font options for the data labels, and then click OK.

5 Click the Borders and Background icon, □, then specify border and background options for the data labels, and then click OK.

6 To show the metadata labels with a standard display, select the Show Metadata Labels check box.
   
   **Note:**
   Financial Reporting implements staggered labels as a default to ensure the even distribution of data on report axes.

7 Click the Font button, A, to set font options for the metadata labels, then click OK.

**Viewing Charts**

You can print and print-preview the chart rendering in Financial Reporting Studio and Financial Reporting. If you installed the Adobe SVG Viewer, charts are rendered in enhanced quality for the following output.

● When viewed in PDF in Financial Reporting.

● When exported to PDF in Financial Reporting Studio.
For information on downloading the Adobe SVG Viewer, see the Hyperion Reporting and Analysis – System 9 Installation Guide.
To build reports, you create a report design by adding report objects to the design and defining the report object properties. Report objects include text boxes, grids, images, and charts. When you create a report, you start with a blank design area. You can modify the blank report as necessary.

**Adding Report Objects**

Report objects are defined as text boxes, grids, charts, or images defined in the design area of a report. Adding report objects to your report involves specifying the report layout and object properties, and selecting the data content. You can also insert report objects previously stored in the repository. Report objects can be used in multiple reports.

After you add a report object, you can assign properties to it such as format options. Format options include font, alignment, spacing, shading, and positioning.
To add a report object:

2. Add report objects to your report using the “Report Objects” on page 19.
3. Save your report by selecting File > Save.

Using Linked and Local Objects

Report objects can be saved to the repository and serve as a resource for other reports. They can be inserted into other reports as linked or local (unlinked) objects and used “as is” or customized.

Linking objects to a source object can save time and effort. By updating one source object, you update all reports that are linked to this source object.

The option to link or not to link is specified while performing the following functions:

- Saving a report object to the repository
- Inserting an object from the repository into your report. When you insert a saved object from the repository as a linked object, you can clear the link after it is copied into the report. However, you cannot reverse this action.

Linked Objects

Linked objects enable you to save an object in a report and in the repository. You can link the object in the report to the source object in the repository so that modifications to the source object are reflected in the object that exists in the report.

When you insert a source object into a report, modify it, then link it to the source object when saving the object, the changes are reflected in the source object and all objects that are linked to it in other reports. For an example of creating a linked report object, see “Saving Text Objects” on page 85.

For example, suppose you insert into your report a text object, Company_Logo, from the repository. You then modify the text in Company_Logo and save the object, specifying a link to the source object. The revised Company_Logo text object overwrites the source object in the repository, and any new report or existing report that is also linked to the Company_Logo source object reflects the modified text.

The following table outlines the objects that can be linked to the repository and included in your reports, and provides the location of procedural information for each object type in Financial Reporting.

<table>
<thead>
<tr>
<th>Table 17 Using Linked Objects</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object</td>
</tr>
<tr>
<td>Grid</td>
</tr>
</tbody>
</table>
### Local Objects in Financial Reporting

When you save a repository object to a report without linking it to the source object, the local object (the object on the current report) is not linked to the saved object in the repository. Changes to the local object do not affect the object saved to the repository, and changes to the repository object do not affect the local object in the report.

This option enables you to customize your report’s copy of the report object to suit your individual requirements.

The following figure illustrates the behavior of linked and local objects in a report.

![Figure 10 Linked and Local Report Objects](image)

In Report A, Report Object 1 is copied from the repository as a local object. Changes made to the local report object are not reflected in the source object. Report Object 3 is linked to its source object in the repository. Changes made to Report Object 3, when saved, are reflected in the source object.
Adding Text Objects

Text objects are report objects that can contain text or text functions. For example, you can enter a label, description, or a function that retrieves the current date in a text box. For more information about text functions, see “Text Functions” on page 208. You can enter multiple paragraphs of text. Like other report objects, you can move, resize, or reposition the area containing the text.

You can create a new text object or insert an existing text object into the report. New text objects are empty areas where you can enter text, text functions, or rich text from an editor or word processor. Text objects are stored in the repository and can be inserted into numerous reports. You might want to add the same text object, for example, in all your report designs.

➤ To add a text object:

1. Select File > Open.
2. Open a report and select Insert > Text.
3. Point to where you want to position the upper left corner of the text box, click and drag to the desired size, then release the mouse button.
4. Click inside the text object, and enter the text directly in the text box.

➤ To insert a text box from the repository:

1. Select File > Open.
2. Open a report and select Insert > Saved Object.
3. In the Type drop-down list, select Text.
4. Select the directory where you want to search for the text object, then select the desired text object.
5. Perform an action:
   - To use the text object as a linked object, select Link to Source Object.
   - To use the text object as an unlinked object, deselect Link to Source Object. This is the default option.
6. Click Insert.

Modifying Text Objects

You can modify the properties of a text object. This includes inserting a function in the text object, modifying the vertical or horizontal position of the text box, and selecting the autosize function, which enables the display of all of the text contained in the text object. You can also select the Page Break Before check box, which displays the text box on the top of the next page.
when you preview or print the report. You can also link the current text object to a source object in the repository.

**Note:**
The Link to Source Object check box is enabled after the text object is saved to the repository and the Link to Source Object check box is selected.

➤ To modify a text object:

1. **Select the text object.**
2. **Using the Text Properties sheet, modify the properties of the object. To modify the text, select Format > Font.**

**Tip:**
To resize the text object, drag a handle. To move the text object, drag inside the text object border.

## Saving Text Objects

When you save a text object, you can create a link between that text object and the source object in the repository. Text objects can be saved to the repository for reuse when building reports. Once they are saved to the repository, they can be inserted into a report as linked or unlinked objects.

**Note:**
Changes to a linked object are not saved when you save and close your design.

➤ To save the text object to the repository:

1. **Click the text object, then select File > Save Object.**
2. **Select a folder or create a folder.**
3. **Perform the following actions:**
   a. In the Name text box, enter the report text object name. You can use upper and lowercase letters, spaces and numbers. The program does not accept special characters such as / \ %, ?, < > | ' “ *.
   b. In the Description text box, enter the description of the text object.
4. **Perform an action:**
   - To create a link from the text object in the report to the source object in the repository, select **Link to Source Object.**
   - To save without creating a link from the text object in the report to the saved object in the repository, clear **Link to Source Object.**
Adding Grids

Grids are tables that can contain data from external database connections. You can add a grid to your report, define its dimension layout, select members, and then format the grid. You can also insert an existing grid to reuse a preformatted grid design. You can use text, dimensions, members, and formulas to define the grid content. You can also hide a grid. For example, you might want to display a chart in a report, but not the grid associated with the chart.

You define the dimension layout for the grid by specifying a database connection, then dragging the available dimensions from the Point of View (POV) frame into the Rows, Columns, and Pages frames. The dimensions that are not placed in the Rows, Columns, or Pages frames are displayed in the user POV bar for that grid. You can layer multiple dimensions on a row, column, or page. For example, you might want to place the Scenario and Time dimensions on the same axis to show actual and budget data over a period of time.

The following figure shows the Dimension Layout dialog box. This is where you define the grid’s dimension layout by dragging the dimensions from the Point of View frame into the Pages, Rows, and Columns frames.

Figure 11  Dimension Layout Dialog Box
If the selected database connection for the grid contains attribute dimensions, they are displayed above the Point of View frame. Like the dimensions, you can drag attribute dimensions into the Point of View frame or the Rows, Columns, or Pages frames.

The following table describes the Dimension Layout dialog box items:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grid</td>
<td>The grid name. You can accept the system default name or enter a new grid name. This option is available only if the grid is not linked to a source grid in the repository.</td>
</tr>
<tr>
<td>Attribute Dimensions</td>
<td>A type of dimension that enables analysis and is based on the attributes or qualities of the members of its base dimension. You can drag attribute dimensions from this frame into the Point of View, Pages, Rows, or Columns frames. Attribute dimensions are displayed only if they exist in the database connection.</td>
</tr>
<tr>
<td>Point of View</td>
<td>The dimensions that define the point of view for the grid. The Point of View identifies the data to retrieve in the grid. You can drag dimensions from this frame to the Pages, Rows, or Columns frames.</td>
</tr>
<tr>
<td>Pages</td>
<td>The third axis on a grid. You can drag into this frame, the dimensions to use on the Page axis from the Attribute Dimension and Point of View frames.</td>
</tr>
<tr>
<td>Columns</td>
<td>A vertical display of information in a grid or table. You can drag into this frame the dimensions to use on the column.</td>
</tr>
<tr>
<td>Rows</td>
<td>A horizontal display of information in a grid or table. You can drag into this frame the dimensions to use on the row axis from the Attribute Dimension and Point of View frames.</td>
</tr>
</tbody>
</table>

After you define the dimension layout, you can select the members to use for each dimension. For more information, see “Assigning Members to Data Rows or Columns” on page 40 and “Assigning Members to the Page Axis” on page 41.

When you add a new grid, the system assigns a default name to the grid. You can rename the grid in the Dimension Layout dialog box or when you save it. The default name assigned is Grid\(_n\), where \( n \) is a system-assigned identification number. For example, if you save a grid that is the sixth system-named grid saved in the report, the default name is Grid\(_6\). The system uses the grid name when a function or chart references the grid. For example, if you design a chart to graphically display the data from a grid, the chart properties must reference the grid by its name.

➤ To add a new grid into your report:

1. Open a report and select Insert > Grid.
2. Point to where you want to place the upper left corner of the grid and drag to the desired size, then release the mouse button.
3. In the Select a Database Connection dialog box, select a Database Connection.
4. Click OK. The Dimension Layout window is displayed.
5 Drag the dimension icons from the Attribute Dimensions frames, if they exist, and Point of View frames into the Pages, Rows, or Columns frames, then click OK.

Note:
You can place multiple dimensions into the Rows, Columns, or Pages frames.

➤ To insert an existing grid into your report:
1 Open a report and select Insert > Saved Object.
2 In the Type drop-down list, select Grid.
3 Select the directory where you want to search for the grid object, then select the desired grid object.
4 Perform an action:
   ● To use the grid object as a linked object, select Link to Source Object.
   ● To use the grid object as an unlinked object, clear Link to Source Object. This is the default.

Note:
For a description of linked objects, see “Using Linked and Local Objects” on page 82.
5 Click Insert.

Modifying the Properties of Grid Objects
You can customize grid objects using the Grid Properties sheet, which contains four primary categories for modifying a selected grid: general, format, suppression, and position. You can use the general and format categories to position and format the selected grid, including dimension layout, show members, cell alignment, and borders and shading. Suppression is used to hide a grid, or values in a grid’s cells. You would use positioning to modify the object’s vertical or horizontal positioning on the grid. The following procedure describes how to modify the properties of a grid object.

➤ To modify the properties of a grid object:
1 Open a report and select the object to be modified.
2 Modify the object using the Grid Properties sheet. For information on customizing your grid, see Chapter 5, “Customizing Grids.”
3 Optional: Click the Dimension Layout button in the Grid Properties sheet to change the dimensions on the grid’s axes. If this is a linked grid, the Grid field displays the name of the grid and its path in the repository.

Tip:
To resize the grid object, drag a handle. To move the grid object, drag the grid’s title bar.
**Saving Grid Objects**

When you save a grid object, you can create a link between that grid object and the source object in the repository. When you save the object in the repository, it can be reused by linking to another report.

**Note:**

You must have Designer or System Administrator level security to perform this function.

➤ To save the grid object to the repository:

1. Click the grid, then select **File > Save Object**.
2. Select a folder in which to store the grid, or create a new folder.
3. In the Name text box, enter the grid name. You can use upper and lowercase letters, spaces and numbers. The program does not accept special characters such as `\ / %, ? + < > | ‘ “ *`.  
4. In the **Description** text box, enter the description of the grid.
5. Perform an action:

   - To create a link from the grid object in the report to the source object in the repository, select **Link to Source Object**.
   - To save a grid object without creating a link from the grid object in the report to the saved source object in the repository, clear **Link to Source Object**.

**Note:**

For a description of linked objects, see “Using Linked and Local Objects” on page 82.

6. Click **Save** to save the grid object to the repository. When you save a grid object, only the specified object is saved, not the entire report design.

**Inserting Images**

Image objects are graphics or pictures that can be used in your report. The following image formats can be used:

- **Bitmaps**: `.bmp` and `.dib`
- **Graphics Interchange Format (GIF)**: `.gif`
- **Joint Photographic Experts Group (JPEG)**: `.jpg`
- **Icon**: `.ico` and `.cur`

You can add images to the header, footer, or body of a report. After you add an image frame with an image file to the report, you can format the image object. For more information on image formatting, see “Formatting Images” on page 196.

You can insert an image file that is stored in a file system outside Financial Reporting into the image frame, or you can insert an entire image object that is saved in Studio Explore.
To insert a new image object located outside of Studio Explore:

1. Open a report and select Insert > Image.
2. Point to where you want to place the upper left corner of the image frame, click and drag to the desired size, then release the mouse button.
3. In the Files of type drop-down list, select an image format.
4. Select an image file from the default Financial Reportingbin directory, or click the Look in drop-down list to search for an image file located on your file system.
5. Click Open to select the image file.
6. Use the Image Properties sheet to modify the image.

Note:
To add the image to the repository, or to save it as a linked object, select File > Save Object. For information, see Saving Image Objects.

To insert an image object from the repository:

1. Open a report and select Insert > Saved Object.
2. In the Type drop-down list, select Image.
3. Select the desired image object.
4. Perform an action:
   - To use the image object as a linked object, select Link to Source Object.
   - To use the image object as an unlinked object, clear Link to Source Object. This is the default.

   Note:
   For a description of linked objects, see “Using Linked and Local Objects” on page 82.
5. Click Insert.

**Saving Image Objects**

When you save an image object, you can create a link between that image object and the source object in the repository. Linking report objects to a source object saves time and effort. By updating one source object, you update all reports that are linked to this source object.

To save the image object to the repository:

1. Select the image, then select File > Save Object.
2 Specify a name and a location to where you want to save the image.

3 Perform an action:
   - To create a link from the image object in the report design to the source object in the repository, select Link to Source Object.
   - To save without creating a link from the image object in the report design to the saved object in the repository, clear Link to Source Object.

4 Click Save to save the image object to the repository. When you save an image object in a report, only the specified object is saved, not the entire report design.

Inserting Charts

Charts enable you to display data from a grid on the report. When you insert a chart in a report, the chart retrieves data from the specified grid on the current report. You can insert bar, pie, line, and combo (bar and line) charts.

For descriptions of each type of chart, see “About Charts” on page 61. For information on designing charts, see Chapter 3, “Customizing Charts.”

To insert a new chart object:
1 Open a report and select Insert > Chart.
2 Point to where you want to place the upper left corner of the chart, click and drag to the desired size, then release the mouse button.
3 Modify the chart using the Chart Properties sheet.

To insert a chart object from the repository:
1 Open a report and select Insert > Saved Object.
2 In the Type drop-down list, select Chart.
3 Select the desired chart object.
4 Perform an action:
   - To use the chart object as a linked object, select Link to Source Object.
   - To use the chart object as an unlinked object, clear Link to Source Object. This is the default.

   Note:
   For a description of linked objects, see “Using Linked and Local Objects” on page 82.
5 Click Insert.
Saving Chart Objects

When you save a chart object, you can create a link between that chart object and the source object in the repository. Linking report objects to a source object saves time and effort. By updating one source object, you update all reports that are linked to this source object.

➤ To save the chart object to the repository:
1 Select the chart, then select File > Save Object.
2 Specify a name and a location to where you want to save the chart.
3 Perform an action:
   ● To create a link from the chart object in the report design to the source object in the repository, select Link to Source Object.
   ● To save without creating a link from the chart object in the report design to the saved object in the repository, clear Link to Source Object.
4 Click Save to save the chart object to the repository. When you save a chart object objects in a report, only the specified object is saved, not the entire report design.

Creating Headers and Footers

You can design a custom header and footer in your report using inches or centimeters as your unit of measure for the height. The header is located immediately below the top margin, and the footer is located immediately above the bottom margin. Headers and footers can be used to add a description, add graphics, or insert text functions such as GetCell, Date, and Page. For more information, see “Designing Headers and Footers” on page 95.

➤ To create headers and footers:
1 Access the Report Properties sheet by clicking an unused area of the report page.
2 In the Header Height text box, perform an action:
   ● If you want to include a header in your report, enter the height of the header.
   When you specify a height for the header and footer, the system takes into account the top and bottom margins and page size specified in Page Setup. For more information, see “Changing the Page Setup” on page 197.
   ● To exclude a header in your report, enter zero (0).
3 In the Footer Height text box, perform an action:
   ● If you want to include a footer in your report, enter the height of the footer.
   When you specify a height for the header and footer, the system takes into account the top and bottom margins and page size specified in Page Setup.
   ● To exclude a footer in your report, enter zero (0).

For information on specifying margins, paper size or viewing size, see “Changing the Page Setup” on page 197.
Positioning Report Objects

Positioning report objects involves placing objects in the desired positions in the Report Designer workspace. For example, you can position a text box on the top left of the report, and position a grid in the center of the report. How you position objects affects the online report and the printed page. You position report objects by specifying position property values or using rulers to position objects manually.

It is important for the appearance of your report to be able to position objects because report objects can change size depending on the amount of data they contain. You can set the position of a report object relative to other report objects above it and to its left. For example, if report objects above the given report object increase or decrease in size, the given report object moves as necessary to maintain the same distance between it and the other report objects.

If you do not position a report object, the report object is printed at its current location regardless of whether report objects above it or to its left increase or decrease in size.

You can also overlap objects, which enables you to organize them however you choose when laying out a report. Objects that can be overlapped include text boxes, grids, charts, and images. When overlapping objects, you can send a report object to the back (behind another object) or bring it to the front (ahead of another object).

Note:

The ability to overlap objects is a design convenience only. When printing reports containing overlapping objects, objects may not print as displayed in the designer, requiring you to rearrange the objects in your report.

When working with multiple overlapped objects in the Report Designer, you can print the report regardless of your object layout. For example, a portion of a text box overlaps a chart, or layers of charts are placed on top of one another. Regardless of how you place the objects in your report, you can print the report.

To position a report object:

1. Open a report.
2. Position the report objects by performing one or more of the following actions:
   - To position a grid, select a grid, then select the **Position** category in the Grid Properties sheet. In the **Horizontal** and **Vertical** drop-down lists, select the grid’s horizontal and vertical position on the report.
   - To position a chart, select a chart, then in the Chart Properties sheet’s **Horizontal** and **Vertical** drop-down lists, select the chart’s horizontal and vertical position on the report.
   - To position a text box, select a text object, then in the Text Properties sheet’s **Horizontal** and **Vertical** drop-down lists, select the text box’s horizontal and vertical position on the report.
   - To position an image, select an image, then in the Image Properties sheet’s **Horizontal** and **Vertical** drop-down lists, select the horizontal and vertical position on the report.
To place the selected object ahead of other objects that it overlaps, select an object, right-
mouse click, and select **Bring to front**.

To place the selected object behind other objects that it overlaps, select an object, right-
mouse click, and select **Send to back**.

**Tip:**
To position grid and chart objects manually, click inside the header area and drag to the
desired position. To position text and image objects manually, click the object and drag to
the desired position.

### Resizing Report Objects

You can resize report objects so they are displayed fully expanded or at a specified height and
width when the report is previewed or printed. You can also enable the system to automatically
increase the size of a text box and grid as more area is needed to include all resulting data. When
you resize report objects, the contents remain the same size, but the space around the contents
changes. For example, you can drag a handle of a grid border to reserve an amount of space to
the left of the grid. When you view the grid, the area to the left of the grid remains blank.

**Note:**
If you reduce the size of a text box or grid so that there is more content than can fit in it, scroll
bars are displayed on the border of an online report.

➤ To resize a report object:

1. **Open a report.**
2. **Resize the report objects as follows:**
   - To resize a text box, select the text object, then in the Text Properties sheet, select
     **Autosize**. The text area fully expands when you preview or print the report.

   **Note:**
   You are limited to 27 lines of text. To see all lines of text, deselect **Autosize**.

   - To enable the system to horizontally and vertically expand a grid, select the grid, then select
     the **General** category on the Grid Properties sheet. Select **Autosize**.

   **Tip:**
   To manually adjust the size of a report object, drag a report object’s handle. Use the
guidelines and the ruler on the Report Designer workspace to assist in sizing report objects.
Saving Report Objects

When you save a report object, you can create a link between that source object and the source object in the repository. Saving report objects in the repository enables you to reuse them on a consistent basis. This saves time and enables you to build a library of objects to access and use when creating reports.

➤ To save report objects:

1. Click the report object, then select File > Save Object.
2. Select a folder or create a new folder.
3. In the Name text box, enter the report object name. You can use upper and lowercase letters, spaces and numbers. The program does not accept special characters such as \ / %, ? + < > | ‘ “ *.
4. In the Description text box, enter the description of the report object.
5. Perform an action to save the local report object to the repository:
   - To create a link from the local object in the report to the source object in the repository, select Link to source object.
   - To save without creating a link from the local object in the report design to the saved object in the repository, clear Link to source object.
6. Click Save to save the report object to the repository. When you save report objects in a report, only the specified object is saved, not the entire report design.

Removing Report Objects from a Report

When you remove a linked report object from a report, it is removed from only the report and not from the repository. You can still use the source report object in other reports. For information on removing report objects from the server, see Chapter 11, “Managing the Explore Repository.”

➤ To remove a report object from a report, select a report object, then click Edit > Delete.

Designing Headers and Footers

Headers and footers are displayed at the top and bottom of each page in a report and can be aligned to the right, left, or center. Headers and footers can include text, images, and formulas that retrieve text, such as the report name. You can also include the page number in a header or footer.

➤ To design headers and footers:

1. Open a report.
2. Click the space outside of a report object to display the Report Properties sheet.
3 Remove any report objects that are located in the header or footer area, then perform one or both of the following actions:

- To specify a header height, enter a height in inches or centimeters in the **Header Height** text box.
- To specify a footer height, enter a height in the **Footer Height** text box.

**Tip:**

If you do not want a header or footer, specify zero (0) for the header or footer height, respectively. The height of the header and footer defaults to zero (0) units in a blank report layout.

4 Perform either of the following actions:

- To insert text in a header or footer:
  a. Select **Insert > Text**.
  b. In the header or footer area, click where you want to place the upper left corner of the text box and drag to the desired size, then release the mouse button.
  c. Click inside the text box. Then, enter the exact text in the text box, or specify a formula in the text box to dynamically retrieve header or footer information. To specify a formula, add functions such as page, date, and report description, click the **Insert Functions** button in the Text Properties sheet.

- To insert an image in a header or footer:
  d. Select **Insert > Image**.
  e. In the header or footer area, point to where you want to place the upper left corner of the image and drag to the desired size, then release the mouse button.

5 Set properties using the Text or Image Properties sheet.

### Creating a Title Page

A title page creates a new page at the beginning of your report with the user-defined text.

➢ To create a title page:

1 Open a report to which you want to add a title page and add a text box at the top of the Report Designer workspace. For instructions on adding a text box, see “Adding Text Objects” on page 84.

2 Select a report object below the text box, then from that report object’s property sheet, select **Page Break Before**.

3 Design the text for the title page using the options in the Text Properties sheet.

4 Select File > Print Preview to view the title page.
Inserting Page Breaks Before Report Objects

You insert a page break before a report object to move the report object to the next page.

➤ To insert a page break before a report object:
1. Open a report and select a report object above which you want to insert a page break.
2. From the report object’s property sheet, select the Page Break Before check box.

Viewing Report Summaries

A Report summary shows the name, the description, and the creator of a report. In addition, a report summary shows the modifier, date, and time the report was last modified.

Summary information is saved when you save the report. The following table describes the options you can select to be displayed in your report summary:

<table>
<thead>
<tr>
<th>Table 19</th>
<th>Report Summary Display Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the report</td>
</tr>
<tr>
<td>Description</td>
<td>The report description, which you can modify</td>
</tr>
<tr>
<td>Author</td>
<td>The user who created the report</td>
</tr>
<tr>
<td>Created On</td>
<td>The date and time the report was created</td>
</tr>
<tr>
<td>Last Modified By</td>
<td>The user who last modified the report</td>
</tr>
<tr>
<td>Last Modified On</td>
<td>The date and time the report was last modified</td>
</tr>
<tr>
<td>Object type</td>
<td>The type of object you are viewing</td>
</tr>
<tr>
<td>Location</td>
<td>The location to which this object is saved</td>
</tr>
<tr>
<td>Database Connections</td>
<td>Identifies the database connections used for this report object</td>
</tr>
</tbody>
</table>

➤ To view report summaries:
1. Open a report.
2. Select File > Summary.

Viewing Server Information

You view server information to monitor the activity on your server. Server information consists of various statistics of your report server. The following table describes the report server statistics:
## Table 20  Report Server Statistics

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reports Currently Running</td>
<td>The total number of reports currently running on the report server.</td>
</tr>
<tr>
<td>Total Requested This Session</td>
<td>The total number of reports that were requested to run since the report server was started.</td>
</tr>
<tr>
<td>Total Memory (Bytes)</td>
<td>The amount of memory used on the report server’s virtual computer.</td>
</tr>
<tr>
<td>Free Memory (Bytes)</td>
<td>The amount of remaining memory available on the report server’s virtual computer.</td>
</tr>
<tr>
<td>Note:</td>
<td>Memory is usually dynamically allocated to the virtual computer. When the memory gets too low, the system allocates more memory, which decreases the amount of free memory available on the server.</td>
</tr>
<tr>
<td>Threads - For Running Reports</td>
<td>The Java sub-process used to run reports. Threads are added automatically to handle additional requests, if needed. The default number is 10 and can be changed in the fr_repserver.properties file.</td>
</tr>
</tbody>
</table>

To view server information:

1. Open a report.
3. Click Close to close the Report Server Info dialog box.
You can customize grids by calculating data rows and columns. You can use functions to refine your report data or to add dynamic data, such as the date the report was created. You can also cut, copy, or paste rows or columns within a grid or across multiple grids.

Before you begin to customize grids, you must insert at least one grid and define its dimension layout. To customize a report, you must insert a text box or a grid in your report. For more information, see “Adding Report Objects” on page 81.
Inserting Rows or Columns in Grids

You insert rows or columns into a grid to add data to the grid. The following table describes the types of rows or columns you can insert into a grid:

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| Data  | A data row or column contains members of dimensions that are retrieved from a database connection. The member in a data row or column defaults to the top-level member of the dimension.  
   Note: A # symbol is used to indicate data rows, columns, or cells in grids. |
| Formula | A formula row or column displays values based on specified formulas. A formula row or column is commonly used to calculate totals, averages, and variances on data rows or columns. For more information on formulas, see “Defining Formula Rows or Columns” on page 128.  
   Note: An = # symbol is used to indicate formula rows, columns, or cells in grids. |
| Text | A text row or column primarily contains text typed into the cells, or added dynamically through a text function.  
   Note: Text rows, columns, or cells in grids do not contain symbols when added to a grid. They are initially blank until populated with text. |

By default, when you add a grid to a report, it contains one of each of the following components: a data row, an anchor row, a data column, and an anchor column. An anchor row or column is a blank row or column located at the end of a row or column. You can add one or more rows or columns within a grid, or you can use the anchor row and column to append new rows and columns.

**Tip:**

Use the formatting information provided in “Formatting Grids” on page 165 to format the grid you added to your report.

The grid boundary remains the same size as you add rows and columns. For information on resizing the grid, see “Resizing Report Objects” on page 94.

To insert rows or columns in grids:

1. **Select a cell or a row or column.** Then select Insert > Row/Column > Data, Formula, or Text. The new row is inserted above the selected row; the new column is inserted to the left of the selected column.

   **Tip:**
   To insert multiple rows/columns, select a number of rows or column on the grid equal to the number of rows or columns you want to insert.

2. **To append a row or column at the end of a grid,** select the grid or an anchor row or column, then perform an action:
   - For a row, select Insert > Row > Data, Formula, or Text.
For a column, select Insert > Column > Data, Formula, or Text.

3 To populate the row or column with data, formula, or text, perform an action:
   ● For a data row or column, double-click the row or column heading and select dimension members to place on the row or column. For more information, see “Assigning Members to Data Rows or Columns” on page 40.
   ● For a formula row or column, select the row or column heading and build a formula in the formula bar. For more information, see “Defining Formula Rows or Columns” on page 128.
   ● For a text row or column, enter text directly into the row or column. For more information on formatting text rows or columns, see “Formatting Text Boxes” on page 163.

Note:
To delete a row or column, select the desired row or column, then select Edit > Delete.

Cutting, Copying, and Pasting in Grids

You can copy, and paste rows and columns and formula rows and columns within the same grid or between two different grids in a report. You can only cut and paste rows and columns and formula rows and columns within the same grid.

Note:
For formula rows and columns, you must cut the entire row or column.

➤ To cut, copy, and paste rows or columns in grids:
1 Open Financial Reporting Studio.
2 Select File > New > Report to open a blank report, or select an existing report.
3 Create a grid.
4 Select a row or column and perform an action:
   ● To cut a row or column and place the information on the Windows clipboard, select Edit > Cut.
   ● To copy a row or column and place the information on the Windows clipboard, select Edit > Copy.

   Tip:
   To select multiple consecutive rows or columns, press the SHIFT key and click multiple rows or columns.
5 Click the destination row or column.
6 To paste the selection in the destination row or column, select Edit > Paste.
Columns are pasted to the left of the selected destination column. Rows are pasted above the selected destination row. Pasting inserts the column or row and does not overwrite the data in the destination row or column.

7 Select File > Save to save the report.

**Specifying Row and Column Headings for Grids**

Defining row and column headings for the grid enables you to specify the information you want displayed in the row and column headings for the entire grid. You can specify one of the following member labels for row and column headings:

- The member name, which displays the member name as the heading.
- The alias or description, which displays the alias or description as the heading.
- The member name and alias or description, which displays the member name and alias or description as the heading.

**Note:**
Whether or not you specify an alias or a description depends on your type of database connection. If you are reporting against an Essbase or Planning Details database connection, select Alias. If you are reporting against a Financial Management database connection, select Description.

When specifying row and column headings, you must define where you want row headings to be positioned in relation to the columns. For example, you might want your row headings to be positioned before column A.

**Note:**
You cannot place row headings before columns that are sorted.

You can also suppress headings for repeating members in a segment. When you suppress headings, only the first instance of the heading for a member that is repeated is displayed. Headings for the additional repeating members are hidden.

If you are using the Entity dimension through a Financial Management database connection, you can select the checkbox for Short Name for Entities for the row, column, or grid using the relevant properties sheet. This option enables you to display the short name of the entity in your report, removing the parent portion of the entity that typically displays.

The standard display for an entity using Financial Management is “parent.child.” If you select Short Name for Entities on the relevant properties sheet, the entity displays as “child,” removing the “parent” from the display. For example, an entity that typically displays as “UnitedStates.Connecticut” displays as “Connecticut” when the Short Name for Entities check box is selected.
You may also want to select the alias table you want to use. You can select alias tables in your Essbase or Planning Details database connection. Although you may not specify aliases on the grid level, if you display aliases for a row or column, the system displays the alias table as selected on the grid level.

The heading properties you specify on the grid apply to all rows and columns unless you specify otherwise. For more information on specifying row and column headings, see “Overriding Row and Column Headings for Grids” on page 103.

To define row and column headings for the grid:

1 Open a report and select the grid.

2 Select one of the following member label options:
   - Member Name, to show the member name as the heading.
   - Alias:Default, to show the alias for a member from a Essbase or Planning Details database connection OR Description, to show a description for a member from a Financial Management database connection.
   - Both, to show the member name and alias or description as the heading.

   **Note:**
   The option that is displayed on the Properties sheet changes depending on your type of database connection. For example, if you are using Financial Management as your type of database connection, the Description option is displayed. In this case, the Alias:Default option is not displayed unless you are using a Essbase or Planning Details type of database connection.

3 Select a column. The row heading is positioned to the left of the selected column. Columns are represented alphabetically as Column A, Column B, Column C, and so on.

4 Optional: Select the Short Name for Entities check box to display the short name for entities in your Financial Management grid.

5 Optional: Select the Suppress Repeats check box to hide headings for repeating members in a segment.

6 Optional: Select the alias table to use when showing aliases. By default, this option is set to the default alias table for the type of database connection.

   **Note:**
   Once in the grid, text can be aligned horizontally or vertically. For more information, see “Aligning Text in Text Boxes” on page 164.

**Overriding Row and Column Headings for Grids**

Defining row and column headings enables you to override the heading properties you set for the grid. You can specify one of the following types of headings for rows or columns:

- Member Labels
The member name, which displays the member name as the heading.

- The alias or description, which displays the alias or description as the heading.
- The member name and alias or description, which displays the member name and alias or description as the heading.

- **Custom Headings**
  - Customized text, which displays the user-defined text as the heading.
  - Text functions, which uses a text function to get data to display as the heading.

You can also suppress headings for repeating members in a segment. When you suppress headings, only the first instance of the heading for a member that is repeated is displayed. Headings for the additional repeating members are hidden.

➤ To override row and column headings for the grid:

1. **Open a report and a formula row or column in the grid.**
2. **Do one of the following tasks:**
   - Select **Member Labels** and then select one of the following member labels options:
     - **Member Name**, to display the member name as the heading.
     - **Alias:Default**, to display an alias for a member from an Essbase or Planning Details database connection OR **Description**, to display a description for a member from a Financial Management database connection.
     - **Both**, to display the member name and alias or description as the heading.

   **Note:**
   The option that is displayed on the Properties sheet changes depending on your database connection. For example, if you are using Financial Management as your database connection, the **Description** option is displayed. In this case, the **Alias:Default** option is not displayed.

   - Select **Custom Heading** and then do one or both of the following tasks:
     - Enter a user-defined text heading to be displayed as the heading.

   **Tip:**
   You can enter keyboard returns to create text headings for columns with multiple lines.

   - Enter a text function, or click the **Insert Function** button, and select the text function you want to use for displaying data on the headings.

   **Note:**
   For more information on adding a text function to a row or column heading, see “Using Text Functions to Display Information” on page 141.

3. **Optional:** Select the **Short Name for Entities** check box to display the short name for entities in your Financial Management grid.
Note:

You must select the entire row or column to display the Suppress Repeats option in the Row and Column property sheets.

About Row and Column Templates

Row and column templates enable you to select a contiguous set of rows or columns and save them as an object in the repository for reuse in one or more reports.

Working with row and column templates can involve the following tasks:

● Creating a Row and Column Template
● Inserting a Row and Column Template
● Unlinking a Row and Column Template
● Modifying a Row and Column Template

A row and column template comprises one or more row or column definitions. These row or column definitions may contain the following components:

● Database connection/dimension/member selections
● Formula rows and columns
● Expansions
● Headings, including customized formatting
● Text rows and columns, where only the text in the heading cells is saved
● Cell formatting
● Basic suppression (#Missing, #Zero, #Error)

When you create a row and column template, the following items are discarded:

● Cell formulas
● Secondary database connection specifications
● Text from the data cell area (text in the heading cells is retained)
● Conditional formatting
● Related Content
● Conditional suppression

After you create a row and column template, you can save it to the repository, with the following limitations:

● Formulas must refer to rows and columns within the selected rows or columns that comprise the template.
● Formulas outside the row and column template cannot refer to selected rows and columns that comprise or are part of a row and column template.
Note:

Cell format inheritance must be set before creating the row and column template. You can format cells using the Format Cells dialog box. For more information, see “Inheriting Cell Formatting” on page 174. When inheriting formatting within a row and column template, you must use the Inherit Formatting from option on the Row and Column Template properties sheet, which indicates the options that are available for inheritance. For example, suppression, formatting, and row height or column width.

How Inheritance Works with Row and Column Templates

When inheritance is used with linked row and column templates, certain formatting options are dynamic and vary from report to report. When a linked row or column template is used in a grid, the format inheritance is automatically reset to the first available non-template row above the row template or to the left of the column template. If you want to keep the format of a row/column template consistent, or if you are experiencing formatting inconsistencies with inheritance and row or column templates, you can perform an action:

- Insert a hidden text row/column containing the formatting you wish to show in the row/column template and set the Inherit from on the Property sheet to reference the hidden row or column.
- Do not use inheritance, but rather set the row or column template with formats through the Format Dialog Box.

Property Values

The following tables describe the property values that are saved, inherited, or discarded in a row and column template.

Table 22  Saved or Inherited Property Values (User option)

<table>
<thead>
<tr>
<th>Property Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row and Column Template database connection</td>
<td>Saved by row or column</td>
</tr>
<tr>
<td>Heading - Suppress Repeats</td>
<td>Saved by row or column</td>
</tr>
<tr>
<td>Display Line Item Details</td>
<td>Saved by row or column</td>
</tr>
<tr>
<td>Headings</td>
<td>Saved by row or column</td>
</tr>
<tr>
<td>Allow Expansions</td>
<td>Saved by row or column</td>
</tr>
<tr>
<td>Calculations</td>
<td>Saved by row or column</td>
</tr>
<tr>
<td>Hide Always</td>
<td>Saved by row or column</td>
</tr>
<tr>
<td>Positive Number Formatting</td>
<td>Saved by cell or inherited by cell - user option</td>
</tr>
<tr>
<td>Negative Number Formatting</td>
<td>Saved by cell or inherited by cell - user option</td>
</tr>
<tr>
<td>Property Value</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>Decimal Places</td>
<td>Saved by cell or inherited by cell - user option</td>
</tr>
<tr>
<td>Scale Value</td>
<td>Saved by cell or inherited by cell - user option</td>
</tr>
<tr>
<td>Top Border</td>
<td>Saved by cell or inherited by cell - user option</td>
</tr>
<tr>
<td>Right Border</td>
<td>Saved by cell or inherited by cell - user option</td>
</tr>
<tr>
<td>Bottom Border</td>
<td>Saved by cell or inherited by cell - user option</td>
</tr>
<tr>
<td>Left Border</td>
<td>Saved by cell or inherited by cell - user option</td>
</tr>
<tr>
<td>Shading</td>
<td>Saved by cell or inherited by cell - user option</td>
</tr>
<tr>
<td>Horizontal Alignment</td>
<td>Saved by cell or inherited by cell - user option</td>
</tr>
<tr>
<td>Vertical Alignment</td>
<td>Saved by cell or inherited by cell - user option</td>
</tr>
<tr>
<td>Indent</td>
<td>Saved by cell or inherited by cell - user option</td>
</tr>
<tr>
<td>Font</td>
<td>Saved by cell or inherited by cell - user option</td>
</tr>
<tr>
<td>Font Style</td>
<td>Saved by cell or inherited by cell - user option</td>
</tr>
<tr>
<td>Font Size</td>
<td>Saved by cell or inherited by cell - user option</td>
</tr>
<tr>
<td>Font Effects</td>
<td>Saved by cell or inherited by cell - user option</td>
</tr>
<tr>
<td>Replace Value</td>
<td>Saved by cell or inherited by cell - user option</td>
</tr>
<tr>
<td>Inherit Formatting From</td>
<td>Saved by cell or inherited by cell - user option</td>
</tr>
</tbody>
</table>

**Note:** If the reference is internal to the row and column template, then it is applied when the row and column template is inserted. If the reference is external, then it is discarded and the “Inherit Formatting From” setting on the row and column template properties property sheet is applied. For more information, see “About Row and Column Templates” on page 105.

<table>
<thead>
<tr>
<th>Property Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row Height/Column Width</td>
<td>Saved by row or column or inherited from another row or column and applied to all rows or columns in the row and column template - User option</td>
</tr>
<tr>
<td>Suppression</td>
<td>Saved by row or column or inherited from another row or column and applied to all rows or columns in the row and column template - User option</td>
</tr>
<tr>
<td>Page Break Before</td>
<td>Saved by row or column discarded</td>
</tr>
</tbody>
</table>

### Table 23  Discarded Property Values

<table>
<thead>
<tr>
<th>Property Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text from text cells</td>
<td>Discarded - text in the heading cells is retained</td>
</tr>
<tr>
<td>Cell Formulas</td>
<td>Discarded</td>
</tr>
</tbody>
</table>
### Creating a Row and Column Template

You create a row and column template based on rows and columns in a grid. When considering rows and columns for inclusion in a template, select those that contain the member selections, formulas, and formatting suitable for future use. The row and column template can then be imported for use in other grids.

**Note:**

When the template is updated, grids containing a link to the template are updated.

**Tip:**

The row and column template must contain at least one data row or column. For example, your template cannot consist solely of text and formula rows or columns.

➤ To create a row and column template:

1. **Open a report that contains a grid, or create a new grid with supported rows or columns.**
2. **Select a set of rows or columns to be included in the template.**

   **Note:**

   The entire row(s) or column(s) must be selected.

3. **Select File > Save Object to save the object to the repository.**

   The Save Object dialog box is displayed.

4. **In the Name text box, enter a unique name for the row and column template (for example, Sales Template).**

5. **Optional:** In the Description text box, provide a brief description. The description is displayed in the repository under Description.

6. **For the Type drop-down list box, Row and Column Template is selected by default.**
7 Optional: To save the row and column template as a linked object in the current grid, select Link to Source Object. To save the row and column template in the grid without linking it to the current grid, deselect Link to Source Object.

Note:
Link to Source Object is disabled if all rows and columns in a grid are selected for inclusion in a row and column template, as you cannot link this object in the grid. The following error message is displayed: Cannot create a linked row and column template based on the selected rows. The grid needs to have at least one data row that is not part of a row and column template.

8 Click Save to return to the grid. Do one of the following to save the row and column template object as linked:

● insert a blank data row or column into the grid, omitting it from the row and column template

● deselect one row or column from the template

Note:
A grid must contain at least one row or column that is not committed to a linked row and column template.

9 Click Save. The system validates the row and column template and checks for properties that are not supported. Depending on the content of your row and column template, you may encounter one or more of the following dialog boxes:

a. If your row and column template contains formulas with external references (for example, to cells outside of the selected row and column template), you are prompted to modify those formulas before saving the row or column template.

Note:
You can save a row and column template that contains cell formulas, as these can be discarded. For more information, see step 9.c on page 109.

b. If a secondary database connection was specified within the row and column template, a dialog box displays prompting you to continue saving the template. If you save the template, the secondary database connection you specified in the row and column template is discarded. The primary database connection is then used for the row and column template.

c. If unsupported properties are found, an Information dialog box presents a list of properties to discard before saving the template. For example, if the row and column template contains a cell formula, you can choose to save the template without the formula or not save the template.

10 Review the properties to be discarded, then perform one of the following tasks:

● Click Yes to save the template with the unsupported properties, and proceed to the next step.
Note:

If you select Yes, the grid is permanently changed. Items listed in the message box are discarded from the grid.

- Click No to prevent changes to the rows and columns (the template is not saved) and return to the grid.

11 Select the options to save, inherit, or discard settings from rows using the **Suppression, Row Height, and Page Breaks** dialog box. The following definitions apply to these selections:

- **Suppression** - you can save or inherit any application of suppression (that is, if zero, missing, or error) within the rows and columns selected.

- **Row Height** - if you selected a row for your template, you can save or inherit any application of row height, which can be changed manually or numerically from the Row Height text box on the Row Properties property sheet, within the selected rows and columns.

- **Column Width** - if you selected a column for your template, you can save or inherit any application of column width, which can be changed manually or numerically from the Column Width text box on the Column Properties property sheet, within the selected rows and columns.

- **Page Breaks** - you can save or discard page breaks specified within the rows and columns selected.

Note:

The options that display on this screen vary according to your selection in the grid.

12 Click OK.
Inserting a Row and Column Template

After saving the row and column template to the repository as an object, you can insert it into an unlimited number of compatible grids. When a row or column template is inserted into a report, formulas outside of the template are adjusted accordingly. Only formulas within a grid are updated; not external formulas, which refer to the grid with the template, from text objects or another grid.

➢ To insert a row and column template:

1. Open a report and select a row or column adjacent to which you want to insert the row and column template.

   **Note:**
   Row templates are inserted below the selected row. Column templates are inserted to the left of the selected cell.

2. Select Insert > Saved Object. The Insert Saved Object dialog box is displayed with a view of the Explore repository.

3. Select the row and column template to insert.

4. To link or unlink a row and column template to or from the repository as an object, perform an action:
   - To create a link between the report and the template in the repository, select **Link to Source Object**. You can link the row and column template to the current grid so that the grid maintains a dynamic connection to the row and column template preserved in the repository.

       **Note:**
       A template that is linked within a grid can only be modified through format inheritance. For more information, see “Inheriting Cell Formatting” on page 174.

   - To use the template in the report without maintaining a dynamic link to the source object in the Explore repository, clear **Link to Source Object**. For more information, see “Unlinking a Row and Column Template” on page 111.

5. Click **Insert**.

   **Note:**
   In a grid on a report, a row and column template is marked with yellow heading cells. Dynamic linking is displayed on the Row and Column Template Properties property sheet.

Unlinking a Row and Column Template

After inserting a row and column template into a grid, you can unlink it. This enables you to use the row and column template as a structural template rather than a dynamically connected replica of the row and column template in the repository.
When you unlink a row and column template, the rows and columns in the template are converted into standard, unlinked rows and columns.

➤ To unlink a row and column template:
1 Open a report that contains a grid with a row and column template inserted.
2 Select the row and column template to unlink.
3 On the Row and Column Template Properties property sheet, clear the Link to Source Object check box.
4 When an Information dialog box asks whether to unlink this object, click Yes.

Modifying a Row and Column Template

You can modify a row and column template using one of the following methods:

● Create a new row and column template and save it using the same name as a row and column template located in the repository. For more information, see “Creating a Row and Column Template” on page 108.

● Unlink a row and column template from a grid, then modify and save it to the repository using the same name and folder of the row and column template in the repository.

Note:
Either methods replace the original row and column template in the repository.

➤ To modify a row and column template by unlinking a row and column template:
1 Open a report and create a grid.
2 Select and unlink a row and column template from the repository, inserting the rows and columns into your grid. For more information, see “Unlinking a Row and Column Template” on page 111.

Note:
Unlinking the template from the repository dissolves the template and inserts the rows and columns that comprised the template into your grid.
3 Modify the rows and columns as needed.
4 Save the row and column template to the repository using the same name and folder as the row and column template you want to replace.
5 Click OK to confirm the replacement of the original row and column template.

Setting Data Query Optimization Options

When working with grids, you can set data query optimization options to enable you to optimize the efficiency of your specified data queries.
Because data queries extract one or more values from a multidimensional database connection, it is beneficial to speed up this process using the data query optimization settings. For example, you can specify suppression options on your servers and include or exclude the Essbase sparse command, which is used to address the low probability that data exists for every combination of dimension members. For example, a dimension is sparse when intersections of data are empty. You can also optimize certain types of Essbase and Workforce Planning Attribute dimension retrievals.

Note:

Using Workforce Planning, a dimension can have attribute associations that change across time periods or other dimensions. For example, an attribute dimension of “Status” associated with an “Employee” dimension allows for the change of employee status over time; In January, John Smith has the status of “Full Time”, in March his status changes to “Part Time”.

For reports with a sparse dimension and at least one of its associated attribute dimensions in the grid row, an option to optimize the query is added. Before the query is run, metadata queries are performed to determine the Attribute members associated with each Sparse dimension member. Because the filtering is performed before the query, when the query is executed, a smaller metadata set and combinations are used. This can result in retrieval performance improvement. Please note that the attribute dimension retrieval optimization only applies to reports with a sparse dimension with its associated attribute dimensions in the grid row.

The Attribute Query Optimization is applied only when the Essbase client and server versions are Release 7.1.2 or later and the preceding conditions are met. Also, note the following information:

- This option is displayed in Data Query Optimization if a release of Essbase prior to Release 7.1.2 is installed on the client and/or server. In this case, the Attribute Optimization does not function.
- This option also appears in Data Query Optimization if a Dense dimension and an Attribute dimension appear in the rows, without a Base (Sparse) dimension. In this case, the Attribute Optimization does not return data.
- Attribute Optimization only returns level 0 Attribute members. Parent Attribute member is not included in the query results if Attribute Optimization is enabled.

➤ To set data query optimization options:

1. Open or create a report that contains a grid.

2. Click Task > Data Query Optimization Settings. See Data Query Optimization Settings dialog box below with asymmetric columns enabled.

Note:

The options that display in the Data Query Optimization Setting dialog box, depend on your column selection and the type of database connection you are using. For example, The Asymmetric Columns Consolidation option is only displayed when two dimensions are on the
column and there are more than four data columns in the grid. The Essbase Sparse Command option is only displayed when Essbase is the database connection.

**Note:**
The ability to suppress rows can be applied to any data source (Financial Management, Planning, SAP BW, and Essbase). All other options on this dialog box apply to Essbase only.

3 To indicate the server on which you want to suppress rows, select one of the following options from the **Suppress the Rows on the** frame:
- Database Connection Server
- Report Server

4 To indicate if the Essbase sparse command is included or excluded, select one of the following options from the **Sparse Command is** frame:
- Included
- Excluded

**Note:**
The Sparse Command option is only displayed when the database connection uses Essbase as a data source.

5 To indicate the number of asymmetric columns to consolidate into a maximum number of symmetric columns add the value into the **Consolidate Asymmetric Columns into a Maximum of** option.

**Note:**
You need at least two dimensions on the column and must have more than four data columns in the grid in order for this option to display. This option is hidden for Financial Management and Planning Details grids.

6 To optimize Attribute dimension queries, select the **Optimize query when row contains attribute dimensions** option.
Note:
To display this option, your database connection must use Essbase as the data source. This option only works for reports with sparse dimensions with at least one associated attribute dimension on a grid row.

If the optimized option is selected, and the base dimension parent members are included in the query, the output shows the parent member after their children. For example, if the query contains the members [“VP R&D”, “E1237”, “E1871”], where “VP R&D” is a parent member, the output returns [“E1237”, “E1871”, “VP R&D”]. The member order of non-optimized queries does not change.

7 Optional: Click Set to Default to use the default data query optimization settings.
8 Click OK to accept the settings you indicated.
9 Optional: Click Cancel to exit and return to the grid in the Report Designer.

Enabling Expansions for Essbase

For Essbase database connections, a Essbase user can enable expansions for Hybrid Data. Hybrid Data is stored outside a Essbase cube in a relational database. This enables report viewers to include Hybrid Data in their report. For more information on setting up access to detail data within reports, see Chapter 7, “Providing for Detailed Data and Documents in Reports.”

Displaying Line Item Detail for Financial Management

For Financial Management database connections, a Financial Management user can select if they want to display line item detail for rows only on Account dimensions. A user can also select the location of the line item detail; before or after the parent member of the line item detail. To display line item detail, all dimensions must be set to a Level 0 member.

➤ To display line item detail for Financial Management:
1 Open a report and select a row in the grid.
2 In the Row Properties Sheet, select Display Line Item Details.
3 Optional: On the Grid Properties sheet, select the Position category and do one of the following in the Position of Line Item Detail box:
   ● To display line item detail before the parent member, click Before Members.
   ● To display line item detail after the parent member, click After Members. This is the default.

Showing Supporting Detail for Planning

When using the Planning Details database connection, and selecting a row, you can display supporting detail for a member. If supporting detail exists for one or more cells in the selected
To show supporting detail for the Planning Details database connection:

1. Open a report and select a row in the grid that contains a member with supporting detail.
2. In the Row Properties sheet, select Display Supporting Details.
3. Specify whether to allow page breaks with the rows of supporting detail:
   - To allow a page break within the rows of supporting detail, select the Allow Page Break Within check box.
   - To keep the parent member and the supporting detail on the same page, deselect the Allow Page Break Within check box. If the supporting detail does not fit on the current page, the parent member and supporting detail is moved to the next page.

   **Note:**
   If the supporting detail spans multiple pages, this option defaults to Allow Page Break Within and page breaks are used.

4. Optional: To position the supporting detail before or after the parent member, select the Grid Properties sheet, select the Position category and select an option in the Position of Supporting Detail box:
   - To display supporting detail before the parent member, click Before Members.
   - To display supporting detail after the parent member, click After Members. This is the default.

5. Optional: To indent each generation within the supporting detail:
   a. Select the heading cell of the member that is going to display the supporting detail.
   b. Select Format > Cells > Alignment tab.
   c. In the Indent Increases for Each Generation by box, select a positive number by which you want to indent (to the right) each generation in the supporting detail list, or select a negative number to indent in reverse (to the left) each generation in the supporting detail list.

   **Note:**
   This property applies only to heading cells on the rows. It is enabled for Planning Details type of database connection only when Display Supporting Detail is selected. For more information on formatting, see Chapter 9, “Formatting Reports.”

6. Optional: To apply additional formatting to supporting detail, use conditional formatting. The following two options are useful for supporting detail:
   - Supporting Detail. If, at runtime, supporting detail results from a cell, you can format the supporting detail.
   - Relative Generation. You can format the different generations of supporting detail independently. For example, if the resulting hierarchy of a member includes four generations
of supporting detail, you can specify the third generation to format. The conditions would resemble the following example:

**Note:**

In order for all types of database connections to use relative generation, you must have selected a member relationship that returns members on multiple levels; for example, Children of...(Inclusive), Descendants of..., Descendants of ...(Inclusive), Parents of... (Inclusive), Ancestors of, Ancestors of...(Inclusive), and AllMembers. For Planning Details, you may use relative generation with a member or dynamic member if supporting detail is turned on.

Condition 1: If
Supporting Detail Is True And
Relative Generation (of) Market = 3

**Note:**

For more information, see “About Conditional Formatting” on page 179.

### Defining the Grid Point of View

The grid point of view (POV) enables designers to specify the members for a dimension on a grid without placing the dimension on the row, column, or page intersection. After a dimension is specified on the grid POV, the designer determines the ways that the viewer can select members, as follows:

- Any member. The viewer can select any member for the dimension.
- A member from list. The viewer can select from a limited list of members that the designer previously defines.
- Nothing, Lock Member Selection. The viewer cannot select any member for the dimension.

**Note:**

To improve report performance, do not use dimensions with only one member selected (for the entire grid) into a row, column, or page axis. Although, it does not increase the potential cell count, it adds overhead to the entire query. Dimensions that are variable or set to one member should be left in the POV. For variable members, include the user POV and for fixed members, include the grid POV. The rules for each database connection for a grid are as follows: - If the dimension is on a grid axis (row, column, or page), use the member selected for that dimension. - If the dimension is set on the grid POV, use the member selected for the grid POV dimension. - Use the member selected for the user POV dimension.
Showing or Hiding the Grid POV Bar

As a report designer, you can hide or display the grid POV bar. Hiding the grid POV prohibits you from changing the grid POV when viewing a report. By default, the grid POV bar is hidden. However, even when a POV bar is hidden, its values are still operative when running the report.

➤ To show or hide a grid POV bar:
1. Open a report.
2. Select the grid for which you want to show or hide its grid POV bar.
3. Do one of the following tasks in the Grid Properties sheet:
   ● To show the grid POV, select the Grid Point of View check box.
   ● To hide the grid POV, deselect the Grid Point of View check box.

   Tip:
   As an alternative, you can also select a grid, right-click inside the grid, and select Grid Point of View.

Selecting Members for the Grid Point of View

On the grid point of view (POV) bar you can select members for dimensions that are not used in rows, columns, or the page axis. The members defined on the POV bar complete the criteria used to retrieve data for the grid. Each POV dimension can contain only one member.

Note:
For Essbase and Planning database connections, Hyperion recommends excluding dimensions with security on it in the Grid POVs since it may cause unexpected results for end users.

➤ To select a POV member for the grid POV:
1. Open a report.
2. To display the grid POVs, select Grid Point of View from the Grid Properties sheet.
3. On the grid POV, click on a dimension to display the Select Members dialog box.
4. In the Select Members dialog box, each dimension is displayed on a separate tab. Select the dimension listed on the tab, then select an associated member. Repeat for all dimensions on the tabs.
5. Click OK. The members are displayed on the grid POV.

Setting Up a Grid Point of View

A designer can set up a grid point of view (POV), to control or limit the selection of members available to end users who view or print the report.
For more information, see Chapter 2, “Selecting Members for Report Designers.”

➤ To set up a grid POV:

1. Open a report with members selected for dimensions on the grid POV.
2. Right-click a grid and select Grid Point of View Setup.
3. For each dimension presented in the dialog box, you can specify the availability of member selection to the end user:
   - **Any Member** - All members are available.
   - **A Member from List** - Only the members you specify are available. Click in the Choices List column. The Select Members dialog box is displayed.
   - **Nothing, Lock Member Selection for a specific dimension** - No members are available.
4. When the Report Viewers May Select column is set to A Member from List, Select a member from the Select Members dialog box, then click OK. For more information on selecting members, see Chapter 2, “Selecting Members for Report Designers.”
5. Select the Show Dimension Name and Show Member Name check box to display the dimension name with the member name.
6. Select the Show Alias check box to display alias names.
7. Click OK.

### Inserting Page Breaks

You can insert a page break before a row or column in a grid from the Row Properties and Column Properties sheets. This enables you to break your report data at a specified location within a grid while keeping required line items together.

Page Breaks are indicated with a heavy, dashed line. The following figure shows a page break before row 2. Page breaks are inserted above the selected row and to the left of the selected column.

![Grid with Page Break](image)

To insert a page break:

1. Open a report, then select a grid.
2 Select or highlight the row or column in which you want to insert a page break.

Note:
You cannot insert a page break before the first column in a report or above the first row in a report.

3 In Row or Column Properties sheet, select the Page Break Before option.

Note:
If Fit Length to Page is selected in Page Setup, you cannot apply page breaks to rows. If Fit Width to Page is selected in Page Setup, you cannot apply page breaks to columns. For more information on Page Setup, see Chapter 14, “Working with Books and Snapshot Books.”

4 Perform an action:
- Select Position at Top when selecting a row if you want the remaining part of your grid to be placed at the top of the new page or select Position at Left when selecting a column if you want the remaining part of your grid to be placed at the left margin of the new page.
- Select Same Position if you want the grid to be placed in the same position as it is currently placed. For example, if a grid is placed half way down the page and you insert a page break with Same Position selected, the remaining part of the grid is displayed half way down on the second page.

Defining Page Axis Headings

A page axis heading prints the member name every time the page member changes. Members on the page axis can have their own custom heading.

For more information on printing the page dimension heading, see “Printing Page Dimension Headings” on page 161.

You specify how to print the page dimension heading using the following options:

<table>
<thead>
<tr>
<th>Table 24</th>
<th>Options for Page Dimension Headings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>New page, Position at Top</td>
<td>Prints a new page at the top of the next page. Use this option when chart is linked to a grid and you want to ensure the chart and grid print next to one another whenever the page member changes.</td>
</tr>
</tbody>
</table>
| New page, Position Same | Prints a page at the specified grid location. Use this option in the following situations:  
  - The grid has horizontal and/or vertical alignment properties set and you want the grid to print in the same position on each page. For example, if you set the Grid position to Center/Middle, it is printed in the center of each page.  
  - When a chart is linked to a grid and you want to ensure the chart and grid print next to one another whenever the page member changes. |
| Same Page | Prints the new page immediately after the data from the previous page. |
To define a page dimension heading:

1. Open a report and select the Pages list box on the grid.
2. On the Page Properties sheet, in the Headings area, select a dimension.
3. Do one of the following tasks:
   - Select Member Labels and then select one of the following member labels options:
     - Member Name, to display the member name as the heading.
     - Alias:Default, to display an alias for a member from an Essbase or Planning Details database connection OR Description, to display a description for a member from a Financial Management database connection.
     - Both, to display the member name and alias or description as the heading.

   **Note:**
   The option that is displayed on the Properties sheet changes depending on your database connection. For example, if you are using Financial Management as your database connection, the Description option is displayed. In this case, the Alias:Default option is not displayed.

   - Select Custom Heading and then do one or both of the following tasks:
     - Enter a user-defined text heading to be displayed as the heading.

     **Tip:**
     You can enter keyboard returns to create text headings for columns with multiple lines.

     - Enter a text function, or click the Insert Function button, and specify a text function to use a text function to get data to be displayed on the headings.

   **Note:**
   For more information on adding a text function to a row or column heading, see “Using Text Functions to Display Information” on page 141.

4. Optional: To set formatting options, click the Format button.

5. Specify a height for the header.

6. In the Page Printing Positioning Option area, select one of the following options:
   - New Page - Top
   - New Page - Same
   - Same Page
Changing the Database Connection of Grids

Database connections of grids is done in Workspace. When you change the database connection of a grid, you display data from another source. Because the dimension names for the new database may differ from the default database, the administrator needs to prepare a mapping schema to maintain the integrity of the data structure. If the structure of the specified database connection differs from that of the current database connection, the report cannot repopulate. For information, see “Changing Financial Reporting Database Connections” in Hyperion Workspace Guide.

Assigning Multiple Database Connection to Grids

You can populate a grid with data from multiple database connections. After you define a grid's initial database connection and dimension layout, you can change the database connection for one or more rows or columns of the grid. You can define another database connection for each data row or data column.

You can preserve the members selected in the grid when changing database connections on a grid row or column. You must map all dimensions that are assigned to rows or columns in a grid from the current database connection to the new database connection. Dimensions on the point of view (POV) need not to be mapped.

➤ To assign multiple database connections to a grid:

1. Open a report.
2. In a grid, select one or more data rows or columns for which you want to change the database connection.
3. In the Row or Column Properties sheet, click the Select Database Connection button.
4. In the Select a Database Connection dialog box, select a database connection from the Database Connection drop-down list, then Click OK.

Note:

If you want to create another database connection, select the New Database Connection button. For information on adding another database connection, see Chapter 11, “Managing the Explore Repository.”

5. In the Map Dimensions Between... dialog box, map dimensions between the default database connection and the selected database connection. You do this by selecting a dimension from the pull-down list in the right column for each dimension in the left column.
6. Optional: Select an alias table for the new database connection.
7. Click OK.
Adding Auto Calculations to Data Rows and Columns

You can append auto calculations to the data rows and columns of your grids. For example, you might want to calculate the total of rows or columns that expand and contain multiple dimensions.

When you define an auto calculation for a data row or column, a row or column is inserted at runtime that contains the calculated value. This calculation goes against all members in a row or column and is displayed when you print or preview the report.

You can apply several formatting options. For each auto calculation, you can specify a heading for the calculated row or column and a group heading. You can specify the location of the calculation row or column in relation to the member, and you can insert blank rows before and after calculation rows and group headings. You can also specify page breaks within rows of calculation and after a calculation row.

You can apply several of the formatting options provided with auto calculation but exclude the auto calculation function for a specified cell, row, or column.

You can define different types of calculation for each dimension or member in the row or column using one of the following functions:

- **Average**—The average value of values in the segment in this dimension at runtime (ignores non-number values)
- **Average All**—The average value of values in the segment in this dimension at runtime (assigns 0 to non-number values)
- **Count**—The number of values in the segment in this dimension at runtime (ignores non-number values)
- **Count All**—The number of values in the segment in this dimension at runtime (assigns 0 to non-number values)
- **Maximum**—The largest value of the values in the segment in this dimension at runtime
- **Minimum**—The smallest value of the values in the segment in this dimension at runtime
- **Product**—This function multiplies all numbers or references in the segment in the dimension and returns the product at runtime
- **Total**—The sum of the values in the segment in this dimension at runtime

You can use the formatting options without having calculation done. This enables you to retain the member grouping without calculations such as totals.

- **No Calculation**—Calculation is not performed on the selected cell, row, or column. However, formatting provided with auto calculation is retained. You can apply No Calculation to an auto calculation row, column, or cell or non-calculation row, column, or cell.

**Note:**

If errors or missing data exist for members, the previous operations include the member value in the subtotal, but the member value is treated as a zero value.
The following figure is an example of a grid where auto calculation is applied. In the grid, the columns Sales and Qtr1, Qtr2 and the rows Scenario and Product are hidden to achieve the desired presentation in the report:

<table>
<thead>
<tr>
<th>Grid1</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Sales</td>
<td>Qtr1, Qtr2</td>
</tr>
</tbody>
</table>

➤ To add auto calculations to data rows or columns:

1. Open a report.
2. Select the heading cell of a row or column that contains multiple members.
3. In the Heading Row or Column Properties sheet, select Auto Calculation, then click Setup. The Insert an Auto Calculation Row / Column dialog box is displayed.

The following two figures illustrate the settings for the example report.

4. In the Calculation area, select a function for the type of calculation you want to perform. Select No Calculation to only include auto calculation formatting.
5. Optional: To add headings to the calculation or group rows or columns, take any of the following actions in the Headings area.
● Select the Group Heading check box, then enter a custom heading to describe the row or column. To insert formulas in the headings, click the Functions button. For more information, see “Using Text Functions to Display Information” on page 141.

**Note:**
When using the MemberName function, you must enter “current” for the row/column/page parameters.

**Note:**
The header is suppressed if the surrounding data is suppressed.

**Tip:**
You can suppress repeats on multiline headers by selecting the Grid Properties sheet, General category, and selecting the Suppress Repeats check box.

● In the Auto Calculation Heading text box, enter a custom heading for the calculation row or column. To insert formulas in the headings, click the Functions button. For more information, see “Using Text Functions to Display Information” on page 141.

6 **Optional:** To insert blank rows or columns before or after calculation rows or columns and group headings, select any check boxes in the Insert Blank Row/Column area.

7 To change the height or width of the inserted row or column, enter the unit in the Row Height or Column Width text box.

**Tip:**
You can specify whether to insert the auto calculation row or column before or after the expanded members of the row or column. Do this by displaying the Grid Properties sheet, then select the Position category.

8 Select Allow Page Breaks Within to allow a page break within the rows of auto calculation. When deselected, the heading cell and the row are kept together. If the row is too long to fit on a page, the heading cell and the row is moved to the next page. If the auto calculation row is longer than one page, the option defaults to Allow Page Break Within.

9 Select Allow Page Breaks After Auto Calculation to allow a page break after the calculation row.

10 Click OK.

11 To view the report, select File > Print Preview. The example report resembles Figure 14.

**Note:**
See Figure 15 to view the same report with applied conditional formatting.
Applying Formatting to Auto Calculated Data Rows and Columns

You can use the conditional formatting feature to apply additional formatting to the auto calculation rows and columns, such as underline, bold, and indent. The conditional formatting feature contains two conditions specifically designed for auto calculation:

- **Auto Calculation**—Used to apply formatting to the auto calculated cells and auto calculation heading.
- **Auto Calculation Group Heading**—Used to apply formatting to the section headings.

For more information on conditional formatting, see “Applying Conditional Formatting on Grids” on page 182.

Figure 15, displayed below, is an example report that uses conditional formatting to specify font, alignment, and border and shading settings. The following conditions were applied to the example report by selecting the East, West Heading Cell and Calculated Data Cell:

- **Format 1**: IF (Auto Calculation Year is True, then Format Cells (double border top, Font = Ariel, Bold, Font size = 12)
- **Format 2**: IF (Auto Calculation Market is True, then Format Cells (single border top)
- **Format 3**: IF (Auto Calculation Group Heading Market is True, then Format Cells (Alignment = center, Font Style = italic)
- **Format 4**: IF (Auto Calculation Group Heading Year is True, then Format Cells (Bold, Font size = 12, Color = blue)
To apply formatting to calculated data rows and columns:

1. Open a report.
2. Select a cell or group of cells that is set up with auto calculation.
4. Select Auto Calculation or Auto Calculation Group Heading from the Property drop-down list located below Condition 1: If, then enter the conditions.
5. Click the Format Cells button to apply formatting to the calculated cell.
6. Click OK to accept the formatting than you specified for the calculated cell. For more information on formatting, see “Formatting Grids” on page 165.
Defining Formula Rows or Columns

A formula consists of a combination of grid references, mathematical functions, and arithmetic operators. A grid reference uses values from the current grid or another grid in a calculation. You can define arithmetic formulas on formula rows, columns, cells, or a range of formula cells in a grid. For example, you might want to build a formula that adds one or more rows. Or, you might want to multiply two rows, add a third row, then display the result. For a list of mathematical functions you can use in formulas, see “Mathematical Functions” on page 202.

Note:
By default, cells that contain missing data (#MISSING) are not treated as zero (0) in formulas, unless specified differently using the IfNonNumber property. In the case of a formula that uses division, an ERROR is returned.

Note:
When using the Financial Management database connection, the results varies, based on the settings of the MissingValuesAreZeroInFormulasInHFM option in the fr_repserver.properties file. If the property is set to one (1), the #Missing value is treated as a zero. However, if the property is set to zero (0), the #Missing value is treated as missing which results in #missing or #error values. The default setting is one (1).

To specify mathematical properties, you can use dot notation. Dot notation is a syntax that specifies properties for a grid or another property. You specify a property using a period (.) followed by the property name.

The following syntax describes how to define formula rows or columns:

```
gridname.row\column[x].property
```

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>gridname</td>
<td>The name of the grid. Grid names cannot include spaces. For more information on grid references, see “Mathematical Functions” on page 202.</td>
</tr>
<tr>
<td>x</td>
<td>The row or column, number, and property.</td>
</tr>
</tbody>
</table>

For example, `mygrid1.row[3].sum` adds all elements in row 3 of `mygrid1`.

Note:
When specifying the full gridname notation, you must also indicate the row, column, or cell.
The following example returns the sum of the \( n \)th column:

\[ mygrid2.column[C].sum \]

You can omit references to the current grid, row, column, or cell. The following example returns the absolute value of the cell located at the intersection of row 5 and column B in the current grid:

\[ \text{ABS}([5,B]) \]

To define formula rows or columns:

1. Open a report.
2. Select a row or column in a grid.
3. Select Insert > Row > Formula or Insert > Column > Formula.
4. Select the formula row or column, or a range of formula cells.
5. In the drop-down menu from the formula bar, select a function. For a list of mathematical functions, see “Mathematical Functions” on page 202.
6. Insert your cursor in the formula text box and enter the rest of the formula.
7. Repeat steps 4 through 6 as necessary to build your formula.
8. Select File > Print Preview to see the results of your formula.

### Defining Headings for Formula Rows and Columns

You can define a heading for a row or column. By default, the formula is shown as the heading for the row or column. You may also create a custom heading for the row or column.

To define headings for formula rows and columns, select the heading cell, then do one of the following from the Headings area of the Row or Column Properties sheet:

- Select the Show Formula option. This is the default.
- Click the Custom Headings button. Enter text in the Custom Heading text box area.

**Note:**

You can also insert a text function in your custom heading.

### Expanding Rows or Columns

In the designer, you can use the design-time row, column, and cell to reference the calculated rows, columns, or cells.

The syntax for row or column is:

\[ \text{AXIS}[\text{Segment (Range)}].\text{Property} \]

The syntax for a cell is:
<table>
<thead>
<tr>
<th>Reference</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>AXIS</strong></td>
<td>A row or column containing the expanded cells identified by the given row and column templates. The default is row. For example, [3] refers to row 3 and [C] refers to column C. The following reference: [3].sum in a column formula is calculated as the sum of row 3. Optional.</td>
</tr>
<tr>
<td><strong>CELL</strong></td>
<td>The intersection of the expanded cells, given the row and column template coordinates, respectively. For example, the following reference: [2,C] is the single cell where row 2 intersects column C. Optional.</td>
</tr>
<tr>
<td><strong>Segment</strong></td>
<td>A value that represents a row or column ID in the designer. Referenced segments refer to design-time rows or columns, which might expand in the viewer. View-time rows and columns are the expanded rows and columns. Use numbers for row IDs and letters for column IDs. <strong>Note:</strong> If you are using an expanded formula row, the default segment is row. If you are using an expanded formula column, the default segment is column. For example, row [ 5 ] refers to expanded row 5. For more information on using segments, see “Expressing the Segment Argument” on page 130. Optional.</td>
</tr>
<tr>
<td><strong>Range</strong></td>
<td>The expanded cells used in the calculation of the function. Range refers to view-time expanded rows and columns. Calculations are performed after suppression. Sorting is performed after calculations. For more information on sorting and suppression, see “Conditional Suppression” on page 189 and “Sorting Rows, Columns, and Pages” on page 177. Use colons to refer to a range of expanded rows or columns. For example, (3:6) addresses rows 3, 4, 5, and 6. For more information on using ranges, see “Expressing the Range Argument” on page 132. Optional.</td>
</tr>
<tr>
<td><strong>Property</strong></td>
<td>A function applied to aggregate rows, columns, or cells. For more information on using properties, see “Property Arguments” on page 205. Optional.</td>
</tr>
</tbody>
</table>

**Expressing the Segment Argument**

The Segment argument is a value that represents a row or column ID in the designer. Referenced segments refer to design-time rows or columns, which might expand in the viewer. View-time rows and columns are the expanded rows and columns. You can use numbers for row IDs and letters for column IDs. You can refer to one or more segments in any standard formula. The following table explains the types of notation used for multiple segments in standard formulas.

### Table 25 Segment Notation

<table>
<thead>
<tr>
<th>Type</th>
<th>Notation</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single segment</td>
<td>[ ]</td>
<td>Single (design-time) segment</td>
<td>This expression points to segment 2: row[2]</td>
</tr>
<tr>
<td>Note: Previous releases support this notation.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Nonconsecutive segment</td>
<td>[:]</td>
<td>Refers to multiple single rows or column segments.</td>
<td>This expression points to segment rows 2, 5, 7, 8 and 10:</td>
</tr>
<tr>
<td>Type</td>
<td>Notation</td>
<td>Description</td>
<td>Example</td>
</tr>
<tr>
<td>---------------------------</td>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>Segment Range</td>
<td>[:]</td>
<td>Refers to a range of rows or column segments.</td>
<td>This expression points to segment rows 2, 3, 4 and 5: row[2:5]</td>
</tr>
</tbody>
</table>

Note: Use a semi-colon rather than a comma to delineate row or column references.

You can use any combination of the above.

**Example:**

The following example points to segment rows 1, 3, 5, 6, 7, 8, 9, 10, 12, 13, 14, 15 and 17:

\[
\text{row[1; 3; 5:10; 12:15; 17]}
\]

**Example:**

If the following expression references row segment 20, but the grid contains only 15 row segments, the formula works only on segment 4:

\[
\text{row[4; 20]}
\]

If you enter a larger starting segment than ending segment, the system internally switches them around.

**Example:**

The following example shows how the segments are internally switched:

\[
\text{row[6:3] becomes row[3:6]}
\]

Multiple references to the same segments are valid. This causes the same segments to be included twice in an expression.

**Example:**

The following example sums row 5 twice:

\[
\text{row[2;3;5;7;5].sum}
\]

**Example:**

The following example references row segments 2, 3, 4, 5, 6, 7, and segment 5 again. It includes segment 5 twice in the calculation of the average:

\[
\text{row[2;7;5].avg}
\]

Text segments are ignored.

**Example:**

The following example ignores row segment 3 if it is a text row:

\[
\text{row[1:5]}
\]
Expressing the Range Argument

The Range argument refers to view-time expanded rows and columns, on which calculations are performed after suppression. Sorting is performed after calculation is completed. The following table explains the expanded range notation:

<table>
<thead>
<tr>
<th>Type</th>
<th>Notation</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td>The Range argument is optional.</td>
<td>This row expression points to all expanded rows in row segment 2.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>row[2]</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Note:</strong> This ensures compatibility with earlier releases.</td>
</tr>
<tr>
<td>Single Range</td>
<td>[segment (range)]</td>
<td>Refers to the single expanded row or column.</td>
<td>This expression points to expanded row 5 in segment 2:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>row[2(5)]</td>
</tr>
<tr>
<td>Consecutive Range Reference</td>
<td>[:]</td>
<td>Refers to a range of expanded rows or columns.</td>
<td>This expression points to expanded rows 5, 6, 7, 8, 9, 10 in row segment 2:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>row[2(5:10)]</td>
</tr>
<tr>
<td>Nonconsecutive Range references</td>
<td>[,]</td>
<td>Refers to multiple single expanded rows or columns.</td>
<td>The following example points to expanded rows 5, 7, 8 and 10 in row segment 2:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>row[2(5,7,8,10)]</td>
</tr>
</tbody>
</table>

If a range is used, you can use any combination of the above range notations.

**Example:**

The following example points to expanded rows 5 through 10 in design-time row 2:

row[2(5:10)]

**Note:**

If row segment 2 expands to 15 rows, the function operates on only expanded rows 5 through 10.

**Example:**

The following example identifies columns C through E in design-time column A:

column[A(C:E)]

**Example:**

The following example points to expanded rows 1, 3, 5, 6, 7, 8, 9, 10, 12, 13, 14, 15 and 17 in design-time row 2:

row[2(1,3, 5:10, 12:15, 17)]
Note:
When the grid contains suppression properties, expanded rows and columns may be suppressed. For information on suppressing data, see “Conditional Suppression” on page 189.

If the Range argument refers to a number of expanded rows that is greater than the maximum number of rows expanded in the segment, the extra rows are ignored.

Example:
In the following example, expanded rows 6 through 10 are identified, but segment 1 contains only 3 expanded rows. In this situation, the function works only on expanded rows 6 through 8:

\[
\text{row}[1(6:10)]
\]

If none of the expanded rows in the Range exist, the entire axis reference is ignored.

Example:
The following example ignores the reference to 23 if segment 3 only contains 10 expanded rows:

\[
\text{row}[3(23)]
\]

Example:
If you enter a larger starting range than ending range, the system internally switches them around.

Example:
The following example shows how the range is reversed:

\[
\text{row}[1(7:5)] \text{ becomes } \text{row}[1(5:7)]
\]

Multiple references to the same expanded rows or columns are valid. However, this may cause the same rows or columns to be included twice in an expression.

Example:
The following example sums expanded row 5 twice:

\[
\text{row}[2(3,5,7,5)].\text{sum}
\]

Example:
The following example specifies expanded rows 3, 4, 5, 6, 7, and row 5. It includes row 5 twice in the calculation of the average:

\[
\text{row}[2(3:7,5)].\text{ave}
\]

Identifying Multiple Segments with Ranges
The syntax for a range in a segment range is:

\[
\text{AXIS[Segment Start : Segment End (Range Start : Range End)]}
\]

where Segment Start and Segment End refers to multiple segments.
Example:
The following example points to expanded rows 5, 6, and 7 in row segments 1, 2, 3, and 4:
\texttt{row[1:4(5:7)]}

Example:
The following example points to expanded rows 5, 7, and 9 in row segments 1, 2, 3, and 4:
\texttt{row[1:4(5,7,9)]}

If the segment argument refers to segments that do not exist in the axis, the segments are ignored. This includes suppressed rows or columns.

Example:
The following example points to expanded rows 4, 6, 7, 8, 9, and 10 in row segment 1 and 4, 5, and 6 in row segment 3 and all expanded rows in row segment 7:
\texttt{row[1(4, 6:10); 3(4:6); 7]}

### Multiple Calculation Iterations

You can specify the maximum number of calculation iterations for all grids and cells in the \texttt{fr_repserver.properties} file to resolve dependencies within references in formulas. During the calculation process of a grid, it may be necessary to evaluate a cell multiple times due to reference precedence. This usually occurs in grids with references to other grids. The maximum iteration property indicates the number of times a formula cell can be evaluated before it is marked as unresolved. Setting the maximum iteration property avoids the possibility of cells, with circular referencing, being evaluated an infinite amount of times. Circular referencing occurs when one cell refers to another cell, which then refers to the original cell.

If there are no circular references and calculation cells are returning #Error, you can increase the maximum iteration property value. For more information, see \textit{Hyperion Workspace Administrator’s Guide}.

### Using the Formula Bar

The formula bar provides a central location for the administration of formulas and selection of members when setting up grids in Financial Reporting.

\textbf{Note:}

You can type selected functions to pick members dynamically. See Table 13 on page 45 for a list of functions that can be used in the Formula Bar and Table 14 on page 47 for a list of functions that cannot be used in the Formula Bar.

The formula bar contains a text box for the entry of formulas and a drop-down list box of functions to choose from when building formulas. If you select a member in a grid, member selection is activated on the formula bar.
The formula bar is displayed below the toolbar so you can easily access its functionality. It is visible but disabled when you are not using grids.

The Financial Reporting formula bar is similar in functionality and appearance to the formula bar in Excel. You can use the formula bar to perform the following tasks on grids:

- Define, edit, and delete a formula in a cell, column, or row
- Modify member selection for a column or row

**Example Report with Formulas**

You can use the formula bar to create formulas that total data, average data, or perform other functions of your choosing. When creating formulas for rows that summarize data for the year, for example, you use the formula bar to select the functions and dimensions that return your result. The following example illustrates this information:

- Monthly total figures for the Product dimension
- A total for all months, calculated using the Sum function
- An average amount per month, calculated using the Avg function

**Note:**

Use custom headings to create titles for the Total and Average columns. This is described in Chapter 4, “Building Reports.”

To create this example, you would create a grid in the designer with Product on the rows and Year on the columns. Double-click Year to bring up member selection. Place all twelve months in the selected pane and remove Year. Click OK.

After you select the members, insert two formula columns: one for the annual total and another for the average monthly amount.
In our example, the first formula column that falls outside the months of the Year member contains a Sum function. This function adds the figures for each month. Since all months are defined in one cell only, the reference is to that cell location. The formula is built in the formula bar:

\[
\text{Sum(} \text{Cell} \ [A,1])
\]

The second formula column calculates the average of the months for the Year member. Because there are 12 months in a year, the Avg function adds all monthly totals and divides the total by 12. The formula is:

\[
\text{Average(} \text{Cell} \ [A,1])
\]

In general, there are two ways to specify a data formula in a grid, a row/column formula, or a cell formula:

- **Row/Column** - apply one formula to the entire row or column, relative to each cell in that row or column. You define a formula by clicking on the formula row or column header to highlight the entire row or column, then entering the formula in the formula bar. There are some performance benefits when applying row/column formulas.

- **Cell** - apply a formula only to cells in a formula row or column. You define a formula by clicking on the cell, selecting Use a Custom Formula from the properties sheet, and entering the formula in the formula bar. Also, if the cell intersects a formula row and formula column, you can select to use the row formula or the column formula as the cell formula. For more information, see “Calculating at the Cell Level” on page 140.

Therefore, if a formula repeats for each cell in a row or column, use a row/column formula. If different formulas are performed on each cell, use a cell formula.

➤ To access the formula bar:

1. Open or create a report.
2. Select a dimension heading or formula row/column in the grid to enable the formula bar.

Creating Formulas Using the Formula Bar

When you select a cell, column, or row containing a formula specification, you can apply a unique formula to that cell.

For example, the custom formula depicted above adds the value of the cell located at A,2 to the value of the cell located at B,2.

Tip:

See the following list to optimize formulas:
● Use row/column formulas as opposed to cell formulas whenever possible.
● Use reference properties instead of functions when possible. Rows, columns, or cell references can have a property associated with it. For example, the row reference: \([1:5].sum\) produces the same result as using the Sum function; \(\text{Sum}(1:5)\). However, the first formula executes faster since it is being used as a reference property.
● Avoid using cross-axis references and consider using a cell reference if possible.
● Use parentheses only when necessary. Improper use of parentheses can result in unnecessary evaluation iterations within the evaluation routine of the calculation engine.

➤ To create a formula using the formula bar:

1 Open or create a report.
2 Insert a grid.
3 Insert a formula row or column and select the formula cell. Alternatively, you can apply a formula to the entire column or row by selecting it.

Note:
When you use a cell formula within a row or column formula, the cell formula should reference the cells exactly (intersection) and not the row/column only.

4 Create a formula for the cell using one of the following methods:
   ● Type the formula directly into the formula bar.
   ● Use the drop-down menu on the formula bar, shown below, to select the function to be used in the formula. For guidance on creating formulas, see "Defining Formula Rows or Columns" on page 128. For a description of available mathematical functions, see “Mathematical Functions” on page 202.

Tip:
When using the formula bar, you can access Function help by clicking the Help button.

5 Validate the formula using the checkmark, on the formula bar.
**Editing Formulas Using the Formula Bar**

You can use the formula bar to modify a formula within a cell in a grid. The ability to edit a formula with ease is essential, as formula syntax is likely to change for reporting purposes.

➤ To edit a formula using the formula bar:

1. Open a report that contains a grid.
2. Select a formula cell, formula row, or formula column that contains or uses a formula. The associated formula is displayed in the formula bar.
3. Modify the formula in the formula bar. You can use the drop-down list of functions, to select a formula.
4. Validate the formula by clicking the checkmark, ✓, in the formula bar.
   
   The validated formula is displayed in the formula bar.

**Deleting Formulas**

You can delete a formula from a grid if you no longer want to use the formula in the grid. You use the formula bar to delete the formula from a cell, formula row, or formula column.

➤ To delete a formula:

1. Select the cell and highlight the formula in the formula bar.
2. Click the Delete button, ✗.
3. Verify the deletion of the formula by performing the following steps:
   
   a. Click the checkmark, ✓, in the formula bar.
   
   b. Click another cell within the grid to reset the formula bar.
   
   c. To verify deletion of the formula, click the cell from which you deleted the formula.

**Modifying Member Selection Using the Formula Bar**

When working with members in a grid, you can use the formula bar to modify the selected members.

The following example shows a textual modification of member selection using the formula bar.

**Note:**

The entry of member names in the Formula Bar is not case-sensitive.

First, you select the heading cell in the grid. The dimension is displayed in the button on the Formula Bar. Next, you can use the Formula Bar to dynamically enter the member function for the selected dimension.
To modify member selection using the formula bar:

1. Open or create a report.
2. Select a heading cell of a data row or column in the grid.
3. On the formula bar, click the dimension button, then use the Select Members dialog box to select or remove members.

The new members are displayed in the grid. For information on using member selections, see Chapter 2, “Selecting Members for Report Designers.”

Note:

When you select a member in the grid, the dimension button on the formula bar is activated. You must indicate a member that exists within the current dimension.

- Modify the member name(s) in the text box on the formula bar.
- Dynamically enter a member function for a dimension using the formula bar. For member function syntax, see Table 13 on page 45.

Note:

You cannot combine the use of numerical functions with member functions; that is, \( \text{Sum} (\text{Children of (Product) (Inclusive)}) \)

4. Click \( \checkmark \) to accept the member entry.

The grid is set to obtain data for the new member/member function.

## Accessing Property Sheet Features

When you select a report component, a corresponding property sheet is displayed on the right side of the design area. When you select another component, the category and the property sheet features change. For example, when you select a cell, the Cell Properties sheet is displayed. You can use the property sheet to make modifications to the selected component.

In general, the property sheet enables you to set various options for the currently selected report component. For more information, see Chapter 1, “Getting Started with Financial Reporting.”
Calculating at the Cell Level

A cell in a formula row or column can contain a formula. You can create a custom cell-level formula on cells in a formula row or column. When you select a formula cell, the Cell Properties sheet allows you to choose a calculation preferences:

- If the cell is an intersection of a formula row and formula column, you can choose whether calculation is based on the row formula, the column formula, or a new custom formula.
- If a cell is located in a formula row, you can choose whether calculation is based on a row formula or a new custom formula.
- If a cell is located in a formula column, you can choose whether calculation is based on a column formula or a new custom formula.

The following table shows an example of a cell that is calculated to display the % variance. Cell D4 displays the % variance between the sum of Jan and the sum of Feb, specifically, \( \frac{(356-350)}{350} \times 100 = 1.71\% \). A cell level formula gives the intended result by placing a custom formula in the cell D4. The formula needed to get the correct result is \( \left( \frac{[B]-[A]}{[A]} \right) \times 100 \).

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Total Corp</td>
<td>Jan</td>
<td>Feb</td>
<td>Var</td>
</tr>
<tr>
<td>1</td>
<td>Cola</td>
<td>100</td>
<td>105</td>
<td>5</td>
</tr>
<tr>
<td>2</td>
<td>Root Beer</td>
<td>200</td>
<td>203</td>
<td>3</td>
</tr>
<tr>
<td>3</td>
<td>Grape</td>
<td>50</td>
<td>48</td>
<td>(2)</td>
</tr>
<tr>
<td>4</td>
<td>[1].sum</td>
<td>350</td>
<td>356</td>
<td>6</td>
</tr>
</tbody>
</table>

To calculate at the cell level:

1. Open a report.
2. Select a formula cell or cells in which you want to enter a formula.
3. In the Calculation order area of the Cell Properties sheet, select one of the following options:
   - Select Use the row formula if you want the row calculation applied to the cells.
   - Select Use the column formula if you want the column calculation applied to the cells.
   - Select Use a custom formula if you want to add a new formula, then perform the following actions:
     a. Go to the formula bar and select a function from the function drop-down menu.
     b. With your cursor in the formula text box, complete the formula.
     c. Select File > Print Preview to see the results of your formula.
Note:
You can select multiple contiguous formula cells in a formula row or column to change the calculation order.

Using Text Functions to Display Information

You use text functions to display report information. You can display information about a report, such as its description, information about a database that is associated with a grid, and a piece of data from your database connection.

You can use text functions in text boxes, data rows or columns, formula rows or columns, or Pages headings. Enclose the formula in double angle brackets (<<) and (>>) to distinguish different text functions. The font for the text function can be formatted like regular text. The text functions and their syntax are defined in “Text Functions” on page 208.

Note:
You must format the entire text function, including the angle brackets, with the same font properties in the text box.

➤ To use text functions to display information:

1. Open a report, then select one of the following items:
   ● Select a text box.
   ● Select a heading cell, then Custom Heading from the property sheet.
   ● Select the Pages drop-down list in a grid, then Custom Heading from the property sheet.

2. Click the Insert Function button. The Insert Function dialog box is displayed.

3. To select the desired function, perform an action:
   ● Double-click the function in the Available Functions list to add it to the Selected Function list.
   ● Select a function from the Available Functions list and click the Add button, to add it to the Selected Function list.

4. In the Select Function area, make your changes to the function’s parameters, then click OK.

Note:
A report designer has the option to enable or disable error messages for text functions that are displayed in the grid or text object. The default is to display error messages. To disable this feature, from the Grid Properties sheet or the Text Properties sheet, deselect the Show Text Function Errors option.

5. Select File > Print Preview to run the report and display the data produced by the function.
Freezing Row and Column Headings

You can select a grid for which you want the row and column heading labels to display when scrolling an HTML report in Workspace.

To freeze the row and column headings of a grid:

1. Select the grid for which you want to freeze the row and column headings.
3. To unlock rows and columns, select the grid and clear Freeze Row & Column Headers.

Note:

If you want to view the report within the entire Workspace area, you must expand the grid size in Financial Reporting Studio.
Defining the User POV

Every data value in a report is derived from the intersection of a member from each dimension in an Essbase, Planning Detail, or Financial Management database connection. Financial Reporting enables a designer to place these dimensions on the report grid or user point of view (POV). Report viewers can change the member selected for dimensions on the user POV. This enables report viewers to customize the reports to fit their needs. The user POV can also be used in books. For more information on selecting the user POV as a member in the book POV, see Chapter 14, “Working with Books and Snapshot Books.”

In a report, the member specified for a dimension in the user POV is used for all grids with that dimension on the user POV. For example, if you select the Budget member for the Scenario dimension, all grids in the report with scenario in the user POV use Budget when you retrieve data. The user POV is not displayed if all of the dimensions are placed on the grid.

The following criteria are used to show dimensions on the user POV bar:

- Dimensions not currently defined on a row, a column, or a page
- Dimensions on a row, a column, or a page that are flagged for the current POV
- Dimensions without a member selected on a grid POV
- Attribute dimensions dragged to the POV area in the Dimension Layout dialog box

Setting Up the User POV from the Report Designer

You can set up the user POV for a database connection while designing reports. This limits the members available on the user POV for that type of database connection. The user POV setup specified remains in force for all grids that uses that type of database connection. For more information on member selection, see Chapter 2, “Selecting Members for Report Designers.” For information on setting up the user POV in the Report Designer workspace, see Hyperion Workspace Administrator’s Guide.

To set up the user POV in the Report Designer:

1. Open a report that contains a grid for which you want to set up the POV.
2 Select Task > Set Up User POV.

Figure 17  Set Up User Point of View Dialog Box

3 Select Any Member or A Member from List for a dimension in the Report Viewers May Select column.

4 When the Report Viewers May Select column is set to A Member from List, click . The Select Members dialog box is displayed.

5 Select a member from the Select Members dialog box, then click OK.

Note:
For more information on selecting members, see Chapter 2, “Selecting Members for Report Designers.”

6 Select the Show Dimension Name and Show Member Name check boxes to display the dimension name with the member name.

7 Select the Show Alias check box to display alias names, then select an Alias Table from the From Alias Table drop-down list.

Note:
If Financial Management is the database connection, Show Descriptions is displayed instead of Show Alias.

8 Click OK.

Selecting Members for the user POV from the Report Designer

The user and grid POV enables report viewers to customize reports by selecting members for dimensions. The following rules apply:

- Only one member can be selected for a dimension on the POV.
- The default member for a dimension is the top member.
For an attribute dimension, you can specify None. In this case the attribute dimension is not used in the report.

To select a member for the user POV:

1. Open a report with dimensions displayed in the user POV.
2. On the user POV, click the dimension for which you want to select a member. The Select Members dialog box is displayed.
3. Select the member to run for this report, then click OK. The member is displayed on the user POV.
4. Optional: If you do not want the attribute dimension to be used in the report select None.

Note:

The following figure shows the member selection options for an attribute dimension.

Figure 18  Attribute Dimension Member Selection
Providing for Detailed Data and Documents in Reports

In This Chapter

Setting Up Expansions to Access Detail Data Within Reports ............................................................... 148
Positioning Expansion Rows and Columns .................................................................................... 148
Attaching Cell Documents in a Report ......................................................................................... 149
Printing Cell Documents ........................................................................................................ .151
Setting Up Links to Related Content ........................................................................................... 152
Creating Links to Related Content.............................................................................................. 152
Removing Access from Related Content....................................................................................... 154
Modifying the Properties for Related Content ................................................................................. 154
Using Smart View for Office .................................................................................................... .155

Providing Expansions and Related Content includes the following topics and tasks:

Expansions and Related Content are features that enable the designer to specify detailed levels of data in a report. You can design your report to allow end users to view detail data residing in the same report using Expansions or in a linked report using Related Content.

For example, you might want to provide the detail of a Market dimension by displaying the areas that comprise a market, such as East, West, North, and South.

- Using Expansion. You can set up viewing of same-report detail data by enabling expansion of summary rows and columns. A report set up with expansion enables end users to select a summary-level row or column and view its related detail in the same report.

- Using Related Content. You can select a data cell and set up links to objects in Financial Reporting, Web Analysis, Application Builder J2EE™, and URLs. A report set up with Related Content enables end users to move between documents in different applications.

You can view a report that has expansion and Related Content enabled during the design phase by selecting File > Web Preview.

Note:

The report designer must save the report as a Report type to view expansion and Related Content in the Report Designer workspace. Reports saved as snapshots lose this capability.
Setting Up Expansions to Access Detail Data Within Reports

You can design a report to display detail rows and columns of a grid at the request of the end user. You do this by enabling the expansion of a dimension that has parent-child relationships among its members. For example, if you enable the Time dimension to expand, users can expand a row that displays quarters into months.

Users access detail rows and columns by selecting summary rows and columns from reports that are displayed.

To set up access to detail data within a report:

1. Open a report.
2. Select the row or column headings for which you want to enable expansion.
3. Select the Allow Expansion check box in the Heading Row or Heading Column Properties sheet.

Note:

When Hybrid Data is available for a base-level member in Essbase, an expansion arrow is displayed next to the base-level member and you can expand into Hybrid Data. Expansions are not allowed on rows with line-item-detail or supporting detail, or on columns containing a row with line-item-detail. For more information on displaying line item details, see “Displaying Line Item Detail for Financial Management” on page 115.

4. Double-click the dimension to select members to expand. For more information on selecting members, see Chapter 2, “Selecting Members for Report Designers.”

Positioning Expansion Rows and Columns

You can specify whether expanded items are displayed before or after the dimension’s summary-level row or column.

To position expansion rows and columns:

1. Open a report.
2. Click the grid for which you want to specify expansion positions.
3. On the Grid Properties sheet, select the Position category.
4. Do one of the following in the Position of Expansions box:
   - To display expansions after the summary-level row or column, click After Parent. This is the default.
   - To display expansions before the summary-level row or column, click Before Parent.
Attaching Cell Documents in a Report

Cell documents that are attached at the data source can be accessed and printed to reports. The attached Microsoft Office documents (Word, Excel, or PowerPoint) prints at the end of a PDF or snapshot report. The documents is accessed in the HTML client when drilling into a cell through related content. In addition, you can insert a footnote into a text object or text cell of the report that lists information about the attached cell documents by selecting the ListOfCellDocuments option from the property sheet.

To include cell documents in a grid’s report, they must exist in Essbase (Linked Reporting Objects) or Financial Management (cell attachments). The data cell must be selected with the RetrieveCellDocument option. All cell documents have a POV associated with the data cell to which they are attached.

Note:
In Essbase, Linked Reporting Objects are attached through the Excel Add-in. In Financial Management, cell documents are attached through the Financial Management Web client. For more information, refer to the respective product’s documentation.

A data cell can contain multiple cell documents. If a data cell contains cell documents in the Financial Management or Essbase data source, a designer can extract those documents, based on the given cell’s POV. Cell documents can be attached to reports contained in books and snapshot books.

Supported File Microsoft Office File Types

The following types of Microsoft Office documents are supported as cell documents:


Supported Print and Print Preview Options

The following table describes the support matrix of cell document output for Financial Reporting Studio and Financial Reporting.

<table>
<thead>
<tr>
<th>Report Output Type</th>
<th>Support</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Financial Reporting Studio Print and Print Preview</td>
<td>None</td>
<td>- The Print or Print Preview commands do not print cell documents.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- The ListOfCellDocuments function returns the FileName and Description parameters, but not the PageNumber parameter.</td>
</tr>
<tr>
<td>Report Output Type</td>
<td>Support</td>
<td>Comments</td>
</tr>
<tr>
<td>--------------------</td>
<td>--------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Financial Reporting Export to PDF — in Workspace | Microsoft Office file types | ● A PDF file is generated. Only supported Microsoft Office file type are included. Non-supported cell documents, such as PDF files, are not included in the PDF. Ignored documents are logged in the FRPrintSrv.log file.  
● The ListOfCellDocuments function returns the FileName and Description parameters for all cell documents, including non-supported documents. The PageNumber parameter is only displayed for the supported Microsoft Office documents. |
| Financial Reporting PDF Preview — in Workspace | Microsoft Office file types | ● The PDF file is shown in Workspace.  
● A PDF file is generated. Only supported Microsoft Office file type are included. Non-supported cell documents, such as PDF files, are not included in the PDF. Ignored documents are logged in the FRPrintSrv.log file.  
● The ListOfCellDocuments function returns the FileName and Description parameters for all cell documents, including non-supported documents. The PageNumber parameter is only displayed for the supported Microsoft Office documents. |
| Financial Reporting HTML Preview — in Workspace | All file types       | ● All cell documents in HTML preview are hyperlinks. When you click a cell document hyperlink, the Related Content" dialog is displayed. All cell documents associated with the corresponding data cell are displayed.  
● When you click a document in the Related Content dialog box, the browser’s File Download dialog is displayed where you can choose to open or save the cell document. When you choose Open, the cell document displays in a new browser. The associated file type for the cell document must be installed on the user’s computer.  
● Depending on the user settings on the browser, the cell document may be opened automatically in a new browser window.  
● The ListOfCellDocuments function returns the FileName and Description parameters, but not the PageNumber parameter. |

In Financial Reporting Studio, you must first save the reports as a snapshot you wish to print-preview the contents of cell documents.
Reports containing cell documents can be saved through Financial Reporting Studio as Snapshot output. You can use the Save option to save the report as a snapshot in the repository. The cell documents are attached to the end of the report.

In Workspace, you can view reports containing cell documents in PDF or HTML output:

- PDF output. You use the Export option to save the report in a PDF file outside the repository. The cell documents are attached to the end of the report.
- HTML output. You use the Save or Save As option to save the report into the repository. The cell documents are stored with hyperlinks to the report.

➤ To attach cell documents:

1. In Financial Reporting Studio, create or select a report that uses a Financial Management or Essbase data source in the database connection.

Note:
For optimum retrieval performance, select Retrieve Cell Documents only for cells with attachments to include in the report.

3. If cell documents exist for the selected cell, they are appended to the report when printed. If no cell documents exist for the selected cell, no documents print.

Considerations

Please make note of the following items when working with Cell Attachment:

- Include the correct supported extensions for files.
- Files which are corrupt or improperly uploaded to the ADM provider (through Financial Management client or Essbase Add-in for Excel) will not print.
- We do not support Microsoft files containing macros or that trigger UI components requiring user input. Some MS files with macros perform operations when the file is opened which include the launching of dialogs requiring user input. Files that display dialogs or UI components requiring user input may not be available to print. Additionally, this may also hold up the completion of the PDF generation process. The server’s administrator may need to kill the application through Task Manage to resume printing activities. Because the application is launched under the SYSTEM account, it may not be visible since the process was not initiated by the login account.
- Documents containing file extensions that are not properly registered to print will fail.

Printing Cell Documents

You can use the Page Setup dialog box - Page Tab, to print cell documents with consecutive page numbers. This feature applies to Word and Excel documents only. The starting page of the first
cell document is determined by the length of the report. Each document prints on a new page. If you do not select to print consecutive numbers on your cell documents, the page numbering reverts to the setting of each document.

For information on setting your print option for cell documents, see “Changing the Page Setup” on page 197.

Note:

In Financial Management, when you upload files for attachments to cell, the file name truncates to 20 characters. You can change the document’s name. Make sure to retain the file name extension (.doc,.xls).

**Printing a List of Attached Cell Documents**

You can use the ListOfCellDocuments text function to display a list of all cell documents and attributes such as description and start page number that are retrieved in the report. The function can be entered into a text object, text cell, or text cell heading. See “List OfCellDocuments” on page 231 for information on this function.

**Setting Up Links to Related Content**

Related Content allows a designer to set up links to Web Analysis, Oracle's Hyperion® Interactive Reporting – System 9, Financial Reporting, and custom links to your own URL.

**Changing the Related Content Server for Multiple Reports or Grids in the Repository**

After migrating content from another server, you can use Workspace to change the server for selected reports, grids, or both in the repository by specifying a new URL or a substitution variable. You may want to change the related content servers; for example, you might do this when moving your reports and grids from a development server to a production server.

For instructions on changing the related content server in the repository, see the *Hyperion Workspace User’s Guide*.

**Creating Links to Related Content**

You can design a report that provides access to another report or a URL through a hyperlink. You can create numerous links through a data cell on the report design. Links can be created to reports through your local Financial Reporting server, or remote Web Analysis, and J2EE servers, if they are registered through Shared Services or on the RelatedContent.properties file. End users can click a cell with Related Content links, then select a linked report from a Related Content menu.
When using Related Content on a report, the system sets the point of view (POV) of the report to that of the selected cell. For example, if the Gross Margin row of the Canada column is selected, the POV for the account is set to Gross Margin and the POV for the entity is set to Canada before the linked report is displayed.

**Note:**

The POV context is not passed when you link to books through Related Content.

You can define Related Content for data cells and formula cells (but not text cells), within a row or column. You can specify the same report for a group of cells by selecting the desired cells in the grid and then defining the Related Content. Also, based on the type of Related Content selected, you can modify properties, such as their label and URL and default display options.

Object-level security is not enforced when you select Related Content, which enables you to select any report among the entire contents of each repository. However, object-level security is enforced when the report is requested for viewing.

➤ To create a link to Related Content:

1. Select a report for which you want to specify Related Content.
2. Select the rows, columns, formula, or data cells for which you want to provide a link to Related Content.
3. From the Property sheet, select the Add Related Content check box, then click the Setup button. The Add Related Content dialog box is displayed.

Each Hyperion server repository is listed as a node in a tree view. The local Financial Reporting repository is listed with the repositories from the remote servers: Hyperion J2EE, and Web Analysis. The remote servers are obtained from the `RelatedContent.properties` file or Shared Services.

4. You can link a folder for Related Content, which enables an end user to select from the complete contents of the folder, or expand the contents of a folder and select a report. To make a selection, perform any of the following actions:
   - To select a folder, highlight the folder in the Available list, then click the arrow button to move the folder to the Selected Related Content area.
   - To select a report object, expand the folder by clicking the node (+), highlight a report object, then click the Add button, to move the report to the Selected Related Content area.

5. You can modify the properties of the selected report object while you add the link or after you add the link:
   - To modify properties while selecting a report object, select the Show Properties dialog when adding content from Hyperion sources check box. As you select a report object to link, the Related Content Properties dialog box is displayed.
   - To modify properties after selecting report objects, highlight the report object in the Selected Related Content list, then click the Properties button.

For information on changing properties, see the “Modifying the Properties for Related Content” on page 154.
6 Select as many additional links as needed.

Note:
For information about changing the properties of the links, see “Modifying the Properties for Related Content” on page 154.

7 To change the position of a report object within the Selected Related Content list, select the object, then click the Up arrow or Down arrow to move the report object up or down, respectively.

8 Click OK.

Removing Access from Related Content
You can remove a link from your report to deny Related Content to end users.

➤ To remove access to a linked report:

1 Select a report that contains links to Related Content.

2 Select the rows, columns, formula, or data cells from which you want to remove a link for Related Content.

3 From the property sheet, select the Add Related Content check box, then click the Setup button. The Add Related Content dialog box is displayed.

4 Highlight the report object to remove in the Selected Related Content list and click the Remove arrow button.

5 Click OK.

Modifying the Properties for Related Content
You can modify properties of a selected report object. Based on the type of report object selected, you can modify such properties such as its label or URL, and you can set default display options.

➤ To modify properties for linked objects:

1 Create a link to a related content in the Add Related Content dialog box. For information on creating a link, see “Creating Links to Related Content” on page 152.

2 In the Add Related Content dialog box, select a report object in the Selected Related Content list, then click the Properties button to display the Related Content Properties dialog box.

Related Content Properties Dialog box
The items in the Related Content Properties dialog box that are displayed for editing depend on the report type you selected. For example, for Financial Reporting, all display options are provided for a report, snapshot, book, and snapshot book. However, for a custom link, only the label and a URL fields are available.
The following items are available for editing:

- Label - Enables you to change the name of the report object link.
- URL tabs - Displays the URL of the linked object which may be modified if needed.
- Display Options:
  - In the Provide list. For Financial Reporting, select the formats that can be viewed by the end user; HTML and/or PDF. For Web Analysis, select whether the report can go to the Java Client, Workspace, or both.
  - In the Default list. Select the format to link with the report name as the primary selection. The format not selected is listed as the secondary selection.

➤ Click Save As Default to update your current selections.

Using Smart View for Office

Smart View provides a common Microsoft Office interface for the following Hyperion products:

- Essbase
- Financial Management
- Planning
- Financial Reporting
- Interactive Reporting
- SQR Production Reporting™
- Web Analysis

The centralized interface enables simultaneous use of multiple Hyperion products, and improves integration with Microsoft Office (2000, 2002, and 2003). The Smart View implementation provides the following Workspace functionality:

- Exports the current page of the current data object to Excel, Word, or PowerPoint
- Exposes Financial Management and Essbase functions in Excel, Word, and PowerPoint content
- Notifies you when you can upgrade to new releases of Hyperion Smart View.
- For more information on using the capability, see Hyperion Workspace User’s Guide
You can preview and print reports and Snapshot reports from Financial Reporting Studio or a Web browser through Workspace. As you preview or print a report, the data is refreshed with new data, calculations, and formatting.

Snapshot reports contain data retrieved at the time the report is saved as a snapshot. The data in a snapshot report remains the same; changes in the database connection since the snapshot was last saved are not reflected when it is previewed or printed.

Note:

For viewing and printing options provided through the Workspace. See *Hyperion Workspace User’s Guide*.

**Responding to Prompts when Previewing**

If the report is designed with prompts, those prompts are displayed when you preview the report. You must respond to the prompt and provide the requested information by selecting members from the prompt list. You can also edit the prompts manually. If the prompts contain alias names, you can edit the alias names by converting to member names. For more information on defining prompts, see Chapter 2, “Selecting Members for Report Designers.”

To respond to a prompt when previewing:

1. From Studio Explore, open a report that has prompts.
2. Under the **Selection** column in the **Respond to Prompts** dialog box, perform an action:
● If the member is known, enter the member name in the text box for the respective prompt. If the text box is disabled, the prompt contains alias names. To edit the text box, select the **Edit Member Names** check box. If multiple members are provided for the prompt, members must be separated by commas.

**Note:**
Selecting the Edit Member Names check box displays the member names in the text box, not the alias names. Edit the member name associated with that alias.

● Click the **Go to Member Selection** button. The **Select Members dialog** box opens. The default member is listed in the right panel - selected area. Click the Add to Selected arrow and Remove from Selected arrow located in the center panel of the dialog to move members between the panels.

For more information on defining members, see Chapter 2, “Selecting Members for Report Designers.”

3 **Select OK.**

4 **Optional:** To undo changes made to prompts, click **Reset from the Respond to Prompts dialog box.**

5 **Click Run.** The report or book is displayed.

### Previewing the Current User POV Settings

In Workspace, a user can preview the user POV before running a report and make changes to the user POV from. For example, it may save time for users to verify that the members on the user POV are appropriate before running the report instead of after the output is displayed.

For information on how a user can preview the user POV settings for a report or book from Workspace, see *Hyperion Workspace User’s Guide*.

### Setting Preview Preferences

Using Workspace, you can set preview preferences. You can preset how to view a report or book. The default settings for opening a report or book are PDF Preview or HTML Preview. For detailed information on this option, see *Hyperion Workspace User’s Guide*.

### Previewing Reports in a Web Browser

You can use the Web Preview feature in Studio Explore or the Designer to preview reports in a Web browser through Workspace.
To preview a report in a Web browser, open any type of report and click the Web Preview button on the toolbar. Workspace provides HTML and PDF preview and printing options.

For information on viewing reports and books using Workspace, see the Hyperion Workspace User’s Guide.

Previewing Reports in Financial Reporting Studio

You can preview a report to view the contents before saving changes or printing. You can zoom in or zoom out, scroll through the report, or print the report. When you preview a report, the data in the report is refreshed. Data in snapshot reports are not refreshed.

Books are previewed using a Web browser through Workspace. For information on previewing books and reports, see the Hyperion Workspace User’s Guide.

To preview a report:
1 From Studio Explore, highlight a report or snapshot.
2 Select File > Print Preview.
3 Optional: Do one of the following tasks:
   ● Select Print to print the report.
   ● Select Next Page to display the next page of the report.
   ● Select Prev Page to display the previous page of the report.
   ● Select Two Page to preview two pages side-by-side.
   ● Select Zoom In to magnify the size of the page on the screen.
   ● Select Zoom Out to decrease the size of the page on the screen.
   ● Select Close to close the Print Preview window.
   ● Use the Page Up or Page Down keys on your keyboard to scroll up or down, respectively.
4 Click Close.

Printing Reports

You can print any type of report. When you print a dynamic report, the data is refreshed. Data in snapshot reports is not refreshed. You can print a report in Explore or design area.

Books and snapshot books are printed through Workspace. For more information on printing books and snapshot books, see the Hyperion Workspace User’s Guide.

To print a report:
1 From Studio Explore, open a report.
   Respond to prompts that are displayed and make necessary changes.
2 Select File > Print.
Printing Tips for Report Designers

The following topics describe how report objects are printed on a page. You can place report objects anywhere in a report. However, the printed results are determined by the report properties and data.

Note:

When printing reports containing overlapping objects, objects may not print as displayed in the designer, requiring you to rearrange the objects in your report. For more information, see Chapter 4, “Building Reports.”

The following areas are described for designing reports from the Financial Reporting Studio:

- “Positioning and Alignment” on page 160
- “Printing Text Boxes” on page 160
- “Printing Grids” on page 161
- “Printing Page Dimension Headings” on page 161
- “Printing Page Members” on page 161
- “Printing Headers and Footers” on page 162

Positioning and Alignment

You can set relative positioning on autosized report objects. This is an advanced positioning mechanism that gives you precise control over how report objects are positioned relative to one another. If none of the report objects in your report is autosized, then the relative positioning is ignored.

If you set the position of a report object to relative, all report objects within the design shift so that the distance between the autosized report object and fixed report objects remain the same.

For example, GridA is autosized and has horizontal positioning set to Center, therefore, GridA is printed in the center of the page. ChartA is linked to GridA, and has its vertical position set to Relative and is placed one inch from the bottom edge of GridA. ChartA is printed one inch from the bottom of Grid A.

If the alignment for ChartA is not set to relative, it is printed on the absolute coordinates in the layout of the grid, so it might overwrite Grid A.

Printing Text Boxes

You can set the autosize property for a text box. When you print a report, the height of a text box increases or decreases to accommodate all text that is entered in the text box. The width of the text box does not change.
Note:
When you autosize, the maximum number of lines for viewing is 27. To view all lines of text,
deselect Autosize.

If the autosize property is not set when you print a report, the report is affected in these ways:
● The text box is printed at the height and width of the grid.
● Text that does not fit in the text box is truncated.

Printing Grids
You can set the autosize property for a grid. When the autosize property is set and you print the
grid, the height and width of the grid increase or decrease to accommodate all data in the grid.

When the autosize property is not set, the grid is printed at the height and width specified. If a
row or column does not fit on a page, it is printed on subsequent pages. The columns are printed
first using as many pages as needed, followed by the rows.

You use the positioning properties of the grid to align the grid on the page. Manually positioning
the grid to the right or bottom of the page does not ensure that the grid will print on the right
or bottom of the report.

When a grid is set to autosize, and does not fit on one page, it is printed on subsequent pages.
The columns are printed first, starting on the left margin of the next page, followed by the rows,
which are printed starting at the top of the next page.

Printing Page Dimension Headings
You can specify a page dimension heading for a grid using the Page Properties sheet. When you
print a report, the page dimension heading is printed every time the page member changes.

The following list describes how the page dimension heading is printed:
● The text is left justified at the left edge of the grid.
● The text is autosized vertically, and the width is set to the width of the grid.
● The heading is printed above the first row in the grid each time the page member changes.

Printing Page Members
When you print a report, a new page is generated every time a page member changes. Using the
Page Properties sheet, you can specify how to print the page using one of the following options:
● New Page, Top - The new page is printed at the top of the page. Use this option when a chart
  is linked to a grid and you want to ensure the chart and grid print next to one another every
time the page member changes.
● New Page, Same - The new page is printed at the grid location specified. This option is used
  for the following situations:
The grid has horizontal and/or vertical alignment properties set and you want the grid to print in the same position on each page. For example, if you set the grid position to Center/Middle, it is printed in the center of each page.

When a chart is linked to a grid and you want to ensure the chart and grid print next to one another every time the page member changes.

- Same Page - The new page is printed immediately after the data from the previous page.

**Note:**

If a chart is linked to a grid, the chart is printed once; not every time the page member changes.

### Printing Headers and Footers

You can place an autosized text box in the header. However, if the text box height expands beyond the header, it prints beyond the header boundary.

You can place an autosized text box in the footer. However, if the text box height expands beyond the footer, the text is truncated.

**Note:**

If an object is placed near the top or bottom of the page, it might overlap the header or the footer.
Formatting reports enables you to specify how report components, such as text boxes, grids, images, and charts, appear in your reports. For example, you can specify fonts and add borders. When you format a report, you define the properties of the components. The formatting you apply affects the printed and online report presentation.

Note:
Each object has default formatting properties. You can use the default format properties if you do not want to format your report.

For general information about report objects, including overlapping objects, see Chapter 4, “Building Reports.” For information about formatting charts, see Chapter 3, “Customizing Charts.”

**Formatting Text Boxes**

You can format the text in text boxes using the following attributes:

- “Specifying Fonts for Text Boxes” on page 163
- “Aligning Text in Text Boxes” on page 164
- “Adding Borders and Shading to Text Boxes” on page 165

**Specifying Fonts for Text Boxes**

You can change the font of text in a text box.
To specify a font:
1. Open a report and select text within a text box.
2. Select Format > Font.
3. Specify the font, font style, size, and color.
4. To place a line through the selected text, select Strikeout.
5. To place a line beneath the selected text, select Underline.
6. Click OK.

Aligning Text in Text Boxes

You can align text in text boxes horizontally. You can also increase or decrease the margin of text in text boxes using the indent option.

The following table explains the text alignment and indentation option settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alignment</td>
<td>Select Left, Center, or Right to specify the horizontal alignment for text in text boxes. For example, if you select Center, the text is aligned in the center of the text box.</td>
</tr>
<tr>
<td>Indent</td>
<td>Select the number of spaces to indent the text to the right for left-aligned text.</td>
</tr>
<tr>
<td>Note:</td>
<td>Indent functionality is limited to left-aligned text.</td>
</tr>
</tbody>
</table>

To align text in a text box:
1. Open a report and create a text box or select an existing text box.
2. In the Text Properties property sheet, select one of the following from the Position Object on Report - Horizontal drop-down list.
   - Select None to position the printed text at its current location regardless of whether report objects above it or to its left change in size.
   - Select Relative to position the printed text relative to report objects to its left.
   - Select Left to position the text box on the left side of the report.
   - Select Center to position the text box in the center of the report.
   - Select Right to position the text box on the right side of the report.
3. Select one of the following from the Position Object on Report - Vertical drop-down list.
   - Select None to position the printed text at its current location regardless of whether report objects above it or to its left change in size.
   - Select Relative to position the printed text relative to report objects above it.
   - Select Top to position the text box at the top of the report.
   - Select Middle to position the text box in the middle of the report.
Select Bottom to position the text box on the bottom of the report.

### Adding Borders and Shading to Text Boxes

You can add a border around a text box, and you can shade the area inside a text box.

➤ To add borders, shading, or both to a text box:

1. **Open a report and select a text box.**
2. **In the Text Properties sheet:**
   - To place a border around the text box, select the *Show Border* check box.
   - To add shading to the text box, select a shade from the *Shading* drop-down list.

### Formatting Grids

Financial Reporting Studio enables you to perform a variety of formatting options when working with grids. You can use the following functionality to format grids in the designer:

- “Expanding the View of a Grid” on page 165
- “Formatting Numbers in Grids” on page 166
- “Aligning Text in Grids” on page 168
- “Modifying Font Options” on page 170
- “Adding Borders or Shading” on page 171
- “Replacing Text” on page 173
- “Inheriting Cell Formatting” on page 174
- “Copying Cell Formatting” on page 175
- “Hiding Rows, Columns, or Grids” on page 176
- “Sorting Rows, Columns, and Pages” on page 177
- “Applying Conditional Formatting on Grids” on page 182

### Expanding the View of a Grid

You can expand the view of a grid to the size of the Report Designer workspace. This is especially helpful when your grid contains many rows and columns. The expanded view enables you to locate cells more easily.

➤ To expand the view of a grid:

1. **Right-click the title bar of the grid.**
2. **Select Zoom.**
3. **To return to the original view, right-click the title bar of the grid and deselect Zoom.**
Formatting Best Practices

Cell formatting has precedence over row/column formatting and grid formatting. Cell formatting allows you to make exceptions to row/column formatting and grid formatting. Row/column formatting has precedence over grid formatting. Row/column formatting allows you to make exceptions to grid formatting. Therefore, the correct sequence in formatting a report is to first format the grid, then apply different formatting to rows/columns, then apply specific cell formatting.

Note:

Conditional formatting takes precedence over all other formatting and replaces formatting previously set at the grid, row/column, or cell level. For example, if you use conditional formatting to change cell colors, yet want to retain a specific number of decimal places applied with regular formatting, you must specify both formats using conditional formatting.

Formatting Numbers in Grids

You can format how numbers are displayed in a grid. You can specify the following options for an entire grid or for individual cells, rows, or columns:

- Positive number symbols, including prefixes and suffixes
- Negative number symbols, including prefixes and suffixes and an option to display negative numbers in red
- Grouping and Decimal Symbols can be determined by the user’s preferences settings or defined explicitly on the cells in a grid

To format numbers in a grid:

1. Create a grid in a report in the Report Designer, or open an existing report containing a grid.
2. Select a cell.
4. Select the Number tab.
Figure 19  Number Tab in the Format Cells Dialog Box

### Format Cells

<table>
<thead>
<tr>
<th>Number</th>
<th>Alignment</th>
<th>Font</th>
<th>Borders &amp; Shading</th>
<th>Replace</th>
<th>Inherit Formatting</th>
</tr>
</thead>
</table>

#### Positive Number Symbols
- **Prefix:**
- **Suffix:**

#### Negative Number Symbols
- **Prefix:**
- **Suffix:**

- **Display in Red**

#### Sample
- **Positive:**
- **Negative:**

#### Decimal Places:
- 

#### Separator Characters:
- **Defined by Preferences**
- **Defined in Report**

#### Thousands Separator:
- 

#### Decimal Separator:
- 

#### Scale Value By:
- 

**OK** | **Cancel** | **Apply** | **Help**

---

**Note:**

You can view the results of your number format option selections in the Sample section at the bottom of the Number tab.

5 **Optional:** Specify a prefix or suffix for positive numbers by selecting a symbol from the Prefix or Suffix drop-down list, or type a user-defined symbol into the Prefix or Suffix fields. A prefix symbol is placed to the left of each positive value. A suffix symbol is placed to the right of each positive value.

**Note:**

You can use a prefix or suffix to reverse the sign of an account member without inserting another row or column. When using conditional formatting, you specify an account row and set the condition. Then, in the Positive Number Symbols Prefix fields, enter the negative (-) symbol and click OK twice. The negative (-) symbol is displayed in front of the numbers for that row.

6 **Optional:** Specify a prefix or suffix for negative numbers by selecting a symbol from the Prefix or Suffix drop-down list box or type a user-defined symbol into the Prefix or Suffix fields. A prefix symbol is placed to the left of each negative value. A suffix symbol is placed to the right of each positive value.

7 **Optional:** To display negative values in red, select the **Display in Red** option. By default, this option is deselected.

8 Select the number of decimal places to apply to a number from the **Decimal Places** drop-down list box. The default ranges are from 0 to 9.

9 Select one of the following for Grouping and Decimal Symbols:
● Defined by Preferences if you want to use the symbols specified in the user’s Preferences dialog box. This enables you to determine which symbols are used.
● Defined in Report if you want to specify thousands and decimal separators for the current report:
  ○ Select a character for separating thousands in values from the Thousands Separator drop-down list. For example, you can select comma (,) to display a value (1,000) or you can select period (.) to display a value (1.000). The options are: comma (,), period (.), underscore (_), and Space. Alternatively, you can specify another symbol in the drop-down by highlighting the field and typing another symbol.
  ○ Select a character to represent decimal points (for example, 1,000.06) from the Decimal Separator drop-down list box. The options are: comma (,), period (.), underscore (_), and Space. Alternatively, you can specify another symbol in the drop-down by highlighting the field and typing another symbol.

10 Select or enter a number from the Scale Value By drop-down list box by which to multiply values for scaling purposes. The default scaling option is 1, which does not scale values. If you select .001 instead, a value of 2,000 is displayed as 2. The options are: percentages, tens, hundreds, thousands, ten thousands, hundred thousands, millions, or billions. Alternatively, you can specify an amount in the drop-down box.
11 Click Apply to apply the number formatting you specified for the selected cells.
12 Click OK to save the number formatting and close the dialog box.

Aligning Text in Grids

You can specify options for aligning and indenting text in selected cells. You can select options for horizontal and vertical alignment. You can also specify the number of character spaces to indent text from the margins of selected cells.

➤ To align text in grids:
1 Create a grid in a report in the Report Designer, or open an existing report containing a grid.
2 Select the cells you want to format.
3 Select Format > Cells to access the Format Cells dialog box.
4 Select the Alignment tab to specify alignment for the selected cells.
5 From the Horizontal drop-down list, select an alignment option. The options are Left, Center, and Right.

6 From the Vertical drop-down list, select an alignment option. The options are Top, Middle, and Bottom.

7 To indent the heading and the associated text, data, or formula cells in the row, from the Indent value box, select the number of spaces to indent the values from the left cell margin.

**Note:**
This control is enabled only if you selected Left from the Horizontal drop-down list.

8 To indent the row headings of each generation of a selected member:
   a. Confirm that you selected a row with the desired heading cell from the Indent Increases for Each Generation By value box.

   **Note:**
   You can specify a reverse indentation (from right to left) by using a negative number in the format property.

   b. Select the number of spaces to indent the text. This number is added to the number in the Indent value box if it contains a value; for example: If Indent contains a 2 and Indent Increases For Each Generation By contains a 4, the output would resemble the following example:

   | East Hartford (2+4+4+4=14) | 120  
   |---------------------------|------
   | West Hartford (2+4+4+4=14)| 130  
   | Hartford (2+4+4=10)      | 250  
   | Springdale (2+4+4+4=14)  | 140  

Figure 20  Alignment Tab in the Format Cells Dialog Box
Note:
For Planning Details, you must select Show Supporting Detail to view detail items. Also, for all database connections including Planning Details, you must select a member relationship that returns members on multiple levels; for example: Children of... (Inclusive), Descendants of..., Descendants of ...(Inclusive), Parents of...(Inclusive), Ancestors of, Ancestors of...(Inclusive), and AllMembers. This control is enabled only if you selected Left from the Horizontal drop-down list.

9 Click Apply to apply the text alignment options to the cells.
10 Click OK to confirm the text alignment options you specified and close the dialog box.

Modifying Font Options
You can specify the font, font style, font size, font color, strikeout lines, and underlining for text in selected cells. A preview of the text displays in the dialog box as you modify the font options.

➤ To modify font options:
1 Create a grid in a report in the Report Designer, or open an existing report containing a grid.
2 Select the cells you want to format.
3 Select Format > Cells to access the Format Cells dialog box.
4 Select the Font tab and perform one or more of the following actions:
   ● Select a font from the Font list box.
   ● Select a font style from the Font Style list box. The options are: Regular, Bold, Italic, or Bold Italic.
   ● Select a font size from the Size list box.
   ● Select the Strikeout checkbox in the Effects section to apply strikeout lines. For example, if you apply the strikeout option to a cell that contains the word “SubTotal,” the word is displayed as SubTotal.
   ● Select the Underline checkbox in the Effects section to underline text. For example, if you apply the underline option to a cell that contains the word “SubTotal,” the word is displayed as SubTotal.
   ● Click the Select button in the Effects section to select a color to apply to the selected cell.
5. Click **Apply** to apply the font options you selected.

6. Click **OK** to confirm the font options you specified and close the dialog box.

**Adding Borders or Shading**

You can apply borders and shading to add emphasis to selected cells, rows, or columns in grids in your reports. You can specify a border style and then apply it to any sides of the selected area. You can also select a shading color to apply shading to your selection.

The following table describes the buttons for indicating border placement options for cells:

<table>
<thead>
<tr>
<th>Table 29</th>
<th>Border Placement Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Button</strong></td>
<td><strong>Task</strong></td>
</tr>
<tr>
<td>![Border button]</td>
<td>Click to remove the borders from each selected grid, cell, row, or column.</td>
</tr>
<tr>
<td>![Border button]</td>
<td>Click to place a border around the outside edge of each selected grid, cell, row, or column.</td>
</tr>
<tr>
<td>![Border button]</td>
<td>Click to place a border along the top of each selected grid, cell, row, or column.</td>
</tr>
<tr>
<td>Button</td>
<td>Task</td>
</tr>
<tr>
<td>--------</td>
<td>------</td>
</tr>
<tr>
<td><img src="image1.png" alt="Button" /></td>
<td>Click to place a border along the bottom of each selected grid, cell, row, or column.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Button" /></td>
<td>Click to place a border along the left side of each selected grid, cell, row, or column.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Button" /></td>
<td>Click to place a border along the right side of each selected grid, cell, row, or column.</td>
</tr>
</tbody>
</table>

To add borders or shading to cells in a grid:

1. Create a grid in a report in the Report Designer, or open an existing report containing a grid.
2. Select the items you want to format: a grid, or one or more cells, rows, or columns in a grid.
3. Select Format > Cells to access the Format Cells dialog box.
4. Select the Borders & Shading tab.

To specify border options, perform the following steps:

a. In the Style box, click the preferred line style for the borders.

b. Click one or more of the border placement buttons. For a description of the border placement buttons, see Table 29 on page 171.
6 To add shading, click the Select button and choose a color to apply shading.
7 Click Apply to apply the border and shading options you selected.
8 Click OK to confirm the border and shading options you selected and close dialog box.

**Replacing Text**

When working with cells in a grid, you can replace values in a cell with different text. This replaces all text in all selected cells with the replacement text you specify.

To replace a value in a grid selection:
1 Create a grid in a report in the Report Designer, or open an existing report containing a grid.
2 Select the cells you want to format.
3 Select Format > Cells to access the Format Cells dialog box.
4 Select the Replace tab.

5 Select the Replace value with checkbox to enable the text box, then enter the replacement text in the text box.

**Note:**

If the checkbox is selected and no text is entered in the text box, the selected cells are displayed as blank in the report.
6 Click Apply to apply the text replacement to your selected cells.
7 Click OK to confirm the replacement of the specified text string.

**Inheriting Cell Formatting**

When formatting cells in a grid, you can inherit formatting from a cell and apply it to another cell. The following formatting options can be inherited in a grid: number, alignment, font, borders and shading, and replace.

**Note:**

If you are working with a row and column template in the current grid, you must establish your format inheritance options before saving a row and column template. For more information, see “Creating a Row and Column Template” on page 108.

➤ To inherit cell formatting:

1. Open a report that contains a grid, or create a new grid with formatted rows or columns.
2. Select the cells to which you want to apply inherited formatting.
4. Click the Inherit Formatting tab.

![Figure 24 Inherit Formatting Tab in the Format Cells Dialog Box](image)
5 In the **Inherit These Formatting Options** area, expand the plus (+) symbols and click the box to select the formatting options to inherit, including number, alignment, font, borders and shading, and replace text, as illustrated in **Figure 24**.

**Note:**
To select all formatting options, click **Select All**. To deselect all formatting options, click **Unselect All**.

**Tip:**
To specify the row or column from which you want to inherit formatting, you must first specify the options you want to inherit (number, alignment, font, borders and shading, and replace).

6 In the **Inherit formatting from** area, select the row or column from which to inherit formatting, using the up and down arrows. Choose from the following inheritance options:

- Select the current row and another column

  **Tip:**
  Use the up and down arrow keys to make your selection.

- Select the current column and another row

- Select another row and another column

**Note:**
You can only inherit from a cell that does not have previously defined inheritance. For example, if you format column A and then inherit formatting into column B, you cannot then inherit formatting from column B into column C. You can, however, format column A, select columns B and C, and inherit formatting for column B and C from column A.

7 **Click Apply.**

8 **Click OK.**

**Note:**
If you have inherited formatting and then modify the format of the cell to which you inherited formatting, the inheritance you established no longer applies. For example, if you inherit the font name property in cell A4 from cell B4 and you subsequently modify the font name in cell A4, the format inheritance no longer exists. This breaks the formatting link that was previously established between the two cells.

**Copying Cell Formatting**
You can copy cell formatting from a cell or range of cells and apply it to a destination cell or range of cells in a grid using Format Painter.
Note:
Format Painter does not copy inherited formatting or conditional formatting.

To copy cell formatting:
1 Create a grid in a report, or open an existing report containing a grid.
2 Format a cell or range of cells using grid formatting. For more information, see “Formatting Grids” on page 165.
3 Select the cell or range of cells containing the formatting to copy.
4 Click ▶.
5 Select the destination cell or range of cells to apply the copied formatting. The formatting is changed when you release the mouse.

Hiding Rows, Columns, or Grids

You can hide rows, columns, or an entire grid so that their values are not displayed when you print or view a report. You might want to hide a grid, for example, if you include a chart based on the grid data and want to display only the chart on the report. When the grid is hidden, the grid’s title bar changes from blue to gray.

The data and calculations in rows or columns are evaluated, regardless of the formatting that is applied to them.

To hide a grid:
1 Create a grid in a report in the Report Designer, or open an existing report containing a grid.
2 Select a grid.
3 In the Grid Properties property sheet, select Suppression category.
4 Select the Hide Grid check box.

To hide a row or column:
1 Create a grid in a report in the Report Designer, or open an existing report containing a grid.
2 Select a row or column.
3 Select the Hide Always check box.

Note:
You can specify whether the data values of hidden row or column are taken into account during suppression. For information on this option, see the next topic, “Controlling the Evaluation of Suppression in Hidden Rows or Columns”.

176 Formatting Reports
Controlling the Evaluation of Suppression in Hidden Rows or Columns

When evaluating suppression, you can include or ignore the values and calculations in a hidden row or column. This option is enabled only when the Hide Always check box is selected for the row or column.

To specify if hidden rows or columns are taken into account during suppression:

1. Select a hidden row or column.
2. Perform an action:
   - To include values and calculations, deselect the Suppression Ignores Row or Column check box. This is the default setting.
   - To ignore values and calculations, select the Suppression Ignores Row or Column check box.

Note:

Hidden cells are ignored when suppression is evaluated unless they are specifically referenced using conditional suppression. For more information, see “Conditional Suppression” on page 189.

Sorting Rows, Columns, and Pages

You can sort a range of consecutive rows or columns in a grid based on the values in a specified column or row. You can also sort columns, rows, and pages based on their headings. If you select a range of columns, the system sorts the columns based on the values in a specified row. If you select a range of rows, the system sorts the rows based on the values in a specified column. If the column or row by which you sort contains multiple members, the sort is based only on the values of the first member.

You can sort columns or rows in ascending or descending order. When you sort in ascending order the lowest number, the beginning of the alphabet, or the earliest date appears first in the sorted list. When you sort in descending order, the highest number, the end of the alphabet, or the latest date appears first in the sorted list.

You can sort only multiple ranges of columns or rows. Suppressed rows or columns are not sorted.

To sort a range of rows and columns:

1. Create a grid in a report in the Report Designer, or open an existing report containing a grid.
2. Set up sorting for the grid:
   a. Select a grid to display Grid Properties sheet.
   b. Select the General category.
   c. Select Sort, and click Setup to display the Sort Dialog box.
3 From Apply Sorting to the, select Rows, Columns, or Pages.

Note:
For the Pages option, you can only select headings from the Sort by: drop-down menu. All other options are disabled.

4 For Rows or Columns, use From and To to select the range of columns or rows to sort.

Note:
When auto calculations is enabled, the outermost layers contains the grand total of all rows in the calculation. Sorting on the outermost layer is ignored. Also, when you select sort with auto calculation set on multiple layers, you must sort on all heading layers which have auto calculations.

5 In the Sort by area:
   a. From the first drop-down list, select the headings or row or column on which to base the sort, then select Ascending or Descending sort order.
   b. Optional: In the Sort by area, set up one or two additional sorts:
      i. For each additional sort, select the Then by check box.
      ii. From the second or third drop-down list or both, select the headings or row or column on which to base the sort.
      iii. For each additional sort, select the Ascending or Descending sort order.

6 Optional: To set up additional sorts:
   a. Click Add Sort. A tab is added to the Sort dialog box.
   b. In the tab, repeat steps 3 through 5 for the new sort.

7 Optional: To delete a sort:
a. Click **Delete Sort**.
b. From the drop-down list, select the sort to delete.

8 **Click OK.**

**About Conditional Formatting**

You can use conditional formatting to apply specified formatting to cells in a grid. For example, suppose you define the criterion “current cell value = 0” and then define a format to change the color of the cell font to blue if the criterion is met. If the data returned for this cell has a value of 0, then the font color is changed to blue.

**Note:**

Conditional formatting takes precedence over all other formatting and replaces formatting previously set at the grid, row or column, or cell level. For example, if you use conditional formatting to change cell colors, yet want to retain a specific number of decimal places applied with regular formatting, you must specify both formats using conditional formatting.

**Note:**

When you select multiple cells, the default formatting is derived from the upper left cell of the selected group of cells.

After you define the conditions and add the formats, you return to the report.

The current grid is displayed. Each cell with conditional formatting contains a colored dash, shown in cell D2 below, as an indication that a conditional format is applied to this cell. This is illustrated in below.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Jan, Feb, Mar, Apr, May, Jun, Jul, Aug, Sep, Oct, Nov, Dec</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>100</td>
<td>#</td>
<td>#</td>
<td>#</td>
<td>#</td>
<td>#</td>
</tr>
<tr>
<td>3</td>
<td>100</td>
<td>#</td>
<td>#</td>
<td>#</td>
<td>#</td>
<td>#</td>
</tr>
<tr>
<td>4</td>
<td>Product</td>
<td>#</td>
<td>#</td>
<td>#</td>
<td>#</td>
<td>#</td>
</tr>
</tbody>
</table>

You can apply conditional formatting to enhance your reports. For example, you can underline any values greater than 1000. You can also set up more complex conditional formatting. For example, if the account type equals expense and the current cell value is greater than 1000, apply bold to the cell. In addition, if the value of a Cola cell is less than 1000, then set the background color of the cell to lime green. You can accomplish this type of formatting by specifying additional conditions and formats, as in the following example:

From the Conditional Format dialog box, select Account Type from the Condition 1: If drop-down list box.
Then, select Expense from the Comparison Options drop-down list box. Click Format Cells to apply bold formatting to the selected cell, leaving all other font properties unchanged.

Next, add a second condition to the selected cell. Click the Add Condition 2 button, setting the Condition 2: If statement to Current Cell Value. Set the operator value to >, leaving the comparison value set to Number. Set the numeric value to 1000, as illustrated below:
Note:
Click Delete Condition to delete a condition.

Next, add another Format by clicking the Add Format 2 button. Establish three conditions as follows to set the background color to lime green when a Cola cell has a value < 1000:

Note:
Use And and Or to combine or differentiate the conditions.

After you establish the conditions, you can select the check box for Allow Parentheses in the Options box.

The following scenario performs the following operation:

Condition 1 and Condition 3
or
Condition 2 and Condition 3

For this example, if a cell has the label Cola associated with it using the Alias:Default and the cell value < 1000, the background is set to lime green. If a Member Name contains Cola and the cell value is < 1000, the background is set to lime green.

Note:
The manner in which you use conditional formatting can impact performance depending on the size of the report. Performance is also contingent on the criteria used and the frequency of use (every cell). Each or all of these factors combined can affect performance. Data value comparisons are the fastest. Criteria such as data value, Member Name, and Member Alias/Description are faster because they are part of the metadata or data query. Avoid criteria such as Generation, Level, Account Type, and Attribute Value whenever possible, as performance is slower because those criteria are not part of the regular metadata or data query.
Applying Conditional Formatting on Grids

You can apply conditional formatting when working with grids in the Report Designer. First, you establish a condition for the selected cells. Then you specify formatting for values that meet that condition.

➤ To apply conditional formatting:

1 Create a grid in a report, or open an existing report containing a grid.
2 Select the cells to which you want to apply conditional formatting.
3 Select Format > Conditional Format to access the Conditional Format dialog box.
4 From the Select Property drop-down list box, select a property.

**Note:**

Your property selection determines the options that are available in the drop-down list boxes.

The following table lists each conditional formatting property with the applicable data sources.

<table>
<thead>
<tr>
<th>Property</th>
<th>Data Source Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cell Value</td>
<td>Essbase, Planning Details, Financial Management, SAP BW, Microsoft Analysis Services</td>
</tr>
<tr>
<td>Row Value</td>
<td>Essbase, Planning Details, Financial Management, SAP BW, Microsoft Analysis Services</td>
</tr>
<tr>
<td>Column Value</td>
<td>Essbase, Planning Details</td>
</tr>
<tr>
<td>Property</td>
<td>Data Source Usage</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Financial Management</td>
</tr>
<tr>
<td></td>
<td>SAP BW</td>
</tr>
<tr>
<td></td>
<td>Microsoft Analysis Services</td>
</tr>
<tr>
<td>Current Cell Value</td>
<td>Essbase</td>
</tr>
<tr>
<td></td>
<td>Planning Details</td>
</tr>
<tr>
<td></td>
<td>Financial Management</td>
</tr>
<tr>
<td></td>
<td>SAP BW</td>
</tr>
<tr>
<td></td>
<td>Microsoft Analysis Services</td>
</tr>
<tr>
<td>Member Name</td>
<td>Essbase</td>
</tr>
<tr>
<td></td>
<td>Planning Details</td>
</tr>
<tr>
<td></td>
<td>Financial Management</td>
</tr>
<tr>
<td></td>
<td>SAP BW</td>
</tr>
<tr>
<td></td>
<td>Microsoft Analysis Services</td>
</tr>
<tr>
<td>Position Within</td>
<td>Essbase</td>
</tr>
<tr>
<td></td>
<td>Financial Management</td>
</tr>
<tr>
<td></td>
<td>Planning</td>
</tr>
<tr>
<td></td>
<td>Microsoft Analysis Services</td>
</tr>
<tr>
<td></td>
<td>SAP BW</td>
</tr>
<tr>
<td></td>
<td>The Position Within property allows designers to format the first or last row or column of a data segment with multiple members or a member function. For example, to set the condition of the top row in a multiple member row or column, the conditions would resemble the following example:</td>
</tr>
<tr>
<td></td>
<td>Condition 1: If</td>
</tr>
<tr>
<td></td>
<td>Position Within Row Is Top Row, then</td>
</tr>
<tr>
<td></td>
<td>Format Cells = $.</td>
</tr>
<tr>
<td>Description</td>
<td>Financial Management</td>
</tr>
<tr>
<td>Alias</td>
<td>Essbase</td>
</tr>
<tr>
<td></td>
<td>Planning Details</td>
</tr>
<tr>
<td></td>
<td>SAP BW</td>
</tr>
<tr>
<td></td>
<td>Microsoft Analysis Services</td>
</tr>
<tr>
<td>Generation</td>
<td>Essbase</td>
</tr>
<tr>
<td></td>
<td>Planning Details</td>
</tr>
<tr>
<td></td>
<td>SAP BW</td>
</tr>
<tr>
<td></td>
<td>Microsoft Analysis Services</td>
</tr>
<tr>
<td>Relative Generation</td>
<td>Essbase</td>
</tr>
<tr>
<td>Property</td>
<td>Data Source Usage</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Level</td>
<td>Essbase</td>
</tr>
<tr>
<td></td>
<td>Planning Details</td>
</tr>
<tr>
<td></td>
<td>Financial Management</td>
</tr>
<tr>
<td>Account Type</td>
<td>Essbase</td>
</tr>
<tr>
<td></td>
<td>Planning Details</td>
</tr>
<tr>
<td></td>
<td>Financial Management</td>
</tr>
<tr>
<td>Авто Расчет</td>
<td>Essbase</td>
</tr>
<tr>
<td></td>
<td>Planning Details</td>
</tr>
<tr>
<td></td>
<td>Financial Management</td>
</tr>
<tr>
<td></td>
<td>SAP BW</td>
</tr>
<tr>
<td></td>
<td>Microsoft Analysis Services</td>
</tr>
<tr>
<td>Авто Расчет Группы Заголовков</td>
<td>Essbase</td>
</tr>
<tr>
<td></td>
<td>Planning Details</td>
</tr>
<tr>
<td></td>
<td>Financial Management</td>
</tr>
<tr>
<td>Attribute Value</td>
<td>Essbase</td>
</tr>
<tr>
<td>Line Item Detail</td>
<td>Financial Management</td>
</tr>
<tr>
<td>Supporting Detail</td>
<td>Planning Details</td>
</tr>
<tr>
<td>Expand Level — Specify a condition which is dependent on the expand level of a row or column dimension (how many times a dimension has been expanded).</td>
<td>Essbase</td>
</tr>
<tr>
<td></td>
<td>Planning Details</td>
</tr>
<tr>
<td></td>
<td>Financial Management</td>
</tr>
<tr>
<td></td>
<td>SAP BW</td>
</tr>
<tr>
<td></td>
<td>Microsoft Analysis Services</td>
</tr>
</tbody>
</table>

5. From the Reference Value drop-down list box, select a value corresponding to the property value you selected from the Select Property drop-down list box.

6. Select an operator:
   - = (is equal to)
   - < > (less than or greater than)
   - > (greater than)
   - < (less than)
   - >= (greater than or equal to)
   - <= (less than or equal to)
   - equals (is equal to)
   - not equals (is not equal to)
   - starts with
ends with
contains
Is

Note:
The full list of operators may not be displayed at the same time, as they rely on previous formatting selections.

7 Select one of the following comparison options:
- Number—Enables the assignment of a certain value to a cell.
- Cell Value—Returns the cell location; for example, A, 3.
- Row Value—Returns the number of the row.
- Column Value—Returns the letter of the column.
- Zero—Assigns zero value for condition.
- No Data—Indicates no data value for selection.
- Invalid—For a Financial Management data source only, indicates an inactive or invalid value.
- Error—Assigns the condition as an error.
- String—Enables the definition of a string for the condition.
- 0, 1, 2—Indicates the number of levels or generations in the selected dimension.

Note:
The options in the drop-down list depend on your property selection.

8 To add another condition, click the Add Format 2 button. Repeat step 4 through step 7 to continue adding conditions.

Note:
The number on this button changes to as many as 7 as you add conditions.

9 Select And to combine this condition with the next condition, or select Or to distinguish this condition from the next condition.

10 Click Format Cells to assign a format to the condition. For more information, see “Formatting Grids” on page 165.

11 Use the Allow Not and Allow Parentheses check boxes, located in the Options section of the Conditional Format dialog box, to establish logic for conditions:
- Allow Not enables you to negate a condition.
- Allow Parentheses enables you to define precedence, or order of consideration for conditions, and specify the set of conditions as intended.

12 When you finish adding conditions for Format 1, perform an action:
To return to the grid in your report, click OK.

To add another format to your selection, click Add Format 2. For more information, see “Adding Conditional Formats” on page 186.

Deleting Conditions

You can delete a condition if it is no longer applicable to the grid, cell, row, or column. This functionality enables you to delete a single condition rather than an entire format, which can hold as many as seven conditions. For information on deleting formats, see “Deleting Conditional Formats” on page 187.

➤ To delete conditions:

1. Create a grid in a report in the Report Designer, or open an existing report containing a grid with conditional formatting applied.
2. Select a grid or one or more cells, rows, or columns in a grid to which conditional formatting is applied.
4. In the Conditional Format dialog box, click the Delete Format button. Use the drop-down list to select the condition to delete.
5. Click OK.

Adding Conditional Formats

You can specify as many as seven formats when applying conditional formatting. For each format, you can create as many as seven conditions.

Additional formats are added to enable the application of multiple formats when different conditions are met. After a condition, or conditions, is formatted, you can add another format that is tied to the cell.

For example, you can create one format that contains row and column numerical conditions to be applied to the selected cell. Then, you can create another format that specifies text color, shading, or alignment for the selected cell.

➤ To add a format:

1. Create a grid in a report in the Report Designer, or open an existing report containing a grid.
2. Select the cells you want to format.
3. Select Format > Conditional Format to access the Conditional Format dialog box.
4. Add a condition to the cell, as described in “Applying Conditional Formatting on Grids” on page 182.
5. Click the Add Format #, where # is the number of the next format to be added.
6. Specify conditions to be included in the format.
7. To add more conditions and formats, repeat step 4 through step 6 as needed.
8 When completed, click OK.

**Changing the Order of Conditional Formats**

After you add multiple formats, you can change the order in which the conditions are evaluated and formats are applied to the selected cells. For example, suppose you specified a blue format for cells with a value of zero. In the second format, you specified a column value equal to the cell value and a row value equal to a specific number. Then, you specified a third format for the selected cell.

Using the arrows in the upper right corner of Conditional Format dialog box, you can change the order in which the formats are applied to a selected cell. The order of the formats is significant, because formats are absolute. The conditions created in the first format take precedence over the other formats and conditions.

➤ To change the order of the conditional formats:

1 Create a grid in a report in the Report Designer or open an existing report containing a grid.
2 Select the cells whose format order you want to modify.
3 Select Format > Conditional Format.
4 Add three formats, as described in “Adding Conditional Formats” on page 186.
5 Select the format tab whose order you want to change.
6 Do either of the following:
  ⚫ To move a formatted tab to the left, click the Move Left button.
  ⚫ To move a formatted tab to the right, click the Move Format Tab Right button.
7 Click OK to return to the grid.

**Deleting Conditional Formats**

You can delete a format when the conditions it contains are no longer applicable. For example, if a format contains six conditions and you delete the format, you delete all six conditions contained in that one format.

➤ To delete a format:

1 Create a grid in a report in the Report Designer, or open an existing report containing a grid.
2 Select a cell containing a numerical value with conditional formatting.

  **Note:**
  Cells with conditional formatting are indicated with a colored bar.
3 Click Format > Conditional Format.
4 Click **Delete Format**. From the drop-down list, select the format number you want to delete.

5 Click **OK** to return to the grid.

### Changing Row Height and Column Width

You can change row heights and column widths in grids. You can apply these changes to the entire grid or to specific rows or columns.

➤ To change row height and column width:

1 Create a grid in a report in the Report Designer, or open an existing report containing a grid.

2 Select the rows or columns to format.

3 Perform an action:

   ● To specify the row height, select a row and enter a value in the **Row Height** field on the **Row Properties** property sheet.

   **Tip:**
   You can also use the arrows to increase or decrease the value.

   ● To specify the column width, select a column and enter a value in the **Column Width** field on the **Column Properties** property sheet.

   **Tip:**
   You can also drag the handle of a row or column in the grid to the desired size. If you make a row or column too small to see, when the pointer becomes a split line, drag the row or column handle until the row or column is visible.

### Merging Cells into One Cell

You can combine two or more cells into one cell in a grid. For example, you can combine several cells to create one data cell, text cell, or formula cell. When you merge cells, the value and format of the upper-left cell is placed into the resulting merged cell. When the merged cell is separated into individual cells, all resulting cells inherit the formatting of the previously merged cell.

**Note:**

Text automatically wraps within a grid’s cell. When print previewing PDF reports in Workspace, text cells with long text are automatically merged into the next cell to the right, if that cell is empty. When previewing HTML reports, text cells are not automatically merged. You may want to use the Merge feature, along with increasing the column width, to expand the area for text to display (the rows height automatically adjusts to display all text).
To merge cells:
1 Open a report that contains a grid.
2 Select the cells to merge.
3 Right-click the selected cells, then select Merge.

Tip:
To change the formatting of the merged cell, such as changing the alignment and font selection, select Format > Cells.

To separate a merged cell into individual cells:
1 Open a report that contains a grid.
2 Select the merged cell.
3 Right-click the selected cell, then select Merge. The resulting cells inherit the formatting of the previously merged cell.

Conditional Suppression

You can suppress the display of rows, columns, or grids using one or both of the following methods:

- Use the Basic option to suppress rows, columns, or grids based upon If Zero, If Missing, and If Error. For procedures, see “Using the Basic Option in Conditional Suppression” on page 191.
- Use the Advanced option to suppress rows, columns, or grids based on a variety of attributes. For example, you can specify that if a row contains cells with values below 100, the entire row is suppressed. For more information on using this type of conditional suppression, see “Using the Advanced Option in Conditional Suppression” on page 192.

Behavior of Conditional Suppression

Conditional suppression behaves in the following manner:

- If an entire row or column meets the criteria specified for conditional suppression, the entire row or column is hidden; if only some of the cells in a row or column meet the criteria specified for conditional suppression, the row or column is not hidden.
- Suppressed data is not included in calculations. For example, if you suppress rows 23 and 24 and then calculate a sum for rows 10 through 30, the sum does not include the values in rows 23 and 24.

Note:
When evaluating suppression, you can include or ignore the values and calculations in hidden rows and columns. This option is enabled only when the Hide Always check box is
selected for the row or column. For instructions on this option, see “Controlling the Evaluation of Suppression in Hidden Rows or Columns” on page 177. Regardless of the setting you select, you can evaluate suppression based on hidden cells when you specifically reference the cells by using the Advanced Options method for conditional suppression.

- Hidden cells are ignored when evaluating suppression of a row or column unless they are specifically referenced. The output of the report is based on the condition used. The following example is a report with hidden columns.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B (Hidden Column)</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>East</td>
<td>West</td>
<td>South</td>
</tr>
<tr>
<td>2</td>
<td>Cola</td>
<td>Missing</td>
<td>Missing</td>
</tr>
<tr>
<td>3</td>
<td>Root Beer</td>
<td>Missing</td>
<td>61</td>
</tr>
<tr>
<td>4</td>
<td>Diet</td>
<td>61</td>
<td>Missing</td>
</tr>
</tbody>
</table>

The above report design is used to describe three conditional suppression scenarios.

**Note:**

In the following 3 examples, column B is hidden and rows 1, 2, and 3 are selected for conditional suppression.

The first example describes the results when specifying suppression based on missing data. Note that because the condition does not reference the hidden column or a specific cell in the hidden column, the hidden column is ignored:

**Suppress Row If:** Data Values in Current Row = No Data

<table>
<thead>
<tr>
<th></th>
<th>East</th>
<th>South</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diet</td>
<td>61</td>
<td>Missing</td>
</tr>
</tbody>
</table>

The following example describes the results when specifying suppression based on the data cells in the hidden column B. Note that since the condition specifies the hidden column B, Root Beer is not suppressed because cell B2 contains data:

**Suppress Row If:** Data Values in Column B = No Data

<table>
<thead>
<tr>
<th></th>
<th>East</th>
<th>South</th>
</tr>
</thead>
<tbody>
<tr>
<td>Root Beer</td>
<td>Missing</td>
<td>Missing</td>
</tr>
<tr>
<td>Diet</td>
<td>61</td>
<td>Missing</td>
</tr>
</tbody>
</table>

The following example describes the results when specifying suppression based on a specific cell in hidden column B. Note that since the specified hidden cell, B2, contains data, all rows are displayed:

**Suppress Row If:** Data/Formula Value in Cell B,2 = No Data

<table>
<thead>
<tr>
<th></th>
<th>East</th>
<th>South</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cola</td>
<td>Missing</td>
<td>Missing</td>
</tr>
<tr>
<td>Root Beer</td>
<td>Missing</td>
<td>Missing</td>
</tr>
<tr>
<td>Diet</td>
<td>61</td>
<td>Missing</td>
</tr>
</tbody>
</table>
When you use conditional suppression based on attributes, you can suppress formula rows or columns based on the suppression status of other data rows or columns. You can suppress text rows or columns based on the suppression status of other rows and columns.

**Note:**

You cannot suppress data rows or columns based on the values of formula rows or columns.

The following table describes whether suppression is valid when referencing another suppressed data, formula, or text row or column.

<table>
<thead>
<tr>
<th>If the Row / Column Type you are suppressing =</th>
<th>And if suppression is based on Row / Column of Type =</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data</td>
<td>Data</td>
</tr>
<tr>
<td>Data</td>
<td>Available</td>
</tr>
<tr>
<td>Formula</td>
<td>Available</td>
</tr>
<tr>
<td>Text</td>
<td>Available</td>
</tr>
</tbody>
</table>

**Using the Basic Option in Conditional Suppression**

Use basic conditional suppression to suppress data in rows or columns based on If Zero, If Missing, Is Error. Basic conditional suppression can be combined with advanced suppression options. See “Using the Advanced Option in Conditional Suppression” on page 192.

To suppress data:

1. Create a grid in a report in the Report Designer, or open an existing report containing a grid.
2. Select the grid, rows, or columns to which you want to apply suppression.
3. In the Row or Column Properties sheet, click the Basic Options button.

**Note:**

If you selected a grid, first select the Suppression category in the Grid Properties property sheet.

4. Select one or more of the following options:
   - Select If Zero, Suppress to hide the rows or columns where all cell values equal zero.
   - Select If Missing, Suppress to hide the rows or columns where all cells are empty.
   - Select If Error, Suppress to hide the rows or columns where data cannot be retrieved or calculated because of errors.

5. Optional: To replace #ZERO, #MISSING, or #ERROR values in a row or column that cannot be hidden, take one or more of the following actions:
**Note:**
You must have a grid selected and select the Suppression category in the Grid Properties property sheet.

- To replace zero (#ZERO) values in cells, type a value in the **Zero Values** text box.
- To replace no data (#MISSING) in cells, type a value in the **No Data** text box.
- To replace erroneous data (#ERROR) in cells, type a value in the **Error** text box.

6 To select all options and specify customized suppression criteria, select **Advanced Options**.

### Using the Advanced Option in Conditional Suppression

The Advanced Option is used to suppress rows or columns in a grid based on specified attributes or values. Conditional suppression can be simple or complex, and can contain a maximum of seven conditions. Advanced conditional suppression can be combined with basic suppression options. See “Using the Basic Option in Conditional Suppression” on page 191.

When you define conditions, you can include the Not operator to suppress rows or columns that do not meet the condition (that result in false), and parenthesis to enclose and separate conditions from other conditions. Conditional suppression may be based on data or formula values.

➤ To apply conditional suppression:

1 Create a report, or open an existing report containing a grid.
2 Select the rows, columns, or grid to which you want to apply suppression.
3 In the property sheet, click **Advanced Options**, then click the Setup button to display the Conditional Suppression dialog box.

**Note:**
If you selected a grid, first select the **Suppression** category in the Grid Properties property sheet.

Conditional Suppression displays a **Basic Options** label above the suppression options. Basic options use OR operators:

- Basic Options:None—Basic options not selected with Advanced options.
- If Zero, Suppress OR ...—If Zero selected with Advanced options.
- If Zero OR Missing, Suppress OR ...—If Zero and If Missing selected with Advanced options.
- If Zero OR Error, Suppress OR ...—If Zero and If Error selected with Advanced options.
- If Zero OR Missing OR Error, Suppress OR ...—If Zero, If Missing and If Error selected with Advanced options.
- If Missing, Suppress OR ...If Missing selected with Advanced options.
● If Missing OR Error, Suppress OR ...If Missing and If Error selected with Advanced options.
● If Error, Suppress OR ...If Error selected with Advanced options.

From Suppress Row or Column If, select a property.

The property selected determines which options are available in the drop-down lists for your expression. The following table lists each property with the default reference, operator, and comparison values. The default values are displayed automatically and can be changed.

<table>
<thead>
<tr>
<th>Property</th>
<th>Data Source Usage</th>
</tr>
</thead>
</table>
| Data/Formula Value in Cell| Essbase
                                 | Financial Management
                                 | Planning Details
                                 | SAP BW                      |
| Data Values in Row        | Essbase
                                 | Financial Management
                                 | Planning Details
                                 | SAP BW                      |
| Data Values in Column     | Essbase
                                 | Financial Management
                                 | Planning Details
                                 | SAP BW                      |
| Data Values in Current Row| Essbase
                                 | Financial Management
                                 | Planning Details
                                 | SAP BW                      |
| Member Name               | Essbase
                                 | Financial Management
                                 | Planning Details
                                 | SAP BW                      |
| Description               | Financial Management                     |
| Alias - Default           | Essbase
                                 | Planning Details                     |
## Property | Data Source Usage
--- | ---
Generation | Essbase
Planning Details | SAP BW
Level | Essbase
Planning Details | SAP BW
Account Type | Essbase
Financial Management | Planning Details
Auto Calculation | Essbase
Financial Management | Planning Details
SAP BW | Planning Details
Line Item Detail | Financial Management
Attribute Value | Essbase
Supporting Detail | Planning Details

5. From the Reference Value drop-down list box, select a value corresponding to the property value you selected from the Suppress Row or Column If drop-down list box.

6. Select one of the following operators, if applicable:

**Note:**

The available operators depend on your property selection.

- < > (less than or greater than)
- > (greater than)
- > = (greater than or equal to)
- < (less than)
- < = (less than or equal to)
- not equals (is not equal to)
- starts with
- ends with
- contains
- Is

7. Select one of the following comparison options, if applicable:
Note:
The available comparison options depend on your property selection.

- **Number**—Enables the assignment of a certain value to a cell.
- **Cell Value**—Returns the cell location; for example: A, 3.
- **Row Value**—Returns the number of the row.
- **Column Value**—Returns the letter of the column.
- **Zero**—Assigns zero value for condition.
- **No Data**—Indicates no data value for selection.
- **Invalid**—For a Financial Management data source only, indicates an inactive or invalid value.
- **Error**—Assigns the condition as an error.
- **string**—Enables the definition of a string for the condition.
- **1, 2, 3,...**—Indicates the number of levels or generations in the selected dimension.
- **Non Expense**—Assigns the condition as a nonexpense.
- **Expense**—Assigns the condition as an expense.
- **True**—Assigns a True value to the condition.

8 To add another condition, click the Add Condition 2 button.

Note:
The number on this button is increased to as many as 7 as you add conditions.

9 To combine the current condition with the following condition, select one of the following operators:
   - Select **And** if both combined conditions must be met.
   - Select **Or** if only one of the combined conditions must be met.

10 Optional: In the Options area, add one of the following logic options to your condition:
   - Select **Allow Not** to allow suppression only if the condition is not met.
   - Select **Allow Parentheses** to define precedence, or order of consideration for the conditions, then specify the set of conditions as intended.

11 To add another condition, click the Add Condition 3 button.

12 Click **OK** to return to the grid in your report.

**Deleting Conditional Suppression**
You can delete conditional suppression if it is no longer applicable. This functionality enables you to delete one condition at a time, which can hold as many as seven conditions.
To delete conditional suppression:

1. Open a report that contains a grid with conditional suppression.
2. Select the rows, columns, or grid to which conditional suppression is applied. The Advanced Options button in the property sheet is selected.
3. In the property sheet, click Setup to display the Conditional Suppression dialog box.

   **Note:**
   If you selected a grid, first select the Suppression category in the Grid Properties property sheet.
4. In the Conditional Suppression dialog box, click Delete Condition. In the drop-down list, click the condition to delete. Repeat to delete additional conditions.
5. Click OK.

### Formatting Images

You can format the display of images in your report. For example, once you place an image, you can stretch the image, insert a page break before the image, and specify horizontal and vertical positions for the image.

To format images in a report:

1. Open a report and select an image to format.
2. To expand or shrink the image to fill the size of the image boundary on the Report Designer workspace, select Stretch on the Image Properties property sheet.

   **Tip:**
   To resize the image manually, click and drag a handle. If the stretch option is not selected, only the box around the image is resized.
3. **Optional:** To set the horizontal positioning of a printed image, do one of the following tasks in the Horizontal drop-down list box:
   - To position the printed image relative to an object to its left, select Relative.
   - To position the printed image to the left side of the report, select Left.
   - To position the printed image in the middle of the report, select Center.
   - To position the printed image to the right of the report, select Right.
   - To position the printed image at its current location regardless of whether report objects to its left change in size, select None.
4. **Optional:** To set the vertical positioning of a printed image, do one of the following tasks in the Vertical drop-down list box:
   - To position the printed image relative to an object above it, select Relative.
   - To position the printed image on the top of the report, select Top.
To position the printed image to the middle of the report, select Middle.

To position the printed image to the bottom of the report, select Bottom.

To position the printed image at its current location regardless of whether report objects above it change in size, select None.

5 To start the image on a new page when it is printed, select the Page Break Before check box.

6 To move the image, click the image and, with all borders activated, drag it to another location.

Note:

Do not click and drag the borders of the image, because this stretches the image vertically or horizontally. Be sure to click the entire image.

Changing the Page Setup

You can alter page settings that control how your reports are printed or viewed. You can change the paper size, page orientation, heading display settings, default width and length for the report, and create a custom size for the work area. You can also specify whether cell documents print with consecutive page numbers or print the page settings on each document.

To change the page setup:

1 Open a report and select File > Page Setup.

2 Select the Page tab.

3 Select Letter, Legal, Ledger, A4 or A3 to specify the paper size.

4 When you print a report with Cell Document attachments enabled, the file attachment page numbers can be renumbered to reflect the page numbers of the report. For example, a nine page report with a five page Word document attached can renumber the Word document output to reflect the page number 10 to 15. To print consecutive page numbers on cell documents, select Consecutive Page Numbers. To print the page numbers as specified on each cell document, clear Consecutive Page Numbers. To learn more about cell documents, see “Attaching Cell Documents in a Report” on page 149.

5 Select Portrait or Landscape to set the orientation.

6 Set the display of row and column headings on your report:
a. To display the row heading on every page of the report, select the **Row Headings on Each Page** check box. Clear this check box to display the row heading only once, on the first page of the report.

b. To display the column heading on every page of the report, select the **Column Headings on Each Page** check box. Clear this setting to display the column heading only once, on the first page of the report.

**Note:**

The default selections include row headings and column headings on each page.

7 **Optional:** Enable the following options to fit the length or width of your report on one page.

- To scale the width of the report so that it fits on one page, select the **Fit Width to Page** check box. Deselect this setting to retain the original dimensions specified in the Design mode.

- To scale the length of the report so that it fits on one page, select the **Fit Length to Page** check box. Deselect this setting to retain the original dimensions specified in the Design mode.

**Note:**

If you select Fit Width to Page, you cannot insert a column page break. If you select Fit Length to Page, you cannot insert a row page break.

8 Select the **Margins** tab and enter values in the margin text boxes. You can specify a value for the top, bottom, left, and right margins. To adjust the margins, use one of the following methods:

- Use the up and down scroll arrows to adjust the margins of your report by increments of 100th of an inch.

- Type the margin settings for your report, in inches.

**Note:**

The Margins tab shows a preview of your report using the margins you specify.
9 Optional: Select the **Workspace Size** tab and then select the **Use a Custom Workspace Size** check box to specify dimensions for the workspace that are different than the paper size specified on the **Page** tab. To specify a workspace size, use one of the following methods:

- Use the up and down scroll arrows to adjust the report workspace size by increments of 100th of an inch.
- Type a width and height for your workspace, in inches.

**Note:**

Neither the height nor the width can exceed 20 inches.

10 When you are finished modifying the **Page Setup** options, click **OK**.
# Using Functions

## In This Chapter

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mathematical Functions</td>
<td>202</td>
</tr>
<tr>
<td>Text Functions</td>
<td>208</td>
</tr>
<tr>
<td>List of Functions</td>
<td>214</td>
</tr>
<tr>
<td>CalcStatus</td>
<td>217</td>
</tr>
<tr>
<td>CellText</td>
<td>218</td>
</tr>
<tr>
<td>CountA</td>
<td>222</td>
</tr>
<tr>
<td>DataSource</td>
<td>222</td>
</tr>
<tr>
<td>Date</td>
<td>224</td>
</tr>
<tr>
<td>Difference</td>
<td>226</td>
</tr>
<tr>
<td>Eval</td>
<td>227</td>
</tr>
<tr>
<td>GetCell</td>
<td>228</td>
</tr>
<tr>
<td>GetHeading</td>
<td>229</td>
</tr>
<tr>
<td>ListOfCellDocuments</td>
<td>231</td>
</tr>
<tr>
<td>IfThen, If</td>
<td>233</td>
</tr>
<tr>
<td>Max</td>
<td>236</td>
</tr>
<tr>
<td>MemberAlias</td>
<td>236</td>
</tr>
<tr>
<td>MemberDescription</td>
<td>237</td>
</tr>
<tr>
<td>MemberName</td>
<td>239</td>
</tr>
<tr>
<td>MemberProperty</td>
<td>240</td>
</tr>
<tr>
<td>MemberQualifiedName</td>
<td>241</td>
</tr>
<tr>
<td>Min</td>
<td>242</td>
</tr>
<tr>
<td>Mod</td>
<td>243</td>
</tr>
<tr>
<td>Page</td>
<td>244</td>
</tr>
<tr>
<td>PageCount</td>
<td>244</td>
</tr>
<tr>
<td>PercentOfTotal</td>
<td>245</td>
</tr>
<tr>
<td>Pi</td>
<td>246</td>
</tr>
<tr>
<td>PlanningAnnotations</td>
<td>246</td>
</tr>
<tr>
<td>POVAlias</td>
<td>249</td>
</tr>
<tr>
<td>POVDescrion</td>
<td>249</td>
</tr>
<tr>
<td>POV / POVMember</td>
<td>250</td>
</tr>
<tr>
<td>ProcessManagementStatus</td>
<td>250</td>
</tr>
<tr>
<td>Product</td>
<td>251</td>
</tr>
<tr>
<td>Random</td>
<td>252</td>
</tr>
</tbody>
</table>
You use functions to create formulas. A formula is a series of functions and operators that produce data shown in a report. Financial Reporting functions are organized into two groups: mathematical functions and text functions. This chapter provides information about how to use functions.

Mathematical Functions

You use mathematical functions to perform calculations on numeric values or data from a grid. This section lists the mathematical functions and an explanation of the syntax. Mathematical functions, formulas, and their syntax are not case-sensitive. For more information on using mathematical functions, see “Defining Formula Rows or Columns” on page 128. The following table lists the mathematical functions:

<table>
<thead>
<tr>
<th>Mathematical Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abs</td>
<td>Returns the absolute value of numeric values or references.</td>
</tr>
<tr>
<td>Average</td>
<td>Returns the average of a group of numeric values or references.</td>
</tr>
<tr>
<td><strong>Mathematical Function</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td><strong>AverageA</strong></td>
<td>Returns the average of a group of numeric values or references. The calculation includes #missing and #error cells only for rows or columns that are not suppressed.</td>
</tr>
<tr>
<td><strong>Count</strong></td>
<td>Returns the number of cells in a group of numeric values or references.</td>
</tr>
<tr>
<td><strong>CountA</strong></td>
<td>Returns the number of values in a group of numeric values or references. The calculation includes missing and error cells only for rows or columns that are not suppressed.</td>
</tr>
<tr>
<td><strong>Difference</strong></td>
<td>Returns the absolute value of a numeric value or reference subtracted from another numeric value or reference.</td>
</tr>
<tr>
<td><strong>Eval</strong></td>
<td>Evaluates an expression. Eval is useful for embedding expressions as function arguments.</td>
</tr>
<tr>
<td><strong>IfThen, If</strong></td>
<td>Returns one value if a condition equals true, and another value if a specified condition equals false.</td>
</tr>
<tr>
<td><strong>Max</strong></td>
<td>Returns the maximum value of a group of numeric values or references.</td>
</tr>
<tr>
<td><strong>Min</strong></td>
<td>Returns the minimum value of a group of numeric values or references.</td>
</tr>
<tr>
<td><strong>Mod</strong></td>
<td>Returns the remainder, modulus, from a division formula.</td>
</tr>
<tr>
<td><strong>PercentOfTotal</strong></td>
<td>Returns the result of a numeric value or reference divided by another numeric value or reference, multiplied by 100.</td>
</tr>
<tr>
<td><strong>Pi</strong></td>
<td>Returns the number 3.14159265358979, to 15 digits.</td>
</tr>
<tr>
<td><strong>Product</strong></td>
<td>Multiplies all numbers or references and returns the product.</td>
</tr>
<tr>
<td><strong>Random</strong></td>
<td>Returns a random number between 0.0 and 1.0.</td>
</tr>
<tr>
<td><strong>Rank</strong></td>
<td>Returns the highest or lowest value of a specified column or row.</td>
</tr>
<tr>
<td><strong>Round</strong></td>
<td>Rounds a number up or down by specified digits.</td>
</tr>
<tr>
<td><strong>Sqrt</strong></td>
<td>Returns the square root of a numeric value, row, column, or cell.</td>
</tr>
<tr>
<td><strong>Sum</strong></td>
<td>Returns the sum of a group of numeric values or references.</td>
</tr>
<tr>
<td><strong>Truncate / Trunc</strong></td>
<td>Removes the specified number of digits from numeric values.</td>
</tr>
<tr>
<td><strong>Variance / Var</strong></td>
<td>Evaluates the difference between the specified values based on the account type for the current account.</td>
</tr>
<tr>
<td><strong>VariancePercent / VarPer</strong></td>
<td>Evaluates the difference, in percent, between the specified values based on account type for the current account.</td>
</tr>
</tbody>
</table>

The syntax for mathematical functions is as follows:

```
FunctionName(arguments)
```
Table 31  Mathematical Functions

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FunctionName</td>
<td>The name of a mathematical function.</td>
</tr>
<tr>
<td>arguments</td>
<td>A numeric value, a row, column, or cell reference, or an embedded function.</td>
</tr>
</tbody>
</table>

**Arguments**

Mathematical functions accept numeric values, row, column, or cell references, or embedded functions as arguments. There are four types of arguments:

- **Numeric Arguments**
- **Property Arguments**
- **Row, Column, or Cell Reference Arguments**
- **Embedded Functions as Arguments**

**Numeric Arguments**

The syntax for a numeric argument is

\[(\text{numeral}_1, \text{numeral}_2, \ldots, \text{numeral}_n)\]

where numerals 1 through n are any numbers including decimals and negative values. For example, the expression \(\text{Average}(10, 20, 30)\) returns the value 20.

**Row, Column, or Cell Reference Arguments**

The row, column, or cell argument identifies a row, column, or cell in a grid. The syntax is:

\(\text{FunctionName}(\text{GridName}.\text{GridElement}[\text{segment(range)}].\text{Property})\)

Table 32  Argument Components

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GridName</td>
<td>The name of a grid. For example:</td>
</tr>
<tr>
<td></td>
<td>Difference (grid1.row[5], grid2.row[5]) returns the difference of two rows</td>
</tr>
<tr>
<td></td>
<td>on grid1 and grid2.</td>
</tr>
<tr>
<td></td>
<td>Optional: If GridName is not specified, the default is the current grid</td>
</tr>
<tr>
<td></td>
<td>where the formula is entered.</td>
</tr>
<tr>
<td>GridElement</td>
<td>One of the following keywords: row, col, column, or cell.</td>
</tr>
<tr>
<td></td>
<td>For example, Max(row[1], row[2], row[3]) returns the maximum value of</td>
</tr>
<tr>
<td></td>
<td>three rows. The keyword row and column or col is optional. The cell reference</td>
</tr>
<tr>
<td></td>
<td>requires that row and column segment IDs be specified. For example, cell[2,</td>
</tr>
<tr>
<td></td>
<td>A] refers to the cell that is the intersection between row 2 and column A.</td>
</tr>
<tr>
<td></td>
<td>The keyword cell is optional. For example, [5,B] refers to the cell which</td>
</tr>
<tr>
<td></td>
<td>is the intersection between row 5 and column B. Cell references can use the</td>
</tr>
<tr>
<td></td>
<td>Optional. If a GridElement is specified, letters represent columns and</td>
</tr>
<tr>
<td></td>
<td>numbers represent rows; for example: Max ([1,A], [2,A], [3,A])</td>
</tr>
</tbody>
</table>
**Argument** | **Description**  
--- | ---  
*segment* | A row, column, or cell reference number of a grid. For an expanded row or column, you must specify the segment. For example, row[2] addresses row segment 2. For more information on segments, see “Expressing the Segment Argument” on page 130. Segments are enclosed in square brackets [ ]. Required. 

*range* | The rows, columns, or cell that are expanded from the specified segment. If range is specified, the system calculates the formula using only the specified range. For example, row[2(3:5)] uses only the 3rd through 5th rows of expanded segment 2. For more information on ranges, see “Expressing the Range Argument” on page 132.  
Optional: When range is not provided, all expanded cells are used.  
**Note:** If a segment expands to only one row or column, do not use the range argument.  

*property* | One of the following keywords: average, averageA, count, countA, max, min, product, and sum. The property is used to aggregate the expanded rows, columns, or cells specified.  
Hyperion recommends that property is *not* specified when a reference is an argument. By not specifying the property, the function calculates the reference in the most appropriate way. For example, the following expression returns the average of the cells within rows 1 and 2:  

```
Average(row[1], row[2])
```

Whereas the following example first calculates the average of row[1], then the average of row[2], adds these 2 results, then divides by 2:  

```
Average(row[1].average, row[2].average)
```

The default property for a row, column, or cell reference which is *not* used as a function argument is the sum property. For example, the following expression’s default property is sum: `row[2]`.  
For more information on properties, see “Property Arguments” on page 205.  
Optional.

Because segment is the only required part of a reference, the following references are the same:

```
Grid1.row[1].sum
```

AverageA and CountA include #missing and #error cells in the calculation. For example, if row 1 is a segment row that expands to Qtr1 = 100, Qtr2 = 200, Qtr3 = #missing, and Qtr4 = 400, the following function returns the value four (4):  

```
row[1].CountA
```

All other functions exclude #missing data or #error cells. For example, the previous example of row 1 that expands to Qtr1 = 100, Qtr2 = 200, Qtr3 = #missing, and Qtr4 = 400, returns three in this example:  

```
row[1].Count
```

**Property Arguments**

Property arguments are a way to consolidate expanded references to a single value which is then used in the calculation. You use property arguments to perform calculations on an aggregate row, column, or cell. The next sections explain the following property arguments:
Aggregate Property Argument

An aggregate row, column, or cell contains multiple rows, columns, or cells, respectively.

The aggregate property argument is the last argument in the following mathematical function syntax:

```
FunctionName(GridName.Gridelement[segment(range)].property)
```

You apply aggregate properties to a row, column, or cell reference. The following table lists the aggregate properties:

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average</td>
<td>Returns the average of a row, column, or cell. The calculation excludes #missing and #error values.</td>
</tr>
<tr>
<td>AverageA</td>
<td>Returns the average of a row, column, or cell. The calculation includes #missing and #error values.</td>
</tr>
<tr>
<td>Count</td>
<td>Returns the number of values in a row, column, or cell. The calculation excludes #missing and #error values.</td>
</tr>
<tr>
<td>CountA</td>
<td>Returns the number of values in a row, column, or cell. The calculation treats #missing and #error values as zero (0).</td>
</tr>
<tr>
<td>Max</td>
<td>Returns the maximum value of a row, column, or cell.</td>
</tr>
<tr>
<td>Min</td>
<td>Returns the minimum value of a row, column, or cell.</td>
</tr>
<tr>
<td>Product</td>
<td>Returns the product of rows or columns.</td>
</tr>
<tr>
<td>Sum</td>
<td>Returns the sum of a row, column, or cell.</td>
</tr>
</tbody>
</table>

When used as a mathematical function argument, the default for property is the same as the function. In the following example the default property is Average:

```
Average(row[2])
```

When not used as a mathematical function argument, the default for property is sum. In the following example the default property is the sum of an aggregate row:

```
row[2]
```

Reference Property Argument

A reference property argument specifies how to treat formula reference results and is used in conjunction with the other properties.

There is one reference property argument: IfNonNumber/IFFN.

IfNonNumber specifies a replacement of #Missing and #Error values with a specific numeric value. The syntax is:
AXIS[segment(range)].IfNonNumber(arg).AggregateProperty

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AXIS</td>
<td>One of the following keywords: row, column, or cell. Optional.</td>
</tr>
<tr>
<td>Segment(range)</td>
<td>Indicates any valid axis reference, such as a row number, column letter.</td>
</tr>
<tr>
<td>IfNonNumber</td>
<td>Indicates how to treat missing or error data within the Axis Ref.</td>
</tr>
<tr>
<td>(arg)</td>
<td>Indicates what number to use if missing or error data is encountered within the AxisRef.</td>
</tr>
<tr>
<td>AggregateProperty</td>
<td>The aggregate function is used for aggregate segments. For more information on AggregateProperty, see &quot;Aggregate Property Argument&quot; on page 206. Optional.</td>
</tr>
</tbody>
</table>

For example:
If cell[1,A] = 3 and cell[1,B] = #Missing,
The expression:
   cell[1,A] / cell[1,B]
returns #Error.
The expression:
   cell[1,A] / cell[1,B].ifNonnumber(1)
replaces cell[1,B] with 1 and returns a 3.

**Note:**
If you use suppression for #Missing or #Error in a grid, and the grid contains a formula row or column that uses the IfNonNumber property, #Missing and #Error remain suppressed.

**Note:**
When using a Financial Management database connection, and the MissingValuesAreZeroInFormulasInHFM option in the fr_repserver.properties file is set to one (1), the #Missing value is zero regardless of the setting of the IfNonNumber property. However, if the file is set to zero, the IfNonNumber property behaves as described.

**Embedded Functions as Arguments**
You can embed functions as arguments within a function.

**Example:**
In the following example, the function Average is embedded in the function Sum:
sum(row[3:5], avg(row[4:6], 40, 50), row[7; 9], 70, 80)

- Row segments 3, 4 and 5
- The average of row segments 4, 5 and 6, with the numbers 40 and 50
- Row segments 7 and 9
- The numbers 70 and 80

Text Functions

Text functions return report information, such as the report name or the report description. You use text functions in grids or in text objects. You enclose text functions in braces as follows:

```
<<TextFunction (arguments) >>
```

You can use spaces between arguments. All of the arguments are enclosed in quotes, except for numeric arguments.

Note:

Arguments related to date formatting are case-sensitive.

You apply text functions to a grid by creating a text row or column, or a heading cell, and then inserting the text function.

Text Function Consideration

When a parameter within a text function contains non-alphanumeric characters, Hyperion recommends that it be enclosed within quotes. For example, the parameter “NYC, New York” within the function `<<POVMember("Grid1", "NYC, New York")>>` should be re-stated as `<<POVMember("Grid1", "NYC, New York")>>`.

The following table lists the text functions:

<table>
<thead>
<tr>
<th>Text Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CalcStatus</td>
<td>Returns the calculation status of a cell in a Financial Management database connection.</td>
</tr>
</tbody>
</table>
| CellText      | Retrieves the textual content from a Financial Management or Essbase database connection as follows:  
  - With Financial Management, retrieves textual content associated with a cell.  
  - With Planning, retrieves cell annotations associated with a cell.  
  - With Essbase, retrieves the textual content from a Linked Reporting Object (LRO) from an Essbase cell (CellText only applies to a Cell note LRO). |
<p>| DataSource    | Returns the server name, application name, database name, or alias table of a grid. |</p>
<table>
<thead>
<tr>
<th>Text Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Returns the date and/or time that an online report is populated with data.</td>
</tr>
<tr>
<td>GetCell</td>
<td>Returns a data value from a cell in a grid.</td>
</tr>
<tr>
<td>GetHeading</td>
<td>Returns text headings in a grid.</td>
</tr>
<tr>
<td>GridDimension</td>
<td>Returns the name of a dimension on a grid axis, based on a numeric index or</td>
</tr>
<tr>
<td></td>
<td>the position of the current cell.</td>
</tr>
<tr>
<td>HFMCurrency</td>
<td>Returns the ID of the currency property for a cell in a Financial Management</td>
</tr>
<tr>
<td></td>
<td>database connection.</td>
</tr>
<tr>
<td>ListOfCellDocuments</td>
<td>Returns a list of all cell documents that are selected in a report.</td>
</tr>
<tr>
<td>MemberAlias</td>
<td>Returns the alias of the member assigned to a dimension in the grid row,</td>
</tr>
<tr>
<td></td>
<td>column, or page. Available only for Essbase and Planning Details.</td>
</tr>
<tr>
<td>MemberDescription</td>
<td>Returns the description of the member assigned to a dimension in the grid</td>
</tr>
<tr>
<td></td>
<td>row, column, or page. Available only for Financial Management.</td>
</tr>
<tr>
<td>MemberName</td>
<td>Returns the name of the member assigned to a dimension in the grid row,</td>
</tr>
<tr>
<td></td>
<td>column, or page.</td>
</tr>
<tr>
<td>MemberProperty</td>
<td>Returns the value of member properties within a text cell or text object for</td>
</tr>
<tr>
<td></td>
<td>a Essbase, Planning Details, or SAP BW database connection.</td>
</tr>
<tr>
<td>MemberQualifiedName</td>
<td>With a Essbase data source, returns the qualified non unique name of the</td>
</tr>
<tr>
<td></td>
<td>member assigned to a dimension in the grid row, column, or page. Available</td>
</tr>
<tr>
<td></td>
<td>only for Essbase 9.0 or later releases.</td>
</tr>
<tr>
<td>Note:</td>
<td></td>
</tr>
<tr>
<td>Page</td>
<td>Returns the current page number in a printed report. This is used in only a</td>
</tr>
<tr>
<td></td>
<td>text object.</td>
</tr>
<tr>
<td>PageCount</td>
<td>Returns the total number of pages in a printed report. This is used only in</td>
</tr>
<tr>
<td></td>
<td>a text object.</td>
</tr>
<tr>
<td>PlanningAnnotations</td>
<td>Retrieves the textual annotations associated with a Planning unit. You can</td>
</tr>
<tr>
<td></td>
<td>limit your annotations by specifying up to five attribute parameters: author,</td>
</tr>
<tr>
<td></td>
<td>title, date, text and PlanningUnit. You can also specify certain annotations</td>
</tr>
<tr>
<td></td>
<td>among all annotations returned.</td>
</tr>
<tr>
<td>POVAlias</td>
<td>Returns the alias of the member assigned to a dimension in the user POV.</td>
</tr>
<tr>
<td></td>
<td>Available only for Essbase and Planning Details.</td>
</tr>
<tr>
<td>POVDescription</td>
<td>Returns the description of the member assigned to a dimension in the user</td>
</tr>
<tr>
<td></td>
<td>POV. Available only for Financial Management.</td>
</tr>
<tr>
<td>POV / POVMember</td>
<td>Returns the name of the member assigned to a dimension in the user POV.</td>
</tr>
<tr>
<td>ProcessManagementStatus</td>
<td>For Financial Management database connection only. Returns the status of</td>
</tr>
<tr>
<td></td>
<td>a specified cell.</td>
</tr>
<tr>
<td>ReportAuthor</td>
<td>Returns the user name of the creator of the report.</td>
</tr>
<tr>
<td>ReportCreated</td>
<td>Returns the date the current report was created.</td>
</tr>
<tr>
<td>ReportDesc</td>
<td>Returns the text description of the current report.</td>
</tr>
<tr>
<td>ReportFolder</td>
<td>Returns the path of the folder where the report is located.</td>
</tr>
<tr>
<td>Text Function</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ReportModified</td>
<td>Returns the date the current report was last modified.</td>
</tr>
<tr>
<td>ReportModifiedBy</td>
<td>Returns the user name of the last user to save the report.</td>
</tr>
<tr>
<td>ReportName</td>
<td>Returns the name of the current report.</td>
</tr>
<tr>
<td>ReportRunBy</td>
<td>Returns the name of the user who is running the report.</td>
</tr>
<tr>
<td>xbrlContext</td>
<td>Returns the value of the specified of XBRL context property in a column heading.</td>
</tr>
<tr>
<td>xbrlLineitem</td>
<td>Returns the value of the specified XBRL line item property in a row heading.</td>
</tr>
</tbody>
</table>

**Current / Cur Keyword**

You can use the Current keyword with certain text functions to make the formulas more dynamic, more useful, and less redundant. The Current keyword can replace required parameters in text functions. Hard-coded parameters produce the same results, whereas the Current keyword can produce dynamic values. For example, when you use Current for the Page parameter in a multiple page grid, it produces the value for each page.

You can use any form of the Current keyword; current, or cur. Current keywords are not case-sensitive.

**Note:**

The Current keyword is only supported with text functions that are entered in text cells or heading cells of a grid; not text objects. A text cell is the intersection of a text row and/or text column. A heading cell is part of a row, column, or page heading.

**Example 1**

In the GetCell function, many of the parameters are or may be relative to the current cell in which the function is entered. Therefore, the Current keyword can be readily applied to this function. The GetCell function uses the following syntax:

```
<<GetCell ("GridName", Row, Column, Page)>>
```

In the following example, the hard-coded parameters for the GetCell Function returns the same cell value of Grid 1, cell1A, page1 across multiple pages:

```
<<GetCell ("Grid1", 1, A, 1)>>
```

The next example uses the Current keyword with the GetCell function. The cell where the function is entered displays different values for each page. Notice that the Current keyword is also applied to the grid name. If the grid name is changed, the text formula is still correct.

```
<<GetCell ("current", 1, current, current)>>
```

**Example 2**
When you use the Current keyword in a cell that expands, the results are relative to the expanded cell.

The following example uses GetCell functions in an expanded cell (Column A expands to columns Qtr1, Qtr2, Qtr3 and row 1 expands to rows East and West). Text Row 1 uses the Current keyword for the Column parameter; Text Row 2 uses a hard-coded value for the Column parameter.

<table>
<thead>
<tr>
<th></th>
<th>Qtr1</th>
<th>Qtr2</th>
<th>Qtr3</th>
</tr>
</thead>
<tbody>
<tr>
<td>East</td>
<td>5,120</td>
<td>4,502</td>
<td>7,304</td>
</tr>
<tr>
<td>West</td>
<td>3,405</td>
<td>2,300</td>
<td>4,462</td>
</tr>
<tr>
<td><strong>Text Row 1</strong></td>
<td>&lt;&lt;GetCell(cur, 1, cur, cur)&gt;&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Text Row 2</strong></td>
<td>&lt;&lt;GetCell(current, 1, A, 1)&gt;&gt;</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The results are indicated in the following table.

<table>
<thead>
<tr>
<th></th>
<th>Qtr1</th>
<th>Qtr2</th>
<th>Qtr3</th>
</tr>
</thead>
<tbody>
<tr>
<td>East</td>
<td>5,120</td>
<td>4,502</td>
<td>7,304</td>
</tr>
<tr>
<td>West</td>
<td>3,405</td>
<td>2,300</td>
<td>4,462</td>
</tr>
<tr>
<td><strong>Text Row 1</strong></td>
<td>5,120</td>
<td>4,502</td>
<td>7,304</td>
</tr>
<tr>
<td><strong>Text Row 2</strong></td>
<td>5,120</td>
<td>5,120</td>
<td>5,120</td>
</tr>
</tbody>
</table>

- Text Row 1 uses the Current keyword for the Column parameter which results in the update of the current column of each expanded cell (Qtr1, Qtr2, Qtr3). Also, since the Current Keyword is used for the Page parameter, the values in Text Row 1 update each page relative to the current page of the grid.
- Text Row 2 uses a hard-coded value for the Column parameter (A) which results in the same value of 5,120 for all quarters. A hard coded reference to a Column parameter returns the same top left value of the column and row.

The following table describes only the text functions that support the Current keyword, along with examples and usages.

<table>
<thead>
<tr>
<th>Text Function</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;&lt;POV(&quot;GridName&quot;, DimName)&gt;&gt;</td>
<td>&lt;&lt;POV(cur, &quot;Years&quot;)&gt;&gt;</td>
</tr>
<tr>
<td>&lt;&lt;POVMember(&quot;GridName&quot;, DimName)&gt;&gt;</td>
<td>&lt;&lt;POVMember(current, current)&gt;&gt;</td>
</tr>
</tbody>
</table>

Parameters, where Applicable:
- GridName: supported in all cells
- DimName: Heading cells only

**Note:** The POV member is shown for the current dimension that corresponds to the heading cell where the function is entered.
<table>
<thead>
<tr>
<th>Text Function</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;&lt;POVAlias(&quot;GridName&quot;,DimName)&gt;&gt;</td>
<td>&lt;&lt;POVAlias(cur,&quot;Markets&quot;)&gt;&gt;</td>
</tr>
<tr>
<td>&lt;&lt;POVDescription(&quot;GridName&quot;,DimName)&gt;&gt;</td>
<td>&lt;&lt;POVDescription(cur,current)&gt;&gt;</td>
</tr>
<tr>
<td>Parameters, where Applicable:</td>
<td>Note: The POV member is shown for the current dimension that corresponds to the heading cell where the function is entered.</td>
</tr>
<tr>
<td>● GridName: supported in all cells</td>
<td>&lt;&lt;POVDesc(current,&quot;Markets&quot;)&gt;&gt;</td>
</tr>
<tr>
<td>● DimName: Heading cells only</td>
<td></td>
</tr>
<tr>
<td>&lt;&lt;DataSource(&quot;GridName.Axis [ID]&quot;,InfoType)&gt;&gt;</td>
<td>&lt;&lt;DataSource(current, &quot;server&quot;)&gt;&gt;</td>
</tr>
<tr>
<td>Parameters where Applicable:</td>
<td>Note: The current grid name is used.</td>
</tr>
<tr>
<td>● GridName: supported in all cells</td>
<td></td>
</tr>
<tr>
<td>● InfoType: not applicable</td>
<td></td>
</tr>
<tr>
<td>&lt;&lt;GetCell(&quot;GridName&quot;,Row,Col,Page)&gt;&gt;</td>
<td>&lt;&lt;GetCell(cur, 1, cur, current)&gt;&gt;</td>
</tr>
<tr>
<td>Parameters where Applicable:</td>
<td>Note: The value from the third (expanded) row of row 1 is shown.</td>
</tr>
<tr>
<td>● GridName: supported in all cells</td>
<td>&lt;&lt;GetCell(cur, 1(3), cur, current)&gt;&gt;</td>
</tr>
<tr>
<td>● Row: supported in all cells</td>
<td></td>
</tr>
<tr>
<td>● Col: supported in all cells</td>
<td>&lt;&lt;GetCell(cur, cur, A, current)&gt;&gt;</td>
</tr>
<tr>
<td>● Page: supported in all cells</td>
<td>Note: The value from the second (expanded) column of column A would be shown.</td>
</tr>
<tr>
<td>Use the following in a data row or column heading:</td>
<td>&lt;&lt;MemberName(current)&gt;&gt;</td>
</tr>
<tr>
<td>&lt;&lt;MemberName(&quot;DimName&quot;)&gt;&gt;</td>
<td></td>
</tr>
<tr>
<td>Use the following in a non-data row or column heading:</td>
<td>&lt;&lt;MemberName(&quot;current&quot;, Row/Col/Page, &quot;current&quot;)&gt;&gt;</td>
</tr>
<tr>
<td>&lt;&lt;MemberName(&quot;GridName&quot;,Row/Col/Page,&quot;DimName&quot;)&gt;&gt;</td>
<td>Note: Returns the name of the member of the data row, column, or page that corresponds to the dimension where the heading cell is located. This can be used with the &lt;&lt;MemberDimension&gt;&gt; function to create custom headings for a grid.</td>
</tr>
<tr>
<td>Parameters where Applicable:</td>
<td></td>
</tr>
<tr>
<td>● DimName: Heading cells only</td>
<td></td>
</tr>
<tr>
<td>Use the following in a data row or column heading:</td>
<td>&lt;&lt;MemberAlias(current)&gt;&gt;</td>
</tr>
<tr>
<td>For Essbase:</td>
<td>&lt;&lt;MemberAlias(cur)&gt;&gt;</td>
</tr>
<tr>
<td>&lt;&lt;MemberAlias(&quot;DimName&quot;)&gt;&gt;</td>
<td>&lt;&lt;MemberDescription(cur)&gt;&gt;</td>
</tr>
<tr>
<td>For Financial Management:</td>
<td>&lt;&lt;MemberDesc(cur)&gt;&gt;</td>
</tr>
<tr>
<td>&lt;&lt;MemberDescription(&quot;DimName&quot;)&gt;&gt;</td>
<td></td>
</tr>
<tr>
<td>&lt;&lt;MemberDesc(&quot;DimName&quot;)&gt;&gt;</td>
<td>Note: Returns the name of the description (HFM) or Alias (Essbase) of the data row, column, or page that corresponds to the dimension where the heading cell is located. This can be used with the</td>
</tr>
<tr>
<td>Use the following in a non-data row or column heading:</td>
<td></td>
</tr>
<tr>
<td>&lt;&lt;MemberAlias(&quot;GridName&quot;,Row/Col/Page,&quot;DimName&quot;)&gt;&gt;</td>
<td></td>
</tr>
<tr>
<td>Text Function</td>
<td>Example</td>
</tr>
<tr>
<td>---------------</td>
<td>---------</td>
</tr>
<tr>
<td><strong>Parameters where Applicable:</strong></td>
<td><strong>Example</strong></td>
</tr>
<tr>
<td>● DimName: Heading cells only</td>
<td>&lt;&lt;MemberName&gt;&gt; function to create custom headings for a grid, or customized text in a text box object.</td>
</tr>
<tr>
<td>&lt;&lt;CalcStatus(&quot;GridName&quot;, Row, Col, Page) &gt;&gt;</td>
<td>&lt;&lt;CellText(&quot;GridName&quot;, Row, Column, Page)&gt;&gt;</td>
</tr>
<tr>
<td><strong>Note:</strong> The parameters allowing current keyword are highlighted in bold</td>
<td>&lt;&lt;CellText(&quot;GridName&quot;, Row, Column, Page, MemberOverride)&gt;&gt;</td>
</tr>
<tr>
<td>&lt;&lt;GridDimension(&quot;GridName&quot;, &quot;Axis&quot;, index)&gt;&gt;</td>
<td>&lt;&lt;MemberAlias(&quot;DimName&quot;)&gt;&gt;</td>
</tr>
<tr>
<td>&lt;&lt;HFMCurrency(&quot;GridName&quot;, Row, Col, Page)&gt;&gt;</td>
<td>&lt;&lt;MemberAlias(&quot;GridName&quot;, &quot;DimName&quot;)&gt;&gt;</td>
</tr>
<tr>
<td><strong>Note:</strong> The parameters allowing current keyword are highlighted in bold</td>
<td>&lt;&lt;MemberAlias(&quot;GridName&quot;, Row</td>
</tr>
<tr>
<td></td>
<td>&lt;&lt;MemberDesc(&quot;DimName&quot;)&gt;&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;&lt;MemberDesc(&quot;GridName&quot;, &quot;DimName&quot;)&gt;&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;&lt;MemberDesc(&quot;GridName&quot;, Row</td>
</tr>
<tr>
<td></td>
<td>&lt;&lt;MemberName(&quot;DimName&quot;)&gt;&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;&lt;MemberName(&quot;GridName&quot;, &quot;DimName&quot;)&gt;&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;&lt;MemberName(&quot;GridName&quot;, Row</td>
</tr>
<tr>
<td></td>
<td>&lt;&lt;MemberQualifiedName(&quot;DimName&quot;)&gt;&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;&lt;MemberQualifiedName(&quot;GridName&quot;, &quot;DimName&quot;)&gt;&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;&lt;MemberQualifiedName(&quot;GridName&quot;, Row</td>
</tr>
<tr>
<td></td>
<td>&lt;&lt;MemberProperty(DimensionName, Property)&gt;&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;&lt;MemberProperty(&quot;GridName&quot;, DimensionName, Property)&gt;&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;&lt;MemberProperty(&quot;GridName&quot;, Row</td>
</tr>
<tr>
<td></td>
<td>&lt;&lt;PlanningAnnotations(&quot;GridName&quot;, Row, Column, Page, Attributes)&gt;&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;&lt;PlanningAnnotations(&quot;GridName&quot;, Row, Column, Page, Attributes, Range)&gt;&gt;</td>
</tr>
<tr>
<td>&lt;&lt;ProcessManagementStatus(&quot;GridName&quot;, Row, Column, Page)&gt;&gt;</td>
<td><strong>Note:</strong> The parameters allowing current keyword are highlighted in bold</td>
</tr>
<tr>
<td>Text Function</td>
<td>Example</td>
</tr>
<tr>
<td>---------------</td>
<td>---------</td>
</tr>
<tr>
<td>&lt;&lt;ListOfCellDocuments(&quot;GridName&quot;, Information)&gt;&gt;</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> The parameters allowing current keyword are highlighted in bold</td>
<td></td>
</tr>
</tbody>
</table>
| <<GridDimension("GridName","Axis",Index)>> | <<GridDimension(cur,"Page",1)>>
| Parameters, where Applicable: | <<GridDimension(cur,cur,cur)>>
| ● GridName: supported in all cells | **Note:** The dimension name corresponding to the heading cell is shown.|
| ● Axis: Heading cells only | |
| ● Index: Heading cells only | |
| <<GetHeading("GridName",Page,Ref,Offset)>> | <<GetHeading(cur, cur, A, " - ")>>
| <<GetHeading("GridName",Page,Ref,"Delim")>> | <<GetHeading(cur, cur, cur, " - ")>>
| Parameters where Applicable: | **Note:** In the above examples, all headings in column A and row 1 are shown for the current page. |
| ● GridName: supported in all cells | <<GetHeading(cur, cur, A, cur)>>
| ● Page: supported in all cells | **Note:** The heading in column A is shown for the dimension that corresponds to where the heading cell with the formula is located. |
| ● Ref: supported for in all cells, but should not be used in heading cells* | <<GetHeading(cur, cur, cur, " - ")>>
| ● Offset: Heading cells only | **Note:** If used within a row text cell, the result is all of the headings in the current column separated by a " - ". This allows users to repeat column headings after a manual page break. |
| ● Delim: not applicable | |

*Usage of the current keyword for the parameter “reference” is limited. The current keyword cannot be used in the GetHeading function when it is entered as a “custom heading” in a row or column because circular reference is created. You can use the current keyword as the third parameter within a cell that is part of a text row or column which is not in the heading area of the grid. For example, if you add the following formula in cell A3 where row 3 is a text row: "<<GetHeading(cur,cur,cur,1)>>", the result is the first heading of column A. You can use the GetHeading function within a heading cell. However, the “reference” parameter should not use the “current” keyword. For example, when you enter in the heading cell of column B"<<GetHeading(cur, cur, A, cur)>>", the column A heading is returned.

## List of Functions

### Abs

Abs is a mathematical function that returns the absolute value of a numeric value, row, column, or cell. The absolute value of a number is that number without a negative sign. A negative number becomes positive, while a positive number remains positive. The function syntax is:

```
Abs (argument)
```

where *argument* is one of the following values:
<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>numeric</td>
<td>A numeric value. For example, Abs (-20) returns the value 20. Numeric values can include decimals and negative values. For a description of numeric arguments, see “Numeric Arguments” on page 204.</td>
</tr>
<tr>
<td>row, column, or cell reference</td>
<td>A pointer to a row, column, or cell within a grid. References can be specified in several ways. The reference syntax is: GridName.GridElement[segment (range)].Property. For a definition of the syntax, see “Row, Column, or Cell Reference Arguments” on page 204.</td>
</tr>
<tr>
<td>function</td>
<td>An embedded function. For a list of mathematical functions, see &quot;Mathematical Functions&quot; on page 202.</td>
</tr>
</tbody>
</table>

**Examples:**

The following expression includes a numeric argument and returns the value 30:

```
Abs ( -30 )
```

The following example returns the absolute value of the value in row 1:

```
Abs(row[1])
```

The following example calculates the absolute value of the sum of column E:

```
Abs( column[E].sum )
```

The following example points to expanded rows 1 through 3 within design segment 3 of Grid1:

```
Abs( Grid1.row[3(1:3)])
```

**Average**

Average is a mathematical function that returns the average of a group of numeric values, rows, columns, or cells. Average excludes #missing and #error cells when obtaining the average.

**Note:**

The calculation does not include missing values regardless of whether they are suppressed or not.

The function syntax is:

```
Average(arguments) or Avg(arguments)
```

where arguments is one or more of the following values:
<table>
<thead>
<tr>
<th><strong>Argument</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>numeric</td>
<td>A numeric value. For example, Average (10, 20, 30) returns the value 20. Numeric values can include decimals and negative values. For more information on numerics, see “Numeric Arguments” on page 204.</td>
</tr>
<tr>
<td>row, column, or cell reference</td>
<td>A pointer to a row, column, or cell within a grid. References can be specified in several ways. The reference syntax is: <code>GridName.GridElement[segment (range)].Property</code> For a definition of the syntax, see “Row, Column, or Cell Reference Arguments” on page 204. For example <code>Avg(Grid1.row[4(3:5)])</code> returns the average of grid1, row segment 4, range 3 through 5.</td>
</tr>
<tr>
<td>function</td>
<td>An embedded function. For a list of mathematical functions, see “Mathematical Functions” on page 202.</td>
</tr>
</tbody>
</table>

**Examples:**

The following expression returns the value 20:

```
Avg( 10, 30, 20)
```

The following example returns the average of all numbers that are part of three aggregate rows:

```
Average( row[1], row[6], row[8] )
```

The following example calculates the average of three aggregate columns; E, G, and I. The calculation produces three numbers, then calculates the average of the three numbers:

```
Avg(column[E].avg, column[G].avg, column[I].avg)
```

The following example calculates the average of two columns; E on the current grid and E on grid2. The calculation includes all expanded columns:

```
Avg( column[E], grid2.column[E] )
```

The following example calculates the average of aggregate row 3 and divides the average by 100:

```
Avg(row[3])/100
```

**AverageA**

AverageA is a mathematical function that returns the average of a group of numeric values, rows, columns, or cells. AverageA includes #missing and #error cells, which are treated as zero values when obtaining the average.

**Note:**

#missing and #error are included only for rows or columns that are not suppressed.

The function syntax is:
AverageA(\textit{arguments}) or \texttt{AvgA}(\textit{arguments})

where \textit{arguments} is expressed by one or more of the following arguments:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>numeric</td>
<td>A numeric value. For example, AverageA (10, 20, 30) returns the value 20. Numeric values can include decimals and negative values.</td>
</tr>
<tr>
<td>row, column, or cell reference</td>
<td>A pointer to a row, column, or cell within a grid. References can be specified in several ways. The reference syntax is: GridName.GridElement[segment(range)]. Property. For a definition of the syntax, see &quot;Row, Column, or Cell Reference Arguments&quot; on page 204. For example, AvgA(Grid1.row[4(3:5)] returns the average of grid1, row segment 4, range 3 through 5.</td>
</tr>
<tr>
<td>function</td>
<td>An embedded function. For a list of mathematical functions, see &quot;Mathematical Functions&quot; on page 202.</td>
</tr>
</tbody>
</table>

Example

In the following example, if a grid has 4 rows with the values 10, 20, 30, and, #error. The following formula in the 5th row returns the value 15:

\[
\text{AverageA}([1:4])
\]

\textbf{CalcStatus}

CalcStatus is a text function that returns the calculation status of a cell for a Financial Management database connection. You can use the CalcStatus function in report headers, rows, and columns.

The function syntax is as follows:

\[
\text{\textless\textgreater CalcStatus("GridName", \textit{Row}, \textit{Col}, \textit{Page})\textless\textgreater}
\]

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GridName</td>
<td>The name of a Financial Management grid. This value must be enclosed in quotation marks</td>
</tr>
<tr>
<td>Row</td>
<td>Numeric value representing the row number of the grid. The first row in a grid has an index of 1, the second row has an index of 2, and so forth.</td>
</tr>
<tr>
<td>Col</td>
<td>A letter representing the column ID of the grid. The first column ID is A, the second column ID is B, and so on.</td>
</tr>
<tr>
<td>Page</td>
<td>A numeric value representing the page dimension index of the grid. The first page dimension in a grid has an index of 1, the second page dimension has an index of 2, and so forth.</td>
</tr>
</tbody>
</table>

The following calculation status values can be returned from Financial Management:
The following syntax displays the calculation status of the cell that is in row 21, column B on page 1 of Grid1:

```
<<CalcStatus("Grid1",21,B,1)>>
```

**Note:**

This function supports the Current keyword. For information and examples, see “Current / Cur Keyword” on page 210.

---

**CellText**

CellText is a text function that retrieves the textual content from any of the following database connections:

- A Financial Management cell.
- Planning cell annotations.
- A Linked Reporting Object (LRO) from a Essbase cell (CellText applies only to a Cell note LRO). For more information, see the Hyperion Essbase Database Administrator’s Guide.

The row, column, and page arguments apply to the intersection in a grid that contains the linked text or note. The function syntax is:

```
<<CellText("GridName", Row, Column, Page)>>
```

Another flavor of the CellText function provides an override of the grid’s “natural” point of view (POV) to a member selection when a cell does not exist in a grid. The function syntax is:

```
<<CellText("GridName", Row, Column, Page, MembeOverride)>>
```

See “CellText Function with MemberOverride” on page 219 for details.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GridName</td>
<td>The name of a grid. This value must be enclosed in quotation marks</td>
</tr>
</tbody>
</table>
### Argument Description

#### Row
Numeric value representing the row number of the grid. The first row in a grid has an index of 1, the second row has an index of 2, and so forth.

#### Column
A letter representing the column of the grid. The first column in a grid has an index of A, the second column has an index of B, and so forth.

#### Page
A numeric value representing the page dimension index of the grid. The first page dimension in a grid has an index of 1, the second page dimension has an index of 2, and so forth.

#### MemberOverride
A string of dimensions and corresponding member selections that overrides the CellText POV. See “CellText Function with MemberOverride” on page 219 for details.

### Note:
If the row or column parameters refer to a segment that expands, the top-left expanded cell is used. You can refer to any expanded cell using the “range” notation as described in “Expressing the Range Argument” on page 132.

### Example
You want to display the text linked to a specific cell in a grid. To do this, first run the report and display it by selecting File > Web Preview. Note the name of the grid, the page dimension that is selected, and the run-time row and column.

The following example shows a report with the linked text in the cell that is in row 21, column B of a grid and is on the first page dimension. The syntax is:

Note re: allocation for Y2002 <<CellText("mygrid",21,B,1)>>.

### Tip:
To view result-time rows and columns, select View > Row & Column Headers in Web Preview, then preview the report by clicking the Web Preview button.

### Note:
This function supports the Current keyword. For information and examples, see “Current / Cur Keyword” on page 210.

### CellText Function with MemberOverride
The MemberOverride parameter can consist of one or more dimensions. It uses the following format:

\[ \text{DimensionName} = \text{MemberName}, \text{DimensionName} = \text{MemberName} \]

where:

DimensionName is the name of an override dimension
**MemberName** is the name of the override member for the dimension.

Follow these guidelines when you specify member overrides:

- If you specify two or more member overrides, separate them with a comma (,) or a semicolon (;) and enclose each dimension and member name in quotation marks (" "), as in the following example:
  
  "Entity"="Acme","Period"="Q1"

- If you specify only one member override, do not include the separator character.

- Dimension names and member names must be enclosed in quotation marks (" ") if they contain any of the following characters: ; , = ( ) < >.

- For a single member override, the parameter may be enclosed in quotation marks (" "). For example, the CellText function is properly evaluated if you use the following member override statement with it:
  
  "Scenario=Budget"

The following table provides examples of ways to use the **MemberOverride** parameter in the CellText function:

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;&lt;CellText(cur, cur, A, cur)&gt;&gt;</code></td>
<td>Existing syntax with no dimension override.</td>
</tr>
<tr>
<td><code>&lt;&lt;CellText(cur, cur, A, cur, Scenario=Budget)&gt;&gt;</code></td>
<td>New syntax with one dimension override.</td>
</tr>
<tr>
<td><code>&lt;&lt;CellText(&quot;Grid Name&quot;, 1, A, current, Value = &quot;Entity Currency&quot;)&gt;&gt;</code></td>
<td>One dimension override using quotation marks in the member name</td>
</tr>
<tr>
<td><code>&lt;&lt;CellText(&quot;Grid Name&quot;, 1, A, cur, Value = Entity Currency)&gt;&gt;</code></td>
<td>No quotation marks in the member name (which contains a space)</td>
</tr>
<tr>
<td><code>&lt;&lt;CellText(&quot;Grid Name&quot;, 1, A, cur, &quot;Value=$USD&quot; = Entity Currency)&gt;&gt;</code></td>
<td>Quotation marks surrounding dimension name which contains an equal sign</td>
</tr>
<tr>
<td><code>&lt;&lt;CellText(Grid1, 1, cur, cur, Value = Entity Currency, Scenario=Actual)&gt;&gt;</code></td>
<td>Two-dimension override that uses a comma separator</td>
</tr>
<tr>
<td><code>&lt;&lt;CellText(Grid1, 1, cur, cur, Value = Entity Currency; Scenario=Actual)&gt;&gt;</code></td>
<td>Two-dimension override that uses a semi-colon separator</td>
</tr>
<tr>
<td><code>&lt;&lt;CellText(&quot;Current&quot;, 34, BB, cur, &quot;Value&quot;= Entity Currency, Scenario=Actual; Period = Qtr3)&gt;&gt;</code></td>
<td>Three-dimension override that uses comma and semicolon separators</td>
</tr>
<tr>
<td><code>&lt;&lt;CellText(cur, 1(3), A(B), cur, 300 = ABC , &quot;Americas, Value=(in</code>)</td>
<td>Four-dimensional override</td>
</tr>
</tbody>
</table>
Count

Count is a mathematical function that returns the number of values in a group of numeric values, rows, columns, or cells. Count excludes #missing and #error when obtaining the count. The function syntax is:

```
Count (arguments)
```

where `arguments` is expressed by one or more of the following arguments:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>numeric</td>
<td>A numeric value. For example, <code>Count (10, 20, 30)</code> returns the value 3. Numeric values can include decimals and negative values. For a description of numeric arguments, see “Numeric Arguments” on page 204.</td>
</tr>
<tr>
<td>row, column, or cell reference</td>
<td>A pointer to a row, column, or cell within a grid. References can be specified in several ways. The reference syntax is: <code>GridName.GridElement[segment (range)].Property</code> For more information, see “Row, Column, or Cell Reference Arguments” on page 204.</td>
</tr>
<tr>
<td>function</td>
<td>An embedded function. For a list of mathematical functions, see “Mathematical Functions” on page 202.</td>
</tr>
</tbody>
</table>

Examples:

The following example returns the count of three rows, 1, 6, and 8:

```
Count(row[1], row[6], row[8])
```

The following example returns the count of 3 columns:

```
Count( column[E], column[G], column[I] )
```

The following example calculates the count of two columns located on different grids:

```
Count( grid1.column[E], grid2.column[E] )
```

The following example calculates the count of the cell located at row 4, column D:

```
Count(cell[D,4])
```

The following example calculates the count of aggregate row 3 in grid 5:

```
Count(grid5.row[3])
```
**CountA**

CountA is a mathematical function that returns the number of values in a group of numeric values, rows, columns, or cells. CountA includes #missing and #error cells when obtaining the count only for rows or columns that are not suppressed. The function syntax is:

\[ \text{CountA}(\text{arguments}) \]

where arguments is expressed by one or more of the following arguments:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>numeric</td>
<td>A numeric value. For example, CountA(10, 20, 30, 50) returns the value 4. Numeric values can include decimals and negative values. For a description of numeric arguments, see “Numeric Arguments” on page 204.</td>
</tr>
<tr>
<td>row, column, or cell reference</td>
<td>A pointer to a row, column, or cell within a grid. References can be specified in several ways. The reference syntax is: CountA(GridName.GridElement[segment (range)][property]). For more information, see “Row, Column, or Cell Reference Arguments” on page 204.</td>
</tr>
<tr>
<td>function</td>
<td>An embedded function. For a list of mathematical functions, see “Mathematical Functions” on page 202.</td>
</tr>
</tbody>
</table>

**Example**

In the following example, if a grid has 4 rows with the values 10, 20, 30, and, #error. The following formula in the 5th row returns the count of four rows:

\[ \text{CountA([1:4])} \]

The following example returns the count of four rows:

\[ \text{CountA(row[1], row[6], row[8] row[where data yields #error])} \]

**DataSource**

DataSource is a text function that returns the server name, application name, database, or alias table name of a grid. You can use this function in a text box, text cell, or a row or column heading. The function syntax is:

\[ \text{<<DataSource("GridName.Axis[ID]",InfoType)>>} \]

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GridName</td>
<td>Any grid in your report, enclosed in quotes. Required.</td>
</tr>
<tr>
<td>Axis[]</td>
<td>A pointer to a design segment of the grid. Axis can be one of the following keywords: row, col, or column, and they are not case-sensitive. For example, &lt;&lt;DataSource(&quot;Grid1.Row[1]&quot;,DB)&gt;&gt;</td>
</tr>
<tr>
<td>Argument</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>addresses the row axis. Optional. When not provided, the grid's default information is returned. You use Axis[ID] when a grid has multiple database connections.</td>
</tr>
</tbody>
</table>
| **ID**   | Indicates the design-time, row number, or column letter from which the database connection information is retrieved. If ID points to an invalid or non-existent row or column ID, the grid default settings are used. Also, if a grid does not have a secondary database connection, the grid default settings are used. For example,  
  `<**DataSource**("Grid1.Col[A]",DB)>>`  
  addresses Column A. If axis is used, then ID is required. |
| **InfoType** | One of the following keywords:  
  - **Server** returns the server name.  
  - **App** returns the application name.  
  - **DB** returns the database name.  
  - **Alias** returns the alias table name. To return the alias, the grid must have the alias table enabled. By default, the alias table is disabled.  
  - **Name** returns the database connection name associated with the specified grid. Required. |

**Note:**
All arguments are case insensitive.

**Example 1:**
The following lines use the Data Source function to insert data source information in your report:

This report uses the `<**DataSource**("Grid1", App)>` with the `<**DataSource**("Grid1",DB)>` database located on the `<**DataSource**("Grid1",Server)>` server and uses the `<**DataSource**("Grid1", Alias)>` alias table.

**Example 2:**
The following shows the database name of the data source associated with the heading where the function was entered:

`<**DataSource**(cur, DB)>`

**Note:**
This function supports the Current keyword. For information and examples, see “Current / Cur Keyword” on page 210.
**Date**

Date is a text function that returns the date and time that an online report is populated with data, or the date and time that a snapshot report is saved. The date and time is retrieved from the report server and corresponds to the country where the report server is located. You can use this function in a text box, text cell, or a row or column heading. The function syntax is:

`<<Date("format")>>`

where `format` is a list of characters enclosed in quotes that define the format of the date and time. The following table lists all `format` date and time characters:

**Note:**

The date and time format characters are case-sensitive.

<table>
<thead>
<tr>
<th>Format Characters</th>
<th>Meaning</th>
<th>Data Type</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>G</td>
<td>era designator</td>
<td>text</td>
<td>AD</td>
</tr>
<tr>
<td>M</td>
<td>month in year</td>
<td>text or number</td>
<td>If the month is July: M displays: 7 MM displays: 07 MMM displays: Jul MMM displays: July</td>
</tr>
<tr>
<td>d</td>
<td>day in month</td>
<td>number</td>
<td>10</td>
</tr>
<tr>
<td>h</td>
<td>hour in am/pm (1-12)</td>
<td>number</td>
<td>11</td>
</tr>
<tr>
<td>H</td>
<td>hour in day (0-23)</td>
<td>number</td>
<td>22</td>
</tr>
<tr>
<td>m</td>
<td>minute in hour</td>
<td>number</td>
<td>30</td>
</tr>
<tr>
<td>s</td>
<td>second in minute</td>
<td>number</td>
<td>25</td>
</tr>
<tr>
<td>S</td>
<td>millisecond</td>
<td>number</td>
<td>978</td>
</tr>
<tr>
<td>E</td>
<td>day in week</td>
<td>text</td>
<td>E: Tue EE: Tuesday</td>
</tr>
<tr>
<td>D</td>
<td>day in year</td>
<td>number</td>
<td>189</td>
</tr>
<tr>
<td>F</td>
<td>day of week in month</td>
<td>number</td>
<td><code>&lt;&lt;Date(&quot;dd-MMM-yy 'is the' F 'th ' E 'of' &quot;MMM&quot;)&gt;&gt;</code> displays: 24-Dec-02 is the 4th Tue of Dec</td>
</tr>
<tr>
<td>w</td>
<td>week in year</td>
<td>number</td>
<td>27</td>
</tr>
<tr>
<td>W</td>
<td>week in month</td>
<td>number</td>
<td>2</td>
</tr>
<tr>
<td>a</td>
<td>am/pm marker</td>
<td>text</td>
<td>PM</td>
</tr>
<tr>
<td>k</td>
<td>hour in day (1-24)</td>
<td>number</td>
<td>23</td>
</tr>
<tr>
<td>Format Characters</td>
<td>Meaning</td>
<td>Data Type</td>
<td>Example</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------</td>
<td>-----------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td>K</td>
<td>hour in am/pm (0-11)</td>
<td>number</td>
<td>If the time is 3:37PM: 3</td>
</tr>
<tr>
<td>z</td>
<td>time zone</td>
<td>text</td>
<td>Pacific Standard Time</td>
</tr>
<tr>
<td>y</td>
<td>year</td>
<td>number</td>
<td>2002,02</td>
</tr>
<tr>
<td>'</td>
<td>literal text</td>
<td>text</td>
<td>&lt;&lt;Date(&quot; D'th day of 'yyyy&quot;)&gt;&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>displays: 105th day of 2002</td>
</tr>
<tr>
<td>''</td>
<td>two single quotes to produce one</td>
<td>text</td>
<td>&lt;&lt;Date(&quot;k:mm 'O''clock' a&quot;)&gt;&gt;</td>
</tr>
<tr>
<td></td>
<td>single quote</td>
<td></td>
<td>displays: 6:15 O’Clock PM</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Note: Use 2 single quotation marks</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>to produce a single quote or an</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>apostrophe as in O’Clock (O’Clock).</td>
</tr>
</tbody>
</table>

The number or count of format characters determines the exact format:

- For text, less than four pattern letters means use short or abbreviated form, if it exists.
- Four or more pattern letters means use full form.
- M or MM means use the month as a number.
- MMM means use the three-letter abbreviation for the month.
- MMMM means use the full name of the month.

For example, if the date is April 24:

<<Date("dd-M-yy")>> displays 24-4-02
<<Date("dd-MM-yy")>> displays 24-04-02
<<Date("dd-MMM-yy")>> displays 24-Apr-02
<<Date("dd-MMMM-yy")>> displays 24-April-02

For numbers, the number of pattern letters is the minimum number of digits. Shorter numbers are padded with zeros. Year is a special case. If you use “yy”, the last two digits of the year are displayed, but if you use “yyyy," the four-digit year is displayed.

For example, if the month is February:

<<Date("MM-yyyy")>> displays 02-2002

All upper and lower case alphabet characters are considered patterns, regardless of whether they are designated format characters.

If you want literal text, you must enclose that text within single quotes. If you want to use a single quote in literal text, you must enclose the text within single quotes and use two single quotes for the apostrophe.

For example, the format to print 4 o’clock is:

<<Date("hh 'o’‘clock’ ")>>

Examples:
The following table demonstrates some common date and time format options. Insert any of these in a report in locations that allows text.

<table>
<thead>
<tr>
<th>Date Format</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;&lt;Date(&quot;d/M/yy&quot;)&gt;&gt;</td>
<td>23/3/02</td>
</tr>
<tr>
<td>&lt;&lt;Date(&quot;d-MMM-yy&quot;)&gt;&gt;</td>
<td>23-Mar-02</td>
</tr>
<tr>
<td>&lt;&lt;Date(&quot;EEEE, MMMM dd, yyyy&quot;)&gt;&gt;</td>
<td>Tuesday, March 23, 2002</td>
</tr>
<tr>
<td>&lt;&lt;Date(&quot;h:mm:ss a&quot;)&gt;&gt;</td>
<td>12:52:05 PM</td>
</tr>
<tr>
<td>&lt;&lt;Date(&quot;h:mm:ss a zzzz&quot;)&gt;&gt;</td>
<td>12:52:05 PM Eastern Standard Time</td>
</tr>
<tr>
<td>&lt;&lt;Date(&quot;EEEE, MMMM dd, yyyy G 'time:' h:mm:ss a zzzz&quot;)&gt;&gt;</td>
<td>Tuesday, March 23, 2002 AD time: 12:52:05 PM Eastern Standard Time</td>
</tr>
<tr>
<td>&lt;&lt;Date(&quot;hh 'o''clock' a, zzzz&quot;)&gt;&gt;</td>
<td>12 O' Clock PM, Eastern Standard Time</td>
</tr>
</tbody>
</table>

Note: You must use two single quotation marks to produce one single quotation mark in the text of your formatted result.

**Difference**

Difference is a mathematical function that returns the absolute value of the difference of a numeric value, row, or column subtracted from another numeric value, row, or column. This is also known as the variance. The function syntax is:

`Difference(arg1, arg2)`

where `arg2` is subtracted from `arg1` and are expressed by one or more of the following arguments:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>numeric</td>
<td>A numeric value. For example, Difference (3, 5) returns the absolute value 2. Numeric values can include decimals and negative values. For a description of numeric arguments, see &quot;Numeric Arguments&quot; on page 204.</td>
</tr>
<tr>
<td>row, column, or reference</td>
<td>A pointer to a row, column, or cell within a grid. References can be specified in several ways. The reference syntax is: <code>GridName.GridElement[segment (range)].Property</code> For more information, see &quot;Row, Column, or Cell Reference Arguments&quot; on page 204. The following example returns the difference of two rows on grid1 and grid2: Difference( grid1.row[1], grid2.row[6] )</td>
</tr>
<tr>
<td>function</td>
<td>An embedded function. For a list of mathematical functions, see &quot;Mathematical Functions&quot; on page 202.</td>
</tr>
</tbody>
</table>

226 Using Functions
**Note:**
The Difference function returns the absolute value of arg2 subtracted from arg1, whereas the minus sign in subtraction negates a number.

**Examples:**
The following example returns the absolute value of 8:

\[
\text{Difference}(3, -5)
\]

The following example calculates the difference of two aggregate columns:

\[
\text{Difference}(\text{column}[E], \text{column}[G])
\]

The following example calculates the difference of two columns that are located on different grids, grid1 and grid2:

\[
\text{Difference}(\text{grid1.column}[E], \text{grid2.column}[E])
\]

**Note:**
You can type the text label “Difference” or “Variance”.

**Eval**

Eval is a mathematical function that evaluates an expression. You use Eval as an embedded function argument to consolidate multiple expressions into one expression. The function syntax is:

\[
\text{Eval}(\text{expression})
\]

where \text{expression} is expressed by one or more of the following arguments:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>numeric</td>
<td>A numeric value. Numeric values can include decimals and negative values. For a description of numeric arguments, see “Numeric Arguments” on page 204.</td>
</tr>
<tr>
<td>row, column, or reference</td>
<td>A pointer to a row, column, or cell within a grid. References can be specified in several ways. The reference syntax is: GridName.GridElement[segment (range)].Property For more information, see “Row, Column, or Cell Reference Arguments” on page 204.</td>
</tr>
<tr>
<td>function</td>
<td>An embedded function. For a list of mathematical functions, see “Mathematical Functions” on page 202.</td>
</tr>
<tr>
<td>operators</td>
<td>Use any of the supported arithmetic operators (+, -, *, /, ^, %, and so on).</td>
</tr>
</tbody>
</table>

**Example**
The following example divides row 1 by row 2 and then rounds the data to 4 places:

\[
\text{Round(Eval([1]/[2]), 4)}
\]
GetCell

GetCell is a text function that returns a data value from a grid. The row, column, and page arguments apply to the grid.

Note:
When referencing a cell containing Planning, GetCell returns a string value instead of a number.

The function syntax is:
\[
\text{GetCell}(\text{"GridName"}, \text{Row}, \text{Column}, \text{Page})
\]

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GridName</td>
<td>The name of a grid or the Current keyword.</td>
</tr>
<tr>
<td>Row</td>
<td>Numeric value representing the row number of the grid. The first row in a grid has an index of one, the second row has an index of two, and so forth. The Current keyword can also be used.</td>
</tr>
<tr>
<td>Column</td>
<td>A letter representing the column of the grid. The first column in a grid has an index of A, the second column has an index of B, and so forth.</td>
</tr>
<tr>
<td>Page</td>
<td>A numeric value representing the page dimension index of the grid. The first page dimension in a grid has an index of one, the second page dimension has an index of two, and so forth.</td>
</tr>
</tbody>
</table>

Note:
The Current keyword can be used in any of the parameters. Doing so, make the function more dynamic. For information and examples, see “Current / Cur Keyword” on page 210.

Note:
If the row or column parameters refer to a segment that expands, the top-left expanded cell is used. You can refer to any expanded cell using the “range” notation as described in “Expressing the Range Argument” on page 132.

Example
You set up a grid to show the grand total of several quarter’s net income. You want to display this value in a text box that contains an executive summary of the report.

The following example shows a report with the value in the cell that is in row 21, column B of a grid and is on the first page dimension. The syntax is:

The grand total for the period was <<GetCell("mygrid",21,B,1)>>.

Tip:
To view result-time rows and columns, choose View > Row & Column Headers Web Preview, then preview the report in Workspace by clicking the Web Preview button.
Note:
This function supports the Current keyword. For information and examples, see “Current / Cur
Keyword” on page 210.

GetHeading

GetHeading is a text function that obtains text headings from a specified grid.
The function has two syntax:

<<GetHeading("GridName", Page, Reference, Offset)>>
<<GetHeading("GridName", Page, Reference, "Delimiter")>>

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GridName</td>
<td>The name of a grid containing the heading to extract. The Current keyword can also be used.</td>
</tr>
<tr>
<td>Page</td>
<td>The numeric value of the page containing the heading. The Current keyword can also be used.</td>
</tr>
<tr>
<td>Reference</td>
<td>Reference is a view time reference of the heading to obtain. The Current keyword can also be used. For further information on the Reference syntax see “Row, Column, or Cell Reference Arguments” on page 204.</td>
</tr>
<tr>
<td>Offset</td>
<td>Offset applies to a row or column heading with more than one dimension. It is a number representing the dimension in the heading. If you provide a numeric offset, you are returned a single dimension heading. For example, a row heading with 3 dimensions, you can specify (starting from left to right) “1” to return the first dimension, “2” to return the second dimension and “3” to return the third dimension.</td>
</tr>
</tbody>
</table>

"Delimiter"  "Delimiter" is a quoted string that separates all headings from the row or column. If you provide a delimiter, you obtain all headings in the reference, separated by the provided delimiter.

Examples:

Use GetHeading to return column and row headings.

<table>
<thead>
<tr>
<th></th>
<th>A(A)</th>
<th>A(B)</th>
<th>A(C)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Actual</td>
<td>Actual</td>
<td>Actual</td>
</tr>
<tr>
<td></td>
<td>Jan</td>
<td>Feb</td>
<td>Mar</td>
</tr>
<tr>
<td>1(1)</td>
<td>Georgia</td>
<td>112</td>
<td>67</td>
</tr>
<tr>
<td>1(2)</td>
<td>East</td>
<td>5,864</td>
<td>3,322</td>
</tr>
<tr>
<td>1(3)</td>
<td>Market</td>
<td>15,904</td>
<td>9,277</td>
</tr>
</tbody>
</table>

Type any of these lines for the previous sample grid:

<table>
<thead>
<tr>
<th>GetHeading Example</th>
<th>Gets or Returns</th>
</tr>
</thead>
<tbody>
<tr>
<td>GetHeading(&quot;Grid1&quot;,1,A,2)</td>
<td>Jan</td>
</tr>
</tbody>
</table>
GetHeading Example | Gets or Returns
---|---
GetHeading("Grid1",1,A(B),2) | Feb
GetHeading("Grid1",1,A(C),"") | Actual - Mar
GetHeading("Grid1",1,1,1) | Georgia
GetHeading("Grid1",1,1(2),1) | East
GetHeading("Grid1",1,1(2),2) | <error> (it is an invalid reference)
GetHeading("Grid1",1,1(3),"") | Market

Note:
This function supports the Current keyword. For information and examples, see “Current / Current Keyword” on page 210.

**GridDimension**

GridDimension is a text function that returns the name of a dimension on a grid’s page, column, or row axis. The function syntax is:

```
<<GridDimension("GridName", "Axis", index)>>
```

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>GridName</strong></td>
<td>The name of a grid in the report enclosed in quotes. The Current keyword can also be used.</td>
</tr>
<tr>
<td><strong>Axis</strong></td>
<td>The grid axis where the dimension is placed: Page, Col, or Row. Keywords must be used. The Current keyword can also be used.</td>
</tr>
<tr>
<td><strong>index</strong></td>
<td>A numeric value representing the offset or index of the dimension on the named axis. The first dimension on an axis has an index of one, the second dimension has an index of two, and so on.</td>
</tr>
</tbody>
</table>

**Note:** You can use the Current keyword on a heading cell only (page, row, or column).

**Example**

You create a shared grid, named `mygrid`, that has several dimensions on each of the row, column, and page axes. You want to display the name of the first dimension on the row axis in a text box. Because that dimension may change in the future, you use the GridDimension function in the text box. Type the following in the text box:

This report is based on the `<<GridDimension("mygrid","Row",1)>>` dimension.

**Note:**
This function supports the Current keyword. For information and examples, see “Current / Current Keyword” on page 210.
**HFMCurrency**

HFMCurrency is a text function that returns the ID of the currency property for a cell in a Financial Management database connection.

The function syntax is as follows:

```
<<HFMCurrency("GridName", Row, Col, Page)>>
```

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GridName</td>
<td>The name of a Financial Management grid. This value must be enclosed in quotation marks</td>
</tr>
<tr>
<td>Row</td>
<td>Numeric value representing the row index of the grid. The first row in a grid has an index of 1, the second row has an index of 2, and so forth.</td>
</tr>
<tr>
<td>Col</td>
<td>A letter representing the column of the grid. The first column in a grid has an index of A, the second column has an index of B, and so forth.</td>
</tr>
<tr>
<td>Page</td>
<td>A numeric value representing the page dimension index of the grid. The first page dimension in a grid has an index of 1, the second page dimension has an index of 2, and so forth.</td>
</tr>
</tbody>
</table>

A designer can map the string returned from Financial Management to another string by way of a properties file change. The mappings are defined in `fr_repserver.properties` in the HFM Entity Currency section. For example, a designer might add these lines to HFM Entity Currency section:

```plaintext
EntityCurrency_USD=$
EntityCurrency_EUR=_
```

If USD is returned from Financial Management, the U.S. dollar symbol ( $ ) is displayed; if EUR is returned from Financial Management, the European euro symbol ( _ ) is displayed. The properties file includes these and other examples as comments.

**Example**

The following syntax displays the currency property for the cell that is in row 21, column B on page 1 of Grid1:

```
<<HFMCurrency("Grid1",21,B,1)>>
```

**Note:**

This function supports the Current keyword. For information and examples, see “Current / Cur Keyword” on page 210.

**ListOfCellDocuments**

ListOfCellDocuments is only available with Financial Management or Essbase as the database connection.

ListOfCellDocuments is a text function that returns a list of all cell documents and their file attributes that a designer has selected to be retrieved from cells within a report. You can use this function in a text box, text cell or text cell heading.
In Financial Management or Essbase, documents are inserted into the data source cells of a report. The Financial Reporting designer selects the cells and chooses Retrieve Cell Documents on the property sheet. If those documents exist, they are appended to the report when printed or saved as a snapshot or PDF. To view the list of cell documents that exist, the designer adds the ListOfCellDocuments to the report in a text box, text cell or text cell heading. For information on inserting cell documents into a report, see “Attaching Cell Documents in a Report” on page 149.

The function syntax is:

```
<<ListOfCellDocuments ("GridName", FileName&Description&PageNumber)>>
```

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>GridName</strong></td>
<td>The name of a grid in the report.</td>
</tr>
<tr>
<td><strong>FileName</strong></td>
<td>Returns the name of the cell document.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Documents extracted from the Financial Management database connection, are truncated to 20 characters; 16 characters for the document name, and 4 characters for the file name extension.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Returns the description of each cell document.</td>
</tr>
<tr>
<td><strong>PageNumber</strong></td>
<td>Returns the consecutive start page number of each cell document within the report. This is not necessarily the page number specified on the document.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Page numbers only display when selecting PDF format for print or Web preview.</td>
</tr>
</tbody>
</table>

**Example:**

In the following example, two grids in the report are selected to print cell document information. In Grid1, the file name, description, and the consecutive start page number of the extracted cell documents are requested, in Grid2 only the file name and start page numbers are requested.

```
<<ListOfCellDocuments ("Grid1", FileName&Description&PageNumber)>>
<<ListOfCellDocuments ("Grid2", FileName&PageNumber)>>
```

The resulting list might look similar to the following, where Grid1 has two attached documents and Grid2 has one attached document:

**Attached Documents:**

- April Variance High Volume Page3
- April Variance Low Volume Page9
- May Variance Page 18

**Note:**

This function supports the Current keyword. For information and examples, see “Current / Cur Keyword” on page 210.
IfThen is a conditional function that returns a value when the condition equals True, and another value when the condition equals False.

The function syntax is as follows:

\[ \text{IfThen}(\text{Condition}, \text{TrueParameter}, \text{FalseParameter}) \]

- **Condition** is a logical expression that evaluates to true or false. Full conditional logic can be used as well as complex Boolean operators (And, Not, and Or). A condition can also test for #missing and #error values. See the following table for a list of valid conditional operators.

- **TrueParameter** and **FalseParameter** are any valid expression that are evaluated based on the outcome of the condition.

The following table describes the conditional operators that are fully supported. Alternate syntax is listed wherever it is supported by a conditional operator.

<table>
<thead>
<tr>
<th>Conditional Operator</th>
<th>Syntax</th>
<th>Logic</th>
</tr>
</thead>
</table>
| Equal To             | expression = expression | Tests if the left expression is equal to the right expression.  
  **Note:** The routine that evaluates the condition does not consider any rounding. If rounding is required, use the Round function.  
  **Example:**  
  1 = 4  
  Returns false |
| Greater Than         | expression > expression | Tests if the left expression is greater than the right expression.  
  **Example:**  
  1 > 4  
  Returns false |
| Greater Than or Equal To | expression >= expression | Tests if the left expression is greater than or equal to the right expression.  
  **Note:** The correct syntax is “>=”. The syntax “=>” is not supported.  
  **Example:**  
  1 >= 4  
  Returns false |
| Less Than            | expression < expression | Tests if the left expression is less than the right expression.  
  **Example:**  
  1 < 4  
  Returns true |
| Less Than or Equal To | expression <= expression | Tests if the left expression is less than or equal to the right expression.  
  **Note:** The correct syntax is “<=". The syntax “<” is not supported.  
  **Example:**  
  1 <= 4  
  Returns true |
<table>
<thead>
<tr>
<th>Conditional Operator</th>
<th>Syntax</th>
<th>Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Conditional Operator</strong></td>
<td><strong>Syntax</strong></td>
<td><strong>Logic</strong></td>
</tr>
</tbody>
</table>
| **Not Equal To** | expression <> expression  
expression!= expression | Tests if the left expression is not equal to the right expression.  
**Note:** The routine that evaluates the condition does not consider any rounding. If rounding is required, use the Round function.  
**Example:**  
1 <> 4  
Returns true  
1 != 4  
Returns true |
| **IsMissing** | IsMissing (reference)  
IsMiss (reference) | Tests if the reference contains a #missing result.  
**Note:** If the reference is an expanded row or column, then all resulting cells must be #missing in order for the condition to be true.  
**Example:**  
IsMissing([1])  
Returns true if row 1 has a #missing value. |
| **IsError** | IsError (reference)  
IsErr (reference) | Tests if the reference contains an #error result.  
**Note:** If the reference is an expanded row or column, all resulting cells must be #error in order for the condition to be true. Only formula rows and columns can result in #error.  
**Example:**  
IsError([2])  
Returns true if row 2 has a #error value. |
| **IsNonNumeric** | IsNN (reference)  
IsNonNumerid (reference)  
IfNN (reference)  
IfNonNumber (reference) | Tests if the reference contains a #missing or #error results.  
**Note:** If the reference is an expanded row or column, all resulting cells must be #missing and/or #error in order for the condition to be true.  
**Example:**  
IsNN([3])  
Returns true if row 3 has a #missing or #error value. |
| **Parenthesis** | (condition) | Used to group a condition. Mostly used for visual clarity.  
**Example:**  
(1 > 4)  
Returns false |
Table 39  Complex Conditions

<table>
<thead>
<tr>
<th>Complex Conditions</th>
<th>Syntax</th>
<th>Logic</th>
</tr>
</thead>
</table>
| And                | (condition AND condition)             | Complex condition used to compare two conditions. Returns true if all conditions result in true.  
  | (condition & condition)               |                                                                        | Example:                                                                 |
|                    |                                       | (1 > 4 AND 5 > 2)                                                    | Returns false                                                                 |
| Not                | NOT (condition)                       | Used to negate the result by reversing the result of the condition.   |
  | ! (condition)      |                                       |                                                                        | Example:                                                                 |
|                    |                                       | Not (1 > 4)                                                          | Returns true                                                                 |
| Or                 | (condition OR condition)              | Complex condition used to compare two conditions. Returns true if any of the conditions result in true.  
  | (condition | condition)                           |                                                                        | Example:                                                                 |
|                    |                                       | (1 > 4 OR 5 > 2)                                                    | Returns true                                                                 |

Notes on Conditions

- **Expression** can be any valid formula expression. The expression can be any combination of a constant (integer or real number), a reference, or another function.

- **Reference** can be any valid reference; thus the IFNN reference property can be utilized as part of the reference.

- **Condition** can be any valid condition applied to the complex conditions And, Not, and Or. Those operators can have embedded conditions.

  **Note:**

  And, Not, and Or operators require surrounding parentheses. See “Complex Conditions” on page 235 for additional information.

- When any expression within the condition returns an #error or #missing value, the If function returns #missing or #error. This does not apply when you use the IsMissing, IsError, or IsNonNumeric conditions.

Complex Conditions

Complex conditions And, Or, and Not are fully supported. However, they must be surrounded by parentheses.

Valid example:

If ( ( [A] > [B] and [A] > 1000), [A], [B])
Invalid example:

If ( [A] > [B] and [A] > 1000, [A], [B])

Max

Max function is a mathematical function that returns the maximum value in a group of numeric values, rows, columns, or cells. The function syntax is:

Max (arguments)

where arguments is expressed by one or more of the following arguments:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>numeric</td>
<td>A numeric value. For example, Max (10, 20, 30) returns the value 30. Numeric values can include decimals and negative values. For a description of numeric arguments, see “Numeric Arguments” on page 204.</td>
</tr>
<tr>
<td>row, column, or cell reference</td>
<td>A pointer to a row, column, or cell within a grid. References can be specified in several ways. The reference syntax is: GridName.GridElement[segment (range)].Property. For more information, see “Row, Column, or Cell Reference Arguments” on page 204.</td>
</tr>
<tr>
<td>function</td>
<td>An embedded function. For a list of mathematical functions, see “Mathematical Functions” on page 202.</td>
</tr>
</tbody>
</table>

Examples:
The following example returns the maximum value in rows 1, 6, and 8:

Max(row[1], row[6], row[8])

The following example calculates the maximum of the sums of aggregate rows:

Max(row[1].sum, row[2].sum, row[3].sum)

MemberAlias

This function is available only with Essbase or Planning Details as the database connection. MemberAlias is a text function. Based on the syntax used, it returns the alias of the member assigned to a dimension in the row, column, page, or Point of View (POV).

- The following syntax returns the alias of a row heading, column heading or page. The syntax can be deployed from any heading cell, text cell or text box object and can reference any grid in a current report.

  <<MemberAlias("GridName", Row/Col/Page, "DimName")>>

- The following syntax returns the alias in a row heading, column heading, or page. The syntax can be deployed from any row, column or page heading in a grid that is designated as a custom heading. To designate a custom heading, click the page, row heading or column
heading, then select **Custom Heading** on the property sheet. You can add the function in the space provided below the custom heading.

```
<<MemberAlias("DimName")>>
```

- The following syntax returns the alias of a grid or user POV. The syntax can be deployed from any text cell or text box object and can reference any grid and corresponding POV in a current report.

```
<<MemberAlias("GridName", "POV DimName")>>
```

where:

- **GridName** is the name of the grid.
- **Row/Col/Page** is the numeric identifier of the row, the alphabetical identifier of the column, or the numeric identifier of the page.
- **DimName** is the name of a dimension in the grid row, column, or page.
- **POV DimName** is the name of the dimension on the grid or user POV.

**Example:**

The following examples yield the alias Diet Root Beer, which is the alias that is assigned to the Product dimension in Grid1, column A:

```
<<MemberAlias("Grid1", A, "Product")>>
<<MemberAlias(current, A, "Product")>>
```

The following examples yields the alias for the Year dimension. The syntax is placed on the grid’s custom heading:

```
<<MemberAlias("Year")>>
<<MemberAlias(current)>>
```

The following examples yields the alias for the Scenario dimension for the POV associated with Grid1:

```
<<MemberAlias("Grid1", "Scenario")>>
<<MemberAlias(current, "Scenario")>>
```

**Note:**

This function supports the Current keyword when used in a grid (not text box object). For information and examples, see “**Current / Cur Keyword**” on page 210.

---

**MemberDescription**

This function is available only with Financial Management as the database connection.

MemberDescription is a text function. Based on the syntax used, it returns the description of the member assigned to a dimension in the row, column, page, or Point of View (POV).
The following syntax returns the description of a row heading, column heading or page. The syntax can be deployed from any heading cell, text cell or text box object and can reference any grid in a current report.

```
<<MemberDescription("GridName", Row/Col/Page, "DimName")>>
```

The following syntax returns the description in a row heading, column heading, or page. The syntax can be deployed from any row, column or page heading in a grid that is designated as a custom heading. To designate a custom heading, click the page, row heading or column heading, then select Custom Heading on the property sheet. You can add the function in the space provided below the custom heading.

```
<<MemberDescription("DimName")>>
```

The following syntax returns the description of a grid or user POV. The syntax can be deployed from any text cell or text box object and can reference any grid and corresponding POV in a current report.

```
<<MemberDescription("GridName", "POV DimName")>>
```

where:

- **GridName** is the name of the grid.
- **Row/Col/Page** is the numeric identifier of the row, the alphabetical identifier of the column, or the numeric identifier of the page.
- **DimName** is the name of a dimension in the grid row, column, or page.
- **POV DimName** is the name of the dimension on the grid or user POV.

**Example:**

The following examples yield the description that is assigned to the Product dimension in Grid1, column A:

```
<<MemberDescription("Grid1", A, "Product")>>
```

```
<<MemberDescription(current, A, "Product")>>
```

The following examples yields the description for the Year dimension. The syntax is placed on the grid’s custom heading:

```
<<MemberDescription("Year")>>
```

```
<<MemberDescription(Current)>>
```

The following examples yields the description for the Scenario dimension for the POV associated with Grid1:

```
<<MemberDescription("Grid1", "Scenario")>>
```

```
<<MemberDescription(current, "Scenario")>>
```

**Note:**

This function supports the Current keyword when used in a grid (not text box object). For information and examples, see “Current / Cur Keyword” on page 210.
MemberName

MemberName is a text function. Based on the syntax used, it returns the name of the member assigned to a dimension in the row, column, page, or Point of View (POV).

- The following syntax returns the name of a row heading, column heading or page. The syntax can be deployed from any heading cell, text cell or text box object and can reference any grid in a current report.

  \[
  \text{<<MemberName(“GridName”, Row/Col/Page, “DimName“)>>}
  \]

- The following syntax returns the name in a row heading, column heading, or page. The syntax can be deployed from any row, column or page heading in a grid that is designated as a custom heading. To designate a custom heading, click the page, row heading or column heading, then select Custom Heading on the property sheet. You can add the function in the space provided below the custom heading.

  \[
  \text{<<MemberName(“DimName“)>>}
  \]

- The following syntax returns the name of a grid or user POV. The syntax can be deployed from any text cell or text box object and can reference any grid and corresponding POV in a current report.

  \[
  \text{<<MemberName(“GridName“, “POV DimName“)>>}
  \]

where:

- \text{GridName} is the name of the grid.
- \text{Row/Col/Page} is the numeric identifier of the row, the alphabetical identifier of the column, or the numeric identifier of the page.
- \text{DimName} is the name of a dimension in the grid row, column, or page.
- \text{POV DimName} is the name of the dimension on the grid or user POV.

Example:

The following examples yield the name that is assigned to the Product dimension in Grid1, column A:

  \[
  \text{<<MemberName("Grid1", A, "Product")>>}
  \]

  \[
  \text{<<MemberName(current, A, "Product")>>}
  \]

The following example yields the name for the Year dimension. The syntax is placed on the grid’s custom heading:

  \[
  \text{<<MemberName("Year")>>}
  \]

The following examples yields the name for the Scenario dimension for the POV associated with Grid1:

  \[
  \text{<<MemberName("Grid1", "Scenario")>>}
  \]

  \[
  \text{<<MemberName(current, "Scenario")>>}
  \]
MemberProperty

This function is applicable to Planning Details, Essbase, SSAS, and SAP BW database connections.

MemberProperty is a text function. Based on the syntax used, it returns the member property value of a dimension in the row, column, page, or Point of View (POV). You can use this function to display a member property in a text row or column.

- The following syntax returns the member property of a row heading, column heading or page. The syntax can be deployed from any heading cell, text cell or text box object and can reference any grid in a current report.

  \[
  \text{\texttt{<<MemberProperty(}} \text{GridName}, \text{Row/Col/Page, DimName, Property})\text{>>}
  \]

- The following syntax returns the member property in a row heading, column heading, or page. The syntax can be deployed from any row, column or page heading in a grid that is designated as a custom heading. To designate a custom heading, click the page, row heading or column heading, then select Custom Heading on the property sheet. You can add the function in the space provided below the custom heading.

  \[
  \text{\texttt{<<MemberProperty(}} \text{DimName}, \text{Property})\text{>>}
  \]

- The following syntax returns the member property of a grid or user POV. The syntax can be deployed from any text cell or text box object and can reference any grid and corresponding POV in a current report.

  \[
  \text{\texttt{<<MemberProperty(}} \text{GridName}, \text{POV DimName, Property})\text{>>}
  \]

where:

- \textit{GridName} is the name of the grid.
- \textit{Row/Col/Page} is the numeric identifier of the row, the alphabetical identifier of the column, or the numeric identifier of the page.
- \textit{DimName} is the name of a dimension in the grid row, column, or page.
- \textit{POV DimName} is the name of the dimension on the grid or user POV.
- \textit{Property} is any custom property (attribute dimensions)

Example:

The following examples yield the member property that is assigned to the Product dimension in Grid1, column A:

\[
\text{\texttt{<<MemberProperty(}} \text{"Grid1", A, Product, Pkg Type})\text{>>}
\]

\[
\text{\texttt{<<MemberProperty(current, A, Product, Pkg Type})\text{>>}}
\]
The following examples yields the member property for the Market dimension. The syntax is placed on the grid’s custom heading:

```
<<MemberProperty("Market", Population)>>
<<MemberProperty(current, Population)>>
```

The following examples yields the member property for the Market dimension for the POV associated with Grid1:

```
<<MemberProperty("Grid1", Market, CurrencyCategory)>>
<<MemberProperty(current, Market, CurrencyCategory)>>
```

The following example retrieves the Member Alias and Ounces property of a product in a custom heading. You do this by selecting the heading, then on the Heading Row Properties sheet, selecting the Custom Heading option and clicking the Functions button. The syntax as follows:

```
<<MemberAlias(current, current, Product)>>:
<<MemberProperty(current, current, Product, Ounces)>>
```

The report output would resemble the following example:

<table>
<thead>
<tr>
<th>Otr 1</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Cola: Ounces</td>
<td>5696</td>
</tr>
<tr>
<td>Diet Cola: Ounces</td>
<td>1.55</td>
</tr>
<tr>
<td>Caffeine Free Cola: Ounces</td>
<td>590</td>
</tr>
</tbody>
</table>

**Note:**

This function supports the Current keyword when used in a grid (not text box object). For information and examples, see “Current / Cur Keyword” on page 210.

---

**MemberQualifiedName**

MemberQualifiedName is a text function for use with Essbase data sources. Based on the syntax used, it returns the qualified name of a non unique member assigned to a dimension in the row, column, page, or Point of View (POV). A nonentity member is a child of multiple parents.

**Note:**

This function is supported only for Essbase 9.0 or later releases.

For example, if a member named 100 that is a child of the Product1 member and the Product 2 member, then 100 is a non unique member name. The MemberQualifiedName function shows the qualified names in reports. The qualified member names in this example are [Product1]. [100] and [Product2].[100].

- The following syntax returns the name of a row heading, column heading or page. The syntax can be deployed from any heading cell, text cell or text box object and can reference any grid in a current report.
The following syntax returns the qualified name in a row heading, column heading, or page. The syntax can be deployed from any row, column or page heading in a grid that is designated as a custom heading. To designate a custom heading, click the page, row heading or column heading, then select Custom Heading on the property sheet. You can add the function in the space provided below the custom heading.

The following syntax returns the name of a grid or user POV. The syntax can be deployed from any text cell or text box object and can reference any grid and corresponding POV in a current report.

where:
- GridName is the name of the grid.
- Row/Col/Page is the numeric identifier of the row, the alphabetical identifier of the column, or the numeric identifier of the page.
- DimName is the name of a dimension in the grid row, column, or page.
- POV DimName is the name of the dimension on the grid or user POV.

Example:
The following examples yield the qualified non unique name that is assigned to a the Product dimension in Grid1, column A:

Example:
The following examples yield the name for the Year dimension. The syntax is placed on the grid’s custom heading:

Example:
The following examples yields the qualified non unique name for the Scenario dimension for the POV associated with Grid1:

Note:
This function supports the Current keyword when used in a grid (not text box object). For information and examples, see “Current / Cur Keyword” on page 210.

Min

Min is a mathematical function that returns the minimum value in a group of numeric values, rows, columns, or cells. The function syntax is as follows:
Min \((\text{arguments})\)

where \textit{arguments} is expressed by one or more of the following arguments:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>numeric</td>
<td>A numeric value. For example, Min ((10, 20, 30)) returns the value 10. Numeric values can include decimals and negative values. For a description of numeric arguments, see “Numeric Arguments” on page 204.</td>
</tr>
<tr>
<td>row, column, or cell reference</td>
<td>A pointer to a row, column, or cell within a grid. References can be specified in several ways. The reference syntax is: GridName.GridElement[segment (range)].Property For more information, see “Row, Column, or Cell Reference Arguments” on page 204.</td>
</tr>
<tr>
<td>function</td>
<td>An embedded function. For a list of mathematical functions, see “Mathematical Functions” on page 202.</td>
</tr>
</tbody>
</table>

Examples:

The following example returns the minimum value in rows 1, 6, and 8:

\[
\text{Min (row[1], row[6], row[8])}
\]

The following example calculates the minimum of the sums of aggregate rows:

\[
\text{Min(row[1].sum, row[2].sum, row[3].sum)}
\]

\textbf{Mod}

Mod is a mathematical function that returns the remainder, or modulus, from a division. The function syntax is:

\[
\text{Mod (arg1, arg2)}
\]

where \textit{arg2} is the divisor and \textit{arg1} and \textit{arg2} are expressed by the following arguments:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>numeric</td>
<td>A numeric value. For example, Mod ((6, 4)) returns the value 2. Numeric values can include decimals and negative values. For a description of numeric arguments, see “Numeric Arguments” on page 204.</td>
</tr>
<tr>
<td>row, column, or cell reference</td>
<td>A pointer to a row, column, or cell within a grid. References can be specified in several ways. The reference syntax is: GridName.GridElement[segment (range)].Property For more information, see “Row, Column, or Cell Reference Arguments” on page 204.</td>
</tr>
<tr>
<td>function</td>
<td>An embedded function. For a list of mathematical functions, see “Mathematical Functions” on page 202.</td>
</tr>
</tbody>
</table>

Example:

\[
\text{Mod 243}
\]
The following example divides 10 by 5 and returns the remainder of 0:

\[ \text{Mod} (10, 5) = 0 \]

**Page**

Page is a text function that returns the current page number of a printed report. You can use this function in a text object to display the current page in a printed report. The function syntax is:

\[ \langle\langle \text{Page}()\rangle\rangle \]

**Note:**

The page function works for printed reports only. Online reports display \[[\text{PageCount}()]\] for the page number.

**Example:**

If the current page is eight, the following example yields: Page 8.

\[ \text{Page } \langle\langle \text{PAGE}()\rangle\rangle \]

**Note:**

The page axis on a grid is different from the page number in a printed report.

**PageCount**

PageCount is a text function that returns the total number of pages in a printed report. You can use this function in a text object. The function syntax is:

\[ \langle\langle \text{PageCount}()\rangle\rangle \]

**Note:**

The PageCount function works for printed reports only. Online reports display \[[\text{PageCount}()]\] for the page number.

**Example:**

If the current page count is 6, the following example yields: The total number of pages are: 6.

\[ \text{The total number of pages is: } \langle\langle \text{PageCount}()\rangle\rangle \]
PercentOfTotal

PercentOfTotal is a mathematical function that returns the result of a numeric value, row, column, or cell divided by another numeric value, row, column, or cell which is multiplied by 100. The function syntax is:

\[ \text{PercentOfTotal} \ (\text{arg1}, \ \text{arg2}) \]

- where \( \text{arg1} \) is a component of the running total (\( \text{arg2} \)). Normally, this is a row or column reference.
- where \( \text{arg2} \) is the running total relative to \( \text{arg1} \). Normally this is a cell reference containing the grand total.
- \( \text{arg1} \) is divided by \( \text{arg2} \), with the result multiplied by 100. \( \text{arg1} \) and \( \text{arg2} \) are expressed by one or more of the following arguments:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>numeric</td>
<td>A numeric value. For example, PercentOfTotal (100, 20) returns the value 500.</td>
</tr>
<tr>
<td></td>
<td>Numeric values can include decimals and negative values. For a description of numeric arguments, see “Numeric Arguments” on page 204.</td>
</tr>
<tr>
<td>row, column, or cell reference</td>
<td>A pointer to a row, column, or cell within a grid. References can be specified in several ways. The reference syntax is: GridName.GridElement[segment (range)].Property</td>
</tr>
<tr>
<td></td>
<td>For more information, see “Row, Column, or Cell Reference Arguments” on page 204.</td>
</tr>
<tr>
<td>function</td>
<td>An embedded function. For a list of mathematical functions, see “Mathematical Functions” on page 202.</td>
</tr>
</tbody>
</table>

**Note:**

This function requires two arguments.

**Examples:**

The following example returns the value of 5 percent.

\[ \text{PercentOfTotal} \ (20, \ 400) \]

The following example divides the value of each cell in column A by the Total Mkt value in cell A5, multiplies the result by 100, and displays the resulting PercentOfTotal in column B. The formula:

\[ \text{PercentOfTotal} \ (\text{[A]}, \ \text{[A,5]}) \]

Using the above example, the following table shows the PercentOfTotal results in column B:

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>% Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mkt1</td>
<td>60</td>
<td>20%</td>
</tr>
<tr>
<td></td>
<td>A</td>
<td>B</td>
</tr>
<tr>
<td>---</td>
<td>----</td>
<td>----</td>
</tr>
<tr>
<td>3</td>
<td>Mkt2</td>
<td>120</td>
</tr>
<tr>
<td>4</td>
<td>Mkt3</td>
<td>120</td>
</tr>
<tr>
<td>5</td>
<td>Total Mkt</td>
<td>300</td>
</tr>
</tbody>
</table>

**Tip:**
You enter the formula by clicking on the header for Column B and using the formula bar.

**Pi**

Pi is a mathematical function that returns the number 3.14159265358979, the mathematical constant, accurate to 15 digits. Pi is the ratio of the circumference of a circle to its diameter. The function syntax is:

\[ \text{PI()} \]

**Example:**
The following example returns row 3 divided by the product of Pi and 2:

\[ \text{row[3]} / (\text{PI()} * 2) \]

**PlanningAnnotations**

PlanningAnnotations is a text function that retrieves the critical notes or comments associated with a cell’s PlanningUnit from the Planning Details database connection. PlanningUnits are a combination of Scenario, Version, and Entity and are derived in Financial Reporting through cell references in a grid.

The function syntaxes are:

\[
<<\text{PlanningAnnotations} \left( \text{GridName}, \text{Row}, \text{Column}, \text{Page}, \text{Attributes}, \text{Range} \right) >>
\]

\[
<<\text{PlanningAnnotations} \left( \text{GridName}, \text{Row}, \text{Column}, \text{Page}, \text{Attributes} \right) >> \quad \text{(assumes “All” for Range parameter)}
\]

**Examples**

\[
<<\text{PlanningAnnotations} \left( \text{Grid Name} \right., \text{1,a,1,All, All} ) >>
\]

\[
<<\text{PlanningAnnotations} \left( \text{Grid Name} \right., \text{100,AB,10,All, All} ) >>
\]

\[
<<\text{PlanningAnnotations} \left( \text{cur, cur,a,cur,Text & Title & Author, Top 5} \right) >>
\]

\[
<<\text{PlanningAnnotations} \left( \text{cur, 315, AB, 255, Text&Title&Author, Top 5} \right) >>
\]

\[
<<\text{PlanningAnnotations} \left( \text{cur, cur A, Cur, PlanningUnit, Top 5} \right) >>
\]

\[
<<\text{PlanningAnnotations} \left( \text{cur, 123, ABC, 101, PlanningUnit, Top5} \right) >>
\]

\[
<<\text{PlanningAnnotations} \left( \text{Grid1, 1, current, cur, Title & Text, Bottom 10} \right) >>
\]

\[
<<\text{PlanningAnnotations} \left( \text{Grid1, 105, ABC, cur, Title & Text, Bottom 10} \right) >>
\]

\[
<<\text{PlanningAnnotations} \left( \text{“Current\”, 34, BB, cur, “All”, Top 40} \right) >>
\]

\[
<<\text{PlanningAnnotations} \left( \text{cur, cur, A cur, “Text & Title & Author”, Top 5} \right) >>
\]

\[
<<\text{PlanningAnnotations} \left( \text{cur, cur, A cur, “Text&Title&Author, “bottom15”} \right) >>
\]
The following table provides a summary of the PlanningAnnotations parameters.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GridName</td>
<td>The name of a grid. GridName is a required parameter.</td>
</tr>
<tr>
<td>Row</td>
<td>A numeric value representing the row number of the grid. The first row in a grid has an index of 1, the second row has an index of 2, and so forth. Row is a required parameter.</td>
</tr>
<tr>
<td>Column</td>
<td>A letter representing the column of the grid. The first column in a grid has an index of A, the second column has an index of B, and so forth. Column is a required parameter.</td>
</tr>
<tr>
<td>Page</td>
<td>A numeric value representing the page dimension index of the grid. The first page dimension in a grid has an index of 1, the second page dimension has an index of 2, and so forth. Page is a required parameter.</td>
</tr>
<tr>
<td>Attributes</td>
<td>The Attributes parameter may include any of the following values: All, Title, Author, Date, Text, PlanningUnit. PlanningUnit is the combination of scenario, version, and entity and is derived from the GridName, Row, column, and Page. The Attributes parameters may be rearranged in the preferred order of output. Each attribute must be separated with an ampersand (&amp;).</td>
</tr>
<tr>
<td>Range</td>
<td>You can use the keywords All, Top, or Bottom. to select a certain number of annotations from the top or bottom of an output, or all annotations; for example:</td>
</tr>
<tr>
<td></td>
<td>● All returns all annotations</td>
</tr>
<tr>
<td></td>
<td>● Top 5 returns the first five annotations</td>
</tr>
<tr>
<td></td>
<td>● Bottom 10 returns the last ten annotations</td>
</tr>
<tr>
<td></td>
<td>● Bottom 1 returns the last annotation</td>
</tr>
</tbody>
</table>

**Example**

For this example you retrieve annotation text that is in row 1, column A, of a grid which is on the current page. You want to display the bottom 3 annotations and all attributes associated with the annotation (title, author, date, text, and planning unit).

**Note:**

If you know that your annotations span multiple pages, Hyperion recommends that you place the function in a text row on a grid, then select Adjust Row Height to Fit on the Row Properties sheet so the text can span multiple pages. This option is not available in a text object. When you use annotations in a text object, only the portion that fits on the page is printed. However, everything is included in HTML output.

- This syntax may be used in a text cell:

  ```text
  <<PlanningAnnotations(Current, 1, A, Current, All, Bottom 3)
  ```
Annotations are returned chronologically in descending order by date, with the most recent annotations on top and the oldest annotation on the bottom.

The resulting annotation text resembles the following example:

Title: Status - Under Review
Author: John Smith
Date: Mar 25, 2003 10:32:49 AM
Planning Unit: Budget, 1st Draft, East
Text: Please review and approve

Title: Status - Not Signed Off
Author: Mary Brown
Date: Mar 21, 2003 2:59:11 PM
Planning Unit: Budget, 1st Draft, West
Text: Sorry, Try Again

Title: Status - Under Review
Author: Admin
Date: Mar 21, 2003 2:54:16 PM
Planning Unit: Budget, 1st Draft, South
Text: Please review and approve budget for 1st draft

Note:
This function supports the Current keyword when used in a grid (not text box object). For information and examples, see “Current / Cur Keyword” on page 210.

Specifying Demarcations Between Annotations

The default demarcation symbols that separate Planning Details unit annotations are a series of em dash characters (—). You can specify another demarcation symbol by configuring the PUASeparator in the fr_repserver.properties file.

Note:
This change affects all reports that retrieve Planning Details unit annotations.

➤ To enter new demarcation symbols:

1 Log off Financial Reporting.
2 Locate the fr_repserver.properties file and open it for editing; for example:
   C:\Hyperion\BIPlus\lib\fr_repserver.properties
3 Locate PUASeparator and repeat the number of demarcation symbols you want to use; for example:
   PUASeparator= — — — — — — — — — — — — — — — — —
4 Save and close the file.
5 Restart the Report Server service, then log on to Financial Reporting.

POVAlias

POVAlias is a text function that returns the alias of the member assigned to a dimension in the user POV. POVAlias is available only with Essbase and Planning Details as the database connection. The function syntax is as follows:

\[ \text{POVAlias} ("GridName", DimName) \]

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GridName</td>
<td>The name of a grid in the report.</td>
</tr>
<tr>
<td>DimName</td>
<td>The name of a dimension in the grid POV or user POV.</td>
</tr>
</tbody>
</table>

Example:

The following example yields the alias, Diet Root Beer, because Diet Root Beer is the alias that is assigned to the Product dimension in the user POV for Grid1.

\[ \text{POVAlias}("Grid1", Product) \]

Note:

This function supports the Current keyword. For information and examples, see “Current / Cur Keyword” on page 210. However, the keyword should be used in the DimName parameter only when the Current Point-of-View member selection is used; otherwise it is invalid.

POVDescription

POVDescription is a text function that returns the description of the member assigned to a dimension in the POV. POVDescription is available only with Financial Management as the database connection. The function syntax is:

\[ \text{POVDescription} ("GridName", DimName) \]

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GridName</td>
<td>The name of a grid in the report.</td>
</tr>
<tr>
<td>DimName</td>
<td>The name of a dimension in the grid POV or user POV.</td>
</tr>
</tbody>
</table>
Example:
The following example yields the description, Diet Root Beer, because Diet Root Beer is the description that is assigned to the Product dimension in the user POV for Grid1.

<<POVDescription("Grid1", Product)>>

Note:
This function supports the Current keyword. For information and examples, see “Current / Cur Keyword” on page 210. However, the keyword should be used in the DimName parameter only when the Current Point-of-View member selection is used; otherwise it is invalid.

POV / POVMember

POVMember is a text function that returns the member name of the member assigned to a dimension in the POV. The function syntax is:

<<POVMember ("GridName", DimName)>>

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GridName</td>
<td>The name of a grid in the report.</td>
</tr>
<tr>
<td>DimName</td>
<td>The name of a dimension in the user POV.</td>
</tr>
</tbody>
</table>

Example:
The following example yields the member, 200, because 200 is the member that is assigned to the Product dimension in the user POV for Grid1.

<<POVMember("Grid1",Product)>>

Note:
This function supports the Current keyword. For information and examples, see “Current / Cur Keyword” on page 210. However, the keyword should be used in the DimName parameter only when the Current Point-of-View member selection is used; otherwise it is invalid.

ProcessManagementStatus

This function is available only with Financial Management as the database connection.

ProcessManagementStatus is a text function that returns the status of a cell in a Financial Management database connection. The possible process levels are Not Started, First Pass, Submitted, Approved, Published, Not Supported, Review Levels 1 through 10. You can use this function in a text box, a text cell, or a text row or column heading.

The function syntax is as follows:

<<ProcessManagementStatus("GridName", Row, Col, Page)>>
### GridName
The name of a Financial Management grid. This value must be enclosed in quotation marks.

### Row
Numeric value representing the row index of the grid. The first row in a grid has an index of 1, the second row has an index of 2, and so forth.

### Col
A letter representing the column of the grid. The first column in a grid has an index of A, the second column has an index of B, and so forth.

### Page
A numeric value representing the page dimension index of the grid. The first page dimension in a grid has an index of 1, the second page dimension has an index of 2, and so forth.

## Example 1
The following syntax examples display the status for the cell that is in row 21, column B on page 1 of Grid1:

```plaintext
<<ProcessManagementStatus("Grid1", 21, B, 1)>>
<<ProcessManagementStatus(Current, 21, B, 1)>>
```

## Example 1
The following syntax example, entered in the text column heading, displays the status for all cells in column B, on page 1 of the current grid:

```plaintext
<<ProcessManagementStatus(Current, Current, B, 1)>>
```

**Note:**
This function supports the Current keyword when used in a grid (not text box object). For information and examples, see “Current / Cur Keyword” on page 210.

## Product
Product is a mathematical function that multiplies all numbers or references and returns the product. The function syntax is:

**Product**(arguments)

where arguments is expressed by one or more of the following arguments:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>numeric</td>
<td>A numeric value. For example, Product(2, 20) returns the value 40. Numeric values can include decimals and negative values. For a description of numeric arguments, see “Numeric Arguments” on page 204.</td>
</tr>
<tr>
<td>row, column, or cell reference</td>
<td>A pointer to a row, column, or cell within a grid. References can be specified in several ways. The reference syntax is: GridName.GridElement[segment (range)].property</td>
</tr>
</tbody>
</table>
Random

Random is a mathematical function that returns a random number between 0.0 and 1.0. The function syntax is:

```
Random()
```

Example:
The following example returns a random number between 0.0 and 1.0 and multiplies it by 1000:

```
Random() * 1000
```

Rank

Rank is a financial function that provides a rank value for a value in a specified range. The Rank function is processed by Financial Reporting and does not depend on the database connection. The function syntax is as follows:

```
Rank([Range], Order)
```

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range</td>
<td>The range of cells, rows, or columns to rank, with letters identifying columns and numbers identifying rows. For example, specify [A,1:5] to rank the values for rows 1 through 5 in column A. You can use the .ifNN property with a range of cells to assign numbers to any cells with nonnumeric values so that those cells can be ranked. For example, you can use .ifNN(-1) to assign the value -1 to any cell with a missing value.</td>
</tr>
</tbody>
</table>
| Order    | 0 to rank values in ascending order and return the rank of highest value or 1 to rank values in descending order and return the rank of lowest value. You can also use the following keywords to indicate ascending or descending order:  
  - Ascending
  - Descending
  - Asc
  - Des
  - Desc |
You can use the Rank function as an embedded argument. It works with the following suppression criteria:

- Skipnone
- Skipmissing
- Skipzero
- Skipboth

Examples

This formula in column B ranks the values in rows 1 through 5 in column A in ascending order:

```
Rank([A,1:5], ascending)
```

The result might be as follows:

<table>
<thead>
<tr>
<th>East</th>
<th>Rank</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cola</td>
<td>16</td>
</tr>
<tr>
<td>Fruit Drinks</td>
<td>23</td>
</tr>
<tr>
<td>Beer</td>
<td>16</td>
</tr>
<tr>
<td>Diet</td>
<td>missing</td>
</tr>
<tr>
<td>Root Beer</td>
<td>0</td>
</tr>
</tbody>
</table>

When two values are equal, they receive the same rank value. In the example above, Cola and Beer have the same value and therefore the same rank.

This formula in column B assigns the value of -1 to any nonnumeric value so it can be ranked:

```
Rank([A,1:5].ifNN(-1), ascending)
```

In the following result, the missing value now has a rank of 5:

<table>
<thead>
<tr>
<th>East</th>
<th>Rank</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cola</td>
<td>16</td>
</tr>
<tr>
<td>Fruit Drinks</td>
<td>23</td>
</tr>
<tr>
<td>Beer</td>
<td>16</td>
</tr>
<tr>
<td>Diet</td>
<td>missing</td>
</tr>
<tr>
<td>Root Beer</td>
<td>0</td>
</tr>
</tbody>
</table>
The following example uses the Rank function as an embedded argument. This example returns a zero if the rank of the corresponding cells in column A are not within the top 10; otherwise, it multiplies the value in column A by 10 percent:

\[
\text{If (Rank([A],1)>10, 0), Eval([A]*10\%)}
\]

### ReportAuthor

ReportAuthor is a text function that returns the user name of the creator of the report. You can use this function in a text box, text cell, or a row or column heading. The function syntax is:

```
<<ReportAuthor()>>
```

**Example:**
The following example returns the name of the report author:

```
<<ReportAuthor()>>
```

### ReportCreated

ReportCreated is a text function that returns the creation date of the current report. You can use this function in a text box, text cell, or a row or column heading. The function syntax is:

```
<<ReportCreated("format")>>
```

where `format` is a list of characters that define the format of the date and time. For a detailed description of date and time formats see Table 37 on page 224.

**Note:**
The date and time format is case-sensitive. ReportCreated returns a value only after the report is saved.

**Example:**
The following example inserts the report creation date in the body of a report:

```
<<ReportName()>> - Created on <<ReportCreated("d-MM-yy")>>
```

### ReportDesc

ReportDesc is a text function that returns the text description of the current report. You can use this function in a text box, text cell, or a row or column heading. The report description is a report property. The function syntax is:

```
<<ReportDesc()>>
```

**Example:**
The following example inserts a report description in the body of a report:
Note:
You can define a report description when you save the report. Afterward, you can change the
description changed in the repository or when you save the report again with the Save As command.

ReportFolder

ReportFolder is a text function that returns the path of the folder where the report is located. You can use this function in a text box, text cell, or a row or column heading.

The function syntax is:

\[<<\text{Reportfolder()}>>\]

Example:
The following example inserts the path of the folder where the report is located:

\[<<\text{Reportfolder( )>>}\]

The following considerations provide additional information when using ReportFolder:

- The report must be located in a folder other than the root folder. The root folder is not considered a report folder and returns an empty string.
- The report must first be saved to a folder in order to return the correct string. An unsaved report returns an empty string.
- If you open a report containing a ReportFolder function, save it to a new folder, then Print Preview the report, the previous location of the folder is displayed. This is by design for performance reasons. To re-evaluate the report, modify a grid or report object, then Print Preview to see the new folder location.

ReportModified

ReportModified is a text function that returns the date the current report was last modified. You can use this function in a text box, text cell, or a row or column heading. The function syntax is:

\[<<\text{ReportModified(”format”)}>>\]

where \textit{format} is a list of characters enclosed in quotes that define the format of the date and time. For a detailed description of date and time formats, see Table 37 on page 224.

Note:
The date and time format is case-sensitive. ReportModified returns a value only after the report is saved.
Example:
The following example inserts the date Jan 19, 2002. That is the date the report was last modified:

\[ \text{Report Modified: } \langle\langle \text{ReportModified("MMM dd, yyyy")} \rangle\rangle \]

**ReportModifiedBy**

*ReportModifiedBy* is a text function that returns the user name of the last user to save the report. You can use this function in a text box, text cell, or a row or column heading. The function syntax is:

\[ \langle\langle \text{ReportModifiedBy()} \rangle\rangle \]

Example:
The following example inserts the user name of the last user to save the report:

\[ \langle\langle \text{ReportModifiedBy()} \rangle\rangle \]

**ReportName**

*ReportName* is a text function that returns the name of the current report. You can use this function in a text box, text cell, or a row or column heading. The function syntax is:

\[ \langle\langle \text{ReportName()} \rangle\rangle \]

Example:
The following example inserts the report name:

\[ \langle\langle \text{ReportName()} \rangle\rangle \]

**ReportRunBy**

*ReportRunBy* is a text function that returns the username of the user who is running the report. You can use this function in a text box, text cell, or a row or column heading. The function syntax is:

\[ \langle\langle \text{ReportRunBy()} \rangle\rangle \]

Example:
The following example inserts the username of the user who is running the report:

\[ \langle\langle \text{ReportRunBy()} \rangle\rangle \]

**Round**

*Round* is a mathematical function that rounds a number up or down by the specified digits. The function syntax is:
Round \((arg1, integer)\)

where \(arg1\) is expressed by one or more of the following arguments:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>numeric</td>
<td>A numeric value. For example, Round((81.3987,3)) returns the value 81.399. Numeric values can include decimals and negative values. For a description of numeric arguments, see &quot;Numeric Arguments&quot; on page 204.</td>
</tr>
<tr>
<td>row, column, or cell reference</td>
<td>A pointer to a row, column, or cell within a grid. References can be specified in several ways. The reference syntax is: GridName/GridElement[segment (range)].property For more information, see &quot;Row, Column, or Cell Reference Arguments&quot; on page 204.</td>
</tr>
<tr>
<td>function</td>
<td>An embedded function. For a list of mathematical functions, see &quot;Mathematical Functions&quot; on page 202.</td>
</tr>
</tbody>
</table>

**Integer** specifies the number of digits to which you want to round the number:

- If *integer* is greater than zero, the number rounds to the specified number of decimal places.
- If *integer* is zero, the number rounds to the nearest integer.
- If *integer* is less than zero, the number is rounded to the left of the decimal point.

**Examples:**

The following example rounds to 3 decimals:

\[
\text{Round}(3594.5567,3) = 3594.557
\]

The following example rounds to the nearest integer:

\[
\text{Round}(3594.5567,0) = 3595
\]

The following example rounds to the thousands. This is also known as scaling:

\[
\text{Round}(3594.5567,-3) = 4000
\]

---

**Sqrt**

Sqrt is a mathematical function that returns the square root of a numeric value, row, column, or cell. The syntax for the Sqrt function is:

\[\text{Sqrt} \ (\text{argument})\]

where \(\text{argument}\) is expressed by one of the following arguments:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>numeric</td>
<td>A numeric value. For example, Sqrt((100)) returns the value 10. Numeric values can include decimals and negative values. For a description of numeric arguments, see &quot;Numeric Arguments&quot; on page 204.</td>
</tr>
</tbody>
</table>
Argument | Description
--- | ---
row, column, or cell reference | A pointer to a row, column, or cell within a grid. References can be specified in several ways. The reference syntax is: `GridName.GridElement[segment (range)].property`

For more information, see “Row, Column, or Cell Reference Arguments” on page 204.

function | An embedded function. For a list of mathematical functions, see “Mathematical Functions” on page 202.

Example

The following example returns the value of 4:

```
Sqrt(16)
```

**Sum**

Sum is a mathematical function that returns the summation of a group of numeric values, rows, columns, or cells.

The syntax for the Sum function is:

```
Sum (arguments)
```

where *arguments* is expressed by one or more of the following arguments:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>numeric</td>
<td>A numeric value. For example, <code>Sum(10, 20, 30)</code> returns the value 60. Numeric values can include decimals and negative values. For a description of numeric arguments, see “Numeric Arguments” on page 204.</td>
</tr>
</tbody>
</table>
| row, column, or cell reference | A pointer to a row, column, or cell within a grid. References can be specified in several ways. The reference syntax is: `GridName.GridElement[segment (range)].property`

For more information, see “Row, Column, or Cell Reference Arguments” on page 204. |
| function | An embedded function. For a list of mathematical functions, see “Mathematical Functions” on page 202. |

Examples:

The following example returns the value 30:

```
sum(10,20)
```

The following example returns the sum of three rows:

```
sum(row[1],row[6],row[8])
```

The following example calculates the sum of three aggregate columns:

```
sum(column[E], column[G], column[I])
```
The following example calculates the sum of two columns which are located on different grids:

\[ \text{sum(grid1.col[E], grid2.colmn[E])} \]

**Truncate / Trunc**

Truncate is a mathematical function that removes the specified number of digits from numeric values.

**Syntax:**

\[
\text{Trunc (arg1, integer)}
\]

- where \( \text{arg1} \) is expressed by one of the following arguments:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>numeric</td>
<td>A numeric value. For example, 234.567. For a description of numeric arguments, see “Numeric Arguments” on page 204.</td>
</tr>
</tbody>
</table>
| row, column, or cell reference | A pointer to a row, column, or cell within a grid. References can be specified in several ways. The reference syntax is: GridName.GridElement[segment (range)].property  
For more information, see “Row, Column, or Cell Reference Arguments” on page 204. |
| function              | An embedded function. For a list of mathematical functions, see “Mathematical Functions” on page 202.                                          |

- where \( \text{integer} \) specifies the number of digits you want to remove:

  - A positive \( \text{integer} \) determines the number of significant digits that remain to the right of the decimal point.
  - A zero (0) \( \text{integer} \) returns the integer located to the left of the decimal point.
  - A negative \( \text{integer} \) indicates the number of significant digits that are truncated to the left of the decimal point.

**Examples:**

The following statement uses a positive integer of 2. The first two digits to the right of the decimal point remain, and the following digit is removed:

\[ \text{Trunc(234.567, 2)} = 234.56 \]

The following statement uses a zero (0) integer. All digits to the right of the decimal point are removed:

\[ \text{Trunc(234.567, 0)} = 234 \]

The following statement uses a negative integer of -2. All digits to the right of the decimal point are removed and the last 2 digits of the integer are truncated.

\[ \text{Trunc(234.567, -2)} = 200 \]
Note:
Formatting previously applied to a cell, column, or row is maintained when you use the Trunc function. The following example shows the results of a Trunc function where the cell value was previously formatted to display three decimal places: \( \text{Trunc}(234.567, 0) = 234.000 \)

**VariableValue**

Used with SAP-BW, VariableValue provides information on what values are used for a SAP-BW variable response.

**Syntax:**

\(<\text{VariableValue}(<\text{GridName}\text{"}, "\text{VariableName}">)>\>

where:

- “\text{GridName}” is the name of the Grid with an SAP-BW datasource. The “current” keyword is supported when the function is used inside of a grid (text cell and/or custom heading).
- “\text{VariableName}” is the name of the SAP-BW variable from which to obtain the return information.

**Note:**

As with all text function, although the quotes are optional, they should be used when the variable name contains non-alphanumeric characters such as parenthesis or a comma.

**Variance / Var**

Variance is a financial function that evaluates the difference between the specified values based on account type for the current account. For example, for an Income, Flow, Asset, or Balance account, a positive result represents an increase, so the result appears as a positive number. For Expense or Liability accounts, a positive result represents a decrease, so the result appears as a negative number. This function is available for standard Essbase, Planning Details, and Financial Management database connections.

- For Essbase: You can use members of an Accounts type dimension that are tagged as Expense or Non Expense.
- For Planning Details: In addition to above (Essbase), you can use the following UDA (User Defined Attributes) Accounts types that are also defined as Asset, Liability, Equity, Revenue, and Expense.
- For Financial Management: You can use the following Accounts types: Asset, Liability, Income, Expense, Flow, Balance, and Balance Recurring.

**Syntax:**

\( \text{Var} (\text{reference1}, \text{reference2}) \)
where reference1 and reference2 are references to a row, column, or cell that correspond to members of the same Account dimension whose variance results are to be calculated.

**Expected Results Using Essbase**

The following table describes the expected results when using the Variance function with Essbase Accounts type members tagged as Expense or Non Expense.

<table>
<thead>
<tr>
<th>Column A</th>
<th>Column B</th>
<th>Var ([A], [B])=0</th>
<th>Var ([A], [B])&gt;0</th>
<th>Var ([A], [B])&lt;0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Non Expense</td>
<td>Non Expense</td>
<td>0</td>
<td>Returns a positive value</td>
<td>Returns a negative value</td>
</tr>
<tr>
<td>Expense</td>
<td>Expense</td>
<td>0</td>
<td>Returns a negative value</td>
<td>Returns a positive value</td>
</tr>
</tbody>
</table>

**Expected Results Using Planning Details**

The following table describes the expected results when using the Variance function with Planning Details Accounts tagged with the below UDAs.

<table>
<thead>
<tr>
<th>Column A</th>
<th>Column B</th>
<th>Var ([A], [B])=0</th>
<th>Var ([A], [B])&gt;0</th>
<th>Var ([A], [B])&lt;0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset</td>
<td>Asset</td>
<td>0</td>
<td>Returns a positive value</td>
<td>Returns a negative value</td>
</tr>
<tr>
<td>Liability</td>
<td>Liability</td>
<td>0</td>
<td>Returns a negative value</td>
<td>Returns a positive value</td>
</tr>
<tr>
<td>Equity</td>
<td>Equity</td>
<td>0</td>
<td>Returns a positive value</td>
<td>Returns a negative value</td>
</tr>
<tr>
<td>Revenue</td>
<td>Revenue</td>
<td>0</td>
<td>Returns a positive value</td>
<td>Returns a negative value</td>
</tr>
<tr>
<td>Expense</td>
<td>Expense</td>
<td>0</td>
<td>Returns a negative value</td>
<td>Returns a positive value</td>
</tr>
</tbody>
</table>

**Expected Results Using Financial Management**

The following table describes the expected results when using the Variance function with Financial Management Accounts listed below.

<table>
<thead>
<tr>
<th>Column A</th>
<th>Column B</th>
<th>Var ([A], [B])=0</th>
<th>Var ([A], [B])&gt;0</th>
<th>Var ([A], [B])&lt;0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset</td>
<td>Asset</td>
<td>0</td>
<td>Returns a positive value</td>
<td>Returns a negative value</td>
</tr>
<tr>
<td>Liability</td>
<td>Liability</td>
<td>0</td>
<td>Returns a negative value</td>
<td>Returns a positive value</td>
</tr>
<tr>
<td>Income</td>
<td>Income</td>
<td>0</td>
<td>Returns a positive value</td>
<td>Returns a negative value</td>
</tr>
<tr>
<td>Column A</td>
<td>Column B</td>
<td>( \text{Var ([A], [B])} = 0 )</td>
<td>( \text{Var ([A], [B])} &gt; 0 )</td>
<td>( \text{Var ([A], [B])} &lt; 0 )</td>
</tr>
<tr>
<td>----------------</td>
<td>----------------</td>
<td>----------------------------------</td>
<td>---------------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>Expense</td>
<td>Expense</td>
<td>0</td>
<td>Returns a positive value</td>
<td>Returns a negative value</td>
</tr>
<tr>
<td>Flow</td>
<td>Flow</td>
<td>0</td>
<td>Returns a positive value</td>
<td>Returns a negative value</td>
</tr>
<tr>
<td>Balance</td>
<td>Balance</td>
<td>0</td>
<td>Returns a positive value</td>
<td>Returns a negative value</td>
</tr>
<tr>
<td>Balance Recurring</td>
<td>Balance Recurring</td>
<td>0</td>
<td>Returns a positive value</td>
<td>Returns a negative value</td>
</tr>
</tbody>
</table>

**Variance Behavior**

- The Variance function expects comparison of the same account type. When you compare two different account types, like Sales & Expense, the Variance function performs the straight math without applying the logic of the account type. For example:

<table>
<thead>
<tr>
<th>Sales</th>
<th>Expense</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>-400</td>
<td>100</td>
<td>-500</td>
</tr>
</tbody>
</table>

- In Essbase and Planning Details, when the Variance function is applied to a dimension that is not tagged as an Accounts type, an #error results at runtime.
- #missing is treated as zero (0), unless specified differently using the ifnonnumber property.
- #error results in #error, unless specified differently using the ifnonnumber property.

**Examples**

The Variance function accepts cell, column, or row references only. For more information, see “Row, Column, or Cell Reference Arguments” on page 204.

**Sample syntax referencing a column:**

Var ([A], [B])

**Sample syntax referencing a row:**

Var ([3], [4])

**Sample syntax referencing a cell:**

Var (Cell [3,A], [3,B])

In this example, the variance between column A (Actual) and column B (Budget) is calculated as follows:

\( \text{Var([A],[B])} \)

This example produces the following report:

<table>
<thead>
<tr>
<th>Year</th>
<th>Product</th>
<th>Actual</th>
<th>Budget</th>
<th>Variance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales (Income)</td>
<td></td>
<td>400,855</td>
<td>373,080</td>
<td>27,775</td>
</tr>
<tr>
<td>COGS (Expense)</td>
<td></td>
<td>179,336</td>
<td>158,940</td>
<td>-20,396</td>
</tr>
</tbody>
</table>

262  Using Functions
VariancePercent / VarPer

VariancePercent is a financial function that evaluates the difference, in percent, between the specified values based on account type for the current account. For example, for an Income, Flow, Asset, or Balance account, a positive result represents an increase, so the result appears as a positive number. For Expense or Liability accounts, a positive result represents a decrease, so the result appears as a negative number. This function is available for standard Essbase, Planning Details, and Financial Management database connections.

- **For Essbase**: You can use members of an Accounts type dimension that are tagged as "Expense" or "Non Expense".
- **For Planning Details**: In addition to above (Essbase), you can use the following UDA (User Defined Attributes) Accounts types that are also defined as Asset, Liability, Equity, Revenue, and Expense.
- **For Financial Management**: You can use the following Accounts types: Asset, Liability, Income, Expense, Flow, Balance, Balance Recurring.

**Syntax:**

\[
\text{VarPer (reference1, reference2)}
\]

- where \( \text{reference1} \) and \( \text{reference2} \) are references to a row, column, or cell that correspond to members of the same Account dimension whose VariancePercent results are to be calculated.

**Expected Results Using Essbase**

The following table describes the expected results when using the VariancePercent function with Essbase Accounts type members tagged as Expense or Non Expense.

<table>
<thead>
<tr>
<th>Col A</th>
<th>Col B</th>
<th>( \text{VarPer ([A] , [B])=0} )</th>
<th>( \text{VarPer([A] , [B])&gt;0} )</th>
<th>( \text{VarPer ([A] , [B])&lt;0} )</th>
</tr>
</thead>
<tbody>
<tr>
<td>Non Expense</td>
<td>Non Expense</td>
<td>0</td>
<td>Returns a positive value</td>
<td>Returns a negative value</td>
</tr>
<tr>
<td>Expense</td>
<td>Expense</td>
<td>0</td>
<td>Returns a negative value</td>
<td>Returns a positive value</td>
</tr>
</tbody>
</table>

**Expected Results Using Planning Details**

The following table describes the expected results when using the VariancePercent function with Planning Details Accounts tagged with the below UDAs.
**Expected Results Using Financial Management**

The following table describes the expected results when using the VariancePercent function with Financial Management Accounts listed below.

<table>
<thead>
<tr>
<th>Col A</th>
<th>Col B</th>
<th>VarPer ([A], [B])=0</th>
<th>VarPer ([A], [B])&gt;0</th>
<th>VarPer ([A], [B])&lt;0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset</td>
<td>Asset</td>
<td>0</td>
<td>Returns a positive value</td>
<td>Returns a negative value</td>
</tr>
<tr>
<td>Liability</td>
<td>Liability</td>
<td>0</td>
<td>Returns a negative value</td>
<td>Returns a positive value</td>
</tr>
<tr>
<td>Equity</td>
<td>Equity</td>
<td>0</td>
<td>Returns a positive value</td>
<td>Returns a negative value</td>
</tr>
<tr>
<td>Revenue</td>
<td>Revenue</td>
<td>0</td>
<td>Returns a positive value</td>
<td>Returns a negative value</td>
</tr>
<tr>
<td>Expense</td>
<td>Expense</td>
<td>0</td>
<td>Returns a negative value</td>
<td>Returns a positive value</td>
</tr>
</tbody>
</table>

**VariancePercent Behavior**

- The VariancePercent function expects comparison of the same account type. When you compare two different account types, like Sales & Expense, the VariancePercent function performs the straight math without applying the logic of the account type. For example:

<table>
<thead>
<tr>
<th>Sales</th>
<th>Expense</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>-400</td>
<td>100</td>
<td>-5.</td>
</tr>
</tbody>
</table>

- In Essbase and Planning Details, when the VariancePercent function is applied to a dimension that is not “Accounts” type, an #error results at runtime.
- #missing is treated as zero (0), unless specified differently using ifnonnumber property.
- #error is results in #error, unless specified differently using ifnonnumber property.
Examples:
The VariancePercent function accepts, cell, column, or row references only. For more information, see “Row, Column, or Cell Reference Arguments” on page 204

<table>
<thead>
<tr>
<th>Sample syntax referencing a column:</th>
<th>VarPer ([A], [B])</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample syntax referencing a row:</td>
<td>VarPer ([3], [4])</td>
</tr>
<tr>
<td>Sample syntax referencing a cell:</td>
<td>VarPer (Cell [3,A], [3,B])</td>
</tr>
</tbody>
</table>

In this example, the VariancePercent between column A (Actual) and column B (Budget) is calculated as follows:
VarPer([A],[B])

This example produces the following report:

<table>
<thead>
<tr>
<th>Year</th>
<th>Product</th>
<th>Market</th>
<th>Actual</th>
<th>Budget</th>
<th>VariancePercent</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Sales(Income)</td>
<td></td>
<td>400,855</td>
<td>373,080</td>
<td>7%</td>
</tr>
<tr>
<td></td>
<td>COGS (Expense)</td>
<td></td>
<td>179,336</td>
<td>158,940</td>
<td>-13%</td>
</tr>
</tbody>
</table>

xbrlUnit

xbrlUnit is a text function that returns information about an XBRL unit that has been defined within a grid. xbrlUnit is supported in a heading cell or text cell, but not in text objects. The function syntax are

xbrlUnit is a text function that returns information about an XBRL unit that has been defined within a grid. xbrlUnit is supported in a heading cell or text cell, but not in text objects. The function syntax are

```
<<xbrlUnit("InfoType")>>
```

```
<<xbrlUnit("GridName", Row, Column, Page, "InfoType")>>
```

where:

Note:
The reference parameters will update when rows or columns are added or deleted from the grid.

Note:
The “current” keyword is supported for the reference parameters (“GridName”, Row, Column, and Page). However, it must be used within a grid’s text cell and/or custom heading (not supported in text objects).

Example:
The following example inserts the unit description into the column heading for an XBRL unit:

<<xbrlContext("unit")>>

xbrlContext

xbrlContext is a text function that returns the value of a specified XBRL context property. You can use this function only in a column heading or a text cell in the column that is set up with XBRL context. The function syntax is:

<<xbrlContext("InfoType")>>

<<xbrlContext("Gridname", Row, Column, Page, InfoType")>>

where:

● **GridName** is the name of the Grid with XBRL metadata.
● **Column** is the column segment (design time) identifier within the grid.
● **Row** is the row segment (design time) identifier within the grid.
● **Page** is the page to be used within the grid. (This parameter is currently ignored because, presently, XBRL metadata can be assigned only within the two-dimensional grid basis (on a row or column). It is provided for future use and consistency with other text functions.)
● **InfoType** is one of the following values.
  ○ entityIdentifier
  ○ entityScheme
  ○ entitySegment
  ○ unit
  ○ unit2
  ○ unitOperation
  ○ period
  ○ cwa
  ○ precision
  ○ scenario

**Note:**
The reference parameters will update when rows or columns are added or deleted from the grid.

**Note:**
The “current” keyword is supported for the reference parameters (“GridName”, Row, Column, and Page). However, it must be used within a grid’s text cell and/or custom heading (not supported in text objects).
Example: The following example inserts the unit description into the column heading for an XBRL context:

```
<<xbrlContext("unit")>>
```

### xbrlLineItem

`xbrlLineItem` is a text function that returns the value of a specified XBRL line item property. You can use this function only in a row heading or a text cell in the row that is defined with an XBRL line item. The function syntax is:

```
<<xbrlLineItem("InfoType")>>
```

```
xbrlLineItem("GridName", Row, Column, Page, "InfoType")
```

where:

- **GridName** is the name of the Grid with XBRL metadata.
- **Row** is the row segment (design time) identifier within the grid.
- **Column** is the column segment (design time) identifier within the grid.
- **Page** is the page to be used within the grid. (This parameter is currently ignored because, presently, XBRL metadata can be assigned only within the two-dimensional grid basis (on a row or column). It is provided for future use and consistency with other text functions.)
- **InfoType** is one of the following values:
  - *name*
  - *schemaNamespace*
  - *schemaLabel*
  - *schemaShortName*
  - *schemaLocalLocation*
  - *label*

**Note:**
The reference parameters will update when rows or columns are added or deleted from the grid.

**Note:**
The “current” keyword is supported for the reference parameters (“GridName”, Row, Column, and Page). However, it must be used within a grid’s text cell and/or custom heading (not supported in text objects).

**Example:**
The following example inserts the schema name into the row heading for an XBRL line item:

```
<<xbrlContext("schemaNamespace")>>
```
Mathematical Operators in Expressions

Operators are symbols that perform arithmetical tasks or comparisons, or refer to ranges of columns, rows, or cells. You use operators in formulas that perform calculations on data rows or columns.

The following table explains the types of operators available in standard formulas:

<table>
<thead>
<tr>
<th>Type</th>
<th>Operator</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arithmetical</td>
<td>+</td>
<td>Adds</td>
<td>The following row formula adds the values in rows 4 and 5: [4] + [5]. A space is needed after +.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Incorrect: 5+4</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Correct: 5+ 4</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Correct: 5+ -4</td>
</tr>
<tr>
<td>Arithmetical</td>
<td>-</td>
<td>Subtracts</td>
<td>The following row formula subtracts 3 from the values in row 4: [4] - 3. A space is needed after -.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Incorrect: 5-4</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Correct: 5 - 4</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Correct: 5 - -4</td>
</tr>
<tr>
<td>Arithmetical</td>
<td>*</td>
<td>Multiplies</td>
<td>The following row formula multiplies the absolute values in row 4 by 150: (\text{Abs}([4]) \times 150)</td>
</tr>
<tr>
<td>Arithmetical</td>
<td>/</td>
<td>Divides</td>
<td>The following row formula divides the values in row 4 by the values in row 5: [4] / [5]</td>
</tr>
<tr>
<td>Arithmetical</td>
<td>%</td>
<td>Percentage</td>
<td>The following row formula adds the values in row 4 and multiplies it by .10: (\text{row}[4].\text{Sum} \times .10)</td>
</tr>
<tr>
<td>Arithmetical</td>
<td>^</td>
<td>Exponential</td>
<td>The following row formula returns the sixth exponent of row 4: [4]^6</td>
</tr>
<tr>
<td>Arithmetical</td>
<td>Decimal</td>
<td>Decimal number</td>
<td>The following row formula multiplies the values in row 4 by 5.67: [4] \times 5.67</td>
</tr>
<tr>
<td>Reference</td>
<td>[]</td>
<td>Specifies a row, column, or cell in a grid. Use numbers for rows and letters for columns.</td>
<td>The following row formula adds the values in rows 4 and 12: (\text{Sum} ([4],[12]))</td>
</tr>
<tr>
<td>Unary minus</td>
<td>-</td>
<td>Changes the sign of a value</td>
<td>The following column expression divides the values in column 4 by 12 and changes the sign of the result: - ([4] / 12)</td>
</tr>
</tbody>
</table>

Tip:

Use the Eval function to perform arithmetic operations as part of a function parameter. For more information on the mathematical function Eval, see “Eval” on page 227.
Natural precedence determines the order the system follows for carrying out operations in an expression with multiple operators. For more information, see “Natural Precedence” on page 269.

Mathematical Operands in Expressions

Operands specify the values that an operator uses to produce a result. The following table explains the types of operands supported in Financial Reporting.

<table>
<thead>
<tr>
<th>Type of Operand</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Literal</td>
<td>3, 0.0, 27.5, 65.334, -841</td>
</tr>
<tr>
<td>Row or column reference number</td>
<td>[1], [4], [8], [A], [C:D]</td>
</tr>
<tr>
<td>Cell reference number</td>
<td>[2, E], [E, 2]</td>
</tr>
<tr>
<td>Functions</td>
<td>Average, Min, Max</td>
</tr>
<tr>
<td>Scoping</td>
<td>Grid1.row[3]</td>
</tr>
</tbody>
</table>

Note: This cell reference addresses row 2 column E.

In the following row formula, which multiplies the values in row 3 by 100, the row reference [3] and 100 are both operands:

\[[3] * 100\]

Natural Precedence

If a standard formula has two or more operators, the system performs the operations in the order of the operators’ natural precedence.

The order of natural precedence that the system follows for performing operations in an expression that has multiple operators is as follows:

1. **Unary minus (−# where # is any number)**

   Note:
   Do not add a space after the unary minus operator.

2. **Multiplication (×) and division (÷)**

3. **Subtraction (− #) and addition (+ # where # is any number)**

   Note:
   Add a space after the subtraction and addition operator.
For example, suppose a standard row formula uses this expression:

\[ 10 + 3 \times 4 \]

In this example, if row 10 has a value of 8, the above expression produces a value of 20 for that column by calculating \( 3 \times 4 + 8 = 20 \), following the order of natural precedence.
Financial Reporting Studio has some of the same functionality as Workspace. The repository stores Financial Reporting objects (reports, snapshots, grids, charts, image objects, text object, row and row and column templates). You can also print and print preview reports and sort items by clicking a column field header.

Items saved to the repository can be used multiple times. For example, you can use a report as a basis for designing another report, or you can use a report object, such as an image object, in several reports.

To access the all available functionality in Workspace, see the Hyperion Workspace User's Guide.

This chapter contains the following topics:

**Creating Folders**

You create and use folders to help organize items in the repository. You can add folders at multiple levels while in the repository or while saving reports and report objects. When a user adds an object in the repository, by default only that user and an administrator can access the object.
To allow other users to see an object, the originator or an administrator must assign access to other users or groups in Workspace. You must have Report Designer or Global Administrator rights to create a folder.

➤ To create folders in the repository:

1. **Launch Financial Reporting.**
   
   The repository is displayed.

2. **Click the location within the repository where you want the folder to reside.**

3. **Select File > New > Folder.** The default folder name is titled **New Folder**.

4. **Enter a folder name in the Enter New Folder Name text box.** You can use uppercase and lowercase letters, numbers, and spaces.

5. **Press OK to activate the folder.**

---

**Duplicating Objects in the Repository**

Use Workspace to duplicate objects in the repository. For detailed information, see the *Hyperion Workspace User’s Guide*.

**Filtering Report Objects**

You can filter repository objects including reports, snapshots, and saved report objects to help you easily locate an object. You filter report objects by the type of object you seek. The system searches all folders in the repository for matching object types and displays them, by folder, in a tree hierarchy. A variety of filter combinations is provided for filtering.

➤ To sort by object types:

1. **Select View > Display Items of Type.**

2. **Select an object type (All Items, Report, Snapshot, Book, Snapshot Book, Batch, or Saved Report Object) to display in the repository.**

3. **Optional:** Repeat steps 1 and 2 to select additional object types.

➤ To redisplay all object types in the repository, select **View > Display Items of Type > All Items.**

You can also sort objects by clicking the column headings. For example, you can display the oldest or newest reports first by clicking the Modified heading, or display report objects alphabetically by clicking the Name heading.
Cutting, Copying, and Pasting in the Repository

In Workspace, you can use the cut-and-paste feature to move report objects between different folders in the repository. Your ability to cut and paste depends on your access privileges. For detailed information, see the *Hyperion Workspace User’s Guide*.

Managing Database Connections

The Database Connection Manager is in Workspace. It provides a means to manage reports, books, snapshots, snapshot books, saved reports objects (row/column templates, grids), batches, and scheduled batches. Reports and report objects can be moved from a development environment to a production environment, or between production servers.

Use Workspace to manage the database connections. For detailed information on adding, editing, and deleting database connections, see *Hyperion Workspace User’s Guide*.

Exporting Repository Objects and Report Objects

In Workspace Explore, you can export saved objects, report objects and folders to a specific directory on your computer. During export, you can specify the format of the objects you are exporting. For information on exporting objects and report objects, see the *Hyperion Workspace User’s Guide*.

Importing Report Objects into the Repository

In Workspace Explore, you can import objects, reports, folders and zipped files previously exported to a file system. For detailed information on importing objects, see *Hyperion Workspace User’s Guide*.

Sending Links to Reports Through E-Mail

Using Workspace Explore, you can use the e-mail Link feature to send a URL link of objects or folders through e-mail. The link can be opened in Workspace by a Financial Reporting user. While sending an e-mail, you can also add and store a list of frequently used e-mail addresses. For detailed information on sending links to reports through e-mail, see *Hyperion Workspace User’s Guide*.

Deleting Items from the Repository

You delete items from the repository when no longer needed. You can permanently delete any items to which you have access privileges.
To delete items from the repository:

1 From the repository list, select the items to delete.

**Tip:**
You can filter the repository by selecting View > Display Items of Type. Select any of the following types: Report, Snapshot, or Saved Report Object.

**Tip:**
Press Shift to select multiple, consecutive items in the repository. Press Ctrl to select multiple, nonconsecutive items in the repository.

2 Select Edit > Delete.

3 Click Yes to confirm the deletion.

**Note:**
Before deleting a folder, you must delete all objects contained inside. You cannot delete a folder containing hidden objects due to insufficient security privileges.

### Changing the Database Connection for Reports and Report Objects in the Repository

Using Workspace, you can change the database connection for reports and books in the repository. You may want to change the database connection when moving from a development environment server to a production environment server. For information on changing database connections, see *Hyperion Workspace User's Guide*.

### Changing a Report Database Connection

When changing a report from an Essbase database connection to a Planning Details database connection or vice versa, there are several restrictions because the data source reference is the only change. There is no conversion.

- For a list of considerations to follow when changing the database connection from Essbase to Planning Details for a report, see *Hyperion Workspace User’s Guide*.
- For a list of considerations to follow when changing the database connection from Planning Details to Essbase, see *Hyperion Workspace User’s Guide*.

### Managing Security for Objects in the Repository

Using Workspace, you can apply security to objects (reports, snapshot reports, books, snapshot books, and batches), folders, and report objects (chart objects, grid objects, text objects, grids,
image objects, and graphics) in the repository. Objects, folders, and report objects are secured by restricting or allowing access privileges for certain users and groups. As a result, only certain designers or viewers can view objects in the repository from Financial Reporting. The roles and permissions that an administrator assigns to a user or group determine if access privileges are restricted in the repository. For more information on assigning roles and access privileges, see Hyperion Workspace User’s Guide.
Using Workspace, you can create, edit, and save batches if you have Administrator or Designer rights. Batches can also be scheduled, with full Batch Scheduler capability. You use batches to group and process sets of reports or books. You can send the output generated by running a batch to a printer or to the repository, and you can export both as HTML and PDF files. You can also e-mail users the exported output.

You can define and save batches in the Batch Editor and copy and delete batches in the repository. Deleting a batch from the repository requires access rights to the batch. By default, only the scheduling user is assigned access rights to snapshots and snapshot books that are saved to the repository. Having access rights to a batch, you can run every report in the batch when scheduled. The scheduling user can assign access to other users and groups at the time of scheduling.

Batches have a batch POV, which you can modify while scheduling. You can also specify prompt information for the batch. The specified POV and prompt information provides values for the POV and prompts specified for each book and report contained in the batch. You can schedule batches for processing immediately or at a later time.

For complete information on batch processing, see Hyperion Workspace User’s Guide.
XBRL in Financial Reporting

In This Chapter

- XBRL Terms ........................................................................................................................................ 279
- Setting Up Financial Reporting for XBRL .......................................................................................... 280
- Using XBRL Management .................................................................................................................. 281
- Managing XBRL Context ..................................................................................................................... 284
- Assigning XBRL Line Items to Rows ................................................................................................. 287
- Using XBRL Facts in Text Objects and Text Cells ............................................................................. 291
- Using XBRL Footnotes in Text Objects and Text Cells ...................................................................... 292
- Exporting the Instance Document ....................................................................................................... 292

XBRL (eXtensible Business Reporting Language) functionality in Financial Reporting enables you to create XBRL instance documents. The designer can take a report, attach XBRL metadata, then export the report as an instance document. XBRL Instance documents can be created using Oracle's Hyperion® Financial Management – System 9, Oracle's Hyperion® Planning – System 9, SAP BW, or Essbase data sources.

XBRL is an XML-based (eXtensible Markup Language) framework that provides the business community with a standards-based method to prepare, publish in a variety of formats, reliably extract, and automatically exchange financial statements.

For additional information relating to XBRL, see the XBRL International Web site (http://www.xbrl.org).

Note:

The functionality in this release supports the XBRL 2.1 specifications. Therefore, when a report is opened using a XBRL 2.0 schema, the unsupported metadata must be removed. If you choose this option, you must map line items that point to the 2.1 schema, create context and units as required in the new release. If you do not wish to remove the metadata, you can close the report.

XBRL Terms

The following list of terms may be useful to an administrator who wishes to know more about XBRL.

- XBRL specification—Defines what XBRL is and how to build taxonomies and instance documents. The specification uses technical terms and is meant for a technical audience.
- XBRL taxonomy—A set of XML schemas and XML Linking compliant linkbases that, taken together, define the syntax and semantics of XML elements corresponding to concepts about which facts can be expressed in XBRL instance documents. For example, a taxonomy may define the concept Net Profit as having certain relationships to other concepts (such as being the difference between Revenue and Expenses) and that a fact about it, such as “it has the value of 2,450,321 US Dollars correct to 7 significant figures, for the period from 1st January 2003 to 31st December 2003, for the US division of company XYZ”, is expressed in an XBRL instance using the XML element “<netProfit>.

- XBRL element—An XML element that is used to express a concept in an XBRL instance document. The syntax and semantics of XBRL elements are defined by XBRL taxonomies.

- Instance document—An XML document, containing a set of XBRL elements, that expresses a set of facts that may constitute one or more business reports. For example, the financial statements of Hyperion Solutions, expressed in XBRL, would be an instance document.

- XML—Markup language for documents containing structural information. XML provides for richly-structured documents that can be used on the Web.

## Setting Up Financial Reporting for XBRL

The following topics guide you through the process of setting up to use XBRL.

**Note:**

If you are using XBRL for the first time, Hyperion recommends that you follow the procedures in the chronological order outlined in this chapter.

### Enabling XBRL

To use the XBRL functionality in Financial Reporting, XBRL functionality must be enabled through Preferences.

➤ To enable XBRL:

1. **Log on to Financial Reporting Studio.**
2. **Select File > Preferences.**
3. **Click Enable XBRL Editing, then click OK.** An information dialog box instructs you to restart Financial Reporting Studio.
4. **Save any reports that may be active.** Restart Financial Reporting Studio. When you log on, XBRL controls are available.

### Downloading XBRL taxonomies to the XBRL directory

You can choose from numerous taxonomies to download. The official XBRL site (http://www.xbrl.org) can provide assistance with your selections.
An XBRL taxonomy can consist of one or more files. All related files must be downloaded.

To download the XBRL taxonomies:

1 Right-click the taxonomy, then click Save Target As or Open.

2 Copy the files to the xbrlfiles directory on the Financial Reporting server; for example, C:\...
   BIPlus\common\xbrlfiles.

Note:
You must have write privileges to the HR Server computer.

Tip:
You can create a separate user-defined folder in the xbrlfiles directory for each taxonomy you download.

3 Unzip the ZIP file within the xbrlfiles directory. Be sure to retain any relative directory structure that is present in the zip file to retain any relative references that might be present in the files constituting the taxonomy.

4 You are now ready to update the XBRL schema registration. Continue to the next topic, "Managing the XBRL Schema" on page 281, for instructions.

Using XBRL Management

Use XBRL Management in the Designer to update manage the XBRL schema, and define XBRL contexts and units for a report.

Managing the XBRL Schema

An XBRL taxonomy contains one or more schemas that define the line items or elements that can be contained in an instance document. After you add or remove XBRL taxonomies in the xbrlfiles directory, you must update the registration of the schemas. (For information on downloading the XBRL taxonomies, see “DownloadingXBRL taxonomies to the XBRL directory” on page 280.)

Some noteworthy information that may affect the outcome of your instance report:

- The taxonomy must exist in the xbrlfiles directory on the Report Server before you can update the list of schemas.
- The taxonomy must exist in the xbrlfiles directory in order to export an instance document. For example, if you add the us-gaap-basi-2005-02-28 taxonomy to the xbrlfiles directory, update the schema registration, then create an XBRL report with that schema / taxonomy, you can create an instance report. However, if you remove the us-gaap-
basi-2005-02-28 taxonomy from the xbrlfiles directory the instance document cannot be exported.

- When you open a report with XBRL line items defined in the report, the dependent taxonomies must be registered on the Report Server. If the taxonomy is not registered, the report does not open.

The following topics describe tasks that can be performed with managing the XBRL schema:

- “Updating Schema Registration” on page 282
- “XBRL Terms” on page 279
- “Editing Labels and Short Names on Schemas” on page 283

### Updating Schema Registration

When you initially set up XBRL in Financial Reporting Studio, you must update the schema registration. After the update, you only must update when adding or deleting schemas / taxonomies from the xbrlfiles directory.

The schema registration should be a reflection of the schemas stored in the xbrlfiles directory. Therefore, whenever a schema is added or removed from the xbrlfiles directory on the Report Server, the schema registration should be updated.

To update schema registration:

1. Log on to Financial Reporting Studio.
3. Confirm that you added the desired taxonomy to the xbrlfiles directory on the Report Server.
4. Select Task > XBRL Management > Schema Manager. The Manage Schemas dialog box is empty if no registered schemas have been updated.
5. Click Update Registration. If new taxonomies are added to the xbrlfiles directory, a list of registrations are displayed in the top list box.
6. Click OK to update the list of schema registrations.
Note:
Some taxonomies import multiple schema. All schema registrations associated with a taxonomy are updated at this time.

Note:
All columns in the XBRL Schema Manager dialog box can be sorted by clicking on the header column.

Maintaining Schema Registration
Whenever you add or delete a taxonomy in the xbrlfiles directory on the Reports Server, you must update your schema registration so that your instance document does not fail upon export.

➤ To maintain schema registration:
1 After you add or delete a taxonomy in the xbrlfiles directory, log on to Financial Reporting Studio.
2 Select File > New > Report.
3 Select Task > XBRL Management > Schema Manager. XBRL Manager - Manage Schemas is displayed.
4 Click Update Registration.
   ● If you added a taxonomy to the xbrlfiles directory, the registration schemas are listed in Registrations to be Added.
   ● If you deleted a taxonomy from the xbrlfiles directory, the registration schemas are listed in Registrations to be Deleted.
5 Click OK to update the registration of schemas.

Editing Labels and Short Names on Schemas
You can change the label and short name of the updated schema registrations to more meaningful descriptions. A modified label provides easier name recognition when you select a schema to assign XBRL line items to rows.

➤ To edit a schema label and short name:
1 Log on to Financial Reporting Studio.
2 Select File > New > Report.
3 From the Financial Reporting Studio designer, select Task > XBRL Management > Schema Manager. XBRL Manager - Manage Schemas is displayed.
4 Select a schema, then click Edit.
5 In Edit Schema, enter a brief description in Label and Short Name.
In the following example, Short Name text is changed to ci. The display-only field Namespace displays the property of the taxonomy, and Physical Location of Schema displays the location of the schema.

Managing XBRL Context

Use the XBRL Context Manager to create reusable definitions of XBRL contexts that can be assigned to columns, cells, and text objects in any financial report and by any Financial Reporting Studio user.

XBRL requires that each piece of data in an instance document be associated with a line item, and each XBRL numeric fact must refer to context and unit. (For information on unit, see “Managing XBRL Units” on page 286.)

XBRL context includes information about the entity, period, and scenario (optional). Context settings are informational only and do not get calculated. You can specify context for a column or specific cells in a column of a text object. Context settings are static settings that do not change when the member selection changes. Types of context information includes:

- Entity—Information about the organization for which the instance document is prepared.
- Period—Options for setting the start date and end date.
- Scenario—Information on the type of data, such as Actual or Budget.

Defining the XBRL Context

Context can be defined once and used throughout any financial report. Contexts are saved within the report; not globally in the repository. Using the Context Manager, Contexts can be created, edited or deleted.

To define XBRL Context

1 Select Task > XBRL Management > Context Manager.
2 In XBRL Manager - Manage Context, click New.
3 In Name, enter a descriptive label for the context.
4 On the Entity tab, perform the following actions:
   a. In Identifier, enter an identifier that conforms to the Scheme/Reference field.
   b. In Scheme/Reference, enter a URI according to XML schema. For example, a US firm registered with SEC would be www.sec.gov.
   c. Optional: If the instance document refers to a specific segment of the entity, (such as the ABC is a subsidiary of the entity XYZ), then select the Include Segment Information check box, and enter the Namespace URI and label for the segment.
Note:
XBRL specifications mandate that you must provide the declared namespace within your XML in order for the instance document to be valid. The namespace should be entered in the following format: prefix="http://www/uri/org/etc". You must enter valid XML that conforms to XBRL specification to describe the entity segment. For information on XBRL specifications, see the XBRL International Web Site (http://www.xbrl.org).

5 Select the Period tab, then select one of the following time periods:

- To specify one point in time, select Instant, then select a date from the calendar.
- To specify a range of dates, select Start Date, End Date, then select an inclusive start date and an inclusive end date from the calendar.

Tip:
To change the calendar month, click the right arrow to move the calendar month forward; click the left arrow to move the calendar month backward, or click the calendar month and select a new month. To change the year, click the calendar year, then click the up or down button to move the calendar year forward or backward, respectively.

- To indicate no date restrictions, select Forever.

Note:
This option is rarely used. It is intended for the possibility that one might want to report the values of certain constants like pi or e or the speed of light.

6 Select the Scenario tab, then perform the following actions:

You can describe the type of data for the Scenario element. Use XML to describe the scenario.

Select Specify Scenario from the Schema, then type the scenario in XML.

Note:
XBRL specifications mandate that you must provide the declared namespace within your XML in order for the instance document to be valid. The namespace should be entered in the following format: prefix="http://www/uri/org/etc". You must enter valid XML that conforms to XBRL specification to describe the entity segment. For information on XBRL specifications, see the XBRL International Web Site (http://www.xbrl.org).

7 Click OK. The Context record is stored as a line item in XBRL Manager - Manage Context.

8 Click Close.

Assigning XBRL Context
You can set XBRL Context on columns, cells in a column, and text objects.
Note:
XBRL Context in a text object is used to define an XBRL Fact. An XBRL fact includes a line item and XBRL Context.

➤ To set XBRL Context:
1 Open a report for which you want to create an XBRL instance document.
2 Select a column, cells in a column or text object.

Note:
When you create a cell-based context, you must select cells within one column only.
3 Select XBRL Context located on the property sheet.
4 Select an XBRL Context from the drop-down list; to create a new XBRL Context, click 🏷.

Note:
The XBRL context you assigned to a column may not be true for all cells in that column. If this is the case, you can modify the context of individual cells. For example, if the context for a column is labeled as January, but a number of those cells are for a different month, you can change the setting of those cells. Use the above procedures to modify specific cells in a column.

Removing XBRL Context
You can remove XBRL context from a columns or cells that you want to exclude from the instance report.

➤ To remove XBRL context:
1 Open a report that contains columns or cells that were previously defined with XBRL context.
2 Select a column or cell that is defined with XBRL context.
3 In the property sheet, deselect XBRL Context. Click Yes to confirm.

Note:
When you remove context from a report, any dependent line items become disassociated with that context. The report needs at least one context assigned to grid or text data in order to generate a valid instance document.

Managing XBRL Units
Use the XBRL Unit Manager to create reusable definitions of simple and compound unit of measures that can be assigned to grids, columns, and cells in any financial report and by any
Financial Reporting Studio user. The compound unit of measure enables you to specify a multiplication or division operator, and then two units; remember that this is only a description.

XBRL requires that each piece of numeric data in an instance document be associated with a line item, and each XBRL fact must refer to context and unit. For information on context, see “Managing XBRL Context” on page 284.

For the most part, all of the numerical facts on a grid will be in the same units. However, you can override the grid settings and define XBRL units at the cell level to formula cells and data cells.

To add XBRL Units

1. Select Task > XBRL Management > Units Manager.
2. In XBRL Manager - Manage Units, click New to display XBRL Manager - Unit Setup.

Assigning XBRL Units

You can set XBRL Units on grids, columns, and cells in a column. The XBRL Units you assigned to a grid may not be true for all columns or cells. If this is the case, you can modify the units of individual columns or cells. For example, if the unit for a grid is labeled as Monetary USD, but a number of those columns or cells are Non-Monetary/Shares, you can change the setting in those areas. Select a column or cell you want to change, and use the following procedures to modify their unit assignment.

To set XBRL Units:

1. Open a report for which you want to create an XBRL instance document.
2. Select a grid, columns, or cells.
3. Select XBRL Unit located on the property sheet (to create a new XBRL Unit, click ).
4. Select an XBRL Unit from the drop-down list.

Assigning XBRL Line Items to Rows

After you complete the setup of XBRL and define the context and units, you can begin assigning XBRL line items to data within a report. You can define one value per line item. If a line item is mapped to a row which contains multiple members, as in children, the values in that row are summed and assigned to that line item.

Note:

When instance documents are generated, numeric values mapped to XBRL line items are saved with their "raw" data values. Any formatting or rounding is removed from numeric values. As such, the XBRL "precision" attribute for numeric line items is always set to the value "INF". This means that the number mapped to the line item is the exact value shown in the instance document (no rounding). If values stored in a data source are already rounded (for example,
the stored value of 250 may actually be 250,000), it may be necessary to manually adjust the precision attribute in the resulting XML file after an instance document is created. For more information regarding the precision attribute please refer to the XBRL 2.1 specification.

➤ To assign XBRL line items to rows:

1. **Open a report that is set up for XBRL.**
   - For information on setting up Financial Reporting Studio for XBRL, see “Setting Up Financial Reporting for XBRL” on page 280.
   - For information on defining the context, see “Managing XBRL Context” on page 284.
   - For information on defining units, see “Managing XBRL Units” on page 286.

2. **Select a data or formula row.** In the following example, data row 3 is selected:

   ![Image of a data or formula row selected](image)

   3. In the **Row Properties** sheet, select **XBRL Line Item**, then click ![XBRL Manager - Line Item Setup](image) to display **XBRL Manager - Line Item Setup**.

4. **In Schema**, select the schema.

   The selected schema is displayed in the Schema drop-down, and the nodes from that schema are displayed below. In the following example, the fsa-rag9-v0.1 schema is selected. Note that in **Name of Selected Line Item**, XBRLtx9:RR0572 is the short name that was entered when the schema was registered.
5 Open the nodes by clicking on the plus (+) button to locate the XBRL line item that matches the selected Financial Reporting Studio line item. In this example, SECTION I: Supplementary product sales data... is selected.

**Note:**
To search for a line item, click Find to display the Find dialog box, enter the line item text and click Find Next. For information on using Find, see “Using the Find Feature in XBRL Line Item Setup” on page 289.

6 In Tuple Instance Name, enter a tuple instance name for this line item.

7 Click OK to accept the line item.

**Note:**
the Find feature searches the text shown in Line Item Setup as well as the equivalent technical XBRL name of the line item as documented on the selected taxonomy. This means that you can search on the item’s taxonomy name as well as its presented label name shown in Line Item Setup. For example, in the "us-gaap-ci" taxonomy, the "Taxes" line item is displayed Line Item Setup. However, its XBRL name in the taxonomy is "CashFlowOperationsDirect:usfr-pte_TaxesPaid". You can type "TaxesPaid" in the find dialog, and the item "Taxes" will match.

### Using the Find Feature in XBRL Line Item Setup

You can search for a specific line item within the Line Item Setup dialog by using the Find feature. The Find feature enables you to enter criteria to search for a line item within the current schema. To aid in your search, you can include wildcard symbols. Other search features include the ability to navigate up or down in the list, match whole words only, and match case.
Using Wildcards in Searches

Wildcards provide a versatile way to find items that contain a specific text pattern. This is useful, for example, if you search for a line item that contains specific text within beginning and end of its name.

The Find feature supports the following wildcard characters:

<table>
<thead>
<tr>
<th>Wildcard</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>?</td>
<td>Use to match any single character.</td>
</tr>
<tr>
<td>*</td>
<td>Use to match zero or multiple characters. For example, when you search for &quot;sale*&quot;, the search matches &quot;Sales&quot; and &quot;Sale&quot;. This is because with the *, there can be zero or more characters after the word &quot;sale&quot;. The default search uses the * wildcard. For example, when you enter &quot;cash&quot; as the criteria, it is equivalent to typing &quot;<em>cash</em>&quot; which finds &quot;Restricted Cash&quot;, &quot;Cash Equivalents&quot;, &quot;Cash&quot;, and &quot;Noncash Expenses&quot;. The word &quot;cash&quot; appears within each matched item.</td>
</tr>
<tr>
<td>#</td>
<td>Use to match any single number (0-9)</td>
</tr>
<tr>
<td>[list]</td>
<td>Use to match any single character within a specified list of characters. This wildcard allows you to specify specific characters to use as wildcards. For example, [aeiou] uses all of the letters within the brackets as a single wildcard character. The &quot;-&quot; character may also be used to indicate a range, such as [A-Z] or [0-9]. If you want to use the &quot;-&quot; as part of the list, enter it at the beginning of the list. For example, [@&amp;] uses the characters with the brackets as the wildcard characters.</td>
</tr>
<tr>
<td>![list]</td>
<td>Use to match any single character not found within specified list of characters. The &quot;-&quot; character may also be used to indicate a range, such as [1A-Z] or [10-9].</td>
</tr>
</tbody>
</table>

Wildcards can be used anywhere within the search string in the Find what text box. For example entering "cash*and" finds all line items that contain the words "cash" followed by "and", such as "Cash and Equivalents", "Cash from Sale of Goods and Services" and "Noncash Investing and Financing Activities".

Tip:

If you want to search for a line item that begins or ends with specific text, check the Match whole word only option and use the "*" wildcard. For example, with the Match whole word only option on, if you enter "cash*" as the criterion, only line items that start with the word "cash" is found. For example, "Cash and Equivalents" is found, but not "Noncash Investments". Similarly, if you enter "*cash", only line items that end with the word cash is found. For example, "Restricted Cash" is found, but not "Cash and Equivalents".
Examples Using Wildcards

The examples below provide additional details on how wildcard characters may be used. All examples assume the Match whole word only option is not selected.

Table 49  Examples Using Wildcards

<table>
<thead>
<tr>
<th>Criteria</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>cash</td>
<td>Finds all occurrences of items with the word “cash”.</td>
</tr>
<tr>
<td>federal*tax</td>
<td>Finds all occurrences of items with the words “federal”, followed by “tax”, such as “Federal Current Tax Expense” and “Deferred Federal Income Tax”.</td>
</tr>
<tr>
<td>gain<em>sale</em>invest</td>
<td>Finds all occurrences of items with the word &quot;gain&quot; followed by &quot;sale&quot; and &quot;invest&quot;, such as “Realized Gains on Sale of Investments”.</td>
</tr>
<tr>
<td>Form ##-K</td>
<td>Finds all occurrences of items with the word &quot;Form &quot; followed by two numeric values and then &quot;,K&quot;, such as &quot;Annual Report on Form 10-K&quot; or &quot;Annual Report on Form 10-KSB&quot;.</td>
</tr>
<tr>
<td>Form ##-[KFQ]</td>
<td>Finds all occurrences of items with the word &quot;Form &quot; followed by two numeric values, then &quot;,&quot; and then the letters &quot;K&quot;, &quot;F&quot; or &quot;Q&quot;, such as &quot;Annual Report on Form 10-K&quot;, &quot;Annual Report on Form 20-F&quot; or &quot;Covered Reports - Form 10-QSB&quot;.</td>
</tr>
<tr>
<td>Form ##-[!KFQ]</td>
<td>Finds all occurrences of items with the word &quot;Form &quot; followed by two numeric values, then &quot;,&quot; and then any character except for the letters &quot;K&quot;, &quot;F&quot; or &quot;Q&quot;.</td>
</tr>
<tr>
<td>stock[A-Z]</td>
<td>Finds all occurrences of items with the word &quot;stock&quot;, followed by any alphabetic letters (A-Z). Thus &quot;Stockholders&quot; is found, but &quot;Stock Dividends&quot; is not found.</td>
</tr>
<tr>
<td>stock![A-Z]</td>
<td>Finds all occurrences of items with the word &quot;stock&quot;, followed by any non-alphabetic letters (A-Z). Thus &quot;Stock Dividends&quot; is found, but &quot;Stockholders&quot; is not.</td>
</tr>
</tbody>
</table>

➤ To search for a line item:

1. In Find what, enter complete or partial text. Partial text can use a wildcard. The * wildcard is used by default. Select Match whole word only or Match case to limit your search.
2. Click Find Next to begin your search. Click Up to change the direction of the search upward in the line items; click Down to change the direction of the search downward in the line items.

Using XBRL Facts in Text Objects and Text Cells

XBRL facts with textual information may get data from text objects or text cells in a grid. The procedures are similar for text objects and text cells. An XBRL fact containing textual information and can be used in the following manner:

- Textual information must reside in a text cell or a text object.
- The XBRL fact with non-numeric data has an XBRL context; Units are not applicable.
- The XBRL line item associated with text must have a data type of string in the schema.
To define text in a text object or text cell as an XBRL fact.

1. Select the content in a text object or text cell.
2. In the property sheet, select **XBRL Fact**
3. In **Line Item**, click ![image] to select a line item for a schema.
4. In **XBRL Context**, select a context. To create a new XBRL Context, click ![image].

**Using XBRL Footnotes in Text Objects and Text Cells**

XBRL instance documents can contain footnotes. Footnotes are textual information about one numerical or text fact. This fact may be in a grid’s text cell or text object. In order to associate a footnote, the line item must be previously mapped.

To associate text from a text object to an XBRL fact in another text object.

1. Select the text object.
2. In the property sheet, select **XBRL Footnote**, **Associate with a**, then select the location of the XBRL Fact associated with this footnote.

   Text cells in grids can contain footnotes also.

To associate a footnote to a text object:

1. Select the cell text.
2. In the **Cell Properties** sheet, select **Text Object**, then select the text object from the list.

   **Note:**

   The text shown in the list represents the first 30 characters of all the text objects currently defined in the report.

**Exporting the Instance Document**

An instance document, in XML format, can be created from Financial Reporting Studio Designer that is defined with XBRL metadata.

To export the instance document:

1. Open a report that is set up for XBRL.
   - For information on setting up Financial Reporting Studio for XBRL, see “Setting Up Financial Reporting for XBRL” on page 280.
   - For information on defining the context, see “Managing XBRL Context” on page 284.
2. Select File > Export.
3 Optional. In the **Save in** drop-down list, select another path than the default directory.

4 Optional. In the **File name** text box, enter an instance report name.

5 In the **Save as type** drop-down, select **XBRL Instance Document (*.xml)**.

6 Click **Save**.

7 If the grid has multiple members on the **Pages** axis, the **Select Members for Page Axis** dialog box. Select a member for the page axis for each grid on the report.

8 Click **OK**.

### Select Member for Page Axis Dialog Box

A drop-down box is displayed for each grid on the report that contains XBRL line items. You are required to select a member for the page axis for each grid on the report that contains XBRL line items.

► To select a member for the page axis, click on each drop-down list and select a member.

**Note:**

If you selected Custom Heading for the page properties (on the Page Properties sheet), you must define the members with **MemberName**, **MembAlias** and/or **Member Description** to display the members in the Select Members for Page Axis dialog box.
Using Workspace, you can assemble reports and snapshots into a book, which enables you to generate output for those reports in one session. You can also configure your book to generate several versions of a report that are run for different member selections. By creating a book containing those reports, you can run all reports at once. The reports contained in the book can be printed or viewed individually or as an entire book.

There are two types of books that you can define and save to the Explore repository:

- **Books.** Reports, and snapshots can be added to a book. When you run a book, the data within the reports is dynamically retrieved from the database; the data within the snapshots remains static.
- **Snapshot books.** A book can be saved as a snapshot book. All reports are converted to snapshots containing static data for that period of time. The data contained in the reports, and a table of contents, is created when you save a book as a snapshot book. Any time a snapshot book is viewed, data-level security does not apply. Data-level security is applied when the snapshot book is created and is based upon the data level security that is set up for the user that saved the snapshot book.

Using Workspace, you can perform the following additional tasks with books and snapshot books from Financial Reporting:

- Use batches to group and process sets of books.
- E-mail links to the books or snapshot books from the repository.
- Change the data source for a book in the repository.
- Make an exact copy of books or snapshot books in the repository.
- Permanently delete books or snapshot books.
- Import books and snapshot books from a file system outside of the repository. When you import the book, it is saved within the Export repository. You can then perform any tasks on the book.
- Export books and snapshot books.

For complete information on the above topics, see *Hyperion Reports Workspace User’s Guide.*
The following administrative tasks are specific to Financial Reporting.

POV Management

The Manage User POV utility is a command line utility where the administrator creates, views, updates, or deletes the Financial Reporting POV for one or more users. The utility is installed with Financial Reporting Studio to the `<BIPlus>\bin` directory as `ManageUserPov.cmd` and comes with a sample configuration file called `ManageUserPOV.properties`.

To run the utility, open a command prompt in the `<BIPlus>\bin` directory and run the `ManageUserPov.cmd:

```
ManageUserPOV <Mode> <ConfigFileName>
```

where `Mode` = Import, Export, or Delete (case insensitive)

where `ConfigFileName` = the name of the configuration file (the default name is `ManageUserPov.properties` located in the `<BIPlus>\bin` directory).

Example: `ManageUserPOV Export ManageUserPov.properties`

Two files must be predefined before executing the POV utility; the configuration file, such as `ManageUserPov.properties`, and, when importing, an import file such as `ManageUserPovImport.xml`. Sample files are provided in the `<BIPlus>\bin` directory:

- `ManageUserPov.properties` file. Use this file to define the report server, assign administrator and data source credentials, specify the import and export file names, and set the various options such as user and data source filters and whether or not to perform a dry
run, or confirm deletion of User POVs. See the sample `ManageUserPov.properties` file for details.

- The `ManageUserPovImport.xml` file. An `ImportFileName`, such as `ManageUserPovImport.xml`. The XML file created during an export can also be edited and used for importing.

**Import Behavior Guidelines**

- Database connections which do not yet exist in the repository are created if the TYPE, SERVER, APPNAME, and DBNAME attributes are provided. Valid data source TYPEs are: Essbase, FinancialManagement, Planning, SAPBW, MSOLAP.

- All dimensions and members are validated against the data source to ensure that only valid User POVs are created or updated.

- Individual user access to a member is not validated; administrators should assign User POVs to only those users with access rights to view them.

- User POVs are only created for provisioned users.

- Partial User POVs are valid; only dimensions specified in the import file are updated.

**Using the User POV Utility**

The following instances describe how the User POV Utility is used.

**Exporting all Existing User POVs**

To export all existing User POVs:

1. **Edit the `ManageUserPov.properties` file and specify the ReportServer.**
2. Open a command prompt in the BIPlus\bin directory and type: `ManageUserPov.cmd Export ManageUserPov.Properties`.  
3. **When prompted, supply the Admin User and Password.**

A `ManageUserPovExport.xml` file is created which contains all the current User POVs in the system. A sample console interaction:

```
C:\Hyperion\BIPlus\bin>ManageUserPov.cmd Export ManageUserPov.properties
Please enter AdminUser : AdminUser
Please enter AdminPassword :********
INFO : Starting Hyperion Financial Reporting ManageUserPOV Utility
INFO : Ending Hyperion Financial Reporting ManageUserPOV Utility
```
Importing User POVs

➤ To update an existing User POV:

1 Follow the steps to export all existing User POVs.

2 Open the ManageUserPovExport.xml file. For example, specify a Member Name="East" for the Market Dimension, for the User LoginID="TestUser", for the DATASOURCE_NAME="Essbase Sample Basic on TestServer"

3 Edit the ManageUserPov.properties file and specify these filters to perform the update for a single user and datasource:

Users = TestUser
Datasources = Essbase Sample Basic on TestServer

Note:
If the Datasource credentials are different from the Admin credentials, you should specify an asterisk (*) to prompt for them separately, such as: DatasourceUser=*

4 Save the file as ManageUserPovImport.xml.

5 Open a command prompt in the BIPlus\bin directory and type: ManageUserPov.cmd Import ManageUserPov.properties.

6 When prompted, supply the Admin User and Password and optionally the Datasource User and Password. The User POV is updated with the new value for Market. A sample console interaction:

C:\Hyperion\BIPlus\bin>ManageUserPov.cmd Import ManageUserPov.properties
Please enter AdminUser : AdminUser
Please enter AdminPassword :*********
Please enter DataSourceUser : TestUser
Please enter DataSourcePassword :*********
INFO : Starting Hyperion Financial Reporting ManageUserPOV Utility
INFO : Setting POV for user: TestUser
INFO : Processing DataSource: Essbase Sample Basic on TestServer
INFO : Processing Year = Year
INFO : Processing Measures = Measures
INFO : Processing Product = Product
INFO : Processing Market = East
INFO : Processing Scenario = Scenario
INFO : Processing Caffeinated = Caffeinated
INFO : Processing Ounces = Ounces
Deleting Existing User POVs

To delete an existing User POV:

1. **Edit the ManageUserPov.properties file and specify the ReportServer and desired filters.**
   
   For example, to delete a single user “TestUser” POV for the datasource “Essbase Sample Basic on TestServer”, specify:
   
   ```
   Users = TestUser
   Datasources = Essbase Sample Basic on TestServer
   ```

2. **Open a command prompt in the BIPlus\bin directory and type:**
   
   ManageUserPov.cmd Delete ManageUserPov.properties.

3. **When prompted, supply the Admin User and Password.**
   
   The User POV is deleted. A sample console interaction:
   
   ```
   C:\Hyperion\BIPlus\bin>ManageUserPov.cmd Delete ManageUserPov.properties
   Please enter AdminUser : AdminUser
   Please enter AdminPassword :*********
   INFO : Starting Hyperion Financial Reporting ManageUserPOV Utility
   This action will delete 1 POV's
   Are you sure you want to proceed? Press 1 to Proceed and 0 to Cancel : 1
   INFO : Ending Hyperion Financial Reporting ManageUserPOV Utility
   ```

Report Server Tasks

Financial Reporting Server configuration is performed as part of the installation process. The following topics describe additional tasks that can be performed.

**Specifying the Maximum Number of Calculation Iterations**

You can specify the maximum number of calculation iterations for all grids and cells in the fr_repserver.properties file to resolve dependencies within references in formulas.
During the calculation process of a grid, it may be necessary to evaluate a cell multiple times due to reference precedence. This usually occurs in grids with references to other grids. The maximum iteration property indicates the number of times a formula cell can be evaluated before it is marked as unresolved. Setting the maximum iteration property avoids the possibility of cells, with circular referencing, being evaluated an infinite amount of times. Circular referencing occurs when one cell refers to another cell which then refers to the original cell.

If there are no circular references and calculation cells are returning #Error, you can increase the maximum iteration property value. The default value for the maximum number of calculation iterations is 10. This value is set in the fr_repservisor.properties file which is installed in the lib directory of your Financial Reporting installation. This file also contains comments to guide you in modifying this value, if necessary.

Note:
Making the maximum iteration property number very high may degrade grid execution performance.

Log File Output Management

Financial Reporting uses the log4j logging mechanism to manage log file output. Logging settings can be configured and are set in the fr_repservisor.properties file for each Financial Reporting server component.

This code is an example of Financial Reporting Server default settings in the fr_repservisor.properties file. Settings you might modify are shown in bold text.

```java
# log4j.rootLogger=ERROR,dest1
# log4j.appender.dest1=org.apache.log4j.RollingFileAppender
# log4j.appender.dest1.ImmediateFlush=true
# log4j.appender.dest1.File=C:/hyperion/BIPlus/logs/FRReportSrv.log
# log4j.appender.dest1.Append=true
# log4j.appender.dest1.MaxFileSize=512KB
# log4j.appender.dest1.MaxBackupIndex=5
# log4j.appender.dest1.layout=org.apache.log4j.PatternLayout
# log4j.appender.dest1.layout.ConversionPattern=%d{MM-dd HH:mm:ss} %-6p%c{1}t%m%n
```

Note:
See fr_global.properties for details on logging levels (FATAL, ERROR, WARN, INFO, DEBUG) and formatting options. The Financial Reporting logging settings can be changed without restarting the servers. The .properties files are monitored for changes to the logging setting every minute. The frequency is set in fr_global.properties. This can be very handy if you want to set the logging level to DEBUG briefly and then change it back for troubleshooting a production environment.
Periodic Log File Rolling

In addition to the default RollingFileAppender there is a DailyRollingFileAppender option to make periodic backups of the current log file. The DailyRollingFileAppender rolls the log file over at a user chosen frequency: monthly, weekly, half-daily, daily, hourly, or every minute.

The rolling schedule is specified by the DatePattern option.

An example of a schedule that rolls the log file on a daily basis:

```
log4j.rootLogger=ERROR,dest1
log4j.appender.dest1=org.apache.log4j.DailyRollingFileAppender
log4j.appender.dest1.ImmediateFlush=true
log4j.appender.dest1.File=d:\Hyperion\HR\Logs\Daily_HRReportSrv.log
log4j.appender.dest1.Append=true
log4j.appender.dest1.DatePattern='.'yyyy-MM-dd
log4j.appender.dest1.layout=org.apache.log4j.PatternLayout
log4j.appender.dest1.layout.ConversionPattern=%d{MM-dd HH:mm:ss} %-6p%c{1}\t%m%n
```

In the above example, at midnight, the Daily_HRReportSrv.log is copied to Daily_HRReportSrv.log.2003-10-30 at midnight on October 30. Logging for the current day continues in Daily_HRReportSrv.log until it rolls over the next day as Daily_HRReportSrv.log.2003-10-31.

**Note:**

The current log file is not rolled to a daily backup file until a log entry needs to be written. So it may not happen right at midnight and if you go a day without log entries you will not see a backup log file for that day. This is done for efficiency reasons. Note that regardless of the delay, all logging events are logged to the correct file.

Reports uses the standard Log4j package from the Apache group to handle logging duties. For more details on the DailyRollingFileAppender syntax and options, see:


Changing Logging Options

The Hyperion Reports logging settings can be changed without restarting servers. The .properties files are monitored for changes to the logging setting every minute. The frequency is set in the fr_global.properties file. This is handy if you want to set the logging level to DEBUG briefly and then change it back for troubleshooting a production environment.
Application Server Logging

Each application server has its own mechanism for logging stdout and stderr for the JVM process(es) it starts:

- **JRun**—\Jrun4\logs
- **WebSphere**—\WebSphere\AppServer\logs\<server name>\/
- **WebLogic**—\<domain location>\wl-domain.log and/or \weblogic<version>\common\nodemanager\NodemanagerLogs (if using node manager to start/stop servers)
- **Tomcat**—\%CATALINA_BASE%\logs (e.g. \Program Files\Hyperion Solutions\Hyperion Reports\HRWeb\logs)

While Financial Reports logs nothing of interest to stdout or stderr, you can check the output in case of a JVM crash (blown heap or native thread dump).

Backing Up Current Log Files

You can make a backup of the current log file on a periodic basis by changing the default RollingFileAppender option to DailyRollingFileAppender. The DailyRollingFileAppender rolls the log file over at a user-chosen frequency of monthly, weekly, half-daily, daily, hourly, or minute. The rolling schedule frequency is specified by the DatePattern option. See the following table for details on the DailyRollingFileAppender syntax and options.

<table>
<thead>
<tr>
<th>DatePattern</th>
<th>Rollover Schedule</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-'yyyy-MM</code></td>
<td>Rollover at the beginning of each month.</td>
<td>At midnight, on October 31, 2003, the Daily_HRReportSrv.log is copied to Daily_HRReportSrv.log.2003-10. Logging for the month of November continues in Daily_HRReportSrv.log until it rolls over the next day to Daily_HRReportSrv.log.2003-11.</td>
</tr>
<tr>
<td><code>-'yyyy-ww</code></td>
<td>Rollover at the first day of each week. The first day of the week depends on the locale.</td>
<td>Assuming the first day of the week is Sunday, on Saturday midnight, October 9th 2003, the file Daily_HRReportSrv.log is copied to Daily_HRReportSrv.log.2003-23. Logging for the 24th week of 2003 is output to Daily_HRReportSrv.log until it is rolled over the next week.</td>
</tr>
<tr>
<td><code>-'yyyy-MM-dd</code></td>
<td>Rollover at midnight each day.</td>
<td>At midnight, on October 2003, the Daily_HRReportSrv.log is copied to Daily_HRReportSrv.log.2003-10-30. Logging for the current day continues in Daily_HRReportSrv.log until it rolls over the next day to Daily_HRReportSrv.log.2003-10-31.</td>
</tr>
<tr>
<td><code>-'yyyy-MM-dd-a</code></td>
<td>Rollover at midnight and midday each day.</td>
<td>At noon, on October 9th, 2003, Daily_HRReportSrv.log is copied to Daily_HRReportSrv.log.2003-10-09-AM.</td>
</tr>
</tbody>
</table>
## Assigning Financial Reporting TCP Ports for Firewall Environments or Port Conflict Resolution

By default, Financial Reporting components communicate with each other through Remote Method Invocation (RMI) on dynamically assigned Transmission Control Protocol (TCP) ports. To communicate through a firewall, you must specify the port of each Financial Reporting component separated by the firewall in its `.properties` file and then open the necessary ports in your firewall. These `.properties` files are located in the Financial Reporting `lib` directory.

In addition, you may need to open ports for the Reports Server RDBMs, for data sources that you report against, and for LDAP/NTMLM for external authentication.

**Note:**

Ports should be opened in the firewall only for Financial Reporting components that must communicate across the firewall. If the Financial Reporting components are not separated by a firewall, they can use the default dynamic port setting.

You can change the port assignments to use in a firewall environment for servers in these Financial Reporting `.properties` files.

- The Communication Server runs on each computer running any of the Financial Reporting server components shown below and requires 1 port. By default, this is 1099 but can be specified in the `fr_global.properties` file using `RMIPort=`.

- The Report Server requires 2 ports which are specified in the `fr_repserver.properties` file using `HRRepSvrPort1=` and `HRRepSvrPort2=`.

- Oracle’s Hyperion® Workspace requires 1 port which are specified in the `fr_webapp.properties` file using `HRHtmlSvrPort=`.

- The Scheduler Server requires 1 port which is specified in the `fr_scheduler.properties` file using `HRSchdSvrPort=`.

---

<table>
<thead>
<tr>
<th>DatePattern</th>
<th>Rollover Schedule</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>`- ‘yyyy-MM-dd-HH</td>
<td>Rollover at the top of every hour.</td>
<td>At approximately 11:00.000 o’clock on October 9th, 2003, Daily_HRReportSrv.log is copied to Daily_HRReportSrv.log.2003-10-09-10. Logging for the 11th hour of the 9th of October is output to Daily_HRReportSrv.log until it is rolled over at the beginning of the next hour</td>
</tr>
<tr>
<td>`- ‘yyyy-MM-dd-HH-mm</td>
<td>Rollover at the beginning of every minute</td>
<td>At approximately 11:23.000 o’clock on October 9th, 2003, Daily_HRReportSrv.log is copied to Daily_HRReportSrv.log.2003-10-09-10-22. Logging for the minute of 11:23 (9th of October) is output to Daily_HRReportSrv.log until it is rolled over the next minute.</td>
</tr>
</tbody>
</table>
The Print Server requires 1 port which is specified in the fr_printserver.properties file using HRPrintSvrPort=.

**Note:**
When assigning static ports for each Financial Reporting component, the typical values are between 1024 and 32767.

When the Financial Reporting Server Components are distributed among several machines, there may be a need for you to change the default RMIPort on one or more machines. For example, suppose you installed a Report Server on MachineA, and left the default RMIPort configuration intact, but installed a Print Server on MachineB, and had to change the default RMIPort assignment to 1100 to resolve a conflict with another application. In this case, it would be necessary for you to reference the Print Server using hostname:port nomenclature in any or all .properties files that refer to the Print Server. In this example, your would assign printserver1=MachineB:1100 in fr_repserver.properties.

**Note:**
If you change the RMIPort for the Report Server component, users logging on through the Reports Desktop should use the same hostname:port nomenclature.

What follows is a list of properties file entries that require :port be appended if the target hostname computer uses another RMIPort. If all components define the same RMIPort, you need supply only hostname in all properties files.

<table>
<thead>
<tr>
<th>Properties Files</th>
<th>Entries</th>
</tr>
</thead>
<tbody>
<tr>
<td>fr_repserver.properties</td>
<td>printserverx=</td>
</tr>
<tr>
<td></td>
<td>SchedulerServer=</td>
</tr>
<tr>
<td>fr_webapp.properties</td>
<td>HRWebReportServer=</td>
</tr>
</tbody>
</table>

**Note:**
If RMIPort is changed in fr_global.properties on the computer where the Report Server is running, and Planning Details is a valid data source, then ADM_RMI_PORT should also be changed in ADM.properties. For example: C:\Hyperion\common\ADM\9.0.0\lib \ADM.properties.

### Accessing Server Components Through a Device that Performs NAT

The following topics discuss how to access server components through Network Address Translation (NAT).
Network Address Translation (NAT)
Network Address Translation (NAT) makes possible the use of a device, such as a router, to act as an agent between two networks whereby only one unique IP address is required to represent an entire group of computers.

Remote Method Invocation (RMI)
Communication between the client and server in Financial Reporting is achieved via Java's Remote Method Invocation (RMI) protocol. By default, an RMI server program communicates with clients using the IP address of the computer on which it is running.

Issue Using RMI Through Devices that Perform NAT
The combination of Java RMI and NAT has an inherent issue, in that Java attempts to route client requests to the IP of the computer on which the RMI server is running, rather than to the masqueraded address supplied by NAT.

To work around this issue, the Java Virtual Machine (JVM) accepts two arguments that allow RMI server programs to communicate with clients using the IP of another computer or device, such as a router that performs NAT.

If your Report Client computers access Reports Server components though a device that masks outgoing packets through NAT (Network Address Translation), then you must follow the procedures listed below.

Adding Required Java Arguments on Windows Systems
The following procedures explain how Java arguments are added to Windows. This applies to the Report Server, Print Server, and Scheduler Server.

To add Java arguments to Windows systems for the Report Server, Print Server, and Scheduler Server:

1. Open the Windows registry, and navigate to HKEY_LOCAL_MACHINE\Software\Hyperion Solutions\Financial Reporting.
2. For each of the keys HRReportSrv, HRPrintSrv, HRSchedSrv:
   - Add two new String Values: JVMOptionx and JVMOptiony, where x and y are replaced with the next available number on their JVMOption series.
   - Assign the new entries these values:
     - JVMOptionx: -Djava.rmi.server.hostname=<IP or hostname of NAT device>
     - JVMOptiony: -Djava.rmi.server.useLocalHostname=false
   - Increase the value of JVMOptionCount by 2.
3. Start or restart the components.
**WebLogic**

➤ For the WebLogic server:

1. **Take an action:**
   - If you chose to run Workspace as a Windows service, open the Windows registry, and navigate to: `HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\beasvc hr_domain_HReports\Parameters`.
     - Edit the string value `CmdLine` by prepending `-Djava.rmi.server.hostname=<IP or hostname of NAT device> -Djava.rmi.server.useLocalHostname=false` to the existing value.
   - If you did not choose to run Workspace as a Windows Service, open the `\HyperionReports\HRWeb\hr_domain\startWeblogic.cmd` in a text editor, and add `-Djava.rmi.server.hostname=<IP or hostname of NAT device> -Djava.rmi.server.useLocalHostname=false` to the `JAVA_OPTIONS` variable declaration.

2. **Start or restart the components.**

**WebSphere**

➤ For the WebSphere server:

1. **Start the WebSphere Administrator's Console.**
2. **Navigate to Servers > Application Servers and select your server.**
3. **In the Additional Properties section, select Process Definition.**
4. **In the Process Definition's Additional Properties section, select Java Virtual Machine.**
5. **Append the following lines to the Generic JVM Argument property:**
   ```
   -Djava.rmi.server.hostname=IP or hostname of NAT device -Djava.rmi.server.useLocalHostname=false
   ```
6. **Start/restart the components.**

**Tomcat**

➤ For the Tomcat server:

1. **Open the Windows registry, and navigate to:** `HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\HRWeb\ Parameters`
2. **Add two new String Values called JVM Option Number x and JVM Option Number y, where x and y are replaced with the next available number on their JVM Option Number series.**
3. **Assign the new entries these values:**
   - JVM Option Number x --> `-Djava.rmi.server.hostname=<IP or hostname of NAT device>`
   - JVM Option Number y --> `-Djava.rmi.server.useLocalHostname=false`
4 Increase the value of JVM Option Count by 2.
5 Start/restart the components.

**Adding Required Java Arguments on UNIX Systems**

The following procedures explain how Java arguments are added to UNIX systems. This applies to the Report Server, Print Server, Scheduler Server, and Tomcat.

➤ To add Java arguments to UNIX systems for the Report Server, Print Server, Scheduler Server, and Tomcat:

1 Open `./BIPlus/bin/freporting` for editing.

2 In the start block for each component installed, add the two new required entries:
   - `Djava.rmi.server.hostname=<IP or hostname of NAT device>`
   - `Djava.rmi.server.useLocalHostname=false`
   after the appropriate `-c "${JAVA_HOME}/bin/java"` line.

   For example:

   `-c "${JAVA_HOME}/bin/java
   -Djava.rmi.server.hostname=IP or hostname of NAT device
   -Djava.rmi.server.useLocalHostname=false`

3 Start/restart the components.

**WebLogic**

➤ For the WebLogic Web server:

1 Open `./HyperionReports/HRWeb/hr_domain/startWeblogic.sh` in a text editor, and add
   `-Djava.rmi.server.hostname=<IP or hostname of NAT device>`
   `-Djava.rmi.server.useLocalHostname=false`
to the `JAVA_OPTIONS` variable declaration.

2 Start/restart the components.

**WebSphere**

➤ For the WebSphere Web server:

1 Start the WebSphere Administrator’s Console.
2 Navigate to Servers > Application Servers and select your server.
3 In the Additional Properties section, select Process Definition.
4 In the Process Definition’s Additional Properties section, select Java Virtual Machine.
5 Append the following to the Generic JVM Argument property:
   `-Djava.rmi.server.hostname=<IP or hostname of NAT device> -Djava.rmi.server.useLocalHostname=false`
6 Start/restart the components.

Essbase Ports

The following topics contain procedures that you might need to implement, you may already have them implemented, or your system may not require them.

Differences Between Essbase Ports and Connections

This section describes the differences between Essbase ports and connections when running this release of Financial Reporting.

Important considerations:

- You are licensed by Essbase ports.
- A 100 concurrent user license for Essbase means 100 Essbase ports are licensed.
- An unlimited number of connections is allowed on each of those ports.
- The number of connections you open to Essbase is not relevant for licensing purposes. What matters is the number of Essbase ports.

When a user runs a report in Financial Reporting, connections are opened to Essbase. For performance optimization purposes, these connections are cached. When the connections become idle, a process is run periodically to close them.

The system administrator can modify the length of time before a connection is considered inactive (MinimumConnectionInactiveTime, default of 5 minutes) and the length of time before inactive connections are closed (CleanUpThreadDelay, default of 5 minutes) in the fr_global properties file.

The number of ports used by Financial Reporting varies, depending on the configuration, as follows:

- If a Report Client such as the Windows UI runs a report, two Essbase connections are made; one for the Report Client, and one for the Report Server.
- If the Report Client and Report Server are on the same computer, two Essbase connections using one Essbase port are made.
  - The Report Client keeps the Essbase connection until the window with the report displayed is closed.
  - The Report Server keeps this Essbase connection until the process is run to close idling open connections.
  - When both connections are closed, the port is released.
- If the Report Client and Report Server are on two different machines, two Essbase connections using two Essbase ports are made.
  - The Report Client keeps the Essbase connection until the window with the report displayed is closed.
The Report Server keeps this Essbase connection until the process is run to close idle open connections.

When the Report Client connection is closed, the corresponding port for that connection is released.

When the Financial Reporting connection is closed, the corresponding port for that connection is released.

When a Financial Reporting Studio user such as the Browser UI runs a report, two Essbase connections are made: one for the Web server and one for the Report Server.

- If the Web server and Report Server are on the same computer, two Essbase connections using one Essbase port are made.
  - The Web server keeps the Essbase connection until the process is run to close idle open connections.
  - The Report Server keeps this Essbase connection until the process is run to close idle open connections.
  - When both connections are closed, the port is released.

- If the Web server and Report Server are on two different computers, two Essbase connections using two Essbase ports are made.
  - The Web server keeps the Essbase connection until the process is run to close idling open connections.
  - The Report Server keeps this Essbase connection until the process is run to close idling open connections.
  - When the Web server connection is closed, the corresponding port for that connection is released.
  - When the Report Server connection is closed, the corresponding port for that connection is released.

The recommended configuration is as follows:

- The Report Server and Web server are installed on the same computer.
- The Report Client is installed on several other computers. In this case, you must take two Essbase ports only for users working with the Report Client. All users connecting to view reports in Workspace take a single Essbase port for each Essbase user, because the Web server and Report Server are on the same computer.

**Checking the Current Essbase Connections**

To check for current connections in the Essbase server command window, type USERS in the command window. The list displays the current connections and ports currently used.

**Changing Settings in Essbase Configuration Files**

When using the following settings in the Essbase configuration file, Essbase Connection Time Outs are reduced.
Add or increase the following Essbase client settings in the `essbase.cfg` file:

- NETDELAY 1000
- NETRETRYCOUNT 1000

**Calculating the Formula for the Maximum Number of Essbase Ports**

The basic formulas for calculating the maximum number of Essbase ports you need for Financial Reporting are as follows:

- If Workspace and Report Server are on the same computer:
  
  Number of Essbase ports = 2 \times \text{the number of Report Clients} + \text{the number of Workspace users}

- If Workspace and Report Server are on different computers:
  
  Number of Essbase ports = 2 \times \text{the number of Report Clients} + 2 \times \text{the number of Oracle's Hyperion® Workspaces}

**Note:**

This formula is for Financial Reporting and does not consider other ways users might be connecting to Essbase; for example, the Application Manager, Oracle's Hyperion® Web Analysis – System 9, or the Excel Add-in. You must consider those potential port-takers separately. If they are used on the same computer as one of the Financial Reporting components, no extra ports are taken as long as the same Essbase user ID is being used.

Data source considerations are as follows:

- If you run a report with two data sources, your number of connections doubles, but the number of ports remains the same as described previously.
- If you run a report with three data sources, your number of connections triples, but the number of ports remains the same as described previously.
- If, after closing the report with two data sources, you run a report with a 3rd data source, your connections increases again but the number of ports does not change.

A user’s connection is open for at least five minutes and remains open for up to 10 minutes, assuming no new activity occurs during that time. If you have a limited number of Essbase ports, and many users are accessing Financial Reporting, you may want to lower both values to 30 seconds (30000).

**Scheduler E-mail Configuration**

For the Financial Reporting Scheduler to successfully send e-mail notifications, a valid smtp mail server must be specified in the `...\lib\fr_global.properties` file.
Scheduler Command Line Interface

Scheduler Command Line Interface is the process of launching a Financial Reporting batch input file from a command line. You can automate the process of launching batch input files using an external scheduler or launching batch input files after some external event occurs, such as the completion of a consolidation.

Creating Batch Input Files

The batch input file specifies the options for the scheduled batch such as the name of the batch to be scheduled, output destinations, e-mail notification information, POV settings, and others.

➤ To create a batch input file:

1. Right-click a previously scheduled batch in the Batch Scheduler dialog box and choose Export for Command Line Scheduling.
2. Open the mybatch.xml where mybatch is the name of your batch input file.
3. Modify this file as needed by editing the values in the tags, see “Modifying Attributes” on page 313 for the commonly used attributes.

Launching Batches from a Command Line

You can use the ScheduleBatch.cmd command file provided in the BIPlus\bin directory to launch the batch specified in the batch input file against a Financial Reporting scheduler server.

➤ To launch a batch from a command line prompt in the BIPlus\bin directory, enter the command by specifying the fully qualified name of the batch input file and the computer name or IP address of the Scheduler Server on which to schedule the batch, for example:

```
ScheduleBatch c:\DailyReports\mybatch.xml MySchedulerServer
```

where MyBatch.xml is the name of your batch input file and MySchedulerServer is the name or IP address of your scheduler server which is typically located on the same computer as the report server.

This launches a batch to run immediately against the scheduler server specified.

Scheduling Batches Using an External Scheduler

You can launch a batch on a periodic basis from an external scheduler. To do this, you set up your own command files and call them from the external scheduler.

For example, you might have a NightlyBatch.cmd file containing these lines:

```
call ScheduleBatch MgtSummaryBatch.xml hr_Server
call ScheduleBatch MgtDetailBatch.xml hr_Server
```
Encoding Passwords

Your passwords are encoded when you export the batch input file. To specify another user ID or data source ID in the batch input file, then you can use the following file to produce an encoded password for use in the batch input file.

- Windows—EncodePassword.cmd
- UNIX—EncodePassword

**Note:**

This procedure is optional.

➤ To encode passwords:

1. Open the batch input file to modify the data source and user ID passwords.
2. From the command line, run the `EncodePassword.cmd` file.
3. Type `EncodePassword Password`, where `Password` is the new password you want to use.
4. Place the encoded password produced in the batch input file.

Modifying Attributes

In a typical batch input file, there are very few attributes to modify. Most attributes are already set properly based on the originally scheduled batch. The following table lists attributes that you are most likely to modify for the associated XML tags.

**Table 52  Commonly Used Attributes**

<table>
<thead>
<tr>
<th>Category</th>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>AUTHOR</td>
<td>Displays in the batch scheduler’s User ID column and is a useful place to show a comment or the name of the XML file that generated the batch.</td>
</tr>
<tr>
<td>E-mail</td>
<td>ATTACH_RESULTS</td>
<td>Enter a “Yes” or “No” value, depending on whether you want to attach PDF or HTML files generated to the e-mail.</td>
</tr>
<tr>
<td>FAILURE_RECIPIENTS</td>
<td>E-mail to recipients if schedule batch failed</td>
<td></td>
</tr>
<tr>
<td>FAILURE_SUBJECT</td>
<td>Text if scheduled batch fails</td>
<td></td>
</tr>
<tr>
<td>RECIPIENTS</td>
<td>A comma-separated list of recipient’s e-mail addresses.</td>
<td></td>
</tr>
<tr>
<td>SENDER</td>
<td>The sender’s e-mail address.</td>
<td></td>
</tr>
<tr>
<td>SUBJECT</td>
<td>The subject of the e-mail.</td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td>Attribute</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Credentials</td>
<td>DS_PASSWD</td>
<td>The encrypted data source password from an existing batch or that you generate using the command line utility.</td>
</tr>
<tr>
<td>DS_USER_NAME</td>
<td></td>
<td>The data source user whose credentials are used for running the reports/books in the batch.</td>
</tr>
<tr>
<td>HR_PASSWD</td>
<td></td>
<td>The encrypted Financial Reporting user password from an existing batch or that you generate using the command line utility.</td>
</tr>
<tr>
<td>HR_USER_NAME</td>
<td></td>
<td>The Financial Reporting user whose credentials are used for running the reports/books in the batch.</td>
</tr>
<tr>
<td>HTML and PDF output</td>
<td>HTML VALUE</td>
<td>Enter a “Yes” or “No” value, depending on whether you want to generate HTML output for the batch.</td>
</tr>
<tr>
<td></td>
<td>PDF VALUE</td>
<td>Enter a “Yes” or “No” value, depending on whether you want to generate PDF output for the batch.</td>
</tr>
<tr>
<td></td>
<td>HTML EXPORT_HTML_FOLDER_LABEL</td>
<td>If exporting as HTML (Value=Yes), The path and folder to external directory.</td>
</tr>
<tr>
<td></td>
<td>PDF EXPORT_HTML_FOLDER_LABEL</td>
<td>If exporting as PDF (Value=Yes), the path and folder to external directory.</td>
</tr>
<tr>
<td>Snapshot Output</td>
<td>SAVE_AS_SNAPSHOT VALUE</td>
<td>Enter a “Yes” or “No” value, depending on whether you want to save the snapshot output in the repository.</td>
</tr>
<tr>
<td></td>
<td>SAVE_NAME</td>
<td>The Folder Name where the Snapshots are to be stored. This must be specified in ReportStore: \  format. If SAVE_NAME = “”, the snapshot output is saved to the same folder as the original object.</td>
</tr>
<tr>
<td></td>
<td>USER_NAMES</td>
<td>Comma-separated Financial Reporting user names who are granted access to the snapshot output.</td>
</tr>
<tr>
<td></td>
<td>GROUP_NAMES</td>
<td>Comma-separated Financial Reporting group names which are granted access to the snapshot output. A special system-defined group, called Everyone, includes all Financial Reporting users and can be used to ensure that all users have access to a snapshot output.</td>
</tr>
<tr>
<td>Printed Output</td>
<td>PRINT NAME</td>
<td>The printer name, if the PRINT VALUE attribute is set to “Yes”.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> You must make sure that this printer is available to the scheduler server.</td>
</tr>
<tr>
<td>Category</td>
<td>Attribute</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PRINT VALUE</td>
<td>Enter a “Yes” or “No” value, depending on whether you want to generate printed output for the batch.</td>
<td></td>
</tr>
</tbody>
</table>

**Note:**

In the USER_POV section of the XML file, HIDDEN=’0’ indicates a dimension which is on the POV and therefore is a candidate or value to be set in the XML file. The value to be changed is “_” in this example.

**Batch Input File XML Tag Reference**

The following topics provide a complete listing of tags and values for the associated attributes. The structure of an XML file is similar to a tree level or directory structure. There is basically one parent-level node tag, and the tags that follow are child node tags.

**BATCH_JOB_OBJECT - Node Tag**

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUTHOR</td>
<td>Displays in the batch scheduler’s User ID column and is a useful place to show a comment or the name of the XML file that generated the batch.</td>
</tr>
<tr>
<td>BATCH_JOB_ID</td>
<td>A random number assigned to the batch</td>
</tr>
<tr>
<td>BATCH_NAME</td>
<td>The name of batch. For example, “ReportStore:\SchdApi\Batches\TestBatch3”.</td>
</tr>
<tr>
<td>REPORT_SERVER_NAME</td>
<td>The name of the report server where the batch is located</td>
</tr>
<tr>
<td>UNSAVED_BATCH</td>
<td>The value of this attribute must be set to “No”.</td>
</tr>
</tbody>
</table>

**RUN_OPTIONS - Child Node Tag**

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FREQUENCY</td>
<td>The value of this attribute should be “1”.</td>
</tr>
<tr>
<td>RUN_IMMEDIATELY</td>
<td>The value of this attribute should be “Yes”.</td>
</tr>
</tbody>
</table>
**NOTIFICATION, EMAIL - Child Node Tag**

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ATTACH_RESULTS</td>
<td>Enter a “Yes” or “No” value, depending on whether you want to attach PDF or HTML files generated to the e-mail.</td>
</tr>
<tr>
<td>RECIPIENTS</td>
<td>A comma-separated list of recipients e-mail addresses.</td>
</tr>
<tr>
<td>SENDER</td>
<td>The sender’s e-mail address</td>
</tr>
<tr>
<td>SUBJECT</td>
<td>The subject of the e-mail.</td>
</tr>
</tbody>
</table>

**JOB_STATUS - Child Node Tag**

This must be copied as it is shown in the following example, JOB_STATUS
CURRENT_STATUS="Pending"

**JOB_OBJECT - Child Node Tag**

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OBJECT_ID</td>
<td>Leave this attribute blank.</td>
</tr>
</tbody>
</table>

**DATA_SOURCE_USER_CREDENTIALS - Child Node Tag**

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DS_PASSWD</td>
<td>The encrypted data source password from an existing batch or that you generate using the command line utility.</td>
</tr>
<tr>
<td>DS_USER_NAME</td>
<td>The data source user whose credentials are used for running the reports/books in the batch.</td>
</tr>
</tbody>
</table>

**HR_USER_CREDENTIALS - Child Node Tag**

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR_PASSWD</td>
<td>The encrypted Financial Reporting user password from an existing batch or that you generate using the command line utility.</td>
</tr>
<tr>
<td>HR_USER_NAME</td>
<td>The Financial Reporting user whose credentials are used for running the reports/books in the batch.</td>
</tr>
</tbody>
</table>

**OUTPUT_OPTIONS - Child Node Tag**

This XML tag enables you to select the format of the batch output.
**CHILD NODE - HTML**

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>HTML VALUE</strong></td>
<td>Enter a “Yes” or “No” value, depending on whether you want to generate HTML output for the batch.</td>
</tr>
</tbody>
</table>

**CHILD NODE - PDF**

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PDF VALUE</strong></td>
<td>Enter a “Yes” or “No” value, depending on whether you want to generate PDF output for the batch.</td>
</tr>
</tbody>
</table>

**CHILD NODE - SAVE_AS_SNAPSHOT**

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SAVE_AS_SNAPSHOT VALUE</strong></td>
<td>Enter a “Yes” or “No” value, depending on whether you want to save the snapshot output in the repository.</td>
</tr>
<tr>
<td><strong>SAVE_NAME</strong></td>
<td>The Folder Name where the Snapshots are to be stored. This must be specified in ReportStore:\ format. If SAVE_NAME = “”, the snapshot output is saved to the same folder as the original object.</td>
</tr>
<tr>
<td><strong>USER_NAMES</strong></td>
<td>Comma-separated Financial Reporting user names who are granted access to the snapshot output.</td>
</tr>
<tr>
<td><strong>GROUP_NAMES</strong></td>
<td>Comma-separated Financial Reporting group names which are granted access to the snapshot output. A special system-defined group, called Everyone, includes all Financial Reporting users and can be used to ensure that all users have access to a snapshot output.</td>
</tr>
<tr>
<td><strong>SUBJECT_TOKENS</strong></td>
<td>This attribute can be left blank or removed from the text file.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This attribute is ignored if USER_NAMES or GROUP_NAMES is used.</td>
</tr>
</tbody>
</table>

**CHILD NODE - PRINT**

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PRINT NAME</strong></td>
<td>The printer name, if the PRINT VALUE attribute is set to “Yes”.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>You must make sure that this printer is available to the scheduler server.</td>
</tr>
<tr>
<td><strong>PRINT VALUE</strong></td>
<td>Enter a “Yes” or “No” value, depending on whether you want to generate printed output for the batch.</td>
</tr>
</tbody>
</table>
**USER_POV - Child Node**

This node is optional. If the User POV is not specified here, the USER POV of the data source user specified in the text file is used instead.

---

**Caution!**

This should be modified only by power users. Specifying a partial USER POV does not work.

---

**Note:**

In the USER_POV section of the XML file, HIDDEN="0' indicates a dimension which is on the POV and therefore is a candidate or value to be set in the XML file. The value to be changed is "_" in this example.

---

**Setting XBRL Schema Registration**

This task is used to update and maintain XBRL schema registration. The update enables you to define XBRL line items for an XBRL instance report. For a description on updating XBRL schema registration, see the *Financial Reporting Studio User’s Guide*.

---

**CHILD NODE - KEY**

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NAME</td>
<td>This is: &lt;datasourceServer&gt;:&lt;AppName&gt;:&lt;DatabaseName&gt;: &lt;DataSourceType&gt; REF_COUNT should be set to 1.</td>
</tr>
</tbody>
</table>

---

**CHILD NODE - POV**

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALIASTABLE</td>
<td>The Alias Table name</td>
</tr>
<tr>
<td>APPNAME</td>
<td>The name of the data source application</td>
</tr>
<tr>
<td>DBNAME</td>
<td>The name of the database</td>
</tr>
<tr>
<td>DIMCOUNT</td>
<td>The total Number of Dimensions in that Database</td>
</tr>
<tr>
<td>DRIVERTYPE</td>
<td>The type of the data source driver</td>
</tr>
<tr>
<td>SERVERNAME</td>
<td>The name of the data source Server</td>
</tr>
<tr>
<td>ORGBYPERIOD_ENABLED</td>
<td>0 or 1 depending on whether the ORG By period is enabled.</td>
</tr>
</tbody>
</table>
This is used only if HFM is the data source.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORGBYPERIOD_PERIOD</td>
<td>The period member name. This is dependent on the previous attribute.</td>
</tr>
<tr>
<td>ORGBYPERIOD_SCENARIO</td>
<td>The scenario member name. This attribute is dependent on whether Org by Period is enabled.</td>
</tr>
<tr>
<td>ORGBYPERIOD_YEAR</td>
<td>The year member name. This attribute is dependent on whether Org by Period is enabled.</td>
</tr>
<tr>
<td>SHOW_ALIAS</td>
<td>Leave this value as 0.</td>
</tr>
<tr>
<td>SHOW_DIMNAME</td>
<td>Leave this value as 1.</td>
</tr>
<tr>
<td>SHOW_MEMBERDESC</td>
<td>Leave this value as 0.</td>
</tr>
<tr>
<td>SHOW_MEMBERNAME</td>
<td>Leave this value as 1.</td>
</tr>
<tr>
<td>VERSION</td>
<td>The version number for Financial Reporting</td>
</tr>
</tbody>
</table>

**DIMENSION - Child Node**

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DISABLED</td>
<td>This should be set to 0.</td>
</tr>
<tr>
<td>HIDDEN</td>
<td>This should be set to 1.</td>
</tr>
<tr>
<td>NAME</td>
<td>The name of the Dimension</td>
</tr>
</tbody>
</table>

**METADATAEXPRESSION - Child Node**

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
</table>
| DATA | The member selection query, must be in the following format: `<DIMENSION DISABLED="0" HIDDEN="0" NAME="Market">

  <METADATAEXPRESSION VALUE=""/><xml version="1.0" encoding="UTF-8"> <COMPOSITEOPERATION TYPE="MemberQuery"> <OPERATION TYPE="Select"> <MULTIVALUE><STRING>Name</STRING> </MULTIVALUE> <STRING>Market</STRING> </OPERATION> <COMPOSITEOPERATION TYPE="Filter"> <OPERATION TYPE="Member"> <STRING>New York</STRING> </OPERATION> <STRING>Market</STRING> </COMPOSITEOPERATION> </COMPOSITEOPERATION> " /></DIMENSION>

**RMI Encryption Implementation**

You can encrypt passwords entered in the Win32 Client by uncommenting the following line in the `fr_repserver.properties` file:

```java
RMI_Encryptor=com.hyperion.reporting.security.impl.HsRMICryptor
```

After enabling or disabling encryption, all Financial Reports services must be restarted.
The following text appears in the fr_repserver.properties file:

# Specify the class name of encryption algorithm to encrypt values
# passed in RMI calls.
#
# By default, no encryption is applied.
#
# To use the encryption provided with the product, set the value to
# com.hyperion.reporting.security.impl.HsRMICryptor
#
# To use any other custom encryption algorithm, extend your
# implementation from
# com.hyperion.reporting.security.IHsRMICryptor
interface.
#
# This interface defines two methods
# public String encrypt(String value) throws HyperionReportException;
# public String decrypt(String value)
throws HyperionReportException;
#
#RMI_Encryptor=com.hyperion.reporting.security.impl.HsRMICryptor
In This Appendix

Report Properties.............................................................................................................. 321
Grid Properties ................................................................................................................ 321
Page Properties ................................................................................................................ 324
Heading Row/Column Properties........................................................................................... 325
Row / Column Properties .................................................................................................... 325
Cell Properties................................................................................................................... 327
Text Row / Column Properties........................................................................................... 327
Text Cell Properties........................................................................................................... 328
Chart Properties............................................................................................................... 329
Image Properties................................................................................................................ 329
Text Properties................................................................................................................... 330
Row and Column Template Properties................................................................................. 331

This appendix describes the property sheets in Financial Reporting Studio. It includes the following topics:

**Report Properties**

Use Report Properties to define properties for the report.

<table>
<thead>
<tr>
<th>Item</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>This is a display-only area that displays the report description after you save the report.</td>
</tr>
<tr>
<td>Header Height</td>
<td>Type a height for the online layout header.</td>
</tr>
<tr>
<td>Footer Height</td>
<td>Type a height for the online layout footer.</td>
</tr>
</tbody>
</table>

**Grid Properties**

You can modify the properties of a grid using the following topics:
Grid Properties - General Category

Use the General category to format the selected grid.

<table>
<thead>
<tr>
<th>Item</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimension Layout</td>
<td>Assign dimensions to the row, column, and page axes.</td>
</tr>
<tr>
<td>Database Connection</td>
<td>Displays the database name the grid is accessing.</td>
</tr>
<tr>
<td>Headings - Member Labels</td>
<td>Perform an action:</td>
</tr>
<tr>
<td></td>
<td>- Select Member Name to show member names as the heading.</td>
</tr>
<tr>
<td></td>
<td>- Select Alias:Default to show the alias as the heading. Alias is used with Essbase or Planning Details database connection.</td>
</tr>
<tr>
<td></td>
<td>- Select Description to show the description as the heading. Description is used with a Financial Management data source. It is a default setting with SAP BW.</td>
</tr>
<tr>
<td></td>
<td>- Select Both to show the member name and alias / description.</td>
</tr>
<tr>
<td>Headings - Row Headings Before</td>
<td>Select the column before which you want to display row headings. For example, select the third column (C), to place the heading before the third column (C). Columns are represented as alphabet characters (A, B, C, and so on).</td>
</tr>
<tr>
<td>Headings - Suppress Repeats</td>
<td>Select to suppress repeated row or column headings. When selected, one column or row heading is displayed across multiple columns or rows. When deselected, the column or row heading is repeated in each column or row.</td>
</tr>
<tr>
<td>Headings - Alias Table</td>
<td>This item is used only in Essbase and Planning Details. Select the alias table to use when showing aliases. By default, this option is set to the default alias table for the database connection.</td>
</tr>
<tr>
<td>Column Width</td>
<td>Enter the width of all columns in the grid.</td>
</tr>
<tr>
<td>Row Height</td>
<td>Enter the height of all rows in the grid.</td>
</tr>
<tr>
<td>Sort</td>
<td>Click to enable sorting on a range of rows or columns. Then click Setup to select sorting options.</td>
</tr>
<tr>
<td>Autosize</td>
<td>Select to enable the system to expand the grid to display all data when viewing or printing. Deselect to control the size of the grid manually. If Autosize is not selected, the report contains scroll bars when viewed online, or it is displayed on separate pages when printed.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Autosize will not expand the grid in Workspace view if Freeze Row &amp; Column Headers is also selected. To view the report within the entire Workspace area, expand the grid size in Financial Reporting Studio.</td>
</tr>
<tr>
<td>Freeze Row &amp; Column Headers</td>
<td>Select a grid, then select Freeze Row &amp; Column Headers to keep row and column headings visible when viewing HTML reports in Workspace. If you want to view the report within the entire Workspace area, you must expand the grid size in Financial Reporting Studio.</td>
</tr>
<tr>
<td>Grid POV</td>
<td>Select to display the grid POV bar. The grid POV bar is displayed below the grid title bar.</td>
</tr>
</tbody>
</table>
### Grid Properties - Suppression Category

Use the following properties to hide a grid, hide specific values in a grid’s cells, and specify text variables for zero values in cells.

**Table 55  Grid Properties - Suppression Category**

<table>
<thead>
<tr>
<th>Item</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide Grid</td>
<td>Select to hide, but not remove, the grid. The grid’s title bar turns gray on the Design tab.</td>
</tr>
</tbody>
</table>
| Suppression         | You can select Basic and Advanced option for conditional suppression. Select **Basic Options** to suppress data based on any of the following methods:  
  - Select If Zero, Suppress to suppress all values that equal zero. If all data values in a given row or column equal zero, the entire row or column is suppressed.  
  - Select If Missing, Suppress, to suppress all cells that do not contain data. If all cells in a given row or column do not contain data, the entire row or column is suppressed.  
  - Select If Error, Suppress to suppress data in cells that cannot be retrieved or calculated because of errors. If all data values contain errors in a given row or column, the entire row or column is suppressed.  
Select **Advanced Options** to suppress data based on specific criteria. Then select **Setup** to define criteria. |
| Text Options       | Enter a value in any of the following areas:  
  - In **Zero Values**, enter a value to replace zero value cells.  
  - In **No Data**, enter a value to replace empty cells.  
  - In **Error**, enter a value to replace error value cells.  
  - **Show Text Functions Errors**, select to enable errors to display for text functions that are placed in the grid. This is the default. |

### Grid Properties - Position Category

Use the Position category to position the selected grid on the report.

**Table 56  Grid Properties - Position Category**

<table>
<thead>
<tr>
<th>Item</th>
<th>Use</th>
</tr>
</thead>
</table>
| Position Object on Report | Perform either of the following actions:  
  - In **Horizontal**, select None or Relative to control the way the grid is printed on the page relative to other report objects. Select Left to position the grid on the left side of the report, select Center to position the grid in the center of the report, or select Right to position the grid on the right side of the report. |
<table>
<thead>
<tr>
<th>Item</th>
<th>Use</th>
</tr>
</thead>
</table>
| Position of Expansions | Select one of the following options:  
  ● Select Before Parent to display expansions before the summary-level row or column.  
  ● Select After Parent to display expansions after the summary-level row or columns. This is the default setting. |
| Position of Auto Calculations | Select one of the following options:  
  ● Select Before Members to display the auto calculation row before the members.  
  ● Select After Members to display the auto calculation row after the members. This is the default setting. |
| Position of Supporting Detail | Note: This control is only displayed for a Planning Details database connection.  
  Select one of the following options:  
  ● Select Members Before Parents to display supporting detail before the parent member.  
  ● Select Members After Parent to display supporting detail after the parent member. This is the default setting. |

**Page Properties**

Use Page Properties to define properties for the Pages members. If a chart is linked to a grid with multiple page members, a new chart is printed for each page member if the Page Printing Position option is set to New Page - Top, New Page - Same, or Same Page.

**Table 57  Page Properties**

<table>
<thead>
<tr>
<th>Item</th>
<th>Use</th>
</tr>
</thead>
</table>
| Member Labels      | Select to display a label from the member as a heading. Then select one of the following methods for displaying member labels:  
  ● Select Member Name to show a label from the member as a heading.  
  ● Select Alias: Default to show the alias as the heading. Alias is used with Essbase and Planning Details data sources.  
  ● Select Description to show the description as the heading. Description is used with a Financial Management data source.  
  ● Select Both to show the member name and alias / description. |
| Custom Heading     | Select to define a custom heading for the row. Then enter the text for the custom heading. |
| Insert Function button | Select to include a function in the custom heading. |
| Short Name for Entities | Select to display the short name for entities in your grid (Financial Management, Entity dimension only). |
| Format button      | Click to open the Format dialog box, where you can specify options for the row. |
| Heading Height     | Enter a value for the height of the heading row. |
Use Heading Row/Column Properties to format the heading of a selected data or formula row or column. The properties that are enabled depend on the type of cell you select. For example, for a formula heading cell, the Show Formula and Custom Heading options are enabled.

### Table 58  Heading Row/Column Properties

<table>
<thead>
<tr>
<th>Item</th>
<th>Use</th>
</tr>
</thead>
</table>
| Headings - Member Labels    | This option is used only in a Data heading. Select to display a label from the member as a heading. Then select one of the following methods for displaying member labels.  
  ● Select Member Name to show a label from the member as a heading.  
  ● Select Alias/Description to show the aliases/descriptions corresponding to the member name as the heading.  
  ● Select Both to show the member name and alias/description as the heading. |
| Headings - Show Formula     | Select to display the formula row or column.                                                                                         |
| Headings - Custom Heading   | Select to define a custom heading for the heading. Then enter the text for the custom heading.                                     |
| Function button             | Select to include a function in the heading.                                                                                         |
| Short Name for Entities     | Select to display the short name for entities in your grid (Financial Management, Entity dimension only).                           |
| Allow Expansion             | Select to enable expansions of data rows or columns in the report.                                                                   |
| Auto Calculation            | Select to enable auto calculation, then select the Setup button to insert an auto calculation row or column.                        |

Use Row and Column Properties to format the selected data or formula rows or columns. The properties that are enabled depend on the type of cell you select.

### Table 59  Row/Column Properties

<table>
<thead>
<tr>
<th>Item</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Connection</td>
<td>Shows the database connection name from which the row receives data.</td>
</tr>
<tr>
<td>Row Height / Column Width</td>
<td>Type the height for the selected rows, or type the width for the selected columns.</td>
</tr>
<tr>
<td>Item</td>
<td>Use</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Hide Always</td>
<td>Select to hide the row or column when the report is viewed and in the printed output. The row is displayed only in the Report Designer.</td>
</tr>
<tr>
<td>Suppression Ignores Row / Column</td>
<td>Perform an action:</td>
</tr>
<tr>
<td></td>
<td>● To ignore the data in the hidden rows / columns, select this option. When evaluating suppression, no cells in the hidden rows / columns are evaluated.</td>
</tr>
<tr>
<td></td>
<td>● To include the data in the hidden rows / columns, deselect this option. When evaluating suppression, all cells in the hidden rows / columns that contain data are evaluated.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can evaluate suppression based on hidden cells when you specifically reference the cells by using the Advanced Options method for conditional suppression.</td>
</tr>
<tr>
<td>Suppression</td>
<td>Select None, Show Always to turn suppression off. This is the default setting. Select Basic Options to suppress data based on any of the following methods:</td>
</tr>
<tr>
<td></td>
<td>● Select If Zero, Suppress to suppress all values that equal zero. If all data values in a given row or column equal zero, the entire row or column is suppressed.</td>
</tr>
<tr>
<td></td>
<td>● Select If Missing, Suppress to suppress all cells that do not contain data. If all cells in a given row or column do not contain data, the entire row or column is suppressed.</td>
</tr>
<tr>
<td></td>
<td>● Select If Error, Suppress to suppress data in cells that cannot be retrieved or calculated because of errors. If all data values contain errors in a given row or column, the entire row or column is suppressed.</td>
</tr>
<tr>
<td></td>
<td>Select Advanced Options to suppress data based on specific criteria. Then select Setup to define your criteria. For Oracle’s Hyperion® Essbase® – System 9 data source rows only. To return the Top N rows based on the values in a specified column, select a row, select <strong>Top</strong>, then select the value and the column.</td>
</tr>
<tr>
<td>Heading - Suppress Repeats</td>
<td>Select to suppress repeated row or column headings in the grid. When selected, the system shows one column or row heading across multiple columns and rows. When deselected, the column or row heading is repeated in each column or row.</td>
</tr>
<tr>
<td>Display Supporting Detail</td>
<td><strong>Note:</strong> This control is only displayed for a data row using the Planning Details database connection. When selected, and Supporting Detail exists for one or more cells in the row, additional rows are inserted to show the Supporting Detail.</td>
</tr>
<tr>
<td>Allow Page Break Within</td>
<td><strong>Note:</strong> This control is only displayed for a data row using the Planning Details database connection. It is enabled if you select Show Supporting Detail. When selected, a page break is allowed within the rows of Supporting Detail. When deselected, the member and all Supporting Detail are kept together. If the Supporting Detail is too long to fit on a page, the member and the Supporting Detail are moved to the next page.</td>
</tr>
<tr>
<td></td>
<td>For Auto Calculation rows, the Allow Page Break Within option is placed in the Auto Calculation dialog box so you can control the option by specific Auto Calculation. For more information, see .</td>
</tr>
<tr>
<td>Show Unary Operator</td>
<td><strong>Note:</strong> This control is only displayed for a data row using the Planning Details database connection. It is enabled if you select Show Supporting Detail. When selected, the unary operator (+, −, /, *) is shown for all supporting detail rows.</td>
</tr>
<tr>
<td>Display Line Item Details</td>
<td>This option is used in Financial Management rows only. Select to include line item detail in the report.</td>
</tr>
<tr>
<td>Page Break Before</td>
<td>Select to insert a page break before the row. Then perform an action:</td>
</tr>
<tr>
<td>Item</td>
<td>Use</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Related Content Setup</td>
<td>Select Related Content Setup to create links to objects in J2EE, Web Analysis, or Financial Reporting. Then click Setup to specify the links within Related Content Setup.</td>
</tr>
<tr>
<td>XBRL Context</td>
<td>This control is only displayed for a column if you enabled XBRL editing in the Preferences dialog box. Select XBRL Context to include information about the entity, units, period, and scenario (optional).</td>
</tr>
<tr>
<td>XBRL Line Item</td>
<td>This control is only displayed for a row if you enabled XBRL editing in the Preferences dialog box. Select XBRL Line Item to include information about XBRL line items. Then click Setup to assign XBRL line items to the selected data or formula row.</td>
</tr>
</tbody>
</table>

**Cell Properties**

Use this property sheet to set properties for formula cells or data cells. The properties that are enabled depend on the type of cell you select in a grid.

**Table 60  Cell Properties Sheet**

<table>
<thead>
<tr>
<th>Item</th>
<th>Use</th>
</tr>
</thead>
</table>
| Calculation order | Select one of the following options for specifying order of calculation:  
  ● Select Use the row formula if you want the row calculation applied to the cell.  
  ● Select Use the column formula if you want the column calculation applied to the cell.  
  ● Select Use a custom formula if you want to add a new formula. |
| Retrieve Cell Documents | For Essbase and Financial Management databases only, select this function to allow the ability to attach documents in Word, Excel, or PDF to the end of a report as well as insert a footnote into the report to add a description about the attached documents. |
| Add Related Content | Select Add Related Content to create links to objects in J2EE, Web Analysis, or Financial Reporting. Then click Setup to specify the links within Related Content Setup.                                        |
| XBRL Context | This control is only displayed if you enabled XBRL editing in the Preferences dialog box. Select XBRL Context to modify XBRL context of cells, then perform an action:  
  ● To exclude XBRL context settings for the selected cells, click None.  
  ● To revert to the default XBRL context setting of the column, click Use Column Context.  
  ● To change the XBRL context settings for the selected cell, click Use Cell Context. Then click Setup. For information on setting XBRL context, see “Managing XBRL Context” on page 284. |

**Text Row / Column Properties**

Use this property sheet to format selected text rows and columns.
### Table 61  Text Row/Column Properties Sheet

<table>
<thead>
<tr>
<th>Item</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row Height / Column Width</td>
<td>Type the height for the selected rows, or type the width for the selected columns.</td>
</tr>
<tr>
<td>Hide Always</td>
<td>Select to hide the row or column when the report is viewed and in the printed output. The row is displayed only in Oracle's Hyperion® Financial Reporting Studio.</td>
</tr>
</tbody>
</table>
| Suppression Ignores Row / Column | Perform an action:  
  - Select to ignore the data in the hidden rows / columns. When evaluating suppression, no cells in the hidden rows / columns are evaluated.  
  - Deselect to include the data in the hidden rows / columns. When evaluating suppression, all cells in the hidden rows / columns that contain data are evaluated.  
  
  **Note:** You can evaluate suppression based on hidden cells when you specifically reference the cells by using the Advanced Options method for conditional suppression. |
| Suppression                    | Select None, Show Always to turn suppression off. This is the default setting.  
Select Basic Options to suppress data based on any of the following methods:  
  - Select If Zero, Suppress to suppress all values that equal zero. If all data values in a given row or column equal zero, the entire row or column is suppressed.  
  - Select If Missing, Suppress, to suppress all cells that do not contain data. If all cells in a given row or column do not contain data, the entire row or column is suppressed.  
  - Select If Error, Suppress, to suppress data in cells that cannot be retrieved or calculated because of errors. If all data values contain errors in a given row or column, the entire row or column is suppressed.  
Select Advanced Options to suppress data based on specific criteria. Then select Setup to define your criteria. |
| Adjust Row Height to Fit      | Enabled for Text Rows only. When selected, enables text cells in grids to span multiple pages. |
| Page Break Before             | Select to insert a page break before the row. Then specify one of the following positions:  
  - For a row, select Position at Top to place remaining part of the grid at the top of the new page.  
  - For a column, select Position at Left to place remaining part of the grid to the left of the new page.  
  - Select Same Position if you want the grid to be placed in the same position as it is currently placed. For example, if a grid is placed halfway down the page and you insert a page break with Same Position selected, the remaining part of the grid is displayed half way down on the second page. |

### Text Cell Properties

Use this property sheet to format a text cell.

### Table 62  Text Cell Properties Sheet

<table>
<thead>
<tr>
<th>Item</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>Enter text.</td>
</tr>
<tr>
<td>Insert Function button</td>
<td>Click to display the Insert Functions Editor, where you can insert a function into the text cell.</td>
</tr>
</tbody>
</table>
Chart Properties

Use this property sheet to specify the chart type, define the data range, and format the selected chart.

Table 63  Chart Properties Sheet

<table>
<thead>
<tr>
<th>Item</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td></td>
</tr>
<tr>
<td>Grid</td>
<td>Select the name of the grid to reference.</td>
</tr>
<tr>
<td>Legend Items from Grid</td>
<td>Select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>● Select Row(s) to reference a series of rows.</td>
</tr>
<tr>
<td></td>
<td>● Select Column(s) to reference a series of columns.</td>
</tr>
<tr>
<td>Data Range for Row(s) and Column(s)</td>
<td>Select the columns and rows to specify the data to include in the chart.</td>
</tr>
<tr>
<td></td>
<td>● For a combo chart, select a bar data range and a line data range.</td>
</tr>
<tr>
<td></td>
<td>● For a pie chart, select a row or column.</td>
</tr>
<tr>
<td>Auto Calculation</td>
<td>Select to include auto calculations from the data set.</td>
</tr>
<tr>
<td>Format Charts</td>
<td>Select to specify formatting options for the selected chart.</td>
</tr>
<tr>
<td>Page Break Before</td>
<td>Select to insert a page break before the chart. The chart is printed on a new page.</td>
</tr>
<tr>
<td>Position Object on Report</td>
<td>Select from the following options:</td>
</tr>
<tr>
<td></td>
<td>● Horizontal (None, Relative, Left, Center, or Right)</td>
</tr>
<tr>
<td></td>
<td>● Vertical (None, Relative, Top, Middle, or Bottom)</td>
</tr>
<tr>
<td></td>
<td>For more information, see “Positioning Charts on Reports” on page 74.</td>
</tr>
</tbody>
</table>

Image Properties

Use this property sheet to format the selected image.

Table 64  Image Properties Sheet

<table>
<thead>
<tr>
<th>Item</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image - Select Image</td>
<td>Click to select an image saved on a file system.</td>
</tr>
<tr>
<td>Image - Stretch</td>
<td>Select to enable the stretch function for the selected image. You can expand or shrink the image to the size of the image's border.</td>
</tr>
<tr>
<td>Position Object on Report - Horizontal</td>
<td>Select one of the following options to set the horizontal positioning of the image:</td>
</tr>
<tr>
<td></td>
<td>● Select None to position the printed image at its current location regardless of whether report objects above it or to its left change in size</td>
</tr>
<tr>
<td></td>
<td>● Select Relative to position the printed image relative to any report object to its left</td>
</tr>
<tr>
<td></td>
<td>● Select Left to position the image on the left side of the report</td>
</tr>
<tr>
<td>Item</td>
<td>Use</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Position Object on Report - Vertical</strong></td>
<td>Select one of the following options to set the perpendicular positioning of the image:</td>
</tr>
<tr>
<td></td>
<td>- Select None to position the printed image at its current location regardless of whether report objects above it or to its left change in size</td>
</tr>
<tr>
<td></td>
<td>- Select Relative to position the printed image relative to any report objects above it</td>
</tr>
<tr>
<td></td>
<td>- Select Top to position the image on the top of the report</td>
</tr>
<tr>
<td></td>
<td>- Select Middle to position the image in the middle of the report</td>
</tr>
<tr>
<td></td>
<td>- Select Bottom to position the image on the bottom of the report</td>
</tr>
<tr>
<td><strong>Page Break Before</strong></td>
<td>Select to insert a page break before the image. The image is displayed on a new page when viewed or printed.</td>
</tr>
<tr>
<td><strong>Link to Source Object</strong></td>
<td>This check box is only enabled after the image is saved to the repository and the Link to Source Object check box is selected. Clear it to unlink the image from its source object in the repository.</td>
</tr>
</tbody>
</table>

**Text Properties**

Use this property sheet to modify the properties of a text object.

**Table 65  Text Properties Sheet**

<table>
<thead>
<tr>
<th>Item</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Borders &amp; Shading - Show Border</strong></td>
<td>Select to place a border around the text box, or clear to remove a border around the text box.</td>
</tr>
<tr>
<td><strong>Borders &amp; Shading - Shading</strong></td>
<td>Click to select a color from the drop-down list to apply to the text box.</td>
</tr>
<tr>
<td><strong>Insert Function</strong></td>
<td>Click to display the Insert Functions Editor where, you can insert a function into the text box.</td>
</tr>
<tr>
<td><strong>Show Text Function Errors</strong></td>
<td>Select to enable errors to display for text functions for text objects. This is the default.</td>
</tr>
<tr>
<td><strong>Autosize</strong></td>
<td>Select to expand the text box when you preview or print the report so that all of the text contained in it is displayed.</td>
</tr>
<tr>
<td><strong>Page Break Before</strong></td>
<td>Select to display the text box on the top of the next page when you preview or print the report. If you are saving a report to HTML, a new HTML page is created before the text box.</td>
</tr>
<tr>
<td><strong>Link to Source Object</strong></td>
<td>This check box is only enabled after the text object is saved to repository and the Link to Source Object check box is selected. Clear the check box to unlink the text box from its source object in the repository. You cannot reverse this action.</td>
</tr>
<tr>
<td><strong>Position Object on Report - Horizontal</strong></td>
<td>Select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>- Select None to position the printed text at its current location regardless of whether report objects above it or to its left change in size</td>
</tr>
<tr>
<td></td>
<td>- Select Relative to position the printed text relative to report objects to its left</td>
</tr>
<tr>
<td>Item</td>
<td>Use</td>
</tr>
<tr>
<td>------</td>
<td>-----</td>
</tr>
<tr>
<td></td>
<td>● Select Left to position the text box on the left side of the report</td>
</tr>
<tr>
<td></td>
<td>● Select Center to position the text box in the center of the report</td>
</tr>
<tr>
<td></td>
<td>● Select Right to position the text box on the right side of the report.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Position Object on Report - Vertical</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select None to position the printed text at its current location regardless of whether report objects above it or to its left change in size</td>
<td></td>
</tr>
<tr>
<td>Select Relative to position the printed text relative to report objects above it</td>
<td></td>
</tr>
<tr>
<td>Select Top to position the text box at the top of the report</td>
<td></td>
</tr>
<tr>
<td>Select Middle to position the text box in the middle of the report</td>
<td></td>
</tr>
<tr>
<td>Select Bottom to position the text box on the bottom of the report</td>
<td></td>
</tr>
</tbody>
</table>

**Row and Column Template Properties**

Use this property sheet to specify inheritance, set precedence, and to unlink the template from the source object.

<p>| Table 66 Row and Column Template Properties Sheet |
|-----------------------------------|-----|</p>
<table>
<thead>
<tr>
<th>Item</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inherit Formatting from</td>
<td>Select to apply formatting to a row or column template by referencing a row or column in the grid. The default row or column is displayed and can be changed.</td>
</tr>
<tr>
<td>Precedence for</td>
<td>This option is enabled only if a row template and column template intersect. Select to apply format and formula precedence to the selected row or column template.</td>
</tr>
<tr>
<td></td>
<td>● To set formatting precedence, select Row Template to apply the formatting of the intersecting row template, or select Column Template to apply the formatting of the intersecting column template.</td>
</tr>
<tr>
<td></td>
<td>● To set formula precedence, select Row Formula to apply the formula of the intersecting row template, or select Column Formula to apply the formula of the intersecting column template.</td>
</tr>
<tr>
<td>Link to Source Object</td>
<td>Clear the check box to unlink the row or column template from its source object in the repository.</td>
</tr>
<tr>
<td></td>
<td><strong>Caution!</strong> You cannot reverse this action.</td>
</tr>
</tbody>
</table>
Frequently Asked Questions

In This Appendix

Why are dimensions listed on the user POV when changing them has no effect on the grid? ........................................ 333
Why are the grid POVs not displayed in the Report Designer Workspace? .................................................................... 334
How will a user running Workspace know that the dimension is set on the grid POV? .................................................. 334
How can a report be designed so that any changes to a user's user POV changes the members selected from a row, column, or page axis on a grid? ........................................................................................................ 335
Why do you need a book POV? ............................................................................................................................................... 335
What are Report Member Selections? ............................................................................................................................ 335
Why not just call Report Member Selections the report POV? ............................................................................................ 335
Why do you need a batch POV? ............................................................................................................................................... 336

This appendix contains a list of commonly asked questions and answers for Financial Reporting:

**Why are dimensions listed on the user POV when changing them has no effect on the grid?**

Multiple grids can be included in a report, where one or more of the grids are affected by changes to those dimensions on the user POV.

Notice in the following figure, the two grids look identical, but have different values for Measures->Year.

**Figure 26  Multiple Grids in One Report**

<table>
<thead>
<tr>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Measures</td>
</tr>
<tr>
<td>-----------</td>
</tr>
<tr>
<td>(Export to Spreadsheet)</td>
</tr>
<tr>
<td>Measures</td>
</tr>
<tr>
<td>(Export to Spreadsheet)</td>
</tr>
</tbody>
</table>
If you go back to the Report client and turn on the grid POV, you see that the members for Product, Market, and Scenario have been set for Grid2. Thus, a user changing any of those dimensions in the Reports Designer workspace has no effect on Grid2.

Therefore, it is probably useful for the designer of the report to indicate the user of page dimensions in a text box or row/column headers.

**Figure 27  Grid POV Enabled**

**Why are the grid POVs not displayed in the Report Designer Workspace?**

If the administrator chooses to disable the grid POV, Workspace viewers cannot see it. In the following figure, the grid POV is not selected and the grid POV is not displayed in Workspace:

![Autosize, Grid Point of View, Page Break Before]

**How will a user running Workspace know that the dimension is set on the grid POV?**

The Report designer should design the grid with a text row footnote that the grid POV for a dimension is set to a particular member in the grid. Another option for the Report designer is to put the dimension value into the row or column headers (see the following figure for an example.) If the designer turned off the grid POV, the column description (using a custom heading) would correctly denote that the grid is displaying Actual for the Scenario dimension.
How can a report be designed so that any changes to a user's user POV changes the members selected from a row, column, or page axis on a grid?

Use the CurrentPOV member for the selected axis or choose a member selection function with CurrentPOV as the member parameter. When the report runs, the axis value is taken from the user POV. You can design a grid so that all axis values are taken from the user POV, making the report completely dynamic on a per user basis.

Why do you need a book POV?

It allows anyone running the book to use the same default values for all grids in all reports in the book simultaneously each time the book is run. It is specific to a database connection for a book, but not specific to any report or grid object in a report in that book. As the book POV values are saved with the book itself, changes to the book POV do not affect the book designer's user POV.

What are Report Member Selections?

The Report Member Selections define the values for any dimensions not on a grid's row, column, or page axis or set in the grid POV for all Grids in a specific report in the book.

Why not just call Report Member Selections the report POV?

All POVs allow a single member to be set for a dimension. Report Member Selections allow multiple members to be set for a dimension. If multiple members or member selection functions resulting in multiple members are set for a dimension, the report in the book is run for each member. If multiple members or member selection functions resulting in multiple members are set for multiple dimensions, the report in the book is run for all combinations of those members.
Just like a grid is generated for each combination of the members on the page axis in a report, a report is generated for each combination of the members set using Report Member Selections in a book.

**Why do you need a batch POV?**

It allows anyone scheduling the batch to use the same default values for all grids in all reports in the batch simultaneously when the batch is run. It is specific to a database connection for a batch, but not specific to any report or grid object in a report in that batch. Since the batch POV values are only saved when the batch is scheduled, you can set different values for the same batch. Changes to the batch POV do not affect the batch designer’s user POV. Also, the changes to the batch designer’s user POV do not affect the batch POV.
This appendix lists and describes the currency symbols that come prepopulated with Oracle's Hyperion® Financial Reporting – System 9.

**Note:**

Finland, France, Germany, Greece, Italy, Luxembourg, Netherlands, Spain, Belgium, Austria, Ireland and Portugal use the European euro currency.

<table>
<thead>
<tr>
<th>Country</th>
<th>Currency Name</th>
<th>Currency Symbol</th>
<th>ISO Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argentina</td>
<td>peso</td>
<td>$</td>
<td>ARS</td>
</tr>
<tr>
<td>Australia</td>
<td>dollar</td>
<td>A$</td>
<td>AUD</td>
</tr>
<tr>
<td>Austria</td>
<td>schilling</td>
<td>S</td>
<td>ATS</td>
</tr>
<tr>
<td>Belgium</td>
<td>franc</td>
<td>BEF</td>
<td>BEF</td>
</tr>
<tr>
<td>Brazil</td>
<td>real</td>
<td>R$</td>
<td>BRL</td>
</tr>
<tr>
<td>Canada</td>
<td>dollar</td>
<td>Can$</td>
<td>CAD</td>
</tr>
<tr>
<td>Chile</td>
<td>peso</td>
<td>Ch$</td>
<td>CLP</td>
</tr>
<tr>
<td>China</td>
<td>yuan</td>
<td>Y</td>
<td>CNY</td>
</tr>
<tr>
<td>Denmark</td>
<td>krone</td>
<td>Dkr</td>
<td>DKK</td>
</tr>
<tr>
<td>Egypt</td>
<td>pound</td>
<td>£E</td>
<td>EGP</td>
</tr>
<tr>
<td>European Union</td>
<td>European Currency Unit</td>
<td>Euro</td>
<td>XEU</td>
</tr>
<tr>
<td>Finland</td>
<td>markka</td>
<td>mk</td>
<td>FIM</td>
</tr>
<tr>
<td>France</td>
<td>franc</td>
<td>F</td>
<td>FRF</td>
</tr>
<tr>
<td>Germany</td>
<td>deutsche mark</td>
<td>DM</td>
<td>DEM</td>
</tr>
<tr>
<td>Greece</td>
<td>drachma</td>
<td>Dr</td>
<td>GRD</td>
</tr>
<tr>
<td>Hong Kong</td>
<td>dollar</td>
<td>HK$</td>
<td>HKD</td>
</tr>
<tr>
<td>Country</td>
<td>Currency Name</td>
<td>Currency Symbol</td>
<td>ISO Code</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------</td>
<td>----------------</td>
<td>----------</td>
</tr>
<tr>
<td>India</td>
<td>rupee</td>
<td>Rs</td>
<td>INR</td>
</tr>
<tr>
<td>Indonesia</td>
<td>rupiah</td>
<td>Rp</td>
<td>IDR</td>
</tr>
<tr>
<td>Ireland</td>
<td>punt</td>
<td>IR£</td>
<td>IEP</td>
</tr>
<tr>
<td>Israel</td>
<td>new shekel</td>
<td>NIS</td>
<td>ILS</td>
</tr>
<tr>
<td>Italy</td>
<td>lira</td>
<td>Lit</td>
<td>ITL</td>
</tr>
<tr>
<td>Japan</td>
<td>yen</td>
<td>¥</td>
<td>JPY</td>
</tr>
<tr>
<td>Korea (South)</td>
<td>won</td>
<td>W</td>
<td>KRW</td>
</tr>
<tr>
<td>Luxembourg</td>
<td>franc</td>
<td>LuxF</td>
<td>LUF</td>
</tr>
<tr>
<td>Malaysia</td>
<td>ringgit</td>
<td>RM</td>
<td>MYR</td>
</tr>
<tr>
<td>Mexico</td>
<td>peso</td>
<td>Mex$</td>
<td>MXP</td>
</tr>
<tr>
<td>Netherlands</td>
<td>guilder</td>
<td>fl</td>
<td>NLG</td>
</tr>
<tr>
<td>New Zealand</td>
<td>dollar</td>
<td>NZ$</td>
<td>NZD</td>
</tr>
<tr>
<td>Norway</td>
<td>krone</td>
<td>NKr</td>
<td>NOK</td>
</tr>
<tr>
<td>Philippines</td>
<td>peso</td>
<td>Php</td>
<td>PHP</td>
</tr>
<tr>
<td>Poland</td>
<td>zloty</td>
<td>Zl</td>
<td>PLN</td>
</tr>
<tr>
<td>Portugal</td>
<td>escudo</td>
<td>Esc</td>
<td>PTE</td>
</tr>
<tr>
<td>Russia</td>
<td>ruble</td>
<td>R</td>
<td>RUR</td>
</tr>
<tr>
<td>Singapore</td>
<td>dollar</td>
<td>S$</td>
<td>SGD</td>
</tr>
<tr>
<td>South Africa</td>
<td>rand</td>
<td>R</td>
<td>ZAR</td>
</tr>
<tr>
<td>Spain</td>
<td>peseta</td>
<td>Ptas</td>
<td>ESP</td>
</tr>
<tr>
<td>Sweden</td>
<td>krona</td>
<td>SEK</td>
<td>SEK</td>
</tr>
<tr>
<td>Switzerland</td>
<td>franc</td>
<td>SwF</td>
<td>CHF</td>
</tr>
<tr>
<td>Taiwan</td>
<td>new dollar</td>
<td>NT$</td>
<td>TWD</td>
</tr>
<tr>
<td>Thailand</td>
<td>baht</td>
<td>Bht</td>
<td>THB</td>
</tr>
<tr>
<td>Turkey</td>
<td>lira</td>
<td>TL</td>
<td>TRL</td>
</tr>
<tr>
<td>United Kingdom</td>
<td>pound</td>
<td>£</td>
<td>GBP</td>
</tr>
<tr>
<td>United States of America</td>
<td>dollar</td>
<td>$</td>
<td>USD</td>
</tr>
</tbody>
</table>
Glossary

!  See bang character (!).

#MISSING  See missing data (#MISSING).

access permissions  A set of operations that a user can perform on a resource.

accessor  Input and output data specifications for data mining algorithms.

account  A dimension that represents an accounting container that identifies the location and primary nature of the data.

account blocking  The process by which accounts accept input data in the consolidated file. Blocked accounts do not receive their value through the additive consolidation process.

account eliminations  Accounts which have their values set to zero in the consolidated file during consolidation.

account type  How an account’s value flows over time, and its sign behavior. Account type options can include expense, income, asset, liability, and equity.

accountability map  A visual, hierarchical representation of the responsibility, reporting, and dependency structure of the accountability teams (also known as critical business areas) in an organization.

accounts dimension  A dimension type that makes accounting intelligence available. Only one dimension can be defined as Accounts.

active service  A service whose Run Type is set to Start rather than Hold.

active user  A user who is entitled to access the system.

active user/user group  The user or user group identified as the current user by user preferences. Determines default user preferences, dynamic options, access, and file permissions. You can set the active user to your user name or any user group to which you belong.

activity-level authorization  Defines user access to applications and the types of activities they can perform on applications, independent of the data that will be operated on.

ad hoc report  An online analytical query created on-the-fly by an end user.

adaptive states  Interactive Reporting Web Client level of permission.

adjustment  See journal entry (JE).

Advanced Relational Access  The integration of a relational database with an Essbase multidimensional database so that all data remains in the relational database and is mapped to summary-level data residing in the Essbase database.

agent  An Essbase server process that starts and stops applications and databases, manages connections from users, and handles user-access security. The agent is referred to as ESSBASE.EXE.

aggregate cell  A cell comprising several cells. For example, a data cell that uses Children(Year) expands to four cells containing Quarter 1, Quarter 2, Quarter 3, and Quarter 4 data.

aggregate function  A type of function, such as sum or calculation of an average, that summarizes or performs analysis on data.

aggregate limit  A limit placed on an aggregated request line item or aggregated metatopic item.
aggregate storage database  The database storage model designed to support large-scale, sparsely distributed data which is categorized into many, potentially large dimensions. Upper level members and formulas are dynamically calculated, and selected data values are aggregated and stored, typically with improvements in overall aggregation time.

aggregate view  A collection of aggregate cells based on the levels of the members within each dimension. To reduce calculation time, values are pre-aggregated and stored as aggregate views. Retrievals then start from aggregate view totals and add up from there.

aggregation  The process of rolling up and storing values in an aggregate storage database; the stored result of the aggregation process.

aggregation script  In aggregate storage databases only, a file that defines a selection of aggregate views to be built into an aggregation.

alias  An alternative name. For example, for a more easily identifiable column descriptor you can display the alias instead of the member name.

alias table  A table that contains alternate names for members.

alternate hierarchy  A hierarchy of shared members. An alternate hierarchy is based upon an existing hierarchy in a database outline, but has alternate levels in the dimension. An alternate hierarchy allows the same data to be seen from different points of view.

ancestor  A branch member that has members below it. For example, the members Qtr2 and 2006 are ancestors of the member April.

appender  A Log4j term for destination.

application  (1) A software program designed to run a specific task or group of tasks such as a spreadsheet program or database management system. (2) A related set of dimensions and dimension members that are used to meet a specific set of analytical and/or reporting requirements.

application currency  The default reporting currency for the application.

Application Migration Utility  A command-line utility for migrating applications and artifacts.

area  A predefined set of members and values that makes up a partition.

arithmetic data load  A data load that performs operations on values in the database, such as adding 10 to each value.

artifact  An individual application or repository item; for example, scripts, forms, rules files, Interactive Reporting documents, and financial reports. Also known as an object.

asset account  An account type that stores values that represent a company’s assets.

attribute  Characteristics of a dimension member. For example, Employee dimension members may have attributes of Name, Age, or Address. Product dimension members can have several attributes, such as a size and flavor.

attribute association  A relationship in a database outline whereby a member in an attribute dimension describes a characteristic of a member of its base dimension. For example, if product 100-10 has a grape flavor, the product 100-10 has the Flavor attribute association of grape. Thus, the 100-10 member of the Product dimension is associated with the Grape member of the Flavor attribute dimension.

Attribute Calculations dimension  A system-defined dimension that performs these calculation operations on groups of members: Sum, Count, Avg, Min, and Max. This dimension is calculated dynamically and is not visible in the database outline. For example, using the Avg member, you can calculate the average sales value for Red products in New York in January.

attribute dimension  A type of dimension that enables analysis based on the attributes or qualities of dimension members.

attribute reporting  A reporting process based on the attributes of the base dimension members. See also base dimension.

attribute type  A text, numeric, Boolean, date, or linked-attribute type that enables different functions for grouping, selecting, or calculating data. For example, because the Ounces attribute dimension has the type numeric, the number of ounces specified as the attribute of each product can be used to calculate the profit per ounce for that product.
**authentication** Verification of identity as a security measure. Authentication is typically based on a user name and password. Passwords and digital signatures are forms of authentication.

**authentication service** A core service that manages one authentication system.

**auto-reversing journal** A journal for entering adjustments that you want to reverse in the next period.

**automated stage** A stage that does not require human intervention, for example, a data load.

**axis** (1) A straight line that passes through a graphic used for measurement and categorization. (2) A report aspect used to arrange and relate multidimensional data, such as filters, pages, rows, and columns. For example, for a data query in Simple Basic, an axis can define columns for values for Qtr1, Qtr2, Qtr3, and Qtr4. Row data would be retrieved with totals in the following hierarchy: Market, Product.

**backup** A duplicate copy of an application instance.

**balance account** An account type that stores unsigned values that relate to a particular point in time.

**balanced journal** A journal in which the total debits equal the total credits.

**bang character** (!) A character that terminates a series of report commands and requests information from the database. A report script must be terminated with a bang character; several bang characters can be used within a report script.

**bar chart** A chart that can consist of one to 50 data sets, with any number of values assigned to each data set. Data sets are displayed as groups of corresponding bars, stacked bars, or individual bars in separate rows.

**base currency** The currency in which daily business transactions are performed.

**base dimension** A standard dimension that is associated with one or more attribute dimensions. For example, assuming products have flavors, the Product dimension is the base dimension for the Flavors attribute dimension.

**base entity** An entity at the bottom of the organization structure that does not own other entities.

**batch calculation** Any calculation on a database that is done in batch; for example, a calculation script or a full database calculation. Dynamic calculations are not considered to be batch calculations.

**batch file** An operating system file that can call multiple ESSCMD scripts and run multiple sessions of ESSCMD. On Windows-based systems, batch files have BAT file extensions. On UNIX, batch files are written as a shell script.

**batch POV** A collection of all dimensions on the user POV of every report and book in the batch. While scheduling the batch, you can set the members selected on the batch POV.

**batch processing mode** A method of using ESSCMD to write a batch or script file that can be used to automate routine server maintenance and diagnostic tasks. ESSCMD script files can execute multiple commands and can be run from the operating system command line or from within operating system batch files. Batch files can be used to call multiple ESSCMD scripts or run multiple instances of ESSCMD.

**block** The primary storage unit which is a multidimensional array representing the cells of all dense dimensions.

**block storage database** The Essbase database storage model categorizing and storing data based on the sparsity of data values defined in sparse dimensions. Data values are stored in blocks, which exist only for sparse dimension members for which there are values.

**Blocked Account** An account that you do not want calculated in the consolidated file because you want to enter it manually.

**book** A container that holds a group of similar Financial Reporting documents. Books may specify dimension sections or dimension changes.

**book POV** The dimension members for which a book is run.

**bookmark** A link to a reporting document or a Web site, displayed on a personal page of a user. The two types of bookmarks are My Bookmarks and image bookmarks.
bounding rectangle  The required perimeter that encapsulates the Interactive Reporting document content when embedding Interactive Reporting document sections in a personal page, specified in pixels for height and width or row per page.

broadcast message  A simple text message sent by an administrator to a user who is logged on to a Planning application. The message displays information to the user such as system availability, notification of application refresh, or application backups.

budget administrator  A person responsible for setting up, configuring, maintaining, and controlling an application. Has all application privileges and data access permissions.

build method  A method used to modify database outlines. Choice of a build method is based on the format of data in data source files.

business process  A set of activities that collectively accomplish a business objective.

business rules  Logical expressions or formulas that are created within an application to produce a desired set of resulting values.

cache  A buffer in memory that holds data temporarily.

calc script  A set of commands that define how a database is consolidated or aggregated. A calculation script may also contain commands that specify allocation and other calculation rules separate from the consolidation process.

Calculated Accounts  You cannot alter the formulas in Calculated Accounts. These formulas are fixed in order to maintain the accounting integrity of the model you are building. For example, the formula for Net Income, a Calculated Account, is modeled into Strategic Finance and can not be changed in either historical or forecast periods.

calculated member in MaxL DML  A member designed for analytical purposes and defined in the optional WITH section of a MaxL DML query.

calculation  The process of aggregating data, or of running a calculation script on a database.

calculation status  A consolidation status that indicates that some values or formula calculations have changed. You must reconsolidate to get the correct values for the affected entity.

calendar  User-defined time periods and their relationship to each other. Q1, Q2, Q3, and Q4 comprise a calendar or fiscal year.

cascade  The process of creating multiple reports for a subset of member values.

Catalog pane  Displays a list of elements available to the active section. If Query is the active section, a list of database tables is displayed. If Pivot is the active section, a list of results columns is displayed. If Dashboard is the active section, a list of embeddable sections, graphic tools, and control tools are displayed.

categories  Groupings by which data is organized. For example, Month

cause and effect map  Depicts how the elements that form your corporate strategy relate and how they work together to meet your organization’s strategic goals. A Cause and Effect map tab is automatically created for each Strategy map.

CDF  See custom-defined function (CDF).

CDM  See custom-defined macro (CDM).

cell  (1) The data value at the intersection of dimensions in a multidimensional database; the intersection of a row and a column in a worksheet. (2) A logical group of nodes belonging to one administrative domain.

cell note  A text annotation for a cell in an Essbase database. Cell notes are a type of LRO.

CHANGED status  Consolidation status that indicates data for an entity has changed.

chart  A graphical representation of spreadsheet data. The visual nature expedites analysis, color-coding, and visual cues that aid comparisons.

chart template  A template that defines the metrics to display in Workspace charts.

child  A member with a parent above it in the database outline.
choice list A list of members that a report designer can specify for each dimension when defining the report's point of view. A user who wants to change the point of view for a dimension that uses a choice list can select only the members specified in that defined member list or those members that meet the criteria defined in the function for the dynamic list.

clean block A data block that where the database is fully calculated, if a calculation script calculates all dimensions at once, or if the SET CLEARUPDATESTATUS command is used in a calculation script.

cluster An array of servers or databases that behave as a single resource which share task loads and provide failover support; eliminates one server or database as a single point of failure in a system.

clustered bar charts Charts in which categories are viewed side-by-side; useful for side-by-side category analysis; used only with vertical bar charts.

code page A mapping of bit combinations to a set of text characters. Different code pages support different sets of characters. Each computer contains a code page setting for the character set requirements of the language of the computer user. In the context of this document, code pages map characters to bit combinations for non-Unicode encodings. See also encoding.

column A vertical display of information in a grid or table. A column can contain data from one field, derived data from a calculation, or textual information.

committed access An Essbase Kernel Isolation Level setting that affects how Essbase handles transactions. Under committed access, concurrent transactions hold long-term write locks and yield predictable results.

computed item A virtual column (as opposed to a column that is physically stored in the database or cube) that can be calculated by the database during a query, or by Interactive Reporting Studio in the Results section. Computed items are calculations of data based on functions, data items, and operators provided in the dialog box and can be included in reports or reused to calculate other data.

configuration file The security platform relies on XML documents to be configured by the product administrator or software installer. The XML document must be modified to indicate meaningful values for properties, specifying locations and attributes pertaining to the corporate authentication scenario.

connection file See Interactive Reporting connection file (.oce).

consolidated file (Parent) A file into which all of the business unit files are consolidated; contains the definition of the consolidation.

consolidation The process of aggregating data from dependent entities to parent entities. For example, if the dimension Year consists of the members Qtr1, Qtr2, Qtr3, and Qtr4, its consolidation is Year.

consolidation file (*.cns) The consolidation file is a graphical interface that enables you to add, delete or move Strategic Finance files in the consolidation process using either a Chart or Tree view. It also enables you to define and modify the consolidation.

consolidation rule Identifies the rule that is executed during the consolidation of the node of the hierarchy. This rule can contain customer specific formulas appropriate for the correct consolidation of parent balances. Elimination processing can be controlled within these rules.

content Information stored in the repository for any type of file.

column A vertical display of information in a grid or table. A column can contain data from one field, derived data from a calculation, or textual information.

context variable A variable that is defined for a particular task flow to identify the context of the taskflow instance.

contribution The value added to a parent from a child entity. Each child has a contribution to its parent.

conversion rate See exchange rate.

cookie A segment of data placed on your computer by a Web site.

correlated subqueries Subqueries that are evaluated once for every row in the parent query; created by joining a topic item in the subquery with a topic in the parent query.
Cost of Debt  Value determined by using a weighted average Yield to Maturity (YTM) of a company’s entire debt portfolio. Use is the current YTM rate rather than the nominal cost of debt. The coupon rate determines the interest payment, but it does not always reflect the actual cost of the company’s debt today. As required returns change, the price of a debt issue also changes so that the actual interest payments and anticipated proceeds, at maturity, yield the investors their revised required return. Therefore, the YTM fully reflects the current return demanded by debt holders and the rate at which existing debt would have to be replaced.

Cost of Equity  The return an investor expects to earn on an individual stock. Using the CAPM method, the Cost of Equity is equal to:

Cost of Preferred  Represents the expected return to preferred stockholders. Like debt, you need to enter the yield to maturity on preferred stock, but without the tax shielding.

critical business area (CBA)  An individual or a group organized into a division, region, plant, cost center, profit center, project team, or process; also called accountability team or business area.

critical success factor (CSF)  A capability that must be established and sustained to achieve a strategic objective; owned by a strategic objective or a critical process and is a parent to one or more actions.

crosstab reporting  Categorizes and summarizes data in table format. The table cells contain summaries of the data that fit within the intersecting categories. For example, a crosstab report of product sales information could show size attributes, such as Small and Large, as column headings and color attributes, such as Blue and Yellow, as row headings. The cell in the table where Large and Blue intersect could contain the total sales of all Blue products that are sized Large.

cube  A block of data that contains three or more dimensions. An Essbase database is a cube.

currency conversion  A process that converts currency values in a database from one currency into another. For example, to convert one U.S. dollar into the European euro, the exchange rate (for example, 0.923702) is multiplied with the dollar (1 * 0.923702). After conversion, the European euro amount is .92.

Currency Overrides  In any input period, the selected input method can be overridden to enable input of that period’s value as Default Currency/Items. To override the input method, enter a pound sign (#) either before or after the number.

currency partition  A dimension type that separates local currency members from a base currency, as defined in an application. Identifies currency types, such as Actual, Budget, and Forecast.

custom calendar  Any calendar created by an administrator.

custom dimension  A dimension created and defined by users. Channel, product, department, project, or region could be custom dimensions.

custom property  A property of a dimension or dimension member that is created by a user.

custom report  A complex report from the Design Report module, composed of any combination of components.

custom-defined function (CDF)  Essbase calculation functions developed in Java and added to the standard Essbase calculation scripting language using MaxL. See also custom-defined macro (CDM).

custom-defined macro (CDM)  Essbase macros written with Essbase calculator functions and special macro functions. Custom-defined macros use an internal Essbase macro language that enables the combination of calculation functions and they operate on multiple input parameters. See also custom-defined function (CDF).

cycle through  To perform multiple passes through a database while calculating it.

dashboard  A collection of metrics and indicators that provide an interactive summary of your business. Dashboards enable you to build and deploy analytic applications.

data cache  A buffer in memory that holds uncompressed data blocks.

data cell  See cell.

data file cache  A buffer in memory that holds compressed data (PAG) files.
**data form**  A grid display that enables users to enter data into the database from an interface such as a Web browser, and to view and analyze data or related text. Certain dimension member values are fixed, giving users a specific view into the data.

**data function**  That computes aggregate values, including averages, maximums, counts, and other statistics, that summarize groupings of data.

**data load rules**  A set of criteria that determines how to load data from a text-based file, a spreadsheet, or a relational data set into a database.

**data lock**  Prevents changes to data according to specified criteria, such as period or scenario.

**data mining**  The process of searching through an Essbase database for hidden relationships and patterns in a large amount of data.

**data model**  A representation of a subset of database tables.

**data value**  See cell.

**database connection**  File that stores definitions and properties used to connect to data sources and enables database references to be portable and widely used.

**Default Currency Units**  Define the unit scale of data. For example, If you select to define your analysis in Thousands, and enter “10”, this is interpreted as “10,000”.

**dense dimension**  In block storage databases, a dimension likely to contain data for every combination of dimension members. For example, time dimensions are often dense because they can contain all combinations of all members. Contrast with sparse dimension.

**dependent entity**  An entity that is owned by another entity in the organization.

**descendant**  Any member below a parent in the database outline. In a dimension that includes years, quarters, and months, the members Qtr2 and April are descendants of the member Year.

**Design Report**  An interface in Web Analysis Studio for designing custom reports, from a library of components.

**destination currency**  The currency to which balances are converted. You enter exchange rates and convert from the source currency to the destination currency. For example, when you convert from EUR to USD, the destination currency is USD.

**detail chart**  A chart that provides the detailed information that you see in a Summary chart. Detail charts appear in the Investigate Section in columns below the Summary charts. If the Summary chart shows a Pie chart, then the Detail charts below represent each piece of the pie.

**dimension**  A data category used to organize business data for retrieval and preservation of values. Dimensions usually contain hierarchies of related members grouped within them. For example, a Year dimension often includes members for each time period, such as quarters and months.

**dimension build**  The process of adding dimensions and members to an Essbase outline.

**dimension build rules**  Specifications, similar to data load rules, that Essbase uses to modify an outline. The modification is based on data in an external data source file.

**dimension tab**  In the Pivot section, the tab that enables you to pivot data between rows and columns.

**dimension table**  (1) A table that includes numerous attributes about a specific business process. (2) In Essbase Integration Services, a container in the OLAP model for one or more relational tables that define a potential dimension in Essbase.

**dimension type**  A dimension property that enables the use of predefined functionality. Dimensions tagged as time have a predefined calendar functionality.

**dimensionality**  In MaxL DML, the represented dimensions (and the order in which they are represented) in a set. For example, the following set consists of two tuples of the same dimensionality because they both reflect the dimensions (Region, Year): \{ (West, Feb), (East, Mar) \}

**direct rate**  A currency rate that you enter in the exchange rate table. The direct rate is used for currency conversion. For example, to convert balances from JPY to USD, In the exchange rate table, enter a rate for the period/scenario where the source currency is JPY and the destination currency is USD.
dirty block  A data block containing cells that have been changed since the last calculation. Upper level blocks are marked as dirty if their child blocks are dirty (that is, they have been updated).

display type  One of three Web Analysis formats saved to the repository: spreadsheet, chart, and pinboard.

dog-ear  The flipped page corner in the upper right corner of the chart header area.

domain  In data mining, a variable representing a range of navigation within data.

drill-down  Navigation through the query result set using the dimensional hierarchy. Drilling down moves the user perspective from aggregated data to detail. For example, drilling down can reveal hierarchical relationships between years and quarters or quarters and months.

drill-through  The navigation from a value in one data source to corresponding data in another source.

duplicate alias name  A name that occurs more than once in an alias table and that can be associated with more than one member in a database outline. Duplicate alias names can be used with duplicate member outlines only.

duplicate member name  The multiple occurrence of a member name in a database, with each occurrence representing a different member. For example, a database has two members named “New York.” One member represents New York state and the other member represents New York city.

duplicate member outline  A database outline containing duplicate member names.

Dynamic Calc and Store members  A member in a block storage outline that Essbase calculates only upon the first retrieval of the value. Essbase then stores the calculated value in the database. Subsequent retrievals do not require calculating.

Dynamic Calc members  A member in a block storage outline that Essbase calculates only at retrieval time. Essbase discards calculated values after completing the retrieval request.

dynamic calculation  In Essbase, a calculation that occurs only when you retrieve data on a member that is tagged as Dynamic Calc or Dynamic Calc and Store. The member’s values are calculated at retrieval time instead of being precalculated during batch calculation.

dynamic hierarchy  In aggregate storage database outlines only, a hierarchy in which members are calculated at retrieval time.

dynamic member list  A system-created named member set that is based on user-defined criteria. The list is refreshed automatically whenever it is referenced in the application. As dimension members are added and deleted, the list automatically reapplies the criteria to reflect the changes.

dynamic reference  A pointer in the rules file to header records in a data source.

dynamic report  A report containing data that is updated when you run the report.

Dynamic Time Series  A process that performs period-to-date reporting in block storage databases.

dynamic view account  An account type indicating that account values are calculated dynamically from the data that is displayed.

Eliminated Account  An account that does not appear in the consolidated file.

elimination  The process of zeroing out (eliminating) transactions between entities within an organization.

employee  A user responsible for, or associated with, specific business objects. Employees need not work for an organization; for example, they can be consultants. Employees must be associated with user accounts for authorization purposes.

encoding  A method for mapping bit combinations to characters for creating, storing, and displaying text. Each encoding has a name; for example, UTF-8. Within an encoding, each character maps to a specific bit combination; for example, in UTF-8, uppercase A maps to HEX41. See also code page and locale.

ending period  A period enabling you to adjust the date range in a chart. For example, an ending period of “month”, produces a chart showing information through the end of the current month.
Enterprise View An Administration Services feature that enables management of the Essbase environment from a graphical tree view. From Enterprise View, you can operate directly on Essbase artifacts.

entity A dimension representing organizational units. Examples: divisions, subsidiaries, plants, regions, products, or other financial reporting units.

Equity Beta The riskiness of a stock, measured by the variance between its return and the market return, indicated by an index called “beta”. For example, if a stock's return normally moves up or down 1.2% when the market moves up or down 1%, the stock has a beta of 1.2.

essbase.cfg An optional configuration file for Essbase. Administrators may edit this file to customize Essbase Server functionality. Some configuration settings may also be used with Essbase clients to override Essbase Server settings.

EssCell A function entered into an Essbase Spreadsheet Add-in to retrieve a value representing an intersection of specific Essbase database members.

ESSCMD A command-line interface for performing Essbase operations interactively or through batch script files.

ESSLANG The Essbase environment variable that defines the encoding used to interpret text characters. See also encoding.

ESSMSH See MaxL Shell.

exceptions Values that satisfy predefined conditions. You can define formatting indicators or notify subscribing users when exceptions are generated.

exchange rate A numeric value for converting one currency to another. For example, to convert 1 USD into EUR, the exchange rate of 0.8936 is multiplied with the U.S. dollar. The European euro equivalent of $1 is 0.8936.

exchange rate type An identifier for an exchange rate. Different rate types are used because there may be multiple rates for a period and year. Users traditionally define rates at period end for the average rate of the period and for the end of the period. Additional rate types are historical rates, budget rates, forecast rates, and so on. A rate type applies to one point in time.

cost account An account that stores periodic and year-to-date values that decrease net worth if they are positive.

Extensible Markup Language (XML) A language comprising a set of tags used to assign attributes to data that can be interpreted between applications according to a schema.

external authentication Logging on to Oracle’s Hyperion applications with user information stored outside the applications, typically in a corporate directory such as MSAD or NTLM.

externally triggered events Non-time-based events for scheduling job runs.

Extract, Transform, and Load (ETL) Data source-specific programs for extracting data and migrating it to applications.

extraction command An Essbase reporting command that handles the selection, orientation, grouping, and ordering of raw data extracted from a database; begins with the less than (<) character.

fact table The central table in a star join schema, characterized by a foreign key and elements drawn from a dimension table. This table typically contains numeric data that can be related to all other tables in the schema.

field An item in a data source file to be loaded into an Essbase database.

file delimiter Characters, such as commas or tabs, that separate fields in a data source.

filter A constraint on data sets that restricts values to specific criteria; for example, to exclude certain tables, metadata, or values, or to control access.

flow account An unsigned account that stores periodic and year-to-date values.

folder A file containing other files for the purpose of structuring a hierarchy.

footer Text or images at the bottom of report pages, containing dynamic functions or static text such as page numbers, dates, logos, titles or file names, and author names.

format Visual characteristics of documents or report objects.
formula A combination of operators, functions, dimension and member names, and numeric constants calculating database members.

frame An area on the desktop. There are two main areas: the navigation and workspace frames.

free-form grid An object for presenting, entering, and integrating data from different sources for dynamic calculations.

free-form reporting Creating reports by entering dimension members or report script commands in worksheets.

function A routine that returns values or database members.

generation A layer in a hierarchical tree structure that defines member relationships in a database. Generations are ordered incrementally from the top member of the dimension (generation 1) down to the child members.

generation name A unique name that describes a generation.

generic jobs Non-SQR Production Reporting or non-Interactive Reporting jobs.

global report command A command in a running report script that is effective until replaced by another global command or the file ends.

grid POV A means for specifying dimension members on a grid without placing dimensions in rows, columns, or page intersections. A report designer can set POV values at the grid level, preventing user POVs from affecting the grid. If a dimension has one grid value, you put the dimension into the grid POV instead of the row, column, or page.

group A container for assigning similar access permissions to multiple users.

GUI Graphical user interface

highlighting Depending on your configuration, chart cells or ZoomChart details may be highlighted, indicating value status: red (bad), yellow (warning), or green (good).

Historical Average An average for an account over a number of historical periods.

holding company An entity that is part of a legal entity group, with direct or indirect investments in all entities in the group.

host A server on which applications and services are installed.

host properties Properties pertaining to a host, or if the host has multiple Install_Homes, to an Install_Home. The host properties are configured from the LSC.

Hybrid Analysis An analysis mapping low-level data stored in a relational database to summary-level data stored in Essbase, combining the mass scalability of relational systems with multidimensional data.

hyperlink A link to a file, Web page, or an intranet HTML page.

Hypertext Markup Language (HTML) A programming language specifying how Web browsers display data.

identity A unique identification for a user or group in external authentication.

image bookmarks Graphic links to Web pages or repository items.

IMPACTED status Indicates changes in child entities consolidating into parent entities.

implied share A member with one or more children, but only one is consolidated, so the parent and child share a value.

inactive group A group for which an administrator has deactivated system access.

inactive service A service suspended from operating.

INACTIVE status Indicates entities deactivated from consolidation for the current period.

inactive user A user whose account has been deactivated by an administrator.

income account An account storing periodic and year-to-date values that, if positive, increase net worth.


index cache A buffer containing index pages.
index entry  A pointer to an intersection of sparse dimensions. Index entries point to data blocks on disk and use offsets to locate cells.

index file  An Essbase file storing block storage data retrieval information, residing on disk, and containing index pages.

index page  A subdivision in an index file. Contains pointers to data blocks.

input data  Data loaded from a source rather than calculated.

Install_Home  A variable for the directory where Oracle’s Hyperion applications are installed. Refers to one instance of Oracle’s Hyperion application when multiple applications are installed on the same computer.

integration  Process that is run to move data between Oracle’s Hyperion applications using Shared Services. Data integration definitions specify the data moving between a source application and a destination application, and enable the data movements to be grouped, ordered, and scheduled.

intelligent calculation  A calculation method tracking updated data blocks since the last calculation.

Interactive Reporting connection file (.oce)  Files encapsulating database connection information, including: the database API (ODBC, SQL*Net, etc.), database software, the database server network address, and database user name. Administrators create and publish Interactive Reporting connection files (.oce).

intercompany elimination  See elimination.

intercompany matching  The process of comparing balances for pairs of intercompany accounts within an application. Intercompany receivables are compared to intercompany payables for matches. Matching accounts are used to eliminate intercompany transactions from an organization’s consolidated totals.

intercompany matching report  A report that compares intercompany account balances and indicates if the accounts are in, or out, of balance.

interdimensional irrelevance  A situation in which a dimension does not intersect with other dimensions. Because the data in the dimension cannot be accessed from the non-intersecting dimensions, the non-intersecting dimensions are not relevant to that dimension.

intersection  A unit of data representing the intersection of dimensions in a multidimensional database; also, a worksheet cell.

Investigation  See drill-through.

isolation level  An Essbase Kernel setting that determines the lock and commit behavior of database operations. Choices are: committed access and uncommitted access.

iteration  A “pass” of the budget or planning cycle in which the same version of data is revised and promoted.

Java Database Connectivity (JDBC)  A client-server communication protocol used by Java based clients and relational databases. The JDBC interface provides a call-level API for SQL-based database access.

job output  Files or reports produced from running a job.

job parameters  Reusable, named job parameters that are accessible only to the user who created them.

jobs  Documents with special properties that can be launched to generate output. A job can contain Interactive Reporting, SQR Production Reporting, or generic documents.

join  A link between two relational database tables or topics based on common content in a column or row. A join typically occurs between identical or similar items within different tables or topics. For example, a record in the Customer table is joined to a record in the Orders table because the Customer ID value is the same in each table.

journal entry (JE)  A set of debit/credit adjustments to account balances for a scenario and period.

JSP  Java Server Pages.

latest  A Spreadsheet key word used to extract data values from the member defined as the latest time period.

layer  (1) The horizontal location of members in a hierarchical structure, specified by generation (top down) or level (bottom up). (2) Position of objects relative to other objects. For example, in the Sample Basic database, Qtr1 and Qtr4 are in the same layer, so they are also in the same generation, but in a database with a ragged hierarchy, Qtr1 and Qtr4 might not be in same layer, though they are in the same generation.
**legend box** A box containing labels that identify the data categories of a dimension.

**level** A layer in a hierarchical tree structure that defines database member relationships. Levels are ordered from the bottom dimension member (level 0) up to the parent members.

**level 0 block** A data block for combinations of sparse, level 0 members.

**level 0 member** A member that has no children.

**liability account** An account type that stores “point in time” balances of a company's liabilities. Examples of liability accounts include accrued expenses, accounts payable, and long term debt.

**life cycle management** The process of managing application information from inception to retirement.

**line chart** A chart that displays one to 50 data sets, each represented by a line. A line chart can display each line stacked on the preceding ones, as represented by an absolute value or a percent.

**line item detail** The lowest level of detail in an account.

**link** (1) A reference to a repository object. Links can reference folders, files, shortcuts, and other links. (2) In a task flow, the point where the activity in one stage ends and another begins.

**link condition** A logical expression evaluated by the taskflow engine to determine the sequence of launching taskflow stages.

**linked data model** Documents that are linked to a master copy in a repository.

**linked partition** A shared partition that enables you to use a data cell to link two databases. When a user clicks a linked cell in a worksheet, Essbase opens a new sheet displaying the dimensions in the linked database. The user can then drill down those dimensions.

**linked reporting object (LRO)** A cell-based link to an external file such as cell notes, URLs, or files with text, audio, video, or pictures. (Only cell notes are supported for Essbase LROs in Financial Reporting.)

**local currency** An input currency type. When an input currency type is not specified, the local currency matches the entity's base currency.

**local report object** A report object that is not linked to a Financial Reporting report object in Explorer. Contrast with **linked reporting object (LRO)**.

**local results** A data model's query results. Results can be used in local joins by dragging them into the data model. Local results are displayed in the catalog when requested.

**locale** A computer setting that specifies a location's language, currency and date formatting, data sort order, and the character set encoding used on the computer. Essbase uses only the encoding portion. See also **encoding** and **ESSLANG**.

**locale header record** A text record at the beginning of some non-Unicode-encoded text files, such as scripts, that identifies the encoding locale.

**location alias** A descriptor that identifies a data source. The location alias specifies a server, application, database, user name, and password. Location aliases are set by DBAs at the database level using Administration Services Console, ESSCMD, or the API.

**locked** A user-invoked process that prevents users and processes from modifying data.

**locked data model** Data models that cannot be modified by a user.

**LOCKED status** A consolidation status indicating that an entity contains data that cannot be modified.

**Log Analyzer** An Administration Services feature that enables filtering, searching, and analysis of Essbase logs.

**LRO** See **linked reporting object (LRO)**.

**LSC services** Services configured with the Local Service Configurator. They include Global Services Manager (GSM), Local Services Manager (LSM), Session Manager, Authentication Service, Authorization Service, Publisher Service, and sometimes, Data Access Service (DAS) and Interactive Reporting Service.

**managed server** An application server process running in its own Java Virtual Machine (JVM).
**manual stage**  A stage that requires human intervention to complete.

**Map File**  Used to store the definition for sending data to or retrieving data from an external database. Map files have different extensions (.mps to send data; .mpr to retrieve data).

**Map Navigator**  A feature that displays your current position on a Strategy, Accountability, or Cause and Effect map, indicated by a red outline.

**Marginal Tax Rate**  Used to calculate the after-tax cost of debt. Represents the tax rate applied to the last earned income dollar (the rate from the highest tax bracket into which income falls) and includes federal, state and local taxes. Based on current level of taxable income and tax bracket, you can predict marginal tax rate.

**Market Risk Premium**  The additional rate of return paid over the risk-free rate to persuade investors to hold “riskier” investments than government securities. Calculated by subtracting the risk-free rate from the expected market return. These figures should closely model future market conditions.

**master data model**  An independent data model that is referenced as a source by multiple queries. When used, “Locked Data Model” is displayed in the Query section’s Content pane; the data model is linked to the master data model displayed in the Data Model section, which an administrator may hide.

**mathematical operator**  A symbol that defines how data is calculated in formulas and outlines. Can be any of the standard mathematical or Boolean operators; for example, +, -, *, /, and %.

**MaxL**  The multidimensional database access language for Essbase, consisting of a data definition language (MaxL DDL) and a data manipulation language (MaxL DML). See also MaxL DDL, MaxL DML, and MaxL Shell.

**MaxL DDL**  Data definition language used by Essbase for batch or interactive system-administration tasks.

**MaxL DML**  Data manipulation language used in Essbase for data query and extraction.

**MaxL Perl Module**  A Perl module (essbase.pm) that is part of Essbase MaxL DDL. This module can be added to the Perl package to provide access to Essbase databases from Perl programs.

**MaxL Script Editor**  A script-development environment in Administration Services Console. MaxL Script Editor is an alternative to using a text editor and the MaxL Shell for administering Essbase with MaxL scripts.

**MaxL Shell**  An interface for passing MaxL statements to Essbase Server. The MaxL Shell executable file is located in the Essbase bin directory (UNIX: essmsih, Windows: essmsih.exe).

**MDX (multidimensional expression)**  The language that give instructions to OLE DB for OLAP-compliant databases, as SQL is used for relational databases. When you build the OLAPQuery section's Outliner, Interactive Reporting Clients translate requests into MDX instructions. When you process the query, MDX is sent to the database server, which returns records that answer your query. See also SQL spreadsheet.

**measures**  Numeric values in an OLAP database cube that are available for analysis. Measures are margin, cost of goods sold, unit sales, budget amount, and so on. See also fact table.

**member**  A discrete component within a dimension. A member identifies and differentiates the organization of similar units. For example, a time dimension might include such members as Jan, Feb, and Qtr1.

**member list**  A named group, system- or user-defined, that references members, functions, or member lists within a dimension.

**member load**  In Essbase Integration Services, the process of adding dimensions and members (without data) to Essbase outlines.

**member selection report command**  A type of Report Writer command that selects member ranges based on outline relationships, such as sibling, generation, and level.

**member-specific report command**  A type of Report Writer formatting command that is executed as it is encountered in a report script. The command affects only its associated member and executes the format command before processing the member.
**merge**  A data load option that clears values only from the accounts specified in the data load file and replaces them with values in the data load file.

**metadata**  A set of data that defines and describes the properties and attributes of the data stored in a database or used by an application. Examples of metadata are dimension names, member names, properties, time periods, and security.

**metadata sampling**  The process of retrieving a sample of members in a dimension in a drill-down operation.

**metadata security**  Security set at the member level to restrict users from accessing certain outline members.

**metaoutline**  In Essbase Integration Services, a template containing the structure and rules for creating an Essbase outline from an OLAP model.

**metric**  A numeric measurement computed from business data to help assess business performance and analyze company trends.

**migration audit report**  A report generated from the migration log that provides tracking information for an application migration.

**migration definition file (.mdf)**  A file that contains migration parameters for an application migration, enabling batch script processing.

**migration log**  A log file that captures all application migration actions and messages.

**migration snapshot**  A snapshot of an application migration that is captured in the migration log.

**MIME Type**  (Multipurpose Internet Mail Extension) An attribute that describes the data format of an item, so that the system knows which application should open the object. A file's mime type is determined by the file extension or HTTP header. Plug-ins tell browsers what mime types they support and what file extensions correspond to each mime type.

**mining attribute**  In data mining, a class of values used as a factor in analysis of a set of data.

**minireport**  A report component that includes layout, content, hyperlinks, and the query or queries to load the report. Each report can include one or more minireports.

**missing data (#MISSING)**  A marker indicating that data in the labeled location does not exist, contains no value, or was never entered or loaded. For example, missing data exists when an account contains data for a previous or future period but not for the current period.

**model**  (1) In data mining, a collection of an algorithm's findings about examined data. A model can be applied against a wider data set to generate useful information about that data. (2) A file or content string containing an application-specific representation of data. Models are the basic data managed by Shared Services, of two major types: dimensional and non-dimensional application objects. (3) In Business Modeling, a network of boxes connected to represent and calculate the operational and financial flow through the area being examined.

**monetary**  A money-related value.

**multidimensional database**  A method of organizing, storing, and referencing data through three or more dimensions. An individual value is the intersection point for a set of dimensions.

**named set**  In MaxL DML, a set with its logic defined in the optional WITH section of a MaxL DML query. The named set can be referenced multiple times in the query.

**native authentication**  The process of authenticating a user name and password from within the server or application.

**nested column headings**  A report column heading format that displays data from multiple dimensions. For example, a column heading that contains Year and Scenario members is a nested column. The nested column heading shows Q1 (from the Year dimension) in the top line of the heading, qualified by Actual and Budget (from the Scenario dimension) in the bottom line of the heading.

**NO DATA status**  A consolidation status indicating that this entity contains no data for the specified period and account.

**non-dimensional model**  A Shared Services model type that includes application objects such as security files, member lists, calculation scripts, and Web forms.

**non-unique member name**  See duplicate member name.

**note**  Additional information associated with a box, measure, scorecard or map element.
null value  A value that is absent of data. Null values are not equal to zero.

numeric attribute range  A feature used to associate a base dimension member that has a discrete numeric value with an attribute that represents a value range. For example, to classify customers by age, an Age Group attribute dimension can contain members for the following age ranges: 0-20, 21-40, 41-60, and 61-80. Each Customer dimension member can be associated with an Age Group range. Data can be retrieved based on the age ranges rather than on individual age values.

ODBC  Open Database Connectivity. A database access method used from any application regardless of how the database management system (DBMS) processes the information.

OK status  A consolidation status indicating that an entity has already been consolidated, and that data has not changed below it in the organization structure.

OLAP Metadata Catalog  In Essbase Integration Services, a relational database containing metadata describing the nature, source, location, and type of data that is pulled from the relational data source.

OLAP model  In Essbase Integration Services, a logical model (star schema) that is created from tables and columns in a relational database. The OLAP model is then used to generate the structure of a multidimensional database.

online analytical processing (OLAP)  A multidimensional, multiuser, client-server computing environment for users who analyze consolidated enterprise data in real time. OLAP systems feature drill-down, data pivoting, complex calculations, trend analysis, and modeling.

Open Database Connectivity (ODBC)  Standardized application programming interface (API) technology that allows applications to access multiple third-party databases.

organization  An entity hierarchy that defines each entity and their relationship to others in the hierarchy.

origin  The intersection of two axes.

outline  The database structure of a multidimensional database, including all dimensions, members, tags, types, consolidations, and mathematical relationships. Data is stored in the database according to the structure defined in the outline.

outline synchronization  For partitioned databases, the process of propagating outline changes from one database to another database.

P&L accounts (P&L)  Profit and loss accounts. Refers to a typical grouping of expense and income accounts that comprise a company’s income statement.

page  A display of information in a grid or table often represented by the Z-axis. A page can contain data from one field, derived data from a calculation, or text.

page file  Essbase data file.

page heading  A report heading type that lists members represented on the current page of the report. All data values on the page have the members in the page heading as a common attribute.

page member  A member that determines the page axis.

palette  A JASC compliant file with a .PAL extension. Each palette contains 16 colors that complement each other and can be used to set the dashboard color elements.

parallel calculation  A calculation option. Essbase divides a calculation into tasks and calculates some tasks simultaneously.

parallel data load  In Essbase, the concurrent execution of data load stages by multiple process threads.

parallel export  The ability to export Essbase data to multiple files. This may be faster than exporting to a single file, and it may resolve problems caused by a single data file becoming too large for the operating system to handle.

parent adjustments  The journal entries that are posted to a child in relation to its parent.

parents  The entities that contain one or more dependent entities that report directly to them. Because parents are both entities and associated with at least one node, they have entity, node, and parent information associated with them.

partition area  A subcube within a database. A partition is composed of one or more areas of cells from a portion of the database. For replicated and transparent partitions, the number of cells within an area must be the same for the data source and target to ensure that the two partitions have the same shape. If the data source area contains 18 cells, the data target area must also contain 18 cells to accommodate the number of values.
**partitioning** The process of defining areas of data that are shared or linked between data models. Partitioning can affect the performance and scalability of Essbase applications.

**pattern matching** The ability to match a value with any or all characters of an item entered as a criterion. Missing characters may be represented by wild card values such as a question mark (?) or an asterisk (*). For example, “Find all instances of apple” returns apple, but “Find all instances of apple*” returns apple, applesauce, applecranberry, and so on.

**percent consolidation** The portion of a child’s values that is consolidated to its parent.

**percent control** Identifies the extent to which an entity is controlled within the context of its group.

**percent ownership** Identifies the extent to which an entity is owned by its parent.

**performance indicator** An image file used to represent measure and scorecard performance based on a range you specify; also called a status symbol. You can use the default performance indicators or create an unlimited number of your own.

**periodic value method (PVA)** A process of currency conversion that applies the periodic exchange rate values over time to derive converted results.

**permission** A level of access granted to users and groups for managing data or other users and groups.

**persistence** The continuance or longevity of effect for any Essbase operation or setting. For example, an Essbase administrator may limit the persistence of user name and password validity.

**personal pages** A personal window to repository information. You select what information to display and its layout and colors.

**personal recurring time events** Reusable time events that are accessible only to the user who created them.

**personal variable** A named selection statement of complex member selections.

**perspective** A category used to group measures on a scorecard or strategic objectives within an application. A perspective can represent a key stakeholder (such as a customer, employee, or shareholder/financial) or a key competency area (such as time, cost, or quality).

**pie chart** A chart that shows one data set segmented in a pie formation.

**pinboard** One of the three data object display types. Pinboards are graphics, composed of backgrounds and interactive icons called pins. Pinboards require traffic lighting definitions.

**pins** Interactive icons placed on graphic reports called pinboards. Pins are dynamic. They can change images and traffic lighting color based on the underlying data values and analysis tools criteria.

**pivot** The ability to alter the perspective of retrieved data. When Essbase first retrieves a dimension, it expands data into rows. You can then pivot or rearrange the data to obtain a different viewpoint.

**planner** Planners, who comprise the majority of users, can input and submit data, use reports that others create, execute business rules, use task lists, enable e-mail notification for themselves, and use Smart View.

**planning unit** A data slice at the intersection of a scenario, version, and entity; the basic unit for preparing, reviewing, annotating, and approving plan data.

**plot area** The area bounded by X, Y, and Z axes; for pie charts, the rectangular area surrounding the pie.

**plug account** An account in which the system stores any out of balance differences between intercompany account pairs during the elimination process.

**POV (point of view)** A feature for working with dimension members not assigned to row, column, or page axes. For example, you could assign the Currency dimension to the POV and select the Euro member. Selecting this POV in data forms displays data in Euro values.

**precalculation** Calculating the database prior to user retrieval.

**precision** Number of decimal places displayed in numbers.

**predefined drill paths** Paths used to drill to the next level of detail, as defined in the data model.
**presentation**  A playlist of Web Analysis documents, enabling reports to be grouped, organized, ordered, distributed, and reviewed. Includes pointers referencing reports in the repository.

**preserve formulas**  User-created formulas kept within a worksheet while retrieving data.

**primary measure**  A high-priority measure important to your company and business needs. Displayed in the Contents frame.

**product**  In Shared Services, an application type, such as Planning or Performance Scorecard.

**Production Reporting**  See SQR Production Reporting.

**project**  An instance of Oracle’s Hyperion products grouped together in an implementation. For example, a Planning project may consist of a Planning application, an Essbase cube, and a Financial Reporting Server instance.

**promote**  The action to move a data unit to the next review level, allowing a user having the appropriate access to review the data. For example, an analyst may promote the data unit to the next level for his supervisor’s review.

**promotion**  The process of transferring artifacts from one environment or machine to another; for example, from a testing environment to a production environment.

**property**  A characteristic of an artifact, such as size, type, or processing instructions.

**provisioning**  The process of granting users and groups specific access permissions to resources.

**proxy server**  A server acting as an intermediary between workstation users and the Internet to ensure security.

**public job parameters**  Reusable, named job parameters created by administrators and accessible to users with requisite access privileges.

**public recurring time events**  Reusable time events created by administrators and accessible through the access control system.

**PVA**  See periodic value method (PVA).

**qualified name**  A member name in a qualified format that differentiates duplicate member names in a duplicate member outline. For example, [Market].[East].[State].[New York] or [Market].[East].[City].[New York]

**query**  Information requests from data providers. For example, used to access relational data sources.

**query governor**  An Essbase Integration Server parameter or Essbase Server configuration setting that controls the duration and size of queries made to data sources.

**range**  A set of values including upper and lower limits, and values falling between limits. Can contain numbers, amounts, or dates.

**reconfigure URL**  URL used to reload servlet configuration settings dynamically when users are already logged on to the Workspace.

**record**  In a database, a group of fields making up one complete entry. For example, a customer record may contain fields for name, address, telephone number, and sales data.

**recurring template**  A journal template for making identical adjustments in every period.

**recurring time event**  An event specifying a starting point and the frequency for running a job.

**redundant data**  Duplicate data blocks that Essbase retains during transactions until Essbase commits updated blocks.

**regular journal**  A feature for entering one-time adjustments for a period. Can be balanced, balanced by entity, or unbalanced.

**Related Accounts**  The account structure groups all main and related accounts under the same main account number. The main account is distinguished from related accounts by the first suffix of the account number.

**relational database**  A type of database that stores data in related two-dimensional tables. Contrast with multidimensional database.

**replace**  A data load option that clears existing values from all accounts for periods specified in the data load file, and loads values from the data load file. If an account is not specified in the load file, its values for the specified periods are cleared.

**replicated partition**  A portion of a database, defined through Partition Manager, used to propagate an update to data mastered at one site to a copy of data stored at another site. Users can access the data as though it were part of their local database.
Report Extractor  An Essbase component that retrieves report data from the Essbase database when report scripts are run.

report object  In report designs, a basic element with properties defining behavior or appearance, such as text boxes, grids, images, and charts.

report script  A text file containing Essbase Report Writer commands that generate one or more production reports.

Report Viewer  An Essbase component that displays complete reports after report scripts are run.

reporting currency  The currency used to prepare financial statements, and converted from local currencies to reporting currencies.

repository  Stores metadata, formatting, and annotation information for views and queries.

resources  Objects or services managed by the system, such as roles, users, groups, files, and jobs.

restore  An operation to reload data and structural information after a database has been damaged or destroyed, typically performed after shutting down and restarting the database.

restructure  An operation to regenerate or rebuild the database index and, in some cases, data files.

result frequency  The algorithm used to create a set of dates to collect and display results.

review level  A Process Management review status indicator representing the process unit level, such as Not Started, First Pass, Submitted, Approved, and Published.

Risk Free Rate  The rate of return expected from “safer” investments such as long-term U.S. government securities.

role  The means by which access permissions are granted to users and groups for resources.

roll-up  See consolidation.

root member  The highest member in a dimension branch.

row heading  A report heading that lists members down a report page. The members are listed under their respective row names.

RSC services  Services that are configured with Remote Service Configurator, including Repository Service, Service Broker, Name Service, Event Service, and Job Service.

rules  User-defined formulas.

runtime prompt  A variable that users enter or select before a business rule is run.

sampling  The process of selecting a representative portion of an entity to determine the entity’s characteristics. See also metadata sampling.

saved assumptions  User-defined Planning assumptions that drive key business calculations (for example, the cost per square foot of office floor space).

scale  The range of values on the Y axis of a chart.

scaling  Scaling determines the display of values in whole numbers, tens, hundreds, thousands, millions, and so on.

scenario  A dimension for classifying data (for example, Actuals, Budget, Forecast1, and Forecast2).

schedule  Specify the job that you want to run and the time and job parameter list for running the job.

scope  The area of data encompassed by any Essbase operation or setting; for example, the area of data affected by a security setting. Most commonly, scope refers to three levels of granularity, where higher levels encompass lower levels. From highest to lowest, these levels are as follows: the entire system (Essbase Server), applications on Essbase Server, or databases within Essbase Server applications. See also persistence.

score  The level at which targets are achieved, usually expressed as a percentage of the target.

scorecard  Business Object that represents the progress of an employee, strategy element, or accountability element toward goals. Scorecards ascertain this progress based on data collected for each measure and child scorecard added to the scorecard.

scorecard report  A report that presents the results and detailed information about scorecards attached to employees, strategy elements, and accountability elements.
**secondary measure**  A low-priority measure, less important than primary measures. Secondary measures do not have Performance reports but can be used on scorecards and to create dimension measure templates.

**Section pane**  Lists all sections that are available in the current Interactive Reporting Client document.

**security agent**  A Web access management provider (for example, Netegrity SiteMinder) that protects corporate Web resources.

**security platform**  A framework enabling Oracle’s Hyperion applications to use external authentication and single sign-on.

**serial calculation**  The default calculation setting Essbase divides a calculation pass into tasks and calculates one task at a time.

**services**  Resources that enable business items to be retrieved, changed, added, or deleted. Examples: Authorization and Authentication.

**servlet**  A piece of compiled code executable by a Web server.

**Servlet Configurator**  A utility for configuring all locally installed servlets.

**session**  The time between login and logout for a user connected to Essbase Server.

**set**  In MaxL DML, a required syntax convention for referring to a collection of one or more tuples. For example, in the following MaxL DML query, SELECT { [100-10] } ON COLUMNS FROM Sample.Basic { [100-10] } is a set.

**shared member**  A member that shares storage space with another member of the same name, preventing duplicate calculation of members that occur multiple times in an Essbase outline.

**Shared Services**  Application enabling users to share data between supported Oracle’s Hyperion products by publishing data to Shared Services and running data integrations.

**sibling**  A child member at the same generation as another child member and having the same immediate parent. For example, the members Florida and New York are children of East and each other’s siblings.

**single sign-on**  Ability to access multiple Oracle’s Hyperion products after a single login using external credentials.

**slicer**  In MaxL DML, the section at the end of a query that begins with and includes the keyword WHERE.

**smart tags**  Keywords in Microsoft Office applications that are associated with predefined actions available from the Smart Tag menu. In Oracle’s Hyperion applications, smart tags can also be used to import Reporting and Analysis content, and access Financial Management and Essbase functions.

**SmartCut**  A link to a repository item, in URL form.

**snapshot**  Read-only data from a specific time.

**source currency**  The currency from which values originate and are converted through exchange rates to the destination currency.

**sparse dimension**  In block storage databases, a dimension unlikely to contain data for all member combinations when compared to other dimensions. For example, not all customers have data for all products.

**SPF files**  Printer-independent files created by a SQR Production Reporting server, containing a representation of the actual formatted report output, including fonts, spacing, headers, footers, and so on.

**Spotlighter**  A tool that enables color coding based on selected conditions.

**SQL spreadsheet**  A data object that displays the result set of a SQL query.

**SQR Production Reporting**  A specialized programming language for data access, data manipulation, and creating SQR Production Reporting documents.

**stacked charts**  A chart where the categories are viewed on top of one another for visual comparison. This type of chart is useful for subcategorizing within the current category. Stacking can be used from the Y and Z axis in all chart types except pie and line. When stacking charts the Z axis is used as the Fact/Values axis.

**stage**  A task description that forms one logical step within a taskflow, usually performed by an individual. A stage can be manual or automated.
For automated stages, the invoked action that executes the stage.

A dimension that is not an attribute dimension.

A journal function used to post adjustments that have common adjustment information for each period. For example, you can create a standard template that contains the common account IDs, entity IDs, or amounts, then use the template as the basis for many regular journals.

The Standard template is the basis for the basic Strategic Finance file. The Standard template contains all default settings. All new files are created from the Standard template unless another template is selected.

The quickest method for creating a Web Analysis document. The Start in Play process requires you to specify a database connection, then assumes the use of a spreadsheet data object. Start in Play uses the highest aggregate members of the time and measures dimensions to automatically populate the rows and columns axes of the spreadsheet.

The status bar at the bottom of the screen displays helpful information about commands, accounts, and the current status of your data file.

In aggregate storage databases outlines only. A hierarchy in which the members are aggregated according to the outline structure. Stored hierarchy members have certain restrictions, for example, they cannot contain formulas.

A long-term goal defined by measurable results. Each strategic objective is associated with one perspective in the application, has one parent, the entity, and is a parent to critical success factors or other strategic objectives.

Represents how the organization implements high-level mission and vision statements into lower-level, constituent strategic goals and objectives.

Displays a topic as a simple list of component data items.

A language used to process instructions to relational databases.

A system for numbering subaccounts using non-sequential, whole numbers.

Flags an item or folder to receive automatic notification whenever the item or folder is updated.

In the Investigates Section, rolls up detail charts shown below in the same column, plotting metrics at the summary level at the top of each chart column.

A special service used by the startCommonServices script to start the RSC services.

A user with full access to all applications, databases, related files, and security mechanisms for a server.

Calculations and assumptions from which the values of cells are derived.

Excludes rows containing missing values, and underscores characters from spreadsheet reports.

A server architecture that enables multiprocessing and multithreading. Performance is not significantly degraded when a large number of users connect to a single instance simultaneously.

Synchronizes Shared Services and application models.

The condition that exists when the latest version of a model resides in both the application and in Shared Services. See also model.

Transfers data from an application’s metadata into an ASCII file.

Navigable views of accounts and reports in Strategic Finance.

Expected results of a measure for a specified period of time (day, quarter, etc.)

A detailed status list of tasks for a particular user.

The automation of a business process in which tasks are passed from one taskflow participant to another according to procedural rules.
**taskflow definition**  Represents business processes in the taskflow management system. Consists of a network of stages and their relationships; criteria indicating the start and end of the taskflow; and information about individual stages, such as participants, associated applications, associated activities, and so on.

**taskflow instance**  Represents a single instance of a taskflow including its state and associated data.

**taskflow management system**  Defines, creates, and manages the execution of a taskflow including: definitions, user or application interactions, and application executables.

**taskflow participant**  The resource who performs the task associated with the taskflow stage instance for both manual and automated stages.

**Taxes - Initial Balances**  Strategic Finance assumes that the Initial Loss Balance, Initial Gain Balance and the Initial Balance of Taxes Paid entries have taken place in the period before the first Strategic Finance time period.


**template**  A predefined format designed to retrieve particular data consistently.

**time dimension**  Defines the time period that the data represents, such as fiscal or calendar periods.

**time events**  Triggers for execution of jobs.

**time scale**  Displays metrics by a specific period in time, such as monthly or quarterly.

**time series reporting**  A process for reporting data based on a calendar date (for example, year, quarter, month, or week).

**Title bar**  Displays the Strategic Finance name, the file name, and the scenario name Version box.

**token**  An encrypted identification of one valid user or group on an external authentication system.

**top and side labels**  Column and row headings on the top and sides of a Pivot report.

**top-level member**  A dimension member at the top of the tree in a dimension outline hierarchy, or the first member of the dimension in sort order if there is no hierarchical relationship among dimension members. The top-level member name is generally the same as the dimension name if a hierarchical relationship exists.

**trace level**  Defines the level of detail captured in the log file.

**traffic lighting**  Color-coding of report cells, or pins based on a comparison of two dimension members, or on fixed limits.

**transformation**  (1) Transforms artifacts so that they function properly in the destination environment after application migration. (2) In data mining, modifies data (bidirectionally) flowing between the cells in the cube and the algorithm.

**translation**  See currency conversion.

**Transmission Control Protocol/Internet Protocol (TCP/IP)**  A standard set of communication protocols linking computers with different operating systems and internal architectures. TCP/IP utilities are used to exchange files, send mail, and store data to various computers that are connected to local and wide area networks.

**transparent login**  Logs in authenticated users without launching the login screen.

**transparent partition**  A shared partition that enables users to access and change data in a remote database as though it is part of a local database.

**triangulation**  A means of converting balances from one currency to another via a third common currency. In Europe, this is the euro for member countries. For example, to convert from French franc to Italian lira, the common currency is defined as European euro. Therefore, in order to convert balances from French franc to Italian lira, balances are converted from French franc to European euro and from European euro to Italian lira.

**triggers**  An Essbase feature whereby data is monitored according to user-specified criteria which when met cause Essbase to alert the user or system administrator.

**trusted password**  A password that enables users authenticated for one product to access other products without reentering their passwords.
trusted user  Authenticated user

tuple  MDX syntax element that references a cell as an intersection of a member from each dimension. If a dimension is omitted, its top member is implied. Examples: (Jan); (Jan, Sales); ([Jan], [Sales], [Cola], [Texas], [Actual])

two-pass  An Essbase property that is used to recalculate members that are dependent on the calculated values of other members. Two-pass members are calculated during a second pass through the outline.

unary operator  A mathematical indicator (+, -, *, /, %) associated with an outline member. The unary operator defines how the member is calculated during a database roll-up.

Unicode-mode application  An Essbase application wherein character text is encoded in UTF-8, enabling users with computers set up for different languages to share application data.

unique member name  A non-shared member name that exists only once in a database outline.

unique member outline  A database outline that is not enabled for duplicate member names.

upper-level block  A type of data block wherein at least one of the sparse members is a parent-level member.

user directory  A centralized location for user and group information. Also known as a repository or provider.

user variable  Dynamically renders data forms based on a user's member selection, displaying only the specified entity. For example, user variable named Department displays specific departments and employees.

user-defined attribute (UDA)  User-defined attribute, associated with members of an outline to describe a characteristic of the members. Users can use UDAs to return lists of members that have the specified UDA associated with them.

user-defined member list  A named, static set of members within a dimension defined by the user.

validation  A process of checking a business rule, report script, or partition definition against the outline to make sure that the object being checked is valid.

value dimension  Used to define input value, translated value, and consolidation detail.

variance  Difference between two values (for example, planned and actual value).

version  Possible outcome used within the context of a scenario of data. For example, Budget - Best Case and Budget - Worst Case where Budget is scenario and Best Case and Worst Case are versions.

view  Representation of either a year-to-date or periodic display of data.

visual cue  A formatted style, such as a font or a color, that highlights specific types of data values. Data values may be dimension members; parent, child, or shared members; dynamic calculations; members containing a formula; read only data cells; read and write data cells; or linked objects.

Web server  Software or hardware hosting intranet or Internet Web pages or Web applications.

weight  Value assigned to an item on a scorecard that indicates the relative importance of that item in the calculation of the overall scorecard score. The weighting of all items on a scorecard accumulates to 100%. For example, to recognize the importance of developing new features for a product, the measure for New Features Coded on a developer’s scorecard would be assigned a higher weighting than a measure for Number of Minor Defect Fixes.

wild card  Character that represents any single character (?) or group of characters (*) in a search string.

WITH section  In MaxL DML, an optional section of the query used for creating re-usable logic to define sets or members. Sets or custom members can be defined once in the WITH section, and then referenced multiple times during a query.

workbook  An entire spreadsheet file with many worksheets.

write-back  The ability for a retrieval client, such as a spreadsheet, to update a database value.

ws.conf  A configuration file for Windows platforms.

wsconf_platform  A configuration file for UNIX platforms.

XML  See Extensible Markup Language (XML).
**Y axis scale**  Range of values on Y axis of charts displayed in Investigate Section. For example, use a unique Y axis scale for each chart, the same Y axis scale for all Detail charts, or the same Y axis scale for all charts in the column. Often, using a common Y axis improves your ability to compare charts at a glance.

**Zero Administration**  Software tool that identifies version number of the most up-to-date plug-in on the server.

**zoom**  Sets the magnification of a report. For example, magnify a report to fit whole page, page width, or percentage of magnification based on 100%.

**ZoomChart**  Used to view detailed information by enlarging a chart. Enables you to see detailed numeric information on the metric that is displayed in the chart.
Index

Financial Reporting, 27, 30, 186, 249
components, 16
overview, 15

Symbols
Financial Reporting, user tasks, 23

A
Abs function, 214
absolute operand, 269
adding report objects
charts, 91
grids, 86
images, 89
text boxes, 84
aggregate property argument, 206
allow expansions
Hyperion Financial Management and Hyperion
Essbase, 148
application name, retrieving, 222
applying formatting
calculated columns, 126
calculated data rows, 126
argument, expressing the range, 132
arguments
cell reference, 204
column reference, 204
embedded functions, 207
numeric, 204
property, 205
row reference, 204
attributes, modifying, 313
Average function, 215
AverageA function, 216
axes
ingling labels, 68
metadata labels, 68
axes titles, defining for charts, 76

B
bar charts
options, 70
overview, 62
batch input file
creating, 312
launching, 312
batch jobs
defining, 277
batch jobs, defining, 277
batch processing, overview, 277
batches of reports, printing, 159
best practices
formatting grids, 166
books
changing data source for, 274
importing, 295
previewing in the Web, 158
borders
adding to text boxes, 165
formatting, 165
bring to front, objects, 93

C
CalcStatus function, 217
calculated data rows and columns
applying formatting, 126
calculation iterations, default, 300
calculations, cell level, 140
cell formatting, Format Painter, 175
cell reference arguments, 204
cells
accessing in a linked report, 152
calculating, 140
defining formulas in, 140
described, 19
merging, 188
CellText function, 218
changing, data source, 122
chart options
  bar charts, 70
  line charts, 71
chart types
  bar chart, 61
  line chart, 62
  pie chart, 64
charts
  adding to reports, 91
customizing axes titles in, 78
customizing overview, 61
defining a chart’s position, 74
defining data, 65
defining legends, 78
defining titles, 76
described, 18
overlapping, 93
positioning on a report, 74
circular referencing
  multiple calculation iterations, 134
closing
  Designer, 27
  Studio Explore, 27
column headings
  defining in grids, 102
displaying on each page, 197
column reference arguments, 204
column reference operand, 269
column width, 188
columns
  described, 19
  expanded, 129
  expanding, 148
  hiding, 176
  inserting into grids, 100
  sorting, 177
  sorting in grids, 177
  specifying width of, 188
  subtotaling in grids, 123
combo charts, described, 63
Command Line Scheduler, XML tags, 315
conditional formatting
  adding formats, 186
applying on grids, 182
changing order of formats, 187
comparison options, 185
deleting formats, 187
properties, 182
reference values, 184
conditional suppression, 189
deleting, 195
Count function, 221
CountA function, 222
creating reports, overview, 81
currency symbol table, 337
Current keyword, 210
customizing
  axes titles in charts, 78
  row and column headings, 102
cut, copy, and paste
grids, 101
repository items, 273

D

data
  accessing from a linked report, 152
  assigning sources for a grid, 122
  changing source for a grid, 122
  suppressing, 189
  using the GetCell function, 228
data prompts
  defining for a batch of reports, 277
  responding to, 157
data query optimization options, setting, 112
data rows and columns, subtotaling, 123
data source
  changing, 274
  changing for a grid, 122
  retrieving the name, 222
  specifying multiple for a grid, 122
data source, changing, 122
database connection
  changing, 274
  managing, 273
database name, retrieving, 222
database retrieval operand, 269
DataSource function, 222
date
  format characters, 224
  retrieving current, 254, 255
Date function, 224
defining
  batch jobs, 277
  chart data, 65
  chart legends, 78
  chart titles, 76
deleting
  conditional suppression, 195
  report objects from the report, 95
  reports from books, 295
  reports from the workspace library, 273
  selected members, 53
Designer
  creating new reports, 24
  described, 20
  toolbar, 28
designing reports, headers and footers, 95
detail
  accessing in a linked report, 152
  viewing in a grid, 148
Difference function, 226
differences between Hyperion Essbase ports and connections, 309
dimensions
  retrieving, 230
  validating that data sources have the same, 274
displaying
  line item detail, 115
  supporting detail, 115
downloading, XBRL taxonomies, 280
Dynamic Time Series (DTS) function, 49
DynamicMemberList, 49

E
  e-mails, sending links to reports via, 273
Edit menu, 30
ing
  hierarchical functions, 52
  member lists, 56
  report formats, 163
embedded functions arguments, 207
Eval function, 227
Exit command, 30
exiting Financial Reporting Studio, 27
expanding rows or columns, using, 129
expansions
  Essbase, 115
see related content, 152
exporting, instance document, 292
expressions
  operands in, 269
  using, 268, 269
F
  File menu, 29
  filters, defining, 54
  finding members, 56
  folders, creating, 271
  fonts, specifying, 163
footers
  described, 19
  designing, 95
Format Chart
  appearance, 68
  axes, 68
  bar options, 68
  element style, 68
  legend, 68
  line and bar (combo) options, 68
  line options, 68
  pie options, 69
Format menu, 32
Format Painter, copy cell formatting, 175
formatting
  cells using inheritance, 174
  columns, 188
  date and time function, 224
  grid, 188
  images, 196
  pages, 197
  shading and borders, 165
  suppressing data, 189
  text, 163
formatting grids
  aligning text in grids, 168
  best practices, 166
  formatting numbers in grids, 166
  modifying font options, 170
  replacing text, 173
Formatting Grids, adding borders or shading, 171
formula bar
  accessing, 136
  creating formulas, 136
  deleting a formula, 138
editing a formula, 138
function help, 137
member selection, 134
modifying member selection, 138
using, 134
formula rows and columns
defining headings, 129
formulas
adding to rows and columns, 128
function operand, 269
functions
Abs, 214
Average, 215
AverageA, 216
CalcStatus, 217
CellText, 218
Count, 221
CountA, 222
DataSource, 222
Date, 224
Eval, 227
GetCell, 228
GetHeading, 229
GridDimension, 230
HFMCurrency, 231
IfThen, 233
Max, 236
MemberAlias, 236
MemberDescription, 237
MemberName, 239, 240
MemberProperty, 240
MemberQualifiedName, 241
Min, 242
Mod, 243
Page, 244
PageCount, 244
PercentOfTotal, 245
Pi, 246
PlanningAnnotations, 246
POVAlias, 249
POVDescription, 249
POVMember, 250
ProcessManagementStatus, 250
Product, 251
Random, 252
ReportAuthor, 254
ReportCreated, 254
ReportDesc, 254
ReportFolder, 255
ReportModified, 255
ReportModifiedBy, 256
ReportName, 256
ReportRunBy, 256
Round, 256
Sqrt, 257
Sum, 258
Truncate, 259
Variance, 260
VariancePercent, 263
functions, editing, 52
G
GetCell function, 228
GetHeading function, 229
graphics, adding to reports, 89
grid
zoom, 36, 165
grid data source, retrieving, 222
grid rows and columns
defining formulas on, 128
expanding, 129
subtotaling, 123
GridDimension function, 230
grids
adding to reports, 86
calculating at the cell level, 140
column width, 188
cut, copy, and paste, 101
data sources for, 122
defining, 86
described, 18
hiding, 176
inserting page breaks, 119
inserting rows and columns in, 100
overlapping, 93
row height, 188
viewing detailed data in, 148
H
headers
described, 18
designing, 95
headings
customizing, 102
defining in grids, 120
displaying on each page, 197
height of columns, specifying, 188
Help menu, 33
HFMCurrency function, 231
hiding grids, 176

I
IfThen function, 233
images
    adding to reports, 89
described, 19
formatting, 196
overlapping, 93
importing
    reports, 273
    snapshot reports, 273
indenting text, 164
inheritance, cell formatting, 174
Insert menu, 31
inserting
    grids, 19
    page breaks, 97
text boxes, 19
instance document, exporting, 292

K
keyword, current, 210

L
labels, editing, 283
legends, defining, 78
line charts
    described, 62
    options, 71
linked report objects, 82
linked report, accessing data from, 152
links to workspace library items, 273
local report objects, 82
logging on to Workspace, 24

M
margins, setting for reports, 197
mathematical
    expressions, natural precedence in, 269
    operands, 269
    operators, 268
    Max function, 236
member lists
    defining, 55
editing, 56
    previewing, 58
member prompts, 157
member selection
    formula bar, 134
MemberAlias function, 236
MemberDescription function, 237
MemberName function, 239
MemberProperty function, 240
MemberQualifiedName function, 241
members
    assigning, 40, 52
copying, 52
deleting, 53
finding, 56
    previewing, 58
    prompting for in batch processing, 277
sorting, 58
menus
    Edit, 30
    File, 29
    Format, 32
    Help, 33
    Insert, 31
    View, 30
    Window, 33
merging cell, 188
metadata label
    axes, 68
metadata labels
    font, 68
Min function, 242
Mod function, 243

N
name
    retrieving for a report, 256
    returning the user name for a report, 256
natural precedence, in mathematical expressions, 269
numeric arguments, 204
objects
   security, 274
opening reports, 26
operands, in mathematical expressions, 269
operators, in mathematical expressions, 268
options, setting for report objects, 20
order of operations, 269
overlapping objects
   bring to front, 93
   reports, 93
   send to back, 93

P
page axis, described, 19
page breaks
   inserting before report objects, 97
   inserting in a grid, 119
page dimension heading, defining, 120
Page function, 244
page number, retrieving, 244
Page Setup options, 30
page, changing, 197
PageCount function, 244
pages, setting up, 197
PercentOfTotal function, 245
PeriodOffset, 48
PI function, 246
pictures, adding to reports, 89
pie charts, described, 64
pie charts, formatting, 72
PlanningAnnotations function, 246
point of view (POV)
   selecting members, 144
   setting up, 143
   showing/hiding POV bar, 118
   user, 143
ports and connections, differences, 309, 310
positioning report objects, 93
POVAlias function, 249
POVDescription function, 249
POVMember function, 250
precedence
   in expressions, 269
   row or column calculation, 140
previewing, selected members, 58
Print Preview, menu command, 28
printing
   page number, 244
   reports, 159
   snapshot reports, 159
tips on, 160
ProcessManagementStatus function, 250
Product function, 251
prompts
   defining in a batch of reports, 277
   responding to when previewing, 157
property arguments, 205
   aggregate, 206
   reference, 206
property sheets, described, 20
related content
   changing the related content server, 152
   creating links, 152
   modifying properties, 154
   removing access, 154
   setting up, 152
removing
   report objects from the report, 95
   selected members, 53
report components, 18
report information
   specifying in a report, 141
   viewing, 97
report menu commands, 30
report objects
   adding, 81
described, 19
   grids, 86
   in the workspace library, 272
   inserting page breaks before, 97
   linked and local, 82
   overlapping, 93
   positioning, 93, 94
   removing, 95
   resizing, 94
   saving, 95
   source, 82
report prompts, setting up for members, 42
ReportAuthor function, 254
ReportCreated function, 254
ReportDesc function, 254
ReportFolder function, 255
ReportModified function, 255
ReportModifiedBy function, 256
ReportName function, 256
ReportRunBy function, 256
reports
  assigning to a batch, 277
  building, 81
  changing data source for, 274
  changing page setup, 197
  creating, 24
  designing new, 24
  formatting, 163
  importing into Financial Reporting, 273
  opening, 26
  previewing in the Web, 158
  sample design, 17
  sending links via e-mail, 273
  setting options, 26
  viewing information on, 97
  viewing snapshot reports, 26
reports and books, print previewing, 159
reports see also linked reports, 152
repository, cut, copy, and paste, 273
resizing report objects, 94
Round function, 256
row and column template
  creating, 108
  inserting, 111
  linking, 111
  modifying, 112
  unlinking, 111
row and column templates, 105
row headings
  defining in grids, 102
  displaying on each page, 197
row height, 188
row reference arguments, 204
row reference operand, 269
rows
  described, 19
  expanded, 129
  expanding, 148
  hiding, 176
  inserting into grids, 100
  sorting, 177
  sorting in grids, 177
  specifying height of, 188
  subtotaling in grids, 123
S
Same As, setting up, 43
sample report, 17
schema labels, 283
schema registration
  maintaining, 283
  updating, 282
schemas, short names, 283
segment, expressing, 130
Select Members dialog box
  finding members, 56
  removing selected members, 53
  sorting members, 58
send to back, objects, 93
server name, retrieving, 222
servers, viewing activity on, 97
setting properties for report properties, 20
shading
  text box options, 165
short names, editing, 283
snapshot books
  importing, 295
  sending links to via e-mail, 273
snapshot reports
  copying in the workspace library, 272
  importing into Financial Reporting, 273
  printing, 159
  sending links to via e-mail, 273
  viewing, 26
sorting
  in grids, 177
  members, 58
source report object, 82
sparse command, 34
special members, 42
Sqrt (square root) function, 257
SSL, configuring for external authentication, 152
Standard toolbar, 27
starting Financial Reporting Studio, 24
Studio workspace, described, 19
subtotaling data rows or columns, 123
Sum function, 258
summaries of reports, viewing, 97
Summary command, 30
summary rows and columns, expanding, 148
supporting detail, showing, 115
suppressing
data, 189
suppression, conditional, 189
syntax, of math functions, 202
system administration tasks, 297
system toolbars, described, 27

T
Task menu, 32
tasks
for Financial Reporting, 23
tasks, system administration, 297
taxonomies, XBRL, downloading, 280
templates
row and column, 105
text
aligning, 164
formatting, 163
indenting and aligning, 164
specifying fonts for, 163
specifying in a report, 141
text boxes
adding borders or shading to, 165
adding to reports, 84
described, 18
inserting, 19
overlapping, 93
text functions
described, 208
using to display report information, 141
time
format characters, 224
retrieving current, 254, 255
title pages, creating, 96
titles, defining in charts, 76
toolbars
buttons, defined, 27
Designer, 28
report object buttons, 19
Standard, 27
totals on data rows and columns, 123
Truncate function, 259

U
user tasks, 23

V
value operand, 269
Variance function, 260
VariancePercent function, 263
View menu, 30
view preferences, setting, 158
Viewing, snapshot reports, 26

W
Web browser, previewing, 158
width of rows, specifying, 188
Window menu, 33
Workspace
changing, 197
workspace library
changing data source in, 274
copying reports and report objects in, 272
filtering report objects in, 272
security, 274
workspace library, described, 81

X
XBRL
enabling, 280
in Financial Reporting, 279
line items, assigning to rows, 287
managing the schema, 281
removing context from a column, 286
setting the context on columns, 284
setting up, 280

Z
zoom, grid, 36, 165